User Guide-Part A

Introduction – Transactions

Advantage Route Systems, Inc.
Your Route Technology Partner
## Contents

### Chapter 1 – Overview
  - Before getting started 1
  - Introduction 1
  - User Content 2
  - Service and Support 2

### Chapter 2 – Management Guide
  - Overview 3
  - Hardware Requirements 3
    - Workstation Requirements 3
    - Server Requirements 3
  - Implementing the System 4
  - Day-to-Day Operations 5
    - Setting up Route Data 5
    - Periodic Maintenance 5
    - Servicing Equipment 5
    - Maintaining Spare Units 5
    - Using Service Agreements 5
    - Obtaining Priority Service 5

### Chapter 3 – Setting Up Your System
  - Overview 7
  - Assembling Your Materials 7
  - Preparing Equipment 8
    - Hardware 8
    - Printer 8
    - USB Port 8
    - Handhelds 8
  - Ordering Paper Supplies 8
  - Installing the RMAdvanced Software 9
  - Starting the Program 12

### Chapter 4 – Using Your Desktop Software
  - Overview 13
  - Getting Started 13
    - Main Menu Screen 14
  - Navigational Tools 15
    - Button Descriptions 15
  - Printing Controls 16
  - Other Controls 17
  - Customer Information Options 17
  - Multi-Branch Screen 19
  - Security 20

### Chapter 5 – Branch Information
  - Overview 21
Branch Setup 22
  Setup Tab 22
Accounting Tab 25
Banking Tab 29
Taxes Tab 31
Customer Tab 32
Desktop Tab 36
Defaults Tab 40
Statement Tab 43
Handheld Tab 45
Equipment Tab 49
Logging Tab 52
Docking Tab 53
Calendars Tab 55
Optimizations Tab 63
Extra Invoice Tab 64
GPS Tab (RT2000 Module) 65
Local Settings 66
  Desktop Tab 66
Communications Tab 68
Directories Tab 70
Printers Tab 71
Messaging 73
  Message Entry 73
Message Reasons 74
Delivery Order Email Setup 75
Manage Data Sets 76
Load Data Set 76
Import 77
  Customer Import Wizard 77
Equipment 78
Bank Information Import (EF2000 Module) 79
Import EDI 79
Export 80
  Sage Export (Germany) 81
Italy Export 81
Export E-Mail Addresses 82
Maintaining Data Files 83
  Rebuild Data Files 83
Pack 84
Backup/Restore 84
Printing Reports and Exiting the System 86
  Print 86
Print Setup 86
Logout 86
Exit and Logout 86

Chapter 6 – List Information 87
  Overview 87
Customer Information 88
    Information Tab 88
Finance Tab 90
Credit Tab 96
Contacts Tab 107
Route Tab 109
Products Tab 124
Equipment Tab 128
Orders Tab 129
Customer Setup Codes 130
Customer Status Codes 131
Customer Type Codes 132
Delivery Order Status Codes 138
Credit Class 139
  Information Tab 139
  Dunning Tab 141
Credit Terms 142
Statement Codes 143
  Layout Tab 143
  Messages Tab 146
  Bill Frequency Tab 147
Dunning Messages 149
Late Charge Codes 151
Administrative Charge Codes 153
Start/Stop Groups 154
Start/Stop Reasons 155
Customer Promotions 156
Contact Message Groups 157
Contact Message Reasons 158
Service Priority Codes 159
Suspend Service Codes 160
Contact Via Codes 161
Contact Frequency Codes 162
Major Account Code 163
Contract Type Codes / Setup Tab 164
  Contract Type Codes / Content Tab 165
  Contract Type Codes / Reference Tab 166
Dynamic Header Codes 167
ZIP Codes 168
Geography Codes 169
Delivery Order Reasons 170
Organizing What You Sell 172
  Product Charge Codes 173
  Accounting Tab 182
  Accounting Tab 182
  Deposit Types 190
  Web Class Codes 192
  Product Group Codes 193
  Primary Category Codes 194
  Secondary Category Codes 195
  Product Unit Codes 196
  Product Price Lists 197
  Period Discount Pricing 199
  Promotional Price Codes 200
  Promotional Price Class 201
  Promotional Price Group Codes 201
  Daily Cost Recording 202
  Gratis Reason Codes 203
  Package Plans 203
  Warehouse Setup 204
  Inventory Adjustment Codes 206
  Quarantine Status Codes 208
  Shipper List Codes 209
  Production Batch Codes 210
  EDI Output Codes 211
  Order Completion Codes 212
  Order Rejection Codes 213
Accounting Setup 214
  Sales Tax Rates 215
  Asset Tax Codes 217
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Statement Assessment</td>
<td>218</td>
</tr>
<tr>
<td></td>
<td>General Ledger Setup</td>
<td>219</td>
</tr>
<tr>
<td></td>
<td>Bank Accounts</td>
<td>220</td>
</tr>
<tr>
<td></td>
<td>Preferred Payment Methods</td>
<td>221</td>
</tr>
<tr>
<td></td>
<td>Credit Card Groups Setup</td>
<td>221</td>
</tr>
<tr>
<td></td>
<td>Departments (Vending Only)</td>
<td>222</td>
</tr>
<tr>
<td></td>
<td>Refund Check Code</td>
<td>223</td>
</tr>
<tr>
<td></td>
<td>Daily Cash Recording Setup</td>
<td>224</td>
</tr>
<tr>
<td></td>
<td>Write-Off Reasons</td>
<td>225</td>
</tr>
<tr>
<td></td>
<td>Credit Note Reasons</td>
<td>225</td>
</tr>
<tr>
<td></td>
<td>Organizing and Tracking Equipment</td>
<td>226</td>
</tr>
<tr>
<td></td>
<td>Equipment Master List</td>
<td>226</td>
</tr>
<tr>
<td></td>
<td>Equipment Type</td>
<td>235</td>
</tr>
<tr>
<td></td>
<td>Equipment Style</td>
<td>236</td>
</tr>
<tr>
<td></td>
<td>Equipment Type and Style Assignment</td>
<td>237</td>
</tr>
<tr>
<td></td>
<td>Equipment Status Codes</td>
<td>238</td>
</tr>
<tr>
<td></td>
<td>Manufacturer List</td>
<td>239</td>
</tr>
<tr>
<td></td>
<td>Equipment Service Codes</td>
<td>240</td>
</tr>
<tr>
<td></td>
<td>Equipment Faults</td>
<td>241</td>
</tr>
<tr>
<td></td>
<td>Equipment Label Generator</td>
<td>242</td>
</tr>
<tr>
<td></td>
<td>Equipment Label Setup</td>
<td>243</td>
</tr>
<tr>
<td></td>
<td>Tank Types</td>
<td>244</td>
</tr>
<tr>
<td></td>
<td>Remote Tank Setup</td>
<td>245</td>
</tr>
<tr>
<td></td>
<td>Setting Up Your Routes</td>
<td>246</td>
</tr>
<tr>
<td></td>
<td>Route Master</td>
<td>246</td>
</tr>
<tr>
<td></td>
<td>Handheld Class</td>
<td>251</td>
</tr>
<tr>
<td></td>
<td>Upload Reports Tab</td>
<td>278</td>
</tr>
<tr>
<td></td>
<td>Route Types</td>
<td>285</td>
</tr>
<tr>
<td></td>
<td>Group Area Codes</td>
<td>287</td>
</tr>
<tr>
<td></td>
<td>Stop Type Codes</td>
<td>287</td>
</tr>
<tr>
<td></td>
<td>Site Inspection Reasons</td>
<td>288</td>
</tr>
<tr>
<td></td>
<td>Handheld Dunning Messages</td>
<td>289</td>
</tr>
<tr>
<td></td>
<td><strong>Container Contents</strong></td>
<td>290</td>
</tr>
<tr>
<td></td>
<td>Employee Setup</td>
<td>291</td>
</tr>
<tr>
<td></td>
<td>Employees</td>
<td>291</td>
</tr>
<tr>
<td></td>
<td>Security Level Codes</td>
<td>296</td>
</tr>
<tr>
<td></td>
<td>Login Policies</td>
<td>297</td>
</tr>
<tr>
<td></td>
<td>Employee Groups</td>
<td>298</td>
</tr>
<tr>
<td></td>
<td>Commission Class Codes</td>
<td>299</td>
</tr>
<tr>
<td></td>
<td>Field Service Qualifications</td>
<td>299</td>
</tr>
<tr>
<td></td>
<td>Truck Information</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>Trucks</td>
<td>300</td>
</tr>
<tr>
<td></td>
<td>Truck Class</td>
<td>302</td>
</tr>
<tr>
<td></td>
<td>License</td>
<td>303</td>
</tr>
<tr>
<td></td>
<td>Vehicle Condition Inspection</td>
<td>304</td>
</tr>
<tr>
<td></td>
<td>Route and Truck Management</td>
<td>305</td>
</tr>
<tr>
<td></td>
<td>Custom Report Groups</td>
<td>306</td>
</tr>
<tr>
<td></td>
<td>Setup Wizards</td>
<td>307</td>
</tr>
<tr>
<td></td>
<td>New Customer with Order Wizard</td>
<td>307</td>
</tr>
<tr>
<td></td>
<td>New Stop Wizard</td>
<td>322</td>
</tr>
<tr>
<td></td>
<td>Equipment Setup Wizard</td>
<td>327</td>
</tr>
</tbody>
</table>

**Chapter 7 – Daily Processing and Transactions** 333

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>333</td>
</tr>
<tr>
<td>Entering and Modifying Invoice Data</td>
<td>334</td>
</tr>
<tr>
<td>Route Settlement Entry</td>
<td>337</td>
</tr>
<tr>
<td><em>Autogenerate Transactions</em></td>
<td>350</td>
</tr>
<tr>
<td>Supply Chain Orders</td>
<td>351</td>
</tr>
<tr>
<td>Enhanced Customer Review</td>
<td>357</td>
</tr>
</tbody>
</table>
Payments 358
Local Payments 359
  Mail Payments 359
  Enter Statement Payments (Optional) 361
  Payments by Major Account 367
  Delete Payments by Batch 368
Credit Cards (Electronic Funds Module) 369
EFT (Electronic Funds Module) 369
Process EDI Transactions (Optional Module) 369
  Lock Box Import 370
  Disputed Invoices 375
  Payment Lookup 376
  Check 21 377
Transaction Reports 378
  Daily Sales by Employee Report 381
  Pre Post Transactions 382
  Post Transactions 384
  General Ledger Postings 386
  Generate Rent Charges 387
  Package Plan 389
  Calculate Late Charges 389
  Calculate Administrative Charges 390
  Generate Recurring Billing 391
  Generate Discounts and Free Goods 392
  Generate / Review Standing Orders / TeleSales 392
  Close Period 392
Refund Checks 393
  Print Refund Checks 393
  Print Check Register 395
  Refund Detail Report 396
  Equipment Processing 397
  Equipment Transfer 397
  Equipment Movement 398
  Equipment Service 399
  Equipment Service Call 400
Inventory 402
  Inventory Adjustments 402
  Inventory Physical Count 405

Index 407
Chapter 1 – Overview

Before getting started

Many new features have been added to this version of Route Manager Advanced™, which has caused the User Guide to grow in features and content. This being the case, the User Guide is now two separate volumes:

**User Guide – Volume A**: Contains information on setting up and using the program as well as definitions for all items located within the *File*, *Lists*, and *Transactions* pads.


In some cases, there may be some cross-referencing of material and information between the two manuals.

Introduction

Route Manager Advanced™ integrates state-of-the-art handheld technology with sophisticated accounts receivable software. This provides a cost-effective solution for field data collection in a variety of route accounting applications serving a number of different industries.

This manual contains the necessary information to help you set up the system quickly and operate it efficiently. The complete collection of manuals includes:

- Getting Started Guide
- Desktop User Manual (A & B)
- Supplemental Manual
- Handheld Guide

These manuals, along with our web-based training videos and other aids, will help you quickly get the program operating and employees using it effectively.
User Content

The two-volume User Guide is the primary manual for the Route Manager Advanced™ desktop software. It is divided into several chapters to allow you to find information quickly.

- Management Guide
- Setting Up Your System
- Using Your Desktop Software
- Branch Information
- Customer Information & Setting Up List Information
- Daily Processing and Transactions
- Reports
- Handheld Options
- Tools
- Help
- Training and Support

Volume B of this user manual also contains appendices.

You can find all of our manuals on your distribution CD and www.ARS247.com.

Service and Support

At ARS, it is our priority to provide you with the highest quality of service and support available. We provide 24-hour-a-day, 7-day-a-week telephone support.

How to contact us:

- Toll free, 24-7 Telephone Support – 866-549-8837
- (Outside the United States at 1-209-632-6358)
- Fax - 1-209-632-6868
- E-mail - Support@ARS247.com
- Web - www.ARS247.com

A support requests sent via an E-mail or fax is responded to during the hours of 7 am to 5 pm US Pacific Time. For more information on ARS support policies, please refer to our Web site.

If you are in the program and need help completing the screen you are viewing, press the F1 key. This will activate the context sensitive help option. It will display the same information as found in the corresponding section of the User Guide for the screen you are currently viewing (active internet connection required).
Chapter 2 – Management Guide

Overview

This chapter provides an overview of the manager’s role in the implementation and maintenance of the RMAdvanced™ system and its components. This includes system setup, day-to-day operations, and periodic maintenance. You will also find the minimum hardware requirements needed to operate the program.

Hardware Requirements

RMAdvanced™ requires a system with enough power to give you the results you expect. The following list contains the minimum hardware requirements to run the RMA program:

Workstation Requirements

- 1 GHz Processor or above
- 512 MB RAM or more
- 1.6 GB hard disk space available
- Windows 2000/XP or later
- Available USB port

Server Requirements

For 2-10 Users

- 3.0 GHz Processor or above
- 1 GB RAM
- 80 GB hard disk space available
- Internet connection: Cable or DSL
- Windows 2000/2003 Server with Terminal Services
- File backup and extended storage capabilities: CD or DVD Re-Writable drive, ZIP drive (or super high capacity disk), or tape backup.
For 11-50 Users

- 1 GHz Dual-Core Xeon Processor or above
- 2GB RAM
- 73 GB (or above) Ultra 320 SCSI hard drives
- Gigabit Network
- Windows 2000/2003 Server with Terminal Services
- File backup and extended storage capabilities: CD or DVD Re-Writable drive, ZIP drive (or super high capacity disk) or tape backup.

For 50-100 Users

- 2 GHz Dual-Core Xeon Processor or above
- 4GB RAM
- 146 GB (or above) Ultra 320 SCSI hard drives in RAID 5
- Gigabit Network
- Windows 2000/2003 Server with Terminal Services
- File backup and extended storage capabilities: CD or DVD Re-Writable drive, ZIP drive (or super high capacity disk) or tape backup.

Implementing the System

The manager’s most important job is setting up the system for all personnel to use. This process is described in Chapter 3. In addition, the manager must coordinate the following activities:

- Getting all hardware together and installed
- Setting up the software
- Training office personnel
- Training drivers
- Ordering supplies

Chapter 3 will describe the activities that will help the manager as he or she sets out to install the system.
Day-to-Day Operations

Setting up Route Data

Each day you will need to transfer route information to the handhelds to be used to run routes the following day. This should be done the night before or early in the morning before the drivers proceed on their routes. When the drivers return each afternoon, they will transfer the data with that day’s transactions from the handheld back to the desktop computer.

NOTE: Loading handheld data the evening prior will prevent delays due to unforeseen circumstances, such as computer or electrical failures.

Periodic Maintenance

RMA can hold many years of data. As long as there is disk space, you can continue to retain your data. However, it will be necessary to clean out unneeded records to save space on the hard drive. This is done at any time. We recommend establishing a monthly or regular schedule to clear out unnecessary data.

Servicing Equipment

Keeping your equipment in good condition is important for obtaining maximum life from each unit. Typically, this is easier to manage when a single unit is assigned to each driver. Tag their route number or name on their handheld, printer, holster, memory card, etc.

Maintaining Spare Units

Unless you are a very small operation, we recommend you have at least one spare unit for every six to eight handhelds.

Using Service Agreements

During your initial 90 days, ARS provides a specified amount of assistance. After this period, you can choose an affordable support plan that best matches your requirements. For complete details of our service and programs, visit our tech support Web site at www.ARS247.com.

Obtaining Priority Service

ARS recommends that you have a high-speed internet connection. This will give you access to our online support tools and program updates.
Chapter 3 – Setting Up Your System

Overview

This chapter will assist you with implementing the RMA program. It covers both hardware setup and software installation — it is recommended that you use the *Getting Started Guide* to assist you with setting up RMA.

Assembling Your Materials

Before installing your software, you need to set up both the desktop and handheld computers.

You will need the following:

- Desktop PC running Windows 2000/2003/XP/Vista/7
- Laser Printer
- Route Manager Advanced™ Software
- Handheld computer
- Manuals

NOTE: We also recommend ordering receipt paper for your handheld computer. This is a special thermal paper. You can obtained it from your reseller or Advantage Route Systems.
Preparing Equipment

It is important to make sure that all of your hardware is compatible with RMA and is in working order.

Hardware

Examine all PC hardware to ensure that it meets the minimum requirements described in Chapter 2.

Printer

RMA requires an ink jet (or better) printer. The system is not designed for use with a dot matrix printer and will not work properly with one. However, a dot matrix printer can be used for mailing labels, custom forms, and equipment tags. A laser printer is essential if you have more than 500 customers. Consider buying a laser printer (or multi function printer) with a speed of at least 20 PPM (pages per minute) if you have over three routes. They are affordable and often perform multiple functions.

USB Port

A Universal Serial Bus (USB) port must be available to use a storage card reader. This allows you to transfer handheld data.

Handhelds

Prior to sending route drivers on their first run, observe the procedures and information below:

- **Diagnostics:** Turn on the handheld computer to make sure it is fully charged and functioning properly.
- **Marking Equipment:** We strongly encourage you to tag or etch your company name and phone number on all of your equipment.
- **Marking PC Cards:** Each memory card should be marked with either the driver’s name or route number. This allows each driver to know which unit is assigned to which route. Due to the close tolerance of the card in the computer, do not apply any sticky labels to the cards. Use permanent marker pens only. It will be necessary to re-label the card every three or four months as the writing gradually wears off.

Ordering Paper Supplies

We recommend ordering at least six months worth of paper supplies at a time. Figure that each roll of paper will generate about 85 receipts. ARS can normally fill orders for plain white paper within a week. Custom-printed paper (with your logo on the front or back) is also an option. Allow eight weeks for delivery.

**WARNING!** Do not use thermal adding machine paper in your printers. The handheld printer uses a special low dust, high sensitivity paper designed for the close tolerance of the print head. Using lower quality paper will damage the unit and void the warranty.
**Stylus**

A stylus is included with each handheld; however, since it can be easily lost, you may want to order the ARS stylus, which comes with a pocket clip — it is also much cheaper than the ones that come with the unit.

**NOTE:** Only use your finger or a stylus with a Teflon® tip on the touch screen. Pens or other objects, even fingernails, will scratch the surface.

**TouchSafe™**

Under normal use, the touch screen of your computer will get scratched and may even pick up a few nicks. Noticeable scratches will first appear in areas where you always touch the screen, such as the Exit button or the Capture Signature screen. To keep this from happening, ARS recommends using our TouchSafe™ screen protectors, these will absorb the abuse and can be replaced every couple of weeks.

**NOTE:** You can order all of the above products directly from our Web site at [www.AdvantageRS.com](http://www.AdvantageRS.com).

---

**Installing the RMAdvanced Software**

Before you begin the installation, make sure you have the original distribution CD supplied to you. You will also need the serialization code found in your new customer introductory letter.

1. Insert the Route Manager Advanced™ into the CD-ROM player.
2. Next, go to **Start**, then **Run**, and type in `X:\SETUP`, where **X** is the drive letter of your CD-ROM Drive.

   This will bring up a screen similar to the following:
3. Choose the type of installation and select **Next**:

The definitions are:

- **Install**: Use this standard option if you are installing RMA for the first time and will be entering or importing your data.
- **Install Demo**: Used for demo purposes only; contains test customers, transactions, etc.
- **Update**: Used only when updating an existing version of RMA.
- **Network Client**: Choose this option when setting up Workstations on a network after the program has been installed on a Server.
- **RM2000 to RMA Upgrade**: Only used when upgrading from RM2000 (Contact ARS for information on this type of upgrade).

4. Choose the primary language the program should use and choose **Next**.
5. Select the target directory for installation and choose **Next**.

**NOTE:** We recommend that the path not contain any spaces in the target path (i.e., install to X:\RMA instead of X:\Program Files\RMA).

6. When the installation process is complete, select **Finish**.

Continue to the next section to learn how to start and register the program.
Starting the Program

To begin using Route Manager Advanced™, select Start > Programs, and choose Route Manager Advanced. Alternatively, you can double-click on the RMA shortcut placed on your desktop.

The program is loading when you see the RMA logo appear on the screen.

The first time you access RMA you will need to enter the Serial Number and CI Code found in the introductory letter included with your shipment. The Registration screen is shown below:

NOTE: If you would like to use Route Manager Advanced in demo mode, select OK without keying in any information.

The login screen shows who is logged into the system as well as the maximum number of users that can be logged in at one time.

To begin, select the Administrator user name and click OK.

You may now begin to enter data or explore the system.

NOTE: Along with the users logged into RMA, the Login screen also displays each user’s login date, duration, and computer name.
Chapter 4 – Using Your Desktop Software

Overview

This chapter will introduce you to the main menu of the program that includes eight main list menus or “pads.” Each pad will be explained in the order listed on the main menu.

Getting Started

After you have logged in to RMA, the main menu screen will appear. This screen displays the RMA logo, the main menu pads, and the toolbar.
Main Menu Screen

There are two ways to select any main menu option in RMA:

- **Mouse:** Place the cursor on top of the word you want and left click on the pad once.
- **Keyboard:** Press ALT + the underlined letter in the menu you wish to go to (i.e., Alt + F for File menu).

Select one of the menu pads. A list of choices will appear underneath it. The *File* menu pad is shown below.

<table>
<thead>
<tr>
<th></th>
<th>Lists</th>
<th>Transactions</th>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Local Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Messaging</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage Data Sets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Import...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Export...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rebuild Data Files</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pack</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Backup/Restore</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print...</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print Setup...</td>
<td></td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Logout</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit and Logout</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notice that horizontal lines separate some items. This allows similar subjects to be grouped together according to topic. Some menu choices have small arrows to the right of the words. When you highlight these words, additional menu choices will appear to the right of the arrow.

The next section introduces you to some of the navigational buttons used throughout the program.
Navigational Tools

The following toolbar options are located on the right side of most screens in RMA. These are the primary utilities needed to find, add, modify, save, or delete data. If you are unsure about a key, place your mouse over it to view a brief text description.

Button Descriptions

Find (CTRL+F/F10): Click Find to initiate a search for a specific record based on entered criteria.

![Find Button](image)

Enter the information you are looking for in the Find box, such as a customer name or account number. Next, choose the binoculars (Find) key on the screen. This will automatically search all available fields within the current record. You can also manually select the field by choosing an item within the IN... option. Each field listed will differ based on the data elements shown on the screen.

NOTE: The computer will automatically search all of the fields in each record unless the option ‘Don’t use Autosense on Find’ is selected within Local Settings.

Browse (CTRL+B, or F8): This will bring up a grid containing the database information associated with the current screen. To search for data on the grid, you can type CTRL+F to initiate a search box. You are restricted from changing data within the fields on the grid.

Modify (CTRL+E, or F9): This button allows you to edit the displayed record. A record must be in edit mode before any changes can be made.

Add (CTRL+A, or F7): This button creates a new record.

More (CTRL+M, or F12): This button saves the information entered and brings up a new record. This is helpful when entering multiple records.
**Save (CTRL+S, or F11):** This button saves all changes made to a current record.

**Delete (CTRL+D, or F5):** This button deletes the record currently displayed. The border of the screen turns red when the item is deleted.

**NOTE:** The border of each deleted record will turn red and remain on the screen until a File > Pack is performed. Once this is executed, all items marked for deletion will be permanently erased.

**Undelete:** The undelete button will “undo” items marked for deletion that are indicated by a red border.

**Print (CTRL+P, or F2):** Click this button to print information associated with the data on the screen.

**NOTE:** Selecting the ‘Print’ key in the Customer Information screen will allow you to print multiple summary reports on the account. Additionally, an Equipment Rental Agreement form is available as well.

**Cancel (F3):** This button cancels any unsaved modifications to the current record.

**Exit (CTRL+Q, or F4):** This button will exit the current record.

### Printing Controls

The following buttons appear on the toolbar displayed within the report screens in RMA. Not all of the buttons are available within each report.

**Print (CTRL+P, or F2):** This button sends the selected report to the default printer.

**Cancel (CTRL+Z, or F3):** This button exits the current report.

**Preview:** This button displays the report on the screen before printing.

**Printer Setup:** This button allows a different printer to be selected for any given report.

**Export Report to Excel:** This button will export the selected report to an Excel spreadsheet.

**Fax Report (AF2000 Required):** This button sends the report to the fax printer. This can be assigned under File > Local Settings, on the Printers tab.

**Alignment:** This button prints an alignment pattern to assist in the placement of dot-matrix forms in your printer.

**Create Statement File:** This button only appears when generating bulk statements. It creates a file to send to a statement processing company.
Other Controls

When reviewing a report, the Print Preview Toolbar will appear.

- **First Page:** Click to view the first page of the report.
- **Previous Page:** Click to view the previous page of the report.
- **Go to Page:** Click to enter a page number of the report to view.
- **Next Page:** Click to view the next page of the report.
- **Last Page:** Click to view the last page of the report.
- **Zoom:** Allows the option to increase or decrease the size of the page on the screen.
- **Close Preview:** Click to close the report preview.
- **Print Report:** Click to print the report.

Customer Information Options

When choosing the ‘Print’ option from within Customer Information, the following options will be available:

- **Customer Information:** Prints customer billing information, including balances and default settings.
- **Customer Contact Messages:** Prints all information logged under the ‘Contacts’ tab on the current account.
- **Route Information:** Prints delivery related information, including Default Products, Delivery Schedule, and installed Equipment.
- **Service Agreement:** This is a custom form used for service agreements with customers.
Service Agreement Configuration

Here is an example of the standard Service Agreement included in RMA:

By default, the Service Agreement terms read:

To replace this text with your own company policies, terms, etc., create a text (.txt) file and place it in the root folder of RMA using the file name 'agreement.txt' (below):

```
RMRDGL5ROUTMAP.CDX
RMRDGL5ROUTETIX.DBF
RMRDGL5ROUTETIX.CDX
gl_export_detail.XLS
gl_export.CSV
agreement.txt
_2500NSI28.bmp
_2500NOGME.bmp
_25N0SP3MJ.bmp
```
When a Service Agreement is printed, it will display the contents of the ‘agreement.txt’ file (example below).

![Example of 'agreement.txt' file](image)

Here is an example of a custom 'agreement.txt' file placed in the RMA root folder.

**NOTE:** To revert back to the default agreement terms in RMA, simply remove the ‘agreement.txt’ file from the RMA root folder.

### Multi-Branch Screen

The Multi-Branch screen allows you to select one or all branches and perform daily functions for the branch or branches selected. If your employees are assigned to more than one branch, they will be able to select one or all of the branches on the screen.

![Multi-Branch Screen](image)
Security

Each user on the system can only be logged onto one machine at a time. If a user attempts to log in to RMA while being signed on at another location, a message similar to the following will appear:

During certain situations, such as power loss, users may become “stuck” in the system. If this occurs, it may be necessary to manually remove the user from the login list.

To remove a “stuck” user, log onto the system as an Administrator (or a user who is set as a “Master User”), and go to Tools > Administration > Users Currently Logged In.

Select the “stuck” user and click the Delete button (trash bin) on the screen. The user will now be able to log in normally.
Overview

The File pad is used to set up default company information and import data from other programs. It also contains printer settings and the backup/restore data utility.

Each menu item is identified and explained within this chapter.
Branch Setup

The *Branch Setup* option is used to capture default company information. If your company has multiple locations, you will add separate branch information for each location.

**NOTE:** When setting up multiple branches, one branch will be designated as a *Master Branch*.

**Setup Tab**

The *Setup* tab is used to input general company information and invoice defaults.

**Company Name/Address:**

- **Name:** The name of the company.
- **Address:** The address of the company.
- **Phone:** The phone number of the company.
- **Fax:** The fax number of the company.
- **E-mail:** The primary E-Mail address of the company.

**Advanced TS Client:**

Fill in this information if you are using Terminal Services.

- **Server IP:** The I.P. (Internet Protocol) address used to connect to the file server.
- **FTP User:** The username used to connect to the file server.
- **FTP Password:** The password used to connect to the file server.
Other:

If the current RMA program is set up as a test or practice area, enter the directory here. This will update the company name to reflect ‘Test Area’ or ‘Practice Area’ for clarification.

Test Area: Enter the directory of the RMA test area.
Practice Area: Enter the directory of the RMA practice area.

Branch Information:

Master Branch: Check this box to identify this branch as the Master Branch. The Master Branch has access to information in all other branches.

Offline Branch: This option is used with the Distributed Database feature, which allows companies with multiple locations to work independently of each other, and only sync databases during an allotted time. Contact ARS for further information.

Branch ID: A four-digit identification code for this branch.

Branch Description: Enter a description (or name) for this branch.

Starting Acct No. (Main): Enter the first account number to use prior to setting up your first customer, up to six digits in length. The account numbers will be automatically incremented.

Next Acct No.: This field displays the account number assigned to the next customer added, up to six characters. This is automatically incremented.

Acct Rollover: Enter the highest account number to reach before reverting back to the Starting Account Number.

Starting Acct No. (Offline): Enter the first account number to use prior to setting up your first customer, up to six digits in length. The account numbers will be automatically incremented.

Next Acct No.: This field displays the account number that will be assigned to the next customer added, up to six characters. This is automatically incremented.

Acct Rollover: Enter the highest account number to reach before reverting to the Starting Account Number.

NOTE: The Offline pool is only used with the Distributed Database feature, which allows companies with multiple locations to work independently of each other, and only sync databases during an allotted time. Contact ARS for further information.

Use Global Account No’s: Check this box to use the Master Branch account number pool on all branches.

Main/Start Invoice No: Enter the lowest (or starting) invoice number to be used.

Next Invoice No.: This field displays the next available invoice number that will be used.

Invoice Rollover: Enter the highest (or ending) invoice number to be used prior to reverting to the Starting Invoice Number.

Offline/Start Invoice No: Enter the lowest (or starting) invoice number to be used.

Next Invoice No.: This field displays the next available invoice number that will be used.

Invoice Rollover: Enter the highest (or ending) invoice number to be used prior to reverting to the Starting Invoice Number.
**NOTE:** The *Offline* pool is only used with the *Distributed Database* feature. This allows companies with multiple locations to work independently of each other, and only sync databases during an allotted time. Contact ARS for further information.

---

**Warehouse Location (Map Start Point):**

This information is used with the *Advanced Mapping* module. It is used to establish the starting and ending points of a route.

**Name:** Enter a name for the starting/ending point facility.

**Address:** Enter the starting/ending point address.

**Lat/Long:** Enter the latitude and longitude coordinates for the starting/ending point.

[Push Pin]: Click here to locate the correct address and map coordinates for this warehouse location.

**MangoGeo User Name:** Displays your *MangoGeo* username.

**MangoGeo Password:** Contains your masked *MangoGeo* password.

**Change Password:** Select this option to update your *MangoGeo* password.

---

**NOTE:** The *MangoGeo* program is used for address verification and correction services. Contact Advantage Route Systems or visit [www.Mango-Geo.com](http://www.Mango-Geo.com) for further information.
Accounting Tab

The Accounting tab contains system accounting information, aging labels and external bookkeeping information.

Default Accounts:

Assign by Branch: Select this option to use unique General Ledger Numbers per branch. Leaving this option blank will use the same G/L numbers — assigned to the Master Branch — for all branches.

For each of the fields listed vertically under Default Accounts, select a general ledger (G/L) account number or product code.

NOTE: This data must be established under the Lists menu before you can select it here.

Accounts Receivable: This account is used for all sales to customers.

Inventory Asset: This account is used for reporting asset cost information on items — such as products and equipment — on the General Ledger Report.

NOTE: If this account is left empty, the information on the G/L Report will be disabled.

Accrued Purchases: This liability account is used for the accumulation of inventory purchases made throughout the period selected that have not been paid.

NOTE: RMA is not an Accounts Payable system. This account should be cleared outside of RMA to your vendor.

Coupon Liability: This account is used to track the amount of coupons sold but not yet redeemed. Typically, this is a liability account.

Coupon / Discount Expense: This account is used to record the loss (or gain) of a coupon based upon the product. Typically, this is an expense account.

Refunds: Select the Product Charge Code to use when processing customer refunds.
**Unearned Rental Income:** This account number is used with Deferred Rent Billing. Most companies will leave this option blank.

**Rounding:**

**Round to (Generally left blank):** Enter a rounding amount that will apply to each transaction.

**NOTE:** If .05 is entered, a transaction for 13.03 will be rounded to 13.05.

**Prod Code:** Select a Product Code that will be used for all rounded transactions (this will be used on each invoice rounded).

**HD Scan Product:**

**Charge Code:** Select the product code used when scanning hard drives flagged for destruction.

**NOTE:** Refer to Chapter 4.19 of the Supplemental Guide for further information on hard drive destruction.

**Other:**

**Aging Levels:** In this section, specify the number of days you would like to use for customer balance aging. Next to each aging level, enter the desired description in the labels column.

**Program:**

**Business Bookkeeping Program:** Specify your accounting program that will interface with RMA.

**NOTE:** We routinely update this list. Contact ARS if your program is not listed.

**G/L Account Number Prefix:** Enter a G/L prefix if your external accounting program requires one.

**Branch G/L Account Number Suffix:** This value represents information that will be added to the end of G/L account numbers (e.g., Branch ID).

**Export during G/L Posting (QuickBooks Only):** Select this option to export your posted totals for QuickBooks.

**NOTE:** Specify the export directory under the G/L Output Directory field within File > Local Settings, on the Directories tab.

**Don’t Print Reports during Pre-Posting:** Select this option to suppress pre-posted totals reports from printing during the pre-posting process.

**Always show positive values on G/L output:** Choose this option to reverse the Credit/Debit options on the G/L output report.

**Export transactions during posting (QuickBooks Only):** Select this option to export posted totals during the Post Transactions process.

**Don’t Print Reports During Pre-posting:** Select this option to suppress printing posting summary reports during the ‘Pre-Post’ process (used in multi-branch environment).
**Check Type:** Select one of the following check formats to use when printing refund checks.

- Check-stub-stub – Use with laser printers
- Check-stub – Use with dot-matrix printers
- Stub-check-stub – Use with laser printers
- Top-Stub-Check-Stub – Use with laser printers

**Reset Monthly Product Totals on GL [Posting]:** Select this option to reset monthly sales totals when the G/L Posting Report is posted. Typically, this happens when the accounting period is closed.

**Show Gratis Amounts on GL Reports:** Select this option to display gratis totals on the G/L Posting Report (separate from other expenses). This is recommended for companies that want to more accurately control free product giveaways.

**Use European Finance Model:** Selecting this option changes multiple areas of the program. This is adapted for European clients.

**Apply unapplied credits to oldest balance for aging:** Select this option to automatically apply all credits (payments) to the oldest balance on the Finance ($) tab of the Customer Information screen. This option is for display purposes only; actually applying any credits will need to be done manually.

**Apply invoices with a negative balance to oldest balance:** Select this option to automatically apply all negative balance invoices to the oldest balance on the Finance ($) tab of the Customer Information screen. This option is for display purposes only; actually applying any credits will need to be done manually.

**Age by period:** Select this option to age your customer balances by the accounting period, and not the date of each invoice.

### Inventory Valuation Method

The following options are used with the Inventory Valuation option available in RMA. This allows you to instantly view your inventory values based on established cost information input into the system. Refer to Chapter 3.20 of the Supplemental Guide for further information.

- **FIFO (First-in, First-out):** Inventory valuation is calculated based on an accumulation of the costs entered when receiving inventory. Inventory will be removed from the oldest batch first.
- **LIFO (Last-in, First-out):** Inventory valuation is calculated based on an accumulation of the costs entered when receiving inventory. Inventory will be removed from the latest batch first.
- **Fixed Cost:** Inventory valuation is calculated based on the cost entered within the Product Charge Code screen for each product. Inventory will not be separated by batch.

### Sub/Master Merge:

**Prod. Chrg Code:** Select a product charge code that will be used for transferring balances between accounts placed on Master Bill.

### Recurring Charges:

**Recurring Charges** allow you to charge your customers a recurring fee on a monthly basis or per delivery. Refer to Chapter 6 for further information on this feature.

**Waive on Hold Service (Handheld Only):** Check this box to waive the Recurring Charge on the handheld when the account is on Hold Service status.
**Handheld Billed:** Check this box to bill *Recurring Charges* on the handheld. If this option is left unchecked, all charges will be generated on the desktop.

**Monthly:** Check this option to bill *Recurring Charges* on the handheld once per month. For customers that were not billed on the handheld during the month, use the *Generate Recurring Charges* option on the desktop.

**Every Delivery (Handheld Only):** Select this option to bill a *Recurring Charge* with each handheld delivery.

**NOTE:** You will not be able to bill multiple *Recurring Charges* to the same account on the desktop; the *Every Delivery* option is only available on the handheld.
Banking Tab

The Banking tab contains optional company and customer related bank information.

Bank Information:

The following information must be provided by your bank when using the optional Electronic Funds Module (EFT).

- Transmitter ID
- Public Key
- Merchant ID
- Legal Name
- Address Information

Credit Card Processing Information:

Depending on your 3rd party merchant processing program, choose the appropriate program from the drop-down list and enter the Login ID and Password/Transaction Key. If you receive this information from the merchant, you will be able to process transactions automatically, and will not be required to install the merchant’s processing program.

NOTE: If this information is left blank, you can export transactions from RMA and import them into the 3rd party application.

Login ID: Enter the merchant ID provided by the processing company.

Password/Transaction Key: Enter the Password/Transaction Key provided by the processing company.

Language for Payment Types: Select this option to change language descriptions for payment types displayed throughout the RMA program.
Customer Bank Information:
The following information will be used by the optional Electronic Funds Module (EFT) when processing ACH direct debit transactions.

Require Bank Account Number: Checking this option will force the input of a bank account number on each customer’s account during new customer entry.

Require Account Type: Checking this button will force input of a bank account type during new customer entry.

Require Routing Information: Checking this button will force input of a bank routing number during new customer entry.

Require Bank Name: Checking this button will force input of a bank name during new customer entry.

Require Bank Branch: Checking this button will force input of a bank branch during new customer entry.

No Default Bank Account during Payment Entry: Check this option to disable the Bank Account field when entering payments.

Do Not Mask Credit Card Numbers: Check this box to display unmasked credit card numbers on the credit card preview box of the Credit tab within Customer Information.

NOTE: Selecting this option will allow all employees with access to the Credit tab to view a customer’s credit card number.

Default Returned Check Accts:
The following options are used during Returned Check Processing within RMA.

Returned Check Balance: Select the product code that will be used to reverse dishonored funds posted to the customer’s account.

Returned Check Fee: Select the product code that will be used to charge the customer a penalty fee for dishonored funds.

Contact Reasons: Select the Contact Reason that you would like to use as a default for logging returned check information within the customer’s Contacts tab.

Currency Information:
Currency: Displays the form of currency your customers use.

Primary (Leave blank in US): Enter the symbol or text to indicate the currency your customers will use most often when keeping track of accounting balances within the RMAAdvanced software.

Secondary: Enter the symbol or text to indicate a secondary currency that customers will use.

NOTE: With the above options enabled, you will be able to choose the currency type used by each account within Customer Information.

Exchange Rate: Enter the rate of exchange when viewing Secondary Currency as you look at account balances or payments.

Show History: This will display a list of Exchange Rate changes entered.

Always use bottle deposits in primary currency: Select this option to use the primary currency for container deposits, regardless of the currency selection within Customer Information.
**Coding Information:**

The following options determine how you would like to display credit card and bank numbers on the Credit tab of the Customer Information screen. Enter the number of digits that will be displayed on the right and left sides of the number (i.e., \( \text{Right} = 2 \) and \( \text{Left} = 4 \)).

- **Credit Card:** Enter the number of beginning (Left) and ending (Right) digits to display — up to 6 characters.
- **Bank:** Enter the number of beginning (Left) and ending (Right) digits to display — up to 6 characters.

**Taxes Tab**

The *Taxes* tab stores information regarding tax labels and miscellaneous tax information.

**Product Tax Category Labels:**

This option allows you to assign titles to the four product tax categories in RMA. These labels are used to identify taxable items in the *Product Charge Code* and *Sales Tax Rates* screens.

- **Categories A - D:** Assign a tax label up to ten characters to each category. The example shown on the screen above is commonly used.

**NOTE:** Each category represents either taxable or non-taxable items. All of your *Product Charge Codes* will be assigned to one of the four categories entered.

**Misc. Tax Information:**

- **Federal Tax ID:** Enter your *Federal Tax ID*, if desired (reference only).
- **State Tax ID:** Enter your *State Tax Reseller ID*, if desired (reference only).
- **Asset Tax:** Select a default *Asset Tax Code* to use on equipment that is not installed.
Sales Tax Inclusive: Select this option if your Sales Tax should be included in the sales price for each item individually. This is an additive tax option (not commonly used).

Reset Tax Totals on Tax Quarterly [Report]: Select this option to enable tax reset dialog screens within the Sales and Tax Report. This will give you the option to reset tax totals after each report is printed.

Customer Tab

The Customer tab contains various customer related options within RMA.

Customer Information:

Mini Descriptions on Invoice Drilldown: Check this option to view mini-descriptions per invoice on the Invoice Drilldown screen within Customer Information > Finance Tab > Invoice Lookup.

NOTE: Mini-descriptions are assigned to each product on the Info tab of the Product Charge Code screen.

Use Detailed Customer Security: Selecting this option allows you to control access to each field within the Customer Information screen. Once this option has been enabled, there will be a series of new items available within Lists > Employee Setup > Security Level Codes.

Global Price List: Checking this box will allow all branches in RMA to use the same Price Lists; they will not be separated by branch.

State Required to be Entered: Select this option to require that a State is entered when adding new ZIP or Postal Codes to the program.

Ignore Equipment Branch in Customer: Select this option to allow any piece of equipment to be assigned to a customer, regardless of branch.

Use Multiple Purchase Orders: Choose this option to enable up to three standing Purchase Orders on a single account at one time. The Purchase Order options will be available on each customer’s Route tab.

NOTE: This option cannot be enabled if you are currently using Customer Level P.O’s (on the Credit tab of Customer Information).
Exclude Current Amount in Total Due Balance: Check this box to exclude the customer’s current amount due from the Total Due column of the Customer Information screen (used in European markets).

Don’t use Equipment Drop Down in Customer Screen: Select this checkbox to disable the equipment drop-down list within the Products tab of Customer Information. With this option enabled, equipment serial numbers will need to be manually entered using your keyboard.

Show only available Equipment: Check this box to filter out all equipment currently assigned to other accounts from the equipment entry drop-down list.

PMT Method/Credit Class Change Alert: Select this option to create an Alert Message on the account when the customer’s Credit Class or Preferred Payment Method is changed.

Use Stop Categories: This option is used during the route scheduling process to inform users if the customer needs to be contacted prior to delivery.

Block Posting of Prepay Products not Setup on Customer: Select this option to prevent the posting of prepaid products on customers that are not assigned to the Prepay Products feature.

Force Address to Upper Case: Checking this option will force capital letters in the address fields of the new customer wizard and Customer Information screens.

Show Routes from all Branches: Select this option if you would like to use global routing. With this option enabled, routes will not be separated by branch.

Message for Status Change: Select the default Contact Message Reason to assign to accounts when the customer’s Account Status Code is changed.

Use Master Account Settings for Invoice Reprint: Select this option to print Master Account details on an invoice printed for a Sub-Account.

Auto change Promo Group Code and Price Level on Customer Type Code Change: Choose this option to update the Promotional Group Code and Price Level on the customer’s account to reflect the settings established within the assigned Customer Type.

Sales Ledger – Print Invoice Copies in Handheld Format (European Finance Only): Select this option to print all invoice copies in the handheld format.

Use Second Address Line for Advanced Mapping: Check this box to export the second address line for MapPoint.

Use Easy Input for Scheduling Customers: Select this option to replace the standard Schedule by Day Label option within the customer’s route calendar with new buttons that represent the frequency of your existing labels (e.g., Schedule Every 1 Week, Schedule Every 2 Weeks).

Add ‘Extra’ field to Account Number on Invoices: Choose this option to display information entered in the Extra field — within Customer Information — on invoices printed from the desktop. This is helpful if you would like to add additional reference information to the invoice.

Reset Package Plan Available Quantities Each Delivery: Select this option to reset all available Package Plan quantities back to the initial quantity available with each posted invoice.

NOTE: This option should not be enabled for most companies, contact ARS for further information.
**Allow Changing of Date for Contact Messages:** Select this option to allow users to change the primary date and time on a contact message added to the Contacts screen within Customer Information.

**Customer Wizard:**

**Open Delivery Order on Save:** Select this option to automatically popup the Delivery Order screen after Save is selected within the New Customer Wizard.

**Clear / Force Status & Type:** Select this option to force the user to select a Customer Type and Customer Status Code from within the New Customer Wizard.

**NOTE:** Leaving this option unchecked will automatically populate each field based on the default Customer Type already displayed.

**Force Route:** Checking this box will require the user to assign each account to a Route within the New Customer Wizard.

**Block Bottle Quantity on Products Tab:** Choose this option to block the ability to manually enter empty container quantities within Step 2 of the New Customer Wizard.

**Block Editing of City and State:** Select this option to disable the ability to edit the City and State fields within the New Customer Wizard.

**Hide Opening Balance:** Check this box to disable the Opening Balance field within the New Customer Wizard.

**Block Editing of Address 1 and 2:** Select this option to disable the address fields within the New Customer Wizard.

**Default Price Level:** Choose this option to establish a Default Price Level to use within the New Customer Wizard.

**Wizard Configuration:**

Select this box to define field requirements within the New Customer Wizard. Each item displayed within each screen (page) of the wizard can be controlled.

**NOTE:** Items marked with an * symbol are required and cannot be changed.
**Fields:**

**Reset All:** Select this option to reset the field requirements to default selections.

**Require All:** Select this option to require that all fields within the wizard are used.

**NOTE:** Select Modify prior to choosing an option above. To enable/disable items individually, simply double-click on the desired option.

---

**Customer Route/Product Information:**

**Hide Site Statistics:** Check this box to remove the Site Stats option within Customer Information, on the Route tab.

**Hide Par:** Check this box to remove the Par option within Customer Information, on the Products tab.

---

**Additional Fields:**

**Start Contract Number:** Enter the starting number that will be used in the Contract Number Pool.

**Current Contract Number:** The current number generally updates automatically, enter the starting number if it is blank.

**Contract Rollover:** The highest number the Contract Pool should reach before rolling back to the Starting Contract Number.

**NOTE:** Contract numbers are part of the Equipment Contract option in RMA. Contact Advantage Route Systems for further information.
Desktop Tab

The Desktop tab includes invoice entry defaults and various customer options.

**Other Information:**

*Show Module Bar (Recommended):* Check this box to use the modular toolbar when running RMA.

**NOTE:** The toolbar controls important features in RMA, it is not recommended to disable this option.

*Disable Notification Messages:* Select this option to disable the *Notification Message* button on the module bar.

**NOTE:** The *Notification Message* option allows the user to retrieve important notifications directly from ARS within RMA.

*Use Departments:* Selecting this option enables you to set up a list of departments that group transactions and isolate sales for specific areas of business (Vending only).

*Post Route Input Batch:* Select this option to prompt the user to select each customer’s pre-assigned invoice number in the *Route Settlement Entry* screen (requires *Route Tickets* to be printed prior to route).

*Order ZIP Codes by City:* Select this option to sort ZIP Codes (Postal Codes) by City within the ZIP code drop-down lists throughout RMA.

*Delete Pending Orders on Manual Input:* Check this box to automatically delete any *Pending Orders* on an account when a manual invoice is created.

*Free Format Phone Numbers:* This turns off the hyphenated format within the phone number fields in RMA.

*Use Conversation:* Checking this box enables the instant messages feature available within RMA — available on the Module Bar.

*Use Enhanced Inventory Tracking:* Checking this option enables additional features for managing inventory within RMA. Refer to Chapter 3.10 of the Supplemental Guide for further information.
Use Active Accounts for Refund Checks: Select this option to automatically include ‘active’ customers when using the Print Refund Checks option.

Popup Customer Note: Select this option to popup the Note dialog box when entering a customer’s account. The note will only popup if there is an entry made within the Note field of the Info tab.

Allow Pre-posting in Single Branch Mode: Select this option to require that a ‘pre-posting’ is performed prior to permanently posting transactions in RMA — this function is generally used for multiple branch configurations, allowing a single user to review all of the pre-posted data.

Payments:

Allow check number entry on cash: Check this box to allow the entry of a reference number in the Check# field of the payment screen (for reference).

Allow Payments to Inactive Accounts: Select this box to allow payments to be entered on Inactive Accounts.

Other Fields:

The following options are used with the Disconnected and Distributed Database feature, which allows satellite locations with sporadic internet connections to transfer and sync their RMA data with a remote location.

NOTE: This option also requires a custom data transfer program outside of RMA, contact Advantage Route Systems for further information.

Remote Data Synchronization Folder: Select the local directory used for importing and exporting DDD data.

Server IP/Name.: Enter the IP or host name of the FTP server.

PASV Mode: Select this option if your FTP server and firewall are set up for PASV mode transfers.

Login ID.: Enter the login ID used for FTP transfers.

Login Password.: Enter the password used for FTP transfers.

Ticket Prefix: Enter a prefix to add to invoices imported using the DDD synchronization option.

Port Number (21): Enter the port number used for FTP transfer (Port 21 will be used if left blank).

Import Confirmation Timeout: Enter the number of seconds the system should wait for data confirmation.

Export ( ) Months of History: Enter the number of months of history to include with exported data.

Invoices:

Add Default Products to Manual Invoices: Check this box to automatically populate the customer’s Default Products when a new invoice is created on the desktop.

Add Pending Orders to Manual Invoices: Check this box to automatically populate any Pending Orders when a new invoice is created on the desktop.

Auto Apply Handheld ROA Payments to Oldest Balance: Checking this box will automatically apply any ROA payments received on route to the oldest invoices on the customer’s account.

NOTE: This option only applies to Open Invoice accounts.
Add Pending Transactions to Invoice Lookup: Check this box to add pending (unposted) transactions to the invoice drilldown area within Customer Information. Pending transactions will be flagged with a “P” beside them.

Use 2nd Driver in Invoice Screen: This option allows two drivers to be assigned to a single invoice from within the Invoices and Adjustments screen. This can be used for commission purposes.

Show Tax Breakdown on Invoices: Select this box to separate sales tax by tax authority on a printed invoice. Typically, this function is used in Canada to display GST and PST totals.

Force Unique Invoice Numbers: Choose this option to prevent duplicate invoice numbers from being used on transactions.

NOTE: This option only applies to invoices within the current Accounting Period.

Use Quick Return Entry: Select this option to enable a new icon on the desktop invoice screen used for entering returned containers. This option simplifies the container swap process on the desktop.

Allow Equipment Service Entry during Invoice Input: Select this option to enable a new icon on the desktop invoice screen used for entering Equipment Service Codes.

Display Warning if Any Line Item Total is Negative: Choose this option to display a warning message when entering a negative quantity or price on a transaction in either the Invoices and Adjustments screen or the Customer Finance Assistant.

Do not Allow Posting of Duplicate Invoice Numbers: Select this option to block the posting of duplicate invoice numbers in the same accounting period.

Alert when Route is left blank: Choose this option to remind employees to enter a Route ID on each invoice.

Use Customer Default Branch for Sales: Select this option to appropriate all sales made to a customer to their assigned ‘Home Branch’ and not the branch assigned to the Route ID on their transaction.

NOTE: This option is helpful for companies that frequently deliver to customers across multiple branches.

Show Original Route/Day/Stop on Modify Delivery Order Due Dates: Select this option to display the customer’s regularly scheduled Route/Day/Stop within the Modify Delivery Order Due Dates screen (instead of the routing info from the Delivery Order).

Allow Pre-Pay Credit for Gratis Sales: Select this option to credit Pre-Pay quantities for customers that were given ‘Gratis’ items (The customer must be assigned to the Pre-Pay Pricing option).

Save as Base Relation in Invoices & Adjustments (MUP): This option works with the Multi-Unit Pricing option in RMA. Selecting this box will automatically convert items to their ‘base’ related quantity upon ‘Save’ within the Invoices and Adjustments screen.

NOTE: For further information on Multi-Unit Pricing, refer to Chapter 2.14 of the Supplemental Guide.
**Do not Post Invoice if Sale is Greater than Capacity:** Select this option to prevent each handheld invoice from being posted if the number of (cage capacity qualifying) items on the invoice exceeds their allotted cage capacity on assigned equipment.

**Warn on price change:** Check this box to display a confirmation dialog screen when changing any product price on a desktop invoice.

**Use Weekly Standing Orders:** Select this option to enable the Weekly Standing Orders feature in RMA.

**NOTE:** Refer to Chapter 4.12 of the Supplemental Guide for further information on Weekly Standing Orders.

**Use Custom DT for reprint:** Select this option to use a custom delivery ticket format when reprinting invoices (requires custom ticket from ARS).

**Invoice No. Mask:** Enter the invoice number length that you would like to use (up to 14).

**NOTE:** Optionally, this field can be used to specify a custom format to use on your invoice numbers. For example, if you would like to use two characters, followed by a hyphen and 6 more characters, enter: `##-######` (this example is 9 characters in length).

**WARNING:** Do not change the `Mask` length after you have posted invoices in RMA. This will prevent invoices from being found in certain areas of the program.

**Custom Forms:** Select this option to manage custom forms and tickets created for your company by ARS.

**Don’t Update First/Last Deliv Dates For Non-Inventory Items:** Select this option to ignore posted transaction dates within the First Delivery (Credit tab) and Last Delivery (Route tab) fields within Customer Information on transactions that only include ‘Non-Inventory’ items.

**NOTE:** The option ‘Non Inventory Item’ can be selected within each item under Lists > Product Codes > Product Charge Codes, on the Info tab. This option is generally selected on items that are not tracked as tangible inventory (e.g., Skip Reasons, Refund Codes, Late Charges).

**Other Fields:**

**Location to Backup Data before Period Close:** Enter the directory to use for storing automatic backups created during the Close Period process.

**AF2000 Directory:** Enter the location of your AF2000 program. This is only used if you have purchased the AF2000 Module.
### Defaults Tab

The *Defaults* tab contains additional company options used in various locations throughout RMA.

#### Include As Contact Notes:
Select any of the following to be automatically logged within each customer’s Contacts tab within Customer Information.

- **Include As Contact Notes:** Select any of the following to be automatically logged within each customer’s Contacts tab within Customer Information.
  - **Handheld Notes:** Select this option to log any notes entered by drivers on the handheld.
  - **Equipment Movement:** Select this option to log any equipment transfers, pickups, drop-offs, etc., from the handheld and desktop.
  - **Default “Add to Contacts” in Tel. Orders:** Select this option to automatically log any Delivery Orders created on the desktop.
  - **Route Changes:** Select this option to log any changes to the customer’s route, route schedule, and equipment service day.

#### Company Defaults:

- **Reward Point Label:** Enter the label you wish to display throughout the program when using the Reward Point or Customer Retention Program.

  **NOTE:** For further information on the Customer Retention Program, refer to Chapter 4.04 of the Supplemental Guide.

- **SSN Mask:** Enter numeric data here in a predefined format to force data consistency when filling in the Social Security Number field in Customer Information and Employee Setup (i.e., 999-99-9999 will always follow this format).

- **Business License Mask:** Enter characters and numeric data here (up to ten) to force data consistency when filling in this field in Customer Information (i.e., !9-a-999-a-999 will always follow this format).

  **NOTE:** For both options above, the dash marks are added by the system and alpha characters are transferred to capital letters.
Character symbols that can be used:

- !: Forces upper Alpha
- A or a: Alpha only
- X: Any (Alphanumeric)
- 9: Numbers and signs (+/-)

**Payment Mask:** Enter characters and numeric data here (up to fifteen) to force data consistency when filling in this field in Customer Information. Refer to the chart above for character symbols that can be used.

**Base ZIP Code Length:** Enter the number of characters needed for the ZIP or Postal Code in your country (e.g., ‘5’ in the United States and ‘3’ in Canada).

**PO Number Length:** Enter the maximum number of characters you will allow on a P.O. number.

**Handheld Transfer:**

**Select Process Date for Transfer (Requires Advanced Communications Module):** Select this option to automatically process Morning Cards during a handheld upload.

**Pick Ticket Options:**

**Use Calculated Mode:** This option enables Calculated Mode within the Generate Pick Tickets screen. Calculated Mode allows you to review product totals with a higher level of detail within the Generate Pick Tickets screen.

---

**NOTE:** The RMA Pick Processing feature allows you to create a series of load orders that can be printed and distributed to your warehouse employees for order picking. Each load order will contain all Delivery Orders, Standing Orders, and Load Requests per route. The Pick Processing feature is especially helpful for companies that have a high volume of orders daily. Refer to Chapter 4.13 of the Supplemental Guide for further information.

---

**Show Perpetual On Board Value on Load Screen:** Select this option to include Perpetual Inventory totals in the Calculated Pick Quantities screen.

**Include Delivery Orders and Ad-hoc in 1st Pick Cycle:** Select this option to include quantity information for Ad-hoc Stock and Telesales Orders on the Generate Pick Tickets screen during Cycle 1.

**Allow Standing Order Generation in 1st Pick Cycle:** Select this option to enable the Generate Standing Order Telesales button within the Generate Pick Tickets screen during Cycle 1.

**Field Modification:**

**Disable modification of Acct. no. on Invoices and Adj.:** Choose this option to disable the ability to modify account numbers on handheld or previously entered invoices within the Invoices and Adjustments screen.

**Disable Modification of Start Rent Date after Posting:** Choose this option to disable the ability to modify the Start Rent Date on equipment after rent has been charged.

**Order Entry:**

The following items control options within the Delivery Order screen.

**Default Follow-up to Blank:** Select this option to remove the Follow-Up Date from the Delivery Order on Save.
**Default Delivery Order [Message] to Handheld:** Select this option to automatically select the Handheld Message option prior to saving the Delivery Order.

**Default Send Order to Route via RMLive (Optional Module):** Select this option to automatically transfer the Delivery Order to the RMLive Dispatch screen.

**Force Contact Reason on Delivery Message:** Select this option to force the user to select a Contact Reason prior to saving the Delivery Order.

**Do not disable Reasons on Delivery Order for Equipment:** Select this option to require a Contact Reason on an equipment service Delivery Order.

**Don’t ask for Contract Cancellation on Delivery Order:** Select this option to disable the ‘Contract Violation’ message that can appear when selecting certain Delivery Order Reasons within the Delivery Orders screen.

**Don’t use Equipment Ticket format on Delivery Order:** This option is currently not in use.

**Force ‘Spoke With’ on Delivery Order:** Select this option to force the user to input a name in the Spoke With field prior to saving the Delivery Order.

**Force Request (checkboxes) on Delivery Order:** Select this option to force the user to choose a Delivery Order Reason prior to saving the Delivery Order.

**Show Rent on Shopping Cart (On Delivery Order):** Select this option to include any rental amount established — added to the Delivery Order under the Equipment Install option — within the Shopping Cart button on the order.

**Show 0 Quantity bottle exchanges:** Choose this option to report zero quantity container exchanges on the handheld receipt.

**Default all Default Products to C/P (Cost Plus) Pricing:** Select this option to use Cost Plus Pricing as the default pricing method within the Default Products screen.

**Print Default Products/Equipment When No Order/Svc:** Select this option to include the customer’s Default Products and Equipment on Delivery Order tickets printed without any assigned items.

**Use Stop Seq # When Order is on Regular Deliver Date:** Select this option to use the customer’s standing sequence number for Delivery Orders scheduled on their regular delivery date.

**Prompt to Skip Next Stop if Within ( ) Days:** Enter the number of days to monitor for the customer’s next delivery day when scheduling a new Delivery Order. A ‘Skip Delivery’ message will be displayed if the order is scheduled within the established range.

**Default Contact Message:** Select a default Contact Message to use when a new Delivery Order is created on the desktop.

**Force all new Delivery Orders to Route:** Select this option to assign all new Delivery Orders to the route selected.

**Automated Orders:**

This feature allows you to import Delivery Order data from an external program. Contact Advantage Route Systems for further information.

**Import Directory:** Select the directory used for import.

**Default Route:** Select the default route to assign to the orders.

**Default Employee:** Select the default employee to use when creating orders.

**Order Type:** Select the format of the imported files (ASCII or XML).
Warehouse Information:

**Default warehouse for branch (Enhanced Inventory Only):** Select the default warehouse to use for the current branch.

**Warehouse Prefix:** Enter a prefix that you would like to include in *Pallet Identification Codes* generated and printed within the *Inventory Adjustments* screen.

**NOTE:** A unique *Pallet ID* can be generated and printed for each inventory item received in RMA, and can be attached to the pallet that contains the items. The *Pallet ID* will only be generated on *Inventory Adjustment Codes* with the option ‘Require Pallet Number’ selected under *Lists > Product Codes*. An optional *Pallet Reference Code* (*Lists > Product Codes > Warehouse Setup*) can be included in the *Pallet ID* as well.

Statement Tab

The *Statement* tab allows you to establish default settings for printing statements in RMA.

**Statement Options:**

**Bulk Statement File Prefix:** Enter the identification code that will be used on the statement file transferred to your statement processing company.

**Matrix:** Select this radio button if you will be using Matrix Imaging for statement processing.

**Other:** Select this radio button if you will be using a statement processing company other than Matrix Imaging.

**Statement Number Length:** Enter the desired statement number length; up to 10 digits (applies to companies using *Statement Numbers*).

**Product Description Length (22-60):** Enter the maximum length that should be used for product descriptions on your statements; up to 60 characters.

**Use Statement Numbers:** Select this option if your company will be assigning numbers to each statement. This option is used in various countries around the world.
**Use Alpha Prefix on Statements:** Check this box if the first letter of your numbered statements is an alpha character. This only applies to custom statements.

**Force Unique Statement Numbers:** Select this option to prevent two statements from having the same number during the current Accounting Period.

**Use Credit Class Due Dates:** Select this option to populate the Due Date on each statement based on information provided from the Credit Class assigned to the customer.

**Hide Payment Bar Code on Statement:** Check this box to suppress the payment barcodes from printing on statements (requires scanner).

**Statement Numbers:**
The statement numbers used on your statements are controlled by the following fields.

**Start:** Enter the first (or lowest) Statement Number to use.

**Current:** This field is updated automatically. However, the Statement Number can be updated if necessary.

**Rollover:** Enter the highest Statement Number to be used by the system before reverting back to the Start number.

**Credit Statement Numbers:**

**Use Stmt Pool:** Select this option to use available Statement Numbers defined in the previous section on your Credit Statements. To use unique Credit Statement Numbers, leave this option blank.

**Start:** Enter the first (or lowest) Credit Statement Number to use.

**Current:** This field is updated automatically. However, the Credit Statement Number can be updated if necessary.

**Rollover:** Enter the highest Credit Statement Number to be used by the system before reverting back to the Start number.

**Postal Indicia:**

**Class:** Select the mailing permit class that will be used on your statements.

**Type:** This field displays the type of permit you have.

**City, State:** Enter the city and state that should be used on your Postal Indicia.

**Permit No:** Enter the Postal Indicia Permit Number.

**Address Adjustment:**

**Company Offset:** Enter a positive or negative number to adjust the placement of the company name for your statement envelope window.

**Address 1 Offset:** Enter a positive or negative number to adjust the placement of the first address line for your statement envelope window.

**Address 2 Offset:** Enter a positive or negative number to adjust the placement of the second address line for your statement envelope window.

**Suppress Address 2:** Allows you to suppress the second address line from printing on your statements.
Credit Cards Accepted:
Select each major credit card type that you will accept:
- American Express
- Discover Card
- Visa
- Master Card

Document Storage:
The following option is required if you are using PDF storage routines with the European Finance Module.

Use Doc Storage: Check this box if you are using the integrated PDF module.

Handheld Tab
The Handheld tab contains handheld related options available in RMA.

Options:
- Time Server Name: Enter the I.P. address or host name of your time synchronization server.
- Hazmat Report: Select this option to enter information that will be printed on the Hazmat Report from the handheld.
In addition to the items listed above, this report includes details for hazardous materials loaded onto the delivery vehicle, and a complete list of emergency actions to follow if needed.

NOTE: The Hazmat Report can be printed from the handheld under the Morning Load screen. Products included on the report are enabled by entering a number other than ‘0’ within the Hazmat Report Product Type field found under Lists > Product Codes > Product Charge Codes, on the Info tab.

Port Number (37): Enter the port number used by the time synchronization server (port 37 will be used if this is left blank).

Do Not Display Errors in Adv. Comm: Select this option to suppress any error messages received within the Advanced Communications screen.

Special Pricing Overrides Quantity Pricing: Checking this box will use Special Pricing instead of Quantity Pricing on the handheld.

Add Release Code/Price Override to Contact History: Select this option to log an entry within the Contacts tab when the Release Code or Price Override option is selected on the Credit tab of Customer Information. This will also allow users to type in the reason for performing each function.

Do not Pre-assign Invoice Numbers: Select this option to assign invoice numbers based on the sequence order of the current route.

NOTE: If not checked, all on-route invoice numbers are assigned and stored during the creation of each Morning Card.

Use Asset Scanning: Select this option to scan bins onsite using the handheld (used in the Paper Shredding industry).

Show/Use Secondary Charge Code: Select this option to enable the Secondary Charge Code option within the Product Charge Codes screen. This is helpful if you need to use codes longer than five characters on invoices.

NOTE: With this option enabled, the Secondary Charge Code can be entered/selected instead of the standard five character code.

Use Product Categories in Miscellaneous Sales: Check this box to use product category filters on the handheld.

NOTE: Product Categories can be established under Lists > Product Codes > Primary/Secondary Categories and assigned to each product under Product Charge Codes > Handheld tab.

Allow Camera to be Used: Choose this option to enable camera features within each Handheld Class, on the Hardware tab.

NOTE: The Photo Directory should also be established under Local Settings > Directories tab to use this option successfully.

Sequence Special Stops: Select this option to assign sequence numbers to special stops when they are scheduled.

Allow Stock Take: Select this option to allow the driver to perform a complete inventory of the delivery vehicle on the handheld.
NOTE: This option is used with the Perpetual Inventory option found under Lists > Routes > Handheld Class, on the Load/Unload tab. For further information on Perpetual Inventory, refer to Chapter 3.17 of the Supplemental Guide.

**Send Adv Comm. Errors Via E-Mail:** Select this option to enter an e-mail address that will receive all errors received within the Advanced Communications screen.

**Stock Take Inventory Adjustment Code (Requires ‘Allow Stock Take’ option above):** Select the Product Charge Code that will be used for Stock Take adjustments.

**Scan Coupon Payments:** This option is currently in development.

**Always Ask for Sequence (Telephone Orders):** Choose this option to require a sequence number when creating and scheduling a Delivery Order on the desktop.

**Sequence Drag Stops:** Select this option to add a sequence number to a stop dragged from another route.

**Update Route Invoice Number with Last Invoice Used:** Select this option to update the next available invoice number based on the invoice numbers used on route (instead of discarding the total number of invoice sent to the handheld).

**Schedule dragged stops on original route:** When choosing this option, a stop that was originally scheduled for a Special Route will revert back to its standard route when it is dragged.

**Cancel Drag When a Special is Scheduled:** Select this option to stop dragging a customer’s delivery if a special stop is made.

**Maximum Number of Days to Drag a Stop:** Enter the maximum number of days to drag a customer’s stop.

**No. of Decimals for Price:** Input up to three digits to be displayed after the decimal point for the price of the product.

**No. of Decimals for Quantity:** Input up to two digits to be displayed after the decimal point for the quantity of products sold.

**Allow Installation of Picked Up (Dirty) Equipment:** Select this option to allow drivers to install equipment previously picked up from another location on the same route day.

**Always Use Delivery Order Price:** Select this option to ensure that the Delivery Order price is used on orders scheduled for customers assigned to any special pricing option (i.e., Quantity Discount, Price Lists).

NOTE: This option will override all special pricing rules.

**Use ‘Do By’ Scheduling in Delivery Orders:** Select this option to enable the ‘Due By’ field within the Delivery Orders screen. This feature allows you to send an order to the handheld beginning on the date entered in the ‘Earliest Delivery Date’ field, and the order will continually be sent to the handheld until it is completed.

NOTE: Once the order reaches the ‘Due By’ date and the order has not been serviced, it will be treated as a standard Delivery Order.

**Allow Selection of Warehouse for Handheld Loads:** Select this option to allow the selection of a Warehouse location when scheduling a Delivery Order.
**Allow Billing of Package Plans on Handhelds:** This option allows the driver to assign the Package Plan billing code via the Misc. Items or Default Products screen for monthly billing purposes.

**NOTE:** In order to use this option properly, you must select ‘Reset Package Plan Available Quantities Each Delivery’ under File > Branch Setup > Customer. Contact ARS prior to enabling this feature to ensure you can use it successfully.

**Allow new Package Plans Setup:** This option allows the driver to assign the Package Plan billing code to a handheld invoice via the Misc. Items screen, which will add the Package Plan to the customer’s account (during the posting process). Additionally, adding the Package Plan to the customer’s invoice will allow the driver to immediately leave the items assigned to the plan with the customer.

**Create Def. Products for new Package Plan Products:** This option will add the Package Plan products to the customer’s Default Product list automatically (during the posting process).

**NOTE:** The Package Plan options above only apply to companies that bill for Package Plans once per month, do not use these options if your billing schedule varies. Please contact ARS prior to enabling these features to ensure you can use them successfully.

**DEX/UCS:**
DEX/UCS options are part of a future enhancement in RMA. Contact Advantage Route Systems for further information.

**Route Defaults:**

**Hide all price information on quick entry screen:** Select this option to suppress all prices on the Quick Entry screen of the handheld.

**Warehouse Equipment:**
The Warehouse Equipment options are not currently in use.

**Open Hours:**

**No. of time bands to show:** Enter up to three time bands that can be used on the handheld. Each time band will include the open hours of operation for each customer’s stop.

**NOTE:** This information can be established per customer under Customer Information > Route > Messages. Select the yellow clock button.

**Alternate Path for Adv. Communications:** This option allows you to specify an alternate FTP directory that will be used for route processing when using the Advanced Communications Module.
Equipment Tab

The *Equipment* tab contains important equipment options available in RMA.

**Equipment Options:**

*Start Rent [ ] Days After Install:* Enter the default number of days that should be used when calculating the customer’s *Start Rent Date* during installation; it can be overwitten with each installation.

*Default Equipment Wizard to Statement Billed:* Select this option to establish the ‘Statement Billed’ option as a default selection within the *Equipment Setup Wizard*.

*Prorate Rent:* Check this box to prorate rental amounts on equipment.

**NOTE:** If a piece of equipment is installed on the 20th of the month, the customer will not be billed until the following month, resulting in a rental for a full month with an additional prorated amount added to it. This is a system setting that cannot be controlled per account.

**NOTE:** *Prorate Rent* is ignored when billing rent on the handheld.

*Bill Partial Rents:* Select this option along with *Prorate Rent* to establish a prorating system that will bill your customers for partial month rentals.

**NOTE:** Selecting this option along with *Prorate Rent* will result in a true prorated amount. The system will not wait a full month to bill the customer for their first rental.

*Defer Rent:* Select this option if you defer rental charges. By using the deferred rents option, you can track how much revenue should be recognized in each period. For more information on this feature, refer to Chapter 4.07 of the Supplemental Guide.

*Use Multiple Rent Codes:* Select this option to establish up to three separate charges per cooler. This feature is generally used in Europe for rent, sanitization, and other charges.

*Ignore Rent Pending Date on Handheld:* Select this option to ignore the rent pending date assigned to each piece of equipment (not generally recommended).
**Generate Rent by Contract Number**: If contract numbers are being used, rentals will be generated based on the contract number and not the customer’s account.

**Link Styles to Types**: This option allows you to link Equipment Style Codes to Equipment Type Codes from within the Equipment Type Codes screen.

**Print Type and Style on Statements**: Choose this option to print equipment Type/Style information when displaying rentals on statements.

**Use Product Descriptions for Rent**: Choose this option to display rent product descriptions on customer statements and invoices, instead of Rent Calendar descriptions.

**Delete Prior Service Calendar Entries**: Select this option to clear equipment service days that have already been performed each month.

**Allow installed equipment to be re-assigned**: Select this option to enable the ability to reassign equipment from within the Products tab of Customer Information.

**Suppress Equipment Movement on Invoice**: This option is part of a custom enhancement and is generally ignored.

**Equipment Transfer Defaults (Optional)**: Establish default settings for equipment as it is checked back into the warehouse from a customer.

**Do not Change Period Code/Charge Code on Handheld Install/Pickup**: Select this option to use the same Period Code already assigned to the piece of equipment when it is returned to the warehouse.

**Do not Change Period Rate on Install/Pickup**: Select this option to use the same Rental Rate already assigned to the piece of equipment when it is returned to the warehouse.

**Default Period Code and Charge Code**: Enter up to three default Period Codes and Charge Codes to use when checking equipment back in to the warehouse from a customer.

**Status for Equipment Picked Up**: Select the default Equipment Status Code to use when equipment is picked up from a customer.

**NOTE**: Equipment Status Codes can be established under Lists > Equipment.
**Equipment Location After Pickup:**
Select the default location where a piece of equipment should be placed each time it is returned to the warehouse:
- Warehouse
- Received
- Service

This new location is updated during the Afternoon Card process.

**Repair Rate:**
*Hourly Rate:* Enter the hourly repair rate applied to equipment servicing. This information will be used during an Equipment Service Entry.

*Default Service Code:* Enter a default Equipment Service Code that will be automatically assigned to equipment when performing an unscheduled equipment service. This entry can be overwritten on the invoice screen if necessary.

*Next Service Ticket No:* Enter the starting Equipment Service Ticket Number you would like to use. This field will be automatically updated as each ticket is generated.

**Rent Billing Calendar:**
The Rent Billing Calendar contains the settings necessary to generate rent charges within RMA.

*Cycle Code:* Enter a cycle code that will be used to bill rentals this month.

*Cycle Type:* Displays the type of Cycle Code selected above (e.g., Monthly, Bi-Monthly).

*Cycle Description:* Enter the rental description that you would like to use on statements and invoices.

- **Clear All Unbilled Cycles:** Select this option to clear the Rent Calendar.

**Rent Calendar 1 & 2:** Up to two rent calendars can be defined within RMA. Using more than one calendar is not common.

- **Create Standard Months Billed in Arrears:** Select this option to automatically populate the Rent Calendar with the most common Rent Codes used when billing for the current period.

- **Create Standard Months Billed Ahead:** Select this option to automatically populate the Rent Calendar with the most common Rent Codes used when billing in advance.

*Service Call Address:* Enter company address information that will print on Equipment Service Call forms found under Transactions > Equipment Processing.

*Text Descriptions:* Select this option to use the standard Cycle Descriptions above on statements and invoices.

*Numeric Descriptions:* Select this option to use rent billing dates as descriptions (e.g., 10/2009-11/2009).
Logging Tab

The Logging tab contains tracking and error reporting settings used in RMA.

Contact Messages:

Delete Messages Older Than ( ) Days: Enter the maximum number of days to retain messages within the Contacts tab of Customer Information.

Keep Last ( ) Messages: Enter the minimum number of messages to retain within the Contacts tab of Customer Information.

Delete Completed Delivery Orders Older than ( ) Days: Enter the maximum number of days to retain completed Delivery Orders in the program.

NOTE: The information established above is processed during the Close Period process.

Logging Options:

Log Customer Changes: Select this option to activate the RMA logging feature. This feature will record certain changes made to each customer’s account, and the employee making the changes.

NOTE: The Log Report can be generated under Transactions > Reports > Communication Reports > Log Report.

Delete Entries Older Than ( ) Days: Enter the maximum number of days to retain logged activity.

Warn Master User if log is greater than ( ) MB: Enter the file size (in megabytes) that should be reached prior to informing a ‘Master User’ that the log file may need to be edited.

Append notes / User Info on Telephone: Select this option to disable the ability to edit a previous Delivery Message or Invoice Message on a saved Delivery Order. The user editing the order will be forced to add a new message if necessary, and both will be displayed on the Delivery Order.

Do not append if blank: Select this option to allow users to edit the original message field only if the field was left blank on the Delivery Order.
Append notes / User Info on Contact:  Select this option to disable the ability to edit a previous message entered on a saved Contact Message. The user will be forced to enter a new message if necessary, and both will be displayed on the Contact Message.

New Customer Wizard:  Enter an email address for each user that should be notified when a new account is created in RMA (one address per line).

NOTE:  This option transmits a .PDF attached file via Email and requires additional configuration prior to usage.  Refer to Chapter 2.12 of the Supplemental Guide for further information on setting up .PDF attachment options in RMA.

Don’t Send diagnostic information to Advantage Route Systems:  Choose this option to disable automatic error reporting transmitted to ARS.

Do not create backup for system errors:  Choose this option to prevent RMA from creating a backup during the posting process (not recommended).

NOTE:  This is not a complete backup of your data.  Only the files updated during the posting process will be included.

Docking Tab

The Docking tab applies to companies using a customized version of RMA that allows the use of handhelds with their existing routing program.

Fields:

Use Output to Host in Non-Docking Mode:  Choose this option to use the ‘Output to Host’ features in non-docking mode.

Docking Program Version:  Choose the version of RMDocking being used.

DL Directory:  The directory where DL (download) files are located.

UL Directory:  The directory where UL (upload) files are located.

Temporary Directory:  The directory where DL (download) files are temporarily located.
**Number of Days for DL/UL:** This field displays the number of days to keep or use the files. When the number of days is reached, the program will delete the files.

**Use History from DL File:** If this is checked, history will be used from the DL files to transfer to the handheld.

**Overwrite Employee(s):** If this is checked, the employee file in the DL file that is transferred to the desktop will replace the employee file on the desktop.

**Automatically Create UL files on Upload:** Checking this box will automatically create a new UL file when routes are uploaded.

**Create all routes on Load From Host:** This will load all routes at once.

**Replace Truck ID with Driver ID:** This will default to the driver ID.

**Do Not Overwrite Route Info:** Check this box to prevent the overwriting of route information.

**Do Not Overwrite Truck Info:** Check this box to prevent the overwriting of truck information.

**Do Not overwrite Tax Info:** Check this box to prevent the overwriting of tax information.

**Use Additional Account Number:** Select this option to use alternative account numbers for your customers in your docking files. The additional account number will be displayed on the top-right corner of the customer’s Route tab within Customer Information. Selecting this option will also enable a new ‘Additional Account Number’ customer lookup field within RMA and the handheld program.

**Only Show Addtl. Acct. # in Customer Info. Find (requires option above):** Select this option to automatically search by the Additional Account Number field when accessing the customer-lookup feature in RMA.

**Export Signatures During Output to Host:** Choose this option to create signatures when exporting data. This will put them into the output directory in a sub folder where they can be incorporated by your host program.

**Exclude Skipped Stops from UL File:** Choose this option to exclude skipped customer stops from the uploaded data.

**External Order Host Program:** Select the external program being used.
Calendars Tab

The Calendars tab contains important settings for routing, accounting, and rent options.

**Holiday Calendar:**

The Holiday Calendar is used to identify all holidays that may, or may not, have an impact on your route schedules. To add a holiday to the calendar, simply click on top of the desired day.

**NOTE:** Adding a holiday to the calendar does not automatically determine a route schedule. You will choose to skip, slide, or ignore each holiday added during the Day Label Setup process.

**Fields:**

*Copy From:* Select this option to copy holidays from other branches already configured.

*Clear All:* Select this option to clear all of the holidays already established.
Day Label Calendar:

The Day Label Calendar is used to create codes (day labels) that your customers will be assigned to that will determine their route schedule. A common Day Label Calendar is shown below.

**NOTE:** For a complete walkthrough on setting up the Day Label Calendar, refer to the Getting Started Guide.

### Fields:

**Route Schedule End Date:** This field determines the date that the current route schedule will end. The date is typically extended for one year in advance.

**Copy Branch:** Select this option to copy the day label calendar from an alternate branch to the current branch.

**Rebuild Day Labels:** Choose this option to update the day label calendar. This is typically used when holiday changes have been made after the calendar has already been extended for the year.

**Add Day Label:** Choose this option to add a new Day Label to the system.

**Clear Day Label:** Choose this option to clear a single Day Label from the calendar.

**Clear All:** Choose this option to clear all Day Labels from the calendar.
**Pre-Call Calendar:**

The *Pre-Call Calendar* is part of the *Advanced Pre-Calling* feature in RMA that allows companies to use a formal calling program to contact customers prior to delivery. The *Pre-Call Calendar* is used to create codes (day labels) that will determine each customer’s pre-call schedule.

**NOTE:** For further information on the *Advanced Pre-Calling* option, refer to Chapter 3.23 of the *Supplemental Guide*.

---

### Fields:

**Pre-Call Schedule End Date:** This field determines the date the current route schedule will end. The date is typically extended for one year in advance.

**Copy Branch:** Select this option to copy the pre-call calendar from an alternate branch to the current branch.

**Rebuild Day Labels:** Choose this option to update the pre-call calendar. This is typically used when holiday changes have been made after the calendar has already been extended for the year.

**Add Day Label:** Choose this option to add a new *Day Label* to the system.

**Clear Day Label:** Choose this option to clear a single *Day Label* from the calendar.

**Clear All:** Choose this option to clear all *Day Labels* from the calendar.
Rent Schedule 1-4

The Rent Schedule calendar offers an alternative to using the standard Rent Calendar found on the Equipment tab of Branch Setup. The Rent Schedule option works on a 7, 14, 28 or 56 day cycle.

To add a new cycle, simply choose one of the cycle buttons and select the day to begin by clicking on the calendar.

**NOTE:** You cannot establish more than one cycle on the calendar. If you require the use of multiple rent cycles, you can create up to four by using Rent Schedules 2-4.

**Schedule 1 (or 2):**

*Copy from:* This option copies calendar information from another branch.

*7 Day Cycle:* Select to indicate a 7 day rent billing cycle.

*14 Day Cycle:* Select to indicate a 14 day rent billing cycle.

*28 Day Cycle:* Select to indicate a 28 day rent billing cycle.

*56 Day Cycle:* Select to indicate a 56 day rent billing cycle.

*Clear All:* Select this option to clear all scheduled rents from the calendar.
Rent Groups

Rent Groups allow you to generate rentals at different times during the month. Instead of generating rentals once per month on the desktop, you will be able to generate rentals throughout the month based on the Rent Groups defined within the calendar.

To create a new Rental Group, select the Add Rental Group option and choose a beginning and ending date for the new group on the calendar.

NOTE: You will be prompted to enter a Rent Group Code during this process. Only numbers 0-9 can be used.

Fields:

Bill Ahead: Select this option to bill customers a month in advance, if applicable.

Copy From: Choose this option to copy Rent Groups from another branch.

Add Rental Group: Choose this option to create a new Rental Group.

Clear All: Choose this option to clear all of the Rental Groups from the calendar.
**Period Calendar**

The Period Calendar allows you to define accounting and general ledger periods important for RMA to function properly.

- **Accounting Period**: Controls when statements are issued, and other customer related information. The Close Period function is run on the last day of the Accounting Period.
- **General Ledger Period**: Controls totals on general ledger driven reports in RMA, and generally matches the Accounting Period above.
- **Quarter End**: Allows you to indicate each quarter end of the year. This is used for quarterly totals within Customer Information and certain reports.
- **Year End**: Allows you to indicate the end of the year on the calendar. This is used for year-to-date totals within Customer Information and certain reports.

In the example below, the Accounting and G/L Periods mirror each other in period length and description (1st – 31st). The Quarter and Year End markers have been added to the last day of December as well.

**Period:  
Add Accounting Period**: Select this button to define a new Accounting Period. Choose the beginning and ending day of each period, and enter a label when prompted.

**Add GL Period**: Select this button to define a new General Ledger Period. Choose the beginning and ending day of each period, and enter a label when prompted.

**Quarter End**: Select this button to define a Quarter-End marker.

**Year End**: Select this button to define a Year-End marker.

**Clear**: Select this button to clear any of the defined period markers on the screen.

**Standard Month Extend**: Select this button to extend the current calendar configuration after you have defined a full calendar year of periods and markers.
**Period Discount Pricing Calendar**

The *Period Discount Pricing Calendar* allows you to establish a custom cycle that will be used when generating period discounts.

**NOTE:** Refer to Chapter 2.15 of the Supplemental Guide for further information on Period Discount Pricing.

---

### Slide for Holidays:
Select this option to slide the discounting cycle around all holidays.

### Copy From:
Select this option to copy an existing calendar from an alternate branch.

**1 Week Cycle:** Select this button to define the discount schedule on a 1 week cycle.

**2 Week Cycle:** Select this button to define the discount schedule on a 2 week cycle.

**3 Week Cycle:** Select this button to define the discount schedule on a 3 week cycle.

**4 Week Cycle:** Select this button to define the discount schedule on a 4 week cycle.

**X Days Cycle:** Select this button to define a custom discount schedule.

**Clear All:** Use this button to clear all discount cycles.
Package Plan Calendar

The Package Plan Calendar allows you to establish a custom cycle that will be used when generating Package Plan billing charges.

**NOTE:** Standard monthly Package Plan billing is used within RMA without creating a billing schedule within this screen; creating a calendar here will override this setting. For further information on using this option, refer to the Package Plan Manual.

Fields:

*Slide for Holidays:* Select this option to slide the package plan calendar around holidays.

*1-4 Week Cycle:* Select this option to create a one to four week billing cycle for Package Plans.

*X Days Cycle:* Select this option to create a custom billing cycle for Package Plans.

*Clear All:* Select this option to clear the current Package Plan billing cycle.
Optimizations Tab

The Optimizations tab contains options for archiving and deleting data.

Memory:

Foreground Memory: Enter a ‘1’ in this field to optimize your PC’s foreground memory for RMA. The displayed information will be updated on Save.

Background Memory: Enter a ‘1’ in this field to optimize your PC’s background memory for RMA. The displayed information will be updated on Save.

Backup:

Backup Copies: Enter the number of backups that should be stored in a single location, prior to overwriting the oldest one (up to 5).

Include ALL history in backups (default is 2 years): Select this option to include all available historical data.

Posting Backup:

Do not Backup Prior to Posting: Check this box if you do not want RMA to backup your data before closing the current period (not recommended).

Posting Backup Copies: Select this option to disable the automatic backup routine performed during the posting process (generally not recommended).

Copy Instead of Compressing: Check this box to create a full copy of the posting data instead of compressing the contents.

Backup Copy Directory: Enter the storage directly for the copied data files when using the ‘Copy’ option above.

Help Desk Destination:

ARS Standard: This is the standard option that should be selected.

Custom: Select this option to direct support requests to a destination of your choice.

Directed to: Enter the name of the destination recipient.

Destination E-mail: Enter the e-mail address to forward all inquiries to.

Fax Number: Enter the fax number for automated fax requests.

Use for all Branches: Select this option if these settings will apply to all branches in RMA.
Other:

**Last Transaction Date for Deleting Customers:** This date is used during the Archive Customers process. For more information on this feature, refer to Chapter 3.16 of the Supplemental Guide.

**Purge Truck Load Qtys After ( ) Days:** Enter the default number of days before truck quantities are reset when using Perpetual Inventory. For more information on this feature, refer to Chapter 3.17 of the Supplemental Guide.

**Purge HH One Time Msgs After ( ) Days:** Enter the default number of days before the system erases One Time Messages within Customer Information.

**Purge Inventory Transactions After ( ) Months:** Enter the default number of months the system should wait before purging old inventory entries within the Inventory Adjustments screen.

**Purge Purchase Order History After ( ) Months:** Enter the default number of months the system should wait before purging old purchase order entries in RMA.

**Purge Upload Reports After:** Enter the default number of months the system should wait before deleting upload reports from the system.

**Extra Invoice Tab**

This tab is only used in Argentina.
GPS Tab (RT2000 Module)

Refer to the Route Track 2000 User Guide or contact Advantage Route Systems for further information on this module.

GPS:

**Default Stop Time:** The default length of time per stop.

**Default Degree of Difficulty:** The default level of difficulty per stop. Onsite security, stairs, and distances are all factors in determining difficulty.

**Route Dispatch Manager Settings:**

**Route Start Time:** Specify the standard time drivers begin their day.

**Route Stop Time:** Specify the standard time drivers end their day.

**Time Interval:** Specify the time interval generally required per route stop (in minutes).

**NOTE:** The Route Dispatch Manager is a unique routing tool that simplifies your daily route management routines. This option can be found under the Route menu in RMA. Contact ARS for further information.
Local Settings

The Local Settings screen contains workstation specific data. Each user can define their default printer(s), language, and other information unique to their workstation.

Desktop Tab

The Desktop tab contains default settings that generally affect the user’s interaction with the Customer Information screens.

Miscellaneous:

Presale Message Copies: Enter the default number of Route Pre-Sale Orders to print automatically once Save is selected.

Phone Message Copies: Enter the default number of Delivery Orders to print automatically once Save is selected.

NOTE: The number entered on each of the items above refers to the number of copies to print. W = Wide and S = Small.

Use 8 ½ X 11 Invoice Format: Check this box to print all invoices in full page format from the desktop.

Include Payment Voucher on 8 ½ x 11 Invoice: Select this option to include individual payment vouchers with each full page invoice printed from the desktop.

Print Invoice Copies One Per Page: Select this option to only include one invoice per page when printing multiple invoices on the same account.

Use legacy report generator: Select this option to enable an enhanced report “preview” option that enables additional features when previewing reports.

NOTE: Exit RMA completely and login again after enabling this feature.

Don’t Use Autosense on Find: Select this option to prevent the program from ‘sensing’ the field to search in based on the data entered.

Default Payment Type: Select the default payment type you would like to use when adding a new payment to RMA.
**Program Language:** Select the language file that will be used on this workstation. For more information on language options within RMA, refer to Chapter 1.04 of the Supplemental Guide.

**Browse Orientation Bar:**

Each user can control the colored bars displayed within the various Browse windows in RMA.

**Every ( ) Lines:** Indicate how often a colored line should appear.

For each color listed, enter a value between 0-255.

- Red
- Green
- Blue

The higher the number entered, the brighter the color will be. Experiment until you find a color combination that is right for you.

**Customer:**

**Default Tab in Customer Info Screen:** Select the default tab to display when accessing the Customer Information screen.

**Customer Info/Credit default page:** Select the default screen to display when accessing the Credit tab of Customer Information.

**Default Equipment Status Customer Info:** Select the default equipment status code assignment to display when accessing the Equipment tab of Customer Information.

**Browse Order:** Select the default sort option to use when accessing the Browse window in Customer Information.

**Disable Browse in Customer Information:** Select this option to disable the 'Browse' button on the toolbar from within the Customer Information screens.

**Top Item in Find:** Enter the default field to search in after selecting the Find option within Customer Information.

**Use left to right search on lookups:** Select this option to prevent the program from searching in all areas of each field when using the Find option.

**NOTE:** With the above option selected, RMA will only search based on left-to-right lookup.

**Use Caller ID with Advanced TS Client:** This option requires special telephone equipment and a TAPI interface to provide caller ID information directly to each workstation. Contact Advantage Route Systems for further information.

**Display Statements on Drill-Down:** Select this option to display Statement Numbers instead of Invoice Numbers within the Invoice Lookup section of Customer Information (select only if you are using Statement Numbers).

**Number of Periods in Drilldown:** Enter the number of periods (months) to use to automatically select drilldown period when entering the Invoice Drilldown screen (from 0-14).

**Package Plan Contract Expiration Days (Package Plan Module):** Enter the default number of days to add to the expiration date when assigning a customer to a Package Plan.

**Do Not Preview Invoices:** Click this box to automatically send invoices to the printer when double-clicking on them.
**Order by Start Time in Route Pre-Sale:** Select this option to sort customers displayed on the Route Pre-Sale screen according to the Start Time listed within the PreCalling tab of each customer’s account.

**Prompt to ‘Edit’ Customer after completing wizard:** Select this option to enable a prompt when completing the New Customer Wizard that will display the Customer Information screen for the account in edit mode.

**Drives:**

**Card Reader:** If your computer is used for data transfers via card reader, enter the letter of the active drive. If there is more than one slot, enter the letter for the slot that will be used frequently.

**Use Delete Method Instead of Format to Clear Card:** Select this option to delete route data on a card, rather than format, when performing a Prepare Data Card function.

**NOTE:** This option is helpful for users that are connecting to RMA via Remote Desktop connection to process route cards.

**RMLive (Optional Module):**

**RMLive Refresh Rate (in seconds):** Enter the refresh rate that should be used within the RMLive Dispatch screen.

**Show Weight Option in RMLive:** Select this option to display weight totals per delivery vehicle within the RMLive Dispatch screen.

**Other Fields:**

**Check Scanner (Check 21 Module only):** Select the check scanner being used.

**Communications Tab**

The Communications tab includes wireless handheld transfer and e-mail options.

![Local Settings](image)

**Communications Options:**

**NOTE:** The Communication Options are used with the Advanced Communications Module. Contact Advantage Route Systems for further information.
**Net/WiFi only:** Select this item if you only use a WiFi Connection to your handheld for data transfers.

**Net/WiFi and Cable:** Select this item if you use a serial cable for communications between the handheld and the desktop.

**Net/WiFi and Modem:** Select this item if the handheld connects to the desktop via dial-up modem.

**Number of Ports:** Enter the number of communication ports available.

**Starting Com Port Number:** Enter the number of the serial port that the handheld is plugged into, or the number of the first serial port on a multi-port board.

**Baud Rate:** Choose the baud rate being used for modem or cradle transfers.

**Start Downloads at:** Input the time (in military format) that you wish to initiate data transfers on each handheld.

**Thin Client Connection Type:**
- **None:** Select this option if a Thin Client program is not being used with RMA.
- **Citrix Meta Frame:** Select this option if you are using Citrix.
- **ARS TS Advanced Client:** Select this option if you are using the Advanced Terminal Services Client.

**E-mail Delivery Method:**

The following options are used to establish e-mail transfers within RMA.

NOTE: For further information on using e-mail within the program, refer to Chapter 2.12 of the Supplemental Guide.

**Microsoft Outlook:** Choose this option if you will be using Microsoft Outlook to process e-mails.

**Outlook Signature:** Select a signature file created within Microsoft Outlook that will be included on each email sent via RMA.

**SMTP Server:** Choose this option if you will be processing e-mail directly through an SMTP Server.

**SMTP Server Address:** Enter the I.P. address or host name of the SMTP Server.

**SMTP Port:** Enter the SMTP Port that should be used for transferring data.

**Use SSL (Secure Sockets Layer):** Select this option if SSL security will be used during transfers.

**Use Login Authentication:** Enter the authentication code (or password) to process SMTP transfers.

**Login Name:** Enter the login name used to access the SMTP Server.

**Login Password:** Enter the password used to access the SMTP Server.
Directories Tab

The *Directories* tab contains directory options used for exporting backup files, reports, and optional modules.

**Fields:**

**Backup Directory:** Enter a directory that will be used when creating RMA backups.

**Browse Button:** By clicking this button next to each option you are able to browse for the directory or file you wish to use.

**G/L Output Directory:** Enter a directory that will be used when exporting the *G/L Report*.

**Backup:** Select this option to create a backup file containing G/L information each time the file is exported.

**Credit Card Processing Directory (Electronic Funds Module):** Enter a directory that will be used when exporting credit card data.

**Backup:** Select this option to create a backup file containing current credit card data each time the file is exported.

**Bank Transfer Processing Directory (Electronic Funds Module):** Enter a directory that will be used when exporting ACH data.

**EF2000 Document Directory (Optional Module):** Enter the customer document storage directory.

**EF2000 Equipment Document Directory (Optional Module):** Enter the equipment document storage directory.

**NOTE:** The *Electronic Filing 2000* module allows you to scan and store legal documents (rental agreements, service agreements, etc.) within the RMA program. Please contact ARS for further information.

**Report Output Directory:** Enter a directory that will be used when exporting reports.

**Mapping Directory (Advanced Mapping Module):** Enter a directory that will be used when exporting or importing mapping data.

**Photo Directory:** Enter a directory that will be used for storing photos taken on each driver’s handheld.
MapPoint File (Advanced Mapping Module Only): Enter the directory that contains your map files.

Printers Tab

The Printers tab allows you to define all of the printers that will be used at each workstation. Each printer available at your workstation will be displayed within the drop-down list next to each item.

Fields:

Standard Printer: Select the printer that you would like to use most commonly.

Use Standard Printer for all Printing: Choose this option to use the Standard Printer for all of your printing needs.

Afternoon Report Printer: This printer will be used when processing reports during the Afternoon Card function.

Fax Printer (Requires AF2000 Module): This printer will be used when faxing within RMA.

Delivery Order Printer: Select the printer that should be used when processing Delivery Orders.

Impact Printer (Requires Additional Setup): This option applies to impact or dot matrix style printers, and generally required program customization.

9 or 24 Pin Head: Indicate the type of impact/dot matrix head.

Label Printer: Select the printer to use when processing mailing labels.

Laser: Select this option if you are using ‘Avery’ style labels.

Statement Printer: Select the printer to use when processing customer statements.

Invoice Reprint Printer: Select the printer to use when reprinting invoices from the desktop.

Use Invoice Reprint Printer for Statements with Invoice Copies: Choose this option to print statements with invoices using the Invoice Reprint Printer above.

PostScript Printer (Requires Additional Setup): Select an installed ‘Postscript’ printer used when processing PDF files for emailing customer statements, invoices, and reports. Refer to Chapter 2.12 of the Supplemental Guide for further information.
**BOL Printer:** Select the *Bill of Lading* printer to use.

**Packing Slip Printer:** Select the printer that will be used for printing packing slips.

**Path to Ghost Script:** Enter the path to the ‘Ghostscript’ program used for processing PDF files for emailing customer statements, invoices, and reports. Refer to Chapter 2.12 of the *Supplemental Guide* for further information.

**Equipment Label Printer:** Select the printer that will be used for printing equipment identification labels.
Messaging

The Messaging option allows you to send notices to your desktop users and drivers. By using these options it will be possible for others to be informed of important information as they do their work.

Message Entry

The Message Entry option allows you to enter messages that will be sent to desktop or handheld users. You will have full control over the type of message, where it appears, and the duration of time it will be valid.

Fields:

Message Type: Choose the type of message you would like to send.
- **Route Message**: Select this type of message to display a message on the desktop when a customer assigned to the Route specified is accessed.
- **Branch Message**: Select this type of message to display a message on the desktop when a customer assigned to the Branch specified is accessed.
- **Employee Group Message**: Select this type of message to display a message on the desktop when an employee assigned to the current Employee Group logs in to the program.
- **Customer Message**: Select this type of message to display a message on the desktop when the assigned customer account is accessed.
- **Handheld by Route**: Select this type of message to display a message on the handheld when a driver logs in to the route specified.
- **Handheld by Area**: Select this type of message to display a message on the handheld when a driver accesses an account that is assigned to the Route Area is selected.

**Route, Branch, Employee Group, Account No., Area**: Depending on the Message Type selected, this option will be updated to reflect the associated data.
**Reason:** Select a *Message Reason* from the dropdown list.

**NOTE:** You should add all of your *Message Reasons* to the program prior to using this feature.

**Entered By:** Display the current employee ID.

**Message:** Enter the message you would like to send.

**Start Date/Time:** Enter the starting date and time that you would like the message to be displayed. Enter the time in 24 hour format (i.e., 3:00 p.m. is 15:00).

**Expires Date/Time:** Enter the ending date and time that you would like the message to expire. Enter the time in 24 hour format (i.e., 3:00 p.m. is 15:00).

**Entry Date/Time:** This displays the date and time the message was originally entered.

### Message Reasons

*Message Reasons* are displayed within the *Message Entry* screen. Enter a series of reasons will be sent to your employees.

![Message Reasons Screen](image)

**Fields:**

**ID:** Enter the ID to use for this *Message Reason*.

**Name:** Enter the description of the *Message Reason*.

**Extra Item 1-2:** Allows you to enter optional information related to each reason.

**Default Days:** Choose the default number of days for this message to be displayed.

**Available:** Displays all of the *Message Types*.

**Used:** Displays the *Message Types* the current message applies to.

**NOTE:** Double-click on each *Available* message type the current reason will apply to.
Delivery Order Email Setup

This feature is used for formatting Delivery Orders sent to your drivers via Email.

**Fields:**

**Account No.:** Check this box to include the account number in the message.

**Account Name:** Check this box to include the customer’s name in the message.

**Address 1:** Check this box to include the first line of the customer’s address in the message.

**Address 2:** Check this box to include the second line of the customer’s address in the message.

**City:** Check this box to include the customer’s city in the message.

**State:** Check this box to include the customer’s state in the message.

**Zip:** Check this box to include the customer’s ZIP code in the message.

**Message Reasons:** Check this box to include the Delivery Order Message Reason in the message.

**Products:** Check this box to include ordered products in the message.

**Equipment Service:** Check this box to include equipment service information in the message.

**NOTE:** In the white box next to each item, you can specify an abbreviation or symbol to replace the text it is related to.
Manage Data Sets

The Manage Data Sets option allows you to manage multiple data sets from within the program. This can be helpful if you establish a ‘Test’ data set on the network.

In order to use this option successfully, the user will add both the ‘Live’ and ‘Test’ data sets to the list (example below). Once this information has been established, you can use the Load Data Set option to switch between each.

To establish a data set in the program, choose the Add button on the screen.

**Fields:**

- **Name:** Enter a description for the data set.
- **Location:** The location of the data set. The path should include the Data folder. If necessary, use the ‘?’ button to locate the data.

**NOTE:** If the directory specified does not exist prior to establishing the data here, the current RMA data will be copied and placed in the new location.

Load Data Set

The Load Data Set option will only be available if you have established more than one data set in the Manage Data Sets location.

**NOTE:** You may have to logout of the system completely before this feature becomes available.

Each time the program is opened, choose the Load Data Set option, you will be prompted to choose the data set to login to.
Import

The Import feature allows files you to import data from other sources. These options help alleviate hours of manual entry.

Customer Import Wizard

The Customer Import Wizard allows you to import data from an outside source by defining a series of default fields that can be imported into RMA. Refer to the Customer Import Wizard document available on www.ARS247.com for further information.
Equipment

The Equipment import option allows you to import data from a pre-formatted spreadsheet into RMA. Refer to the Equipment Import document available on www.ARS247.com for further information.

Field:

Folder to import from: Select the folder to import the data from.

File to import: Select the file that should be imported.

Replace existing data: Check this box to replace any existing equipment that has the same serial number in RMA.
Bank Information Import (EF2000 Module)

The Bank Information Import option allows you to import bank transactions from a pre-formatted spreadsheet. Refer to the EF2000 User Guide for further information.

Import EDI

This is used with the Electronic Data Interchange module. Purchasers of this module will receive full separate documentation for this program. Contact Advantage Route Systems for further information.
The Export feature allows database files to be exported from RMA. Each option is discussed within this section.

**Export**

The Export option allows you to export any of the RMA database files in Excel and Comma Delimited format. This is helpful for creating your own reports outside of the program.

**NOTE:** The Technical Reference Guide available at [www.ARS247.com](http://www.ARS247.com) contains definitions for each database file in RMA.

**Fields:**

**Save As:** Enter the filename you would like to use after you have selected the desired database file in the list.

**Type:** Select the type of file that should be created when exporting data.

**Delimited With (Delimited Type Only):** Enter a character that will enclose each record within the exported file (quote marks are commonly used).

**Delimiter (Delimited Type Only):** Enter a character that will be used to separate each record within the exported file (commas are commonly used).
Sage Export (Germany)

RMA provides a special export designed to interface with the SAGE accounting program. Contact Advantage Route Systems for further information.

Italy Export

This is a specialty export program designed for market users in Italy. Contact Advantage Route Systems for further information.
Export E-Mail Addresses

This option allows you to export a complete ledger of customer email addresses that includes account numbers, names, and route information into a single spreadsheet file.

![Image of Export Email Addresses dialog box]
Maintaining Data Files

The following options help to maintain all of the data contained within RMA. Each utility should be executed periodically, and can be run at any time.

Rebuild Data Files

In order to maintain optimum performance from RMA, it is recommended that the Rebuild Data Files function is ran once per week. The rebuild process will delete temporary files and permanently remove records marked for deletion. This is a single user operation, and no other users can be in the system when you execute this process.

Rebuild Tables From X:\XXX\TABLES.ZIP: This option will optimize your data files by deleting temporary files and permanently removing records marked for deletion.

Rebuild History Files: This option will rebuild historical data tables.

NOTE: Rebuilding history files may take a fair amount of time. We recommend performing this function once per month.

Perform Data Integrity Check: This option will check your RMA data for errors and problems (this is not a single-user operation).

Rebuild ALL Data Sets: Select this box if you have more than one data set and you would like to rebuild all of them.

Fill Languages: This option updates entries in all custom language files.

Clear All Data From Log: This option will delete all entries in the log file used to record certain modifications made within Customer Information by your employees.

NOTE: The Log Customer Changes option can be enabled or disabled within Branch Setup, on the Logging tab.

Force Rebuild of ALL Tables: Select this option to rebuild all tables, even if there are no structure changes – this option is helpful for re-indexing tables and repairing memo files.
Pack

The Pack function permanently deletes all items marked for deletion within RMA (items with a red background).

**NOTE:** Performing a Rebuild Data Files will automatically ‘pack’ the files as well, but will take longer to perform.

Backup/Restore

The Backup/Restore function allows you to backup or restore your RMA data. It is important to routinely backup your data files on a daily basis.

**Backup Data Files**

Use the Backup Data Files function to create a backup copy of your RMA data. The backup location is established under File > Local Settings.

![Backup Data Files](image)
**Restore Data Files**

Use the *Restore Data Files* function to restore data from a previous backup file. If you have more than one backup copy, simply choose the desired file from the drop-down list — each file selected will display the date, time, and any comments entered to assist you in choosing the proper file.

During the restore process, you will be required to enter the approximate time the backup file was created, as displayed above: 10:45:46. You will also be asked to enter the reason for restoring the data. These additional requirements were added for security purposes, to ensure that you would like to proceed.

**NOTE:** Detailed restore information will be logged within the *Activity.log* file found under the *Data* folder of the RMA directory, for reference and security purposes.
Printing Reports and Exiting the System

Print

The *Print* option can be used to generate a list report for items currently displayed on the screen (this option is grayed out in some cases).

Print Setup

The *Print Setup* option allows you to establish default printing options within RMA that will be used for all printers established within *File > Local Settings*.

Logout

This function allows you to logout of RMA.

Exit and Logout

This function allows you to logout and exit the RMA program.
Chapter 6 – List Information

Overview

The Lists pad allows you to input and edit information used throughout the desktop and handheld.

<table>
<thead>
<tr>
<th>Customer Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Setup Codes</td>
</tr>
<tr>
<td>ZIP Codes</td>
</tr>
<tr>
<td>Geography Codes</td>
</tr>
<tr>
<td>Delivery Order Reasons</td>
</tr>
<tr>
<td>Product Codes</td>
</tr>
<tr>
<td>Accounting Setup</td>
</tr>
<tr>
<td>Equipment</td>
</tr>
<tr>
<td>Routes</td>
</tr>
<tr>
<td>Employee Setup</td>
</tr>
<tr>
<td>Truck Information</td>
</tr>
<tr>
<td>Custom Report Groups</td>
</tr>
<tr>
<td>Wizards</td>
</tr>
</tbody>
</table>

These topics are described individually within this chapter.
Customer Information

The most important information in the program is the customer data. This includes names, phone numbers, account balances, route information, and more. The Customer Information screens gather all of this information in a centralized location for easy lookup and reference.

**NOTE:** Before you can input your customers into RMA, certain codes and preliminary data must be set up. If you are unsure of what to do, refer to the Getting Started Guide.

### Information Tab

The Information tab contains billing information for each customer.

![Image of Customer Information screen]

**Fields:**

- **Account Number:** The customer’s six digit account number.
- **Home Branch:** The customer’s assigned company branch.
- **Customer Type:** The customer’s account type.

**Bill To:**

- **Name:** The customer’s billing name.
- **ZIP Code:** The customer’s ZIP or Postal Code. Each code will automatically populate the City and State fields on the screen.

- **MangoGeo:** Select this option to use the MangoGeo program for address verification and correction services.

**NOTE:** Try the MangoGeo program at no charge for fifteen addresses before being prompted to sign up for service. Additionally, you will automatically receive fifty additional usages by simply providing us with your contact information if you’re interested in the program.

- **Detail Button:** Select this option to select enter advanced address information associated with Lists > Geography Codes.
**Check Address:** Select this option to verify address information using the *Advanced Mapping Module*.

**NOTE:** The *Advanced Mapping Module* integrates with *Microsoft Mappoint* to provide address correction and route optimization options. Contact Advantage Route Systems for further information.

**Address:** Contains up to two billing address lines per account.

**Extra:** This field can be used to store additional identification information such as an old account.

**Legal Name:** Some countries require a long field for the legal name of the company. This will allow you to enter up to 80 bytes of text and is only used on custom forms.

**Note:** This information box is used to record permanent notes about the customer. These messages are only displayed on the screen and the customer will never see them.

**NOTE:** The *Note* field is not used to store contact history or delivery messages on the account. These types of messages will be covered on two additional tabs within *Customer Information*.

**Contact Info:**

**Phone:** The customer’s primary billing phone number. You can also include an extension if necessary.

**Fax:** The customer’s billing fax number.

**Work Phone:** The customer’s primary work number to contact for billing.

**Cell:** The customer’s mobile phone number to contact for billing.

**Contact:** The name of the person to contact for billing assistance with this account.

**Contact Phone:** The phone number for the contact person.

**E-mail:** The customer’s e-mail address.

**NOTE:** Multiple e-mail addresses can be entered if desired, in the following format: email1@domain.com;email2@domain.com (there should not be any spaces after each semicolon). Up to 50 characters can be used for all addresses in this field.

**Plain Text, HTML, and As attachment:** The format of the e-mail to send when contacting this customer.

**Sales Rep1, Rep2, and Rep3:** Displays up to three sales reps assigned to the customer’s account.

**Entered By (Read-Only):** Displays the ID of the user that added the account to the program.

**Major Account Code:** Displays the Major Account Code assigned to the customer. These accounts are generally considered top priority.

**Reset eStoreFront Password:** Select this option to clear the existing password and enter a new one for the customer on the eStoreFront site.

**NOTE:** This option is part of the *eStoreFront Module*, which allows your customers to manage their accounts, make payments, and schedule deliveries from your Web site. Contact ARS for further information.
**Disable eStoreFront Login:** Check this box to block access to eStoreFront on this account.

## Finance Tab

The Finance ($) tab contains information related to account balances, customer history, and finance charges.

**NOTE:** Depending on your computer’s regional settings, there may be a character other than a ‘$’ sign on this tab.

![Customer Information Screen](image)

**Balances:**

**Balance Forward:** The customer’s ending balance from the previous month.

**Aging Levels:** The aged balance on the customer’s account. These levels are established in Branch Setup, on the Accounting tab.

**Total Due:** The amount the customer owes on the account.

**Total Past Due:** The total amount considered past due (controlled by the assigned Credit Class).

**Highest Balance:** The highest balance reached on the account.
Totals:

[Invoice Lookup] View: Select the Invoice Lookup button to view all of the customer’s transactions and more.

<table>
<thead>
<tr>
<th>Monthly Invoice Listing</th>
<th>Open Invoices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice</td>
<td>Date</td>
</tr>
<tr>
<td>01/01/2009</td>
<td>10/10/2009</td>
</tr>
<tr>
<td>02/02/2009</td>
<td>11/11/2009</td>
</tr>
<tr>
<td>03/03/2009</td>
<td>12/12/2009</td>
</tr>
<tr>
<td>04/04/2009</td>
<td>01/01/2010</td>
</tr>
<tr>
<td>05/05/2009</td>
<td>02/02/2010</td>
</tr>
<tr>
<td>06/06/2009</td>
<td>03/03/2010</td>
</tr>
<tr>
<td>07/07/2009</td>
<td>04/04/2010</td>
</tr>
<tr>
<td>08/08/2009</td>
<td>05/05/2010</td>
</tr>
<tr>
<td>09/09/2009</td>
<td>06/06/2010</td>
</tr>
<tr>
<td>10/10/2009</td>
<td>07/07/2010</td>
</tr>
<tr>
<td>11/11/2009</td>
<td>08/08/2010</td>
</tr>
<tr>
<td>12/12/2009</td>
<td>09/09/2010</td>
</tr>
<tr>
<td>01/01/2010</td>
<td>10/10/2010</td>
</tr>
<tr>
<td>02/02/2010</td>
<td>11/11/2010</td>
</tr>
<tr>
<td>03/03/2010</td>
<td>12/12/2010</td>
</tr>
<tr>
<td>04/04/2010</td>
<td>01/01/2011</td>
</tr>
<tr>
<td>Totals</td>
<td>1</td>
</tr>
</tbody>
</table>

Button Descriptions:

YEAR: This button will access the previous year’s transactions.

YEAR: This button will access the next year’s transactions.

Select All Periods: Choose this button to select and every period (month) the customer has had activity.

BACK: This button will return to the previous screen.

NEXT: This button will proceed to the next screen.

Print: Choosing this button will print out a listing of all Open Items displayed on the screen (if applicable).

Account Activity

Select at least one period (month) by clicking on it. A checkmark will appear next to each period selected. Choose Next to view the Invoice Listing screen.
The Invoice Listing screen will display the items within the period(s) selected. All of the items will be listed in order by date.

### Button Descriptions:

**Print/E-mail Selected:** This option allows you to select multiple items on the screen (using ctrl+click method) for batch processing. After you have made your selection, you can either left-mouse-click to print the items, or right-mouse-click to e-mail them.

**Statement:** Choose the Stmt button to print a monthly statement for the account. Once selected, you will be prompted to choose the desired Statement Type and month to process.

**NOTE:** If you receive the message ‘Nothing Selected’ when choosing the Stmt button, highlight a single invoice on the screen and try again.

**Info:** Click this button to view a Payment Receipt after you have selected a payment. The Payment Receipt will display a ledger of all invoices the current payment was applied to.

---

**Payment Receipt**

Advantage Water Company  
546 South Bowers Ave  
Turlock, CA 95380

Paid by:  
Robert Jordan  
1173 Quail Ave  
Modesto, CA 95356

Payment Date 06/07/2009  
Check No. 1274  
Payment Amount 18.25

---

<table>
<thead>
<tr>
<th>Invoice</th>
<th>Invoice Date</th>
<th>Amount Paid</th>
<th>Prev. Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>10349</td>
<td>05/10/2008</td>
<td>57.50</td>
<td>144.31</td>
</tr>
<tr>
<td>10352</td>
<td>11/10/2008</td>
<td>20.75</td>
<td>144.31</td>
</tr>
</tbody>
</table>

Acct. No. 100000
Fax (Requires AF2000 Module): Clicking this button will send the selected items to the fax printer.

NOTE: You can also fax information to each customer by selecting an installed fax printer after choosing the Print/E-mail Selected option discussed earlier. This does not require the AF2000 Module.

E-mail: Select a single item listed on the screen and click this button to E-mail the item to the customer. Alternatively, you can process all of the displayed items to the customer by right clicking on the E-mail button.

NOTE: In order to use the E-mail functions within RMA, you will need to set up a few additional items first. For more information on this feature, refer to Chapter 2.12 of the Supplemental Guide.

Print: Choose this button to print a Customer Invoice Ledger listing all activity displayed on the screen.

Viewing Invoices

Double-click on any item on the screen to view it. When previewing invoices, any captured signatures are displayed with the item.

NOTE: Invoices can be converted to a full page by choosing the 'Use 8 1/2 X 11 Invoice format' option within File > Local Settings.
Right-clicking on an invoice will automatically preview all of the invoices displayed on the screen; generally, two per page when using the handheld format.

Totals, continued...

**Fields:**

**Sales:** The *Sales* field is updated each time an invoice is posted and contains month-to-date and year-to-date sales totals.

**Profit:** The *Profit* field displays month-to-date and year-to-date profit totals stemming from total sales.

**NOTE:** In order to view accurate *Profit* totals, you will need to establish a price and cost for each product being sold.

**Invoices:** The *Invoices* field displays the number of invoices sold to the customer for the month and year.
Finance Charges:

**J F M A M J J A S O N D:** This field displays the months of the year, indicated by letter. Each month that the customer receives a late charge will automatically be selected.

**Times Late:** The total number of Late Charges billed to the customer.

**Y-T-D:** The customer’s year-to-date late charge accumulation.

**Last Date:** The last date the customer received a late charge.

History:

**Last Transaction:** The date of the customer’s last sale.

**NOTE:** The Last Transaction date does not include payments, late fees, or no-sale deliveries.

**Last Payment:** The date of the last posted payment on the account.

**Last Pay Amount:** The last posted payment amount on the account.

**Last Check Number:** The last check number posted on the account.

**Last Statement:** The date that the last statement was processed on the account.

**Account Deposit:** Contains any initial deposit amounts being retained on the account for equipment, etc.

**NOTE:** This field will automatically be updated if you have selected the ‘Update Account Deposit’ option within the Product Charge Codes screen, on the Info tab. This type of deposit is not generally used for containers.

Returned Checks:

**Number:** The check number of the last returned check on the account.

**Date:** The date of the last returned check.

**Amount:** The amount of the last returned check.

**Returned Check:** This box is automatically checked when a returned check is processed on the account.

**Paid:** This box is automatically checked when the returned check has been resolved by the customer.

**NOTE:** The options above are automatically updated as checks are processed using the Returned Check Processing option found under the Payments menu.
Credit Tab

The Credit tab contains various settings for each customer that includes Start Reasons, Statement Codes, Credit Classes, etc. Most of the items found on this screen are set up under the ‘Lists’ menu within RMA.

NOTE: Refer to the Getting Started Guide for further assistance on each of the required ‘Lists’ menu items.

The Credit tab graphic below is divided into a top and a lower half. The fields displayed in the top half are obtained by pressing the buttons in the lower half of the screen. To make it easier to view all of the data presented on the Credit tab, there are several boxes located in the lower right and lower left corners of the screen that control the displayed fields in the top section of the screen.

Status/Contract Tab:

Click on the Status/Contract tab shown below to view the following fields.

Fields:

Account Status Code: These codes are used as additional customer filters. They can also be used to change the customer’s Statement and Credit Class upon status change. Common codes are Active, Pending Setup, and Inactive.

Service Priority Code: To prioritize service for your customers, you can set up a list of codes that designate service level priorities. Each code can be configured to control follow-up priorities.

Entered Date: Displays the date that the customer was entered into the program.

Start Date: Displays the date that the customer will start service with your company.

Start Reason Group: This option is used to classify the source of a lead. The group works as a filter for the Start Reason field below.

Start Reason: The reason this customer began service with your company.
**Customer Promotions Code:** This option is used for promotions that can be offered to customers for signing up for service with your company.

**NOTE:** Optionally, any products included in a promotion can be added to each Customer **Promotions Code** under **Lists > Customer Setup Codes**. As the **Promotion Code** is selected within the **New Customer W/ Order Wizard**, any products associated with the promotion will automatically be added to the customer’s **First Order**.

**First Delivery Date:** The date of the first delivery scheduled for the customer (read only).

**End Date:** The date that the customer will terminate service with your company. The customer will be flagged as ‘Inactive’ when this date is populated.

**End Reason:** The reason the customer is terminating service.

**Request Cancel Acct:** This date field can be used to establish a future date that the customer would like to terminate service. Once this date is reached, the **End Date** will need to be populated manually. Use the **Request Cancel Date Report** to generate a list of customers that are cancelling service, found under **Reports > Management Reports**.

**Suspend Date:** This date field can be used as the starting date to temporarily suspend a customer from receiving deliveries on route.

**Suspend Reason:** Allows you to select the reason the customer’s service is being suspended.

**End Suspend Date:** Enter the ending date for suspending a customer from route. The customer’s deliveries will automatically resume after this date.

**Clear:** Clears all suspend information populated in the previous three fields.

**Contract Expiration Date:** If you have a contract with this customer, enter the date when the contract expires.

**Contracts**

RMA includes contract options that will allow you to create, edit, and manage contract information on your customer’s accounts. This feature is commonly used for equipment, but can be used in a number of different ways (click **Modify** to activate this screen).

**NOTE:** For detailed information on contract setup and usage, refer to **Chapter 4.08** of the **Supplemental Guide**.
**Billing/Statement Tab:**

Click on the **Billing/Statement** tab shown below to view the following fields.

![Customer Information](image)

**Fields:**

**Price Level:** This option allows you to choose one of ten different levels of pricing that the customer can be assigned to. Each **Price Level** is established globally within **Lists > Product Charge Codes**, on the **Pricing** tab.

**NOTE:** For further information on all of the pricing options within RMA, refer to Chapter 2.01 of the Supplemental Guide.

**Open Invoice:** Check this box if you would like to apply payments directly to the customer’s open invoices from within the payment screen. If this option is not selected, the customer’s invoices will not be itemized within the payment screen (**Balance Forward**) and each payment will be applied to the total amount due on the account.

**Promotional Price Group:** This option is part of the **Buy/Gets Module**, which allows customers to redeem free products or promotional items for purchases made. Please contact ARS for further information.

**Rent Calendar:** Choose the **Rent Calendar** that the customer’s installed equipment should be assigned to. The **Rent Calendar** is set up under **File > Branch Setup > Equipment**.

**NOTE:** For further information on equipment rent, refer to Chapter 3.11 of the Supplemental Guide.

**Statement Billed Rent:** Check this box if all rentals will be billed on the desktop for this customer.

**Statement:** This option is used for processing a financial statement for the customer. Statements are generally run once per month, and there are many different options and types available. They can be set up under **Lists > Customer Setup Codes > Statement Codes**.

**2nd Statement:** This option allows you to assign the customer to more than one statement type (i.e., one e-mailed and one mailed).
**Rent Invoice:** Select this option if you would like to print a copy of the customer’s rental invoice when generating a statement on their account. The customer will need to be assigned to a statement with invoice copies in order for this option to function properly.

**NOTE:** Selecting this option will **only** print rental invoices for the customer in addition to the statement. All other invoice copies will be suppressed. Generally, customers with the Rent Invoice option selected are assigned to their own statement type.

**EDI Code:** This is part of the optional EDI Module. Contact Advantage Route Systems for further information.

**Period Discount Code:** This unique pricing option allows you to set up discounts or free items for customers that purchase an established quantity of items over a period of time.

**NOTE:** For further information on Period Discount Pricing, refer to Chapter 2.15 of the Supplemental Guide.

**Master Bill:** Enter a ‘master’ account number here to link two accounts together, and automatically forward all transactions to the master account. The master account will carry all of the balances for each sub account.

**NOTE:** Binoculars will appear next to the Master Bill field when the accounts are linked. When you are viewing the master account, click on the binoculars to view a list of all of the associated sub accounts. When you are on a sub account, choose the binoculars to immediately jump to the master account.

**Consolidated Stmt:** Select this option to link two or more accounts together. Each account will retain all of its balance and transaction data; but a statement will only be processed from the master account, which will include all of the sub account details.

**NOTE:** All accounts linked using the Consolidated Statement option will be forced to use the same Statement Code.

**Master Bill Acct No:** The account number used for Master Bill or Consolidated Stmt.

**Use Bill to Address from Sub Account:** This option is only used with a custom statement created by ARS.

**Refund Check Code:** This option allows you to select a code that determines how refunds are handheld on the account. Refer to the Refund Check Setup section found in Chapter 6 for further information.

**Statement Message:** This option allows you to enter a custom message that will only appear on this customer’s statement.
**Reward Points Tab:**

Click on the *Reward Points* tab to view the following fields.

The *Reward Points* option allows customers to earn ‘points’ that will be used towards future purchases or bonus items. For detailed set up and usage instructions on this feature, refer to *Chapter 4.04* of the *Supplemental Guide*.

**Credit Terms Tab:**

Click on the *Credit Terms* tab shown below to view the following fields.

**Fields:**

*Credit Class:* This option is used to control credit options on the account. Each *Credit Class* controls many options on the account, including past due and hold service status.

*Late Charge:* This option determines when a customer will receive a late charge on their account.

*Administrative Charge:* This option is used to assess a fee on accounts that require extra handling time due to a high volume of purchases.

**NOTE:** To set up the items above, browse to *Lists > Customer Setup Codes*.

*Credit Limit:* A credit limit can be placed on each individual account if desired. This information can be used to prevent sales or force payments during delivery. If you leave the amount at 0.00, the account will have unlimited credit.
**Credit Rating:** Enter the customer’s credit rating (for reference only).

**Statement Assessment:** This option allows you to add an extra charge to a customer’s statement.

**NOTE:** *Statement Assessment Codes* can be created under *Lists > Accounting Setup.*

### Contact:

Choose this option to store contact information for ‘credit’ related inquiries.

![Credit Contact Information](image)

- **Contact:** The name of the person to contact.
- **Phone:** The primary phone number to use.
- **Alternate Phone:** A secondary phone number.
- **Ext:** The phone number extension to dial.
- **Fax:** The fax number to use.
- **E-mail:** The customer’s e-mail address.

**Use Customer Level PO:** Select this option to enter a Purchase Order that will always be used on the account. This will override any P.O. information entered on the Route tab of the account.

**NOTE:** This option will not be available if ‘Use Multiple Purchase Orders’ is selected within *File > Branch Setup > Customers.*
**Purchase Order:**

Select this option to enter the *Customer Level* P.O. details.

**Purchase Order:** The Purchase Order to use on the account.

**P.O. Exp. Date:** Enter the date the current P.O. will expire.

**Available:** This field is updated automatically when a *P.O. Limit* is established.

**P.O. Limit:** Enter the maximum amount of the purchase order.

**Release Code:** Selecting this option will generate a code that can be entered on the driver’s handheld to authorize a new invoice for customer’s that are past due, over their credit limit, or placed on hold service.

**NOTE:** Each Release Code option can be defined within Lists > Routes > Handheld Class, on the Finance tab.

**Price Release:** When a driver is not authorized to change a price on the handheld, a code can be given from the office that will authorize the override. By pressing this button, a code will be generated that can be given to the driver to make a price change.

**NOTE:** Optionally, if ‘Add Release Code/Price Override to Contact History’ is selected within File > Branch Setup > Handheld, you will be required to enter further details regarding each release code. This information will be logged within the customer’s Contacts tab for reference.

**Hold Service:** This option allows you to manually place a customer’s account on hold. This setting will override the assigned Credit Class.

**Release Until:** Entering a date here will release a customer from hold service status temporarily, until the date is surpassed.

**Credit Controller:** Assign an employee to the account that will manage credit or past due inquiries.

**Credit Terms:** Choose the terms that you would like to assign to this account.

**NOTE:** Credit Terms can be established under Lists > Customer Setup Codes.

**Preferred Payment:** Choose the default payment method this customer will generally use (speeds up payment entry).
**Payment Note:** A note entered here will be displayed when a new payment is added for this customer.

**Preferred Bank:** Enter the default bank account that this account’s payments will be posted to.

**Business License:** Enter a business license if desired.

**SS Number:** Enter the customer’s social security number if desired.

**Additional Flags Tab:**

Each data field under the Additional Flags option is customizable and can be used to store the data of your choice.

Refer to Chapter 1.04 of the Supplemental Guide for further information on using these fields.
Credit Card Tab (EF2000 Module):

The Credit Card button allows you to store credit card details on the customer’s account. This information will be used to process transactions through a third party vendor.

NOTE: The Credit Card option is part of the Electronic Funds Module. Contact Advantage Route Systems for further information and alternate training material.

Fields:

Cardholder Name: Enter the name displayed on the credit card.

Cardholder Last Name: Enter the last displayed on the credit card.

Individual or Business: If this card is part of a business account, select Business and enter a Company Name.

Cardholder Address: Enter the cardholder’s address.

Cardholder ZIP Code: Enter the cardholder’s ZIP code.

Phone Number: Enter the cardholder’s phone number if desired.

E-mail Address: Enter the cardholder’s e-mail address if desired.

Credit Card Number: Enter the number of the cardholder’s credit card.

Expiration Date: Enter the expiration date of the credit card.

Card Type: Choose the credit card type.

Vault ID: Used to identify the customer’s credit card when processing transactions.

Vault Pay ID: Used to identify the customer’s payment method on file.

Last Bill Date: The date the last time the card was billed.

Last Bill Amount: The amount of the last credit card charge.

Last Bill Status: The status of the customer’s last billing.

Customer Notified: Enter the date the customer was notified of their status.

Don’t Bill: This option prevents this card from being billed during credit card processing.
**Signature on File:** Check the box if you have a hard copy of the customer’s signature in your office — some credit card processing systems require you to have a signature on file in order to process payments.

**Credit Note:** Enter a note that relates to the credit card, used for reference only.

**NOTE:** When the Signature on File box is checked, the credit card flag will turn green. By default, the flag will be red.

**Bill:**

**Bill One Time Only On:** Enter the date to bill the customer one time only using the credit card on file.

**Amount:** Enter the amount to bill the customer, or simply leave it blank to bill the customer for their total amount due when the transaction is processed.

**Document ID:** Enter any unique identification code required, if applicable.

**Monthly:** Select this option to bill the customer each month using the credit card on file.

**By Group:** Select this option if you would like to assign the current credit card to a Credit Card Group. This option allows you to bill credit cards in different batches throughout the month.

**NOTE:** Credit Card Groups can be set up under Lists > Accounting Setup.

**Charge Now:** Select this option to process a credit card payment immediately; you will be prompted to enter the payment amount.

**Bank Information (EF2000 Module):**

This optional module allows each customer’s bank information to be saved and billed on the customer’s account.

**Fields:**

**Bank Name:** Enter the name of the customer’s bank.

**Bank Address:** Enter the address of the bank.
Routing Information: Enter the routing code or information needed to access this customer’s account.

Don’t Bill: This option prevents this account from being billed during bank processing.

Account Name: Enter the name on the bank account.

Account Number: Enter the customer’s account number.

Last Bill Date: Enter the date of the last billing.

Key: This is used in Europe for special banking requirements and is part of the export file.

Amount: Enter the amount of the last billing.

Status: The status of the account.

Customer Notified: Enter the date the customer was notified of their account status.

Bank Note: A comment option used in rare cases, not critical to processing.

Branch: Enter the branch number of the bank.

Authorization Expiration Date: Enter the expiration date of this information.

Maximum Amount Authorized: Enter the maximum amount to bill.

Amount Used: Enter the amount billed so far.

Bill:

One Time Only On: If this account is being billed once, then enter the date and amount to be billed.

Amount: Enter the amount.

Document ID: A unique identifying number.

Every Month End: If you want to bill this account at the end of every month, click this box.

Charge Now: Select this option to automatically process a payment on the customer’s account.

Coupon Info Tab: Contact Advantage Route Systems for further information on using coupons in RMA.
Contacts Tab

The Contacts tab contains logged messages and order history on the customer’s account. It provides a useful log of events that have occurred with the customer. Some information is logged manually, while others are automatic.

NOTE: The automatic events can be defined under Branch Setup, on the Defaults tab.

Fields:

- **Add**: This button will allow you to create a new Contact Reason on the account. This will allow you to record any number of reasons why the customer was contacted, enter specific details, and schedule a follow-up if necessary.
- **Delete**: This button will delete any selected records on the screen.
- **Modify**: This button will allow you to edit any currently selected records.
- **Playback Message (RV2000 Module)**: This button will allow you to listen to voice messages left by the customer.
- **Handheld Notes Button**: Click this button to view any handheld notes associated with the selected entry on the screen.

NOTE: Notes entered on the handheld can be automatically stored on the Contacts tab by selecting the Handheld Notes option under File > Branch Setup > Defaults tab.

- **View Message**: Clicking this button will display any notes associated with the selected entry on the screen.
- **View Delivery Order Button**: Select a Delivery Order on the screen and choose this button to preview the order on the screen.
Other Fields:

Contact Message Filter: These boxes allow you to view only the types of messages you are interested in. Each message logged on the Contacts tab will be assigned to one of the listed filters. These filters can be set up under Lists > Customer Setup Codes > Contact Message Groups.

NOTE: You can configure Employee Groups (found under Lists > Employees) to control the default Contact Message Groups selected per employee.

View Files Button (EF2000 Module): This button allows you to view scanned documents and agreements on the account.

Pictures: Choose this option to view any photos that have been taken by your driver’s pertaining to this account. This is helpful for logging equipment issues on site.

NOTE: A camera equipped handheld is required to use this feature. ‘Local Settings > Directories’ and ‘Handheld Class > Hardware’ will need to be configured in order to take photos on route.

Creating Message Screen:

The following screen is displayed when the Add option is selected.

Fields:

Spoke with: The name of the customer you are contacting.

Date: The current date.

Time: The current time.

Created By: The employee that contacted the customer.

Follow Up: The date the customer should be contacted again for follow-up.

NOTE: Leave the date defaulted to the current date if no follow-up is necessary.

Follow Up by: The employee who will follow-up with the customer.

Contact Reason: Choose a ‘reason’ for the type of message. This list can be established under Lists > Customer Setup Codes > Contact Message Reasons.
**Show message on payment entry:** Select this option if you would like the current message to pop-up when entering a payment on the account.

**Message:** Enter the message details here.

**Completed:** Check this box if no further follow-up is necessary.

**Completed Date:** The date the customer’s request is completed.

**Ungrouped Reasons:** Select this option to display all contact messages that have not been assigned a Contact Reason.

**Select All:** Select this option to display all of the contact messages assigned to the account.

## Route Tab

The Route tab contains all of the customer’s routing information. Each account can have up to 99 stops on the Route tab. A record will exist for each stop that will include all of the required routing information. All of the options are defined below.

![Route Tab Image](image.png)

### Fields:

**Delivery Name/Address:** Enter the delivery name of the customer receiving the delivery.

**ZIP Code:** Select the delivery ZIP code from the drop-down list.

- **Copy to:** Choosing this button will populate the ZIP code and delivery address fields with the information entered on the Info tab.

- **MangoGeo:** Select this option to use the MangoGeo program for address verification and correction services.

**NOTE:** Try the MangoGeo program at no charge for fifteen addresses before being prompted to sign up for service. Additionally, you will automatically receive fifty additional usages by simply provided us with your contact information if you’re interested in the program.

**Detail Button:** Select this option to select enter advanced address information associated with Lists > Geography Codes.
**Check Address**: Select this option to verify address information using the Advanced Mapping Module.

**NOTE**: The Advanced Mapping Module integrates with Microsoft Mappoint to provide address correction and route optimization options. Contact Advantage Route Systems for further information.

**Delivery Address**: Contains up to two delivery address lines per account.

**Delivery Contact Info**:

**Delivery Phone**: The customer’s primary delivery phone number. You can also include an extension if necessary.

**Fax**: The customer’s delivery fax number.

**Delivery Work Phone**: The customer’s primary work number to contact for deliveries.

**Cell**: The customer’s mobile phone number to contact for deliveries.

**Contact**: The name of the person to contact for deliveries.

**Contact Phone**: The phone number for the contact person.

**E-mail**: The customer’s e-mail address.

**Contact Via (Route Pre-Sale)**: The method of contact that should be used.

**Frequency (Route Pre-Sale)**: The frequency that the customer should be contacted.

**Other Delivery Name/Address Fields**:

**Send Message**: This option can be used to send a message to the driver assigned to the customer’s route.

To: support@Advantagedemo.com

Cc: 

- Incl. Operator Name
- Incl. Operator Phone
- Call office first

Text Message

Send text message. Character count = 70

**To**: The recipients e-mail address.

**NOTE**: You can establish an e-mail address within each driver’s Employee Setup screen to automatically populate the address within this screen.

**Cc**: Enter an address to send a copy of the message to, if desired.

**Incl. Operator Name**: Select this option to include the name of the employee sending the message.
**Incl. Operator Phone:** Select this option to include the phone number of the employee.

**Call office first:** Select this option if the driver should call the office prior to acting on any instructions in the message.

**Inactive Route Stop:** Select this option to inactivate the current route stop. This is especially useful with multiple stop accounts.

**Exact:** Select this option to only allow the current stop to be scheduled on the “exact” Day Label assigned within the deliver calendar when managing routes within the RDM screen.

**NOTE:** If the stop is assigned to Day Label ‘W01’ within the delivery calendar, then the stop can only be assigned to available ‘W01’ labels within the RDM screen when the Exact option is selected.

**Will Call:** Check this box to prevent the current stop from showing up on route, even if a delivery schedule has been established. The stop will only show up on route when either a Delivery Order or Route Pre-Sale has been created.

**Stop Navigation:** These options allow you to navigate through each stop on a multiple stop account. A stop number identifies each stop. Click on the arrows pointing to the right or left to scroll through each stop, or choose the binoculars to manually select the desired stop.

**Driver:** This field displays the name of the driver that is associated with the route assigned to the current stop.

**Route:** The route assigned to the current stop.

**Sequence:** The sequence number assigned to the next delivery date.

**Next Delivery:** The next scheduled delivery date for the customer.

**Last Delivery:** The last delivery date for the customer.

**Generate Lat/Long (Internet Required):** Select the ‘globe’ to populate the Latitude and Longitude fields — based on the customer’s delivery address.

**Latitude and Longitude:** The coordinates of the customer’s delivery address.

**NOTE:** This information is used with MangoGeo, TomTom, and the Advanced Mapping Module.

**Map Page:** This field can be used to reference a page number when using a map book (e.g., Thomas Guide) on route. The reference information is displayed within the Driver Instructions field on the handheld.

**Key No.:** This field can be used to store a key code, and is displayed within the Driver Instructions field on the handheld.

**Sales Tax:** The customer’s assigned Sales Tax Code. The rates listed are established under Lists > Accounting Setup > Sales Tax Rates.

**Asset Tax:** The customer’s assigned Asset Tax Code. This code will be used for personal property taxes on installed equipment.

**NOTE:** For further information on asset tax in RMA, refer to Chapter 3.18 of the Supplemental Guide.

**Stop Type:** A Stop Type can be assigned to each account and used as an identifier on certain reports in RMA.
NOTE: Stop Type Codes can be created under Lists > Routes.
**Messages:**

The *Messages* feature allows you to enter messages that can be viewed by your drivers on the handheld. These messages may include special instructions while on-site, or notes on how to get to a location.

**Fields:**

*Alert Message:* Enter a message here that you would like to popup automatically each time the driver accesses the customer on the handheld.

*One Time Message:* This message is similar to the alert message, except it will only appear on the handheld for the period of time defined in the *Begin* and *End* date fields to the right of the message.

*Begin and End:* These date fields control the duration of time the *One-Time Message* above will be displayed on the handheld.

*Time Band:* This option can be used to specify the approximate hours the company operates daily. Multiple time bands can be enabled under *File > Branch Setup*, on the *Handheld* tab.

*Open Hours:* A simpler version of the *Time Band* option above, enter the stop’s hours of operation for driver reference during delivery.

*Driver Directions:* This message can be used to give the driver simple driving instructions to the stop.

*Site Instructions:* This message can be used to provide the driver with delivery instructions while on-site.

*Invoice Messages:* This message can be used to print additional information on the customer’s receipt with each delivery.
**Route Calendar:**

Use the *Route Calendar* to set up your customer’s delivery days. To schedule the customer, each stop will be assigned to a *Day Label* on the calendar. The steps are covered after the field definitions below.

### Fields:

- **Acct Number:** This field displays the customer’s account number.
- **Route:** This field displays the route assigned to this stop.
- **Schedule by Day Label:** Select this option to assign the customer to a *Day Label*.

**NOTE:** Each stop may be assigned to more than one *Day Label* if necessary.

- **Clear All:** Choose this option to clear the stop’s current route schedule.
- **Color-Coded boxes:** The boxes below the calendar are color coded to help you quickly identify each type of stop on the calendar.
  - **Red** – Automated schedules. This appears when you use a repeating schedule.
  - **Violet** – Skip this regularly scheduled stop until the next delivery. This is typically due to a customer request when calling.
  - **Green** – A stop that was “dragged” from a previous day.
  - **Yellow** – A *Delivery Order* has been scheduled on this day.
  - **Aqua** – Special – RDEX Skip.
  - **Orange** – Manual Special / Forward Sales / Re-sequence.
**Scheduling a Customer:**

After choosing the *Schedule by Day Label* button, the following message will appear:

![Image of message]

Select the date of the first delivery for the customer and a screen similar to the following will be displayed:

![Image of selection screen]

Click **OK** to the message and now you will be prompted to select a *Day Label Code*.

Select Day...

Which day do you want to schedule by?

- B01
- B02
- B03
- B04

Make your selection and click **OK** to continue.

Each stop will need to be ‘sequenced’ into the route based on delivery location. Enter the appropriate *Sequence Number*, or leave it blank for the driver to sequence the stop manually on the handheld.

![Image of stop sequence]

Click **OK** to complete the process.

**NOTE:** Each sequence number is always four digits in length (e.g., 0010, 1050).

Once you have successfully routed the stop, each delivery day will be colored red on the calendar.
**Manually Skipping a Delivery:**

To manually skip a customer’s delivery on the calendar, click on any of the scheduled deliveries on the calendar.

**Manually Scheduling a Special:**

Special deliveries are generally created using the *Deliver Order* option, which allows you to assign products and enter detailed information on the order. Alternatively, a special delivery can be created by simply right-clicking on a day without a delivery already scheduled.

**NOTE:** This method only allows you to schedule a delivery on the customer’s current route, and product orders cannot be assigned to the order — use the *Delivery Order* option for further flexibility when scheduling special deliveries.

**NOTE:** For further information on *Day Label Codes* and route scheduling, refer to the *Getting Started Guide.*
**Route Options Menu:**

In this section, you can select from eight different options.

<table>
<thead>
<tr>
<th>Handheld Options</th>
<th>PreCalling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order</td>
<td>Water Analysis</td>
</tr>
<tr>
<td>Site Stats</td>
<td>Industry</td>
</tr>
<tr>
<td>Service Schedule</td>
<td>Other</td>
</tr>
</tbody>
</table>

### Handheld Options:

- **Signature Required:** Select this option if you would like to capture a signature from this customer with each delivery.
- **Remittance Stub:** Check this box to print a remittance stub with the printed handheld invoice.
- **Suppress Prices on Invoice:** Select this option to suppress all product prices on the printed handheld receipt.
- **Suppress Totals on Invoice:** Select this option to suppress all product price totals on the printed handheld receipt.
- **Suppress Balance:** Check this box to prevent the account balance from appearing on your customer’s printed handheld receipt.
- **Use Alternate Invoice Label:** Select this option to replace the standard Invoice Label with the Alternate Invoice Label found under Lists > Routes > Handheld Class, on the Labels tab.
- **Display Unit Reference on Invoice:** Select this option to use the unit Product Reference Label — under Product Charge Codes, on the Info tab — and the Base Qty (Pricing tab) as the product reference on each invoice.
- **Group Area Code:** This option allows you to separate customers by groups within the Off-Route List of the handheld. The codes can be set up under Lists > Routes > Group Area Codes.

### Fields:

- **Signature Required:** Select this option if you would like to capture a signature from this customer with each delivery.

- **Remittance Stub:** Check this box to print a remittance stub with the printed handheld invoice.

- **Suppress Prices on Invoice:** Select this option to suppress all product prices on the printed handheld receipt.

- **Suppress Totals on Invoice:** Select this option to suppress all product price totals on the printed handheld receipt.

- **Suppress Balance:** Check this box to prevent the account balance from appearing on your customer’s printed handheld receipt.

- **Use Alternate Invoice Label:** Select this option to replace the standard Invoice Label with the Alternate Invoice Label found under Lists > Routes > Handheld Class, on the Labels tab.

- **Display Unit Reference on Invoice:** Select this option to use the unit Product Reference Label — under Product Charge Codes, on the Info tab — and the Base Qty (Pricing tab) as the product reference on each invoice.

- **Group Area Code:** This option allows you to separate customers by groups within the Off-Route List of the handheld. The codes can be set up under Lists > Routes > Group Area Codes.

**NOTE:** This feature is enabled by choosing Filter Types 5 or 6 within Lists > Routes > Handheld Class, on the Off-Route tab.
**Invoice Copies:** Enter the number of invoice copies you would like to print for the customer with each delivery (0-9).

**NOTE:** If ‘9’ is entered, a ‘delivery ticket’ will be printed, which suppresses all pricing details on the receipt.

**Dynamic Header Code:** Dynamic Header Codes allow you to use alternate company headers on handheld invoices for each customer, and can be found under Lists > Customer Setup Codes. This is an alternative to the standard company header found under the Handheld Class screen.

**Deliv. Time:** Select the customer’s preferred delivery time: AM or PM.

**NOTE:** Customers can be sorted by delivery time on the handheld by selecting the ‘Allow Route List Filtering by Delivery Time’ option under Lists > Customer Information > Routes > Handheld Class, on the Screen tab.

**PreCalling:**

The following fields contain settings for the Route Pre-Sale feature and the optional RV2000 Module.

**Fields:**

**Don’t Call (RV2000):** Check this box if you are using the RV2000 Module and the current customer should not receive calls.

**Don’t Call (Presale):** Check this box if you are using the Route Pre-Sale feature and the customer should not be contacted.

**Start / End Time:** Select the time range that the customer would like to receive a call when using RV2000 or Route Pre-Sale.

**Language:** Select the language required when contacting this customer.

**Phone Number to Call:** Enter the phone number to use when pre-calling this customer.

**Route Caller:** Select an employee in charge of pre-calling the customer (employee must be type: Route Caller).

**NOTE:** The following options are part of the Advanced Pre-Calling option in RMA. Refer to Chapter 3.23 of the Supplemental Guide for further information.

**Call Freq:** Select the Pre-Call Calendar code to assign to the customer.

**Weeks:** Select the number of weeks that you would like to the customer to receive a pre-call.
**Last Called:** Displays the last date that the customer received a pre-call.

**Next Call:** Displays the next pre-call scheduled on the account.

## Purchase Order:

The *Purchase Order* option allows you to establish up to three standing P.O.’s on the customer’s account at one time. Each P.O. can be set up with an expiration date or credit limit as well.

**NOTE:** You have the option of using a single or multiple P.O. system in RMA. Multiple P.O.’s can be enabled/disabled by selecting the ‘Use Multiple Purchase Orders’ option under *File > Branch Setup > Customer* tab.

![Purchase Order interface](image)

### Fields:

**Require PO Entry on Invoicing:** Select this option to require a Purchase Order entry on all desktop and handheld invoices (excludes *Skip Remaining Stops* on the handheld).

**Purchase Order (up to 3):** Enter a purchase order up to 30 characters on the account.

**P.O. Exp. Date:** If you would like this P.O. to expire, enter an expiration date.

**NOTE:** A report can be run periodically that will list all of the expired, or about to expire, P.O. numbers. This report can be generated under *Reports > Management Reports > Expired Purchase Orders*.

**Product Class (Multiple P.O. Only):** This option allows you to choose a specific Product Class that this P.O. will apply to. Products from other classes will not be assigned this P.O.

**NOTE:** If the Product Class field is empty, all products will apply to the P.O. as normal.

**Available:** This field is automatically updated when an amount has been entered within the *P.O. Limit* field below.

**P.O. Limit:** Enter the maximum amount that can be billed under the current P.O.

**Note:** Available for additional text.
**Water Analysis:**

The *Water Analysis* option allows you to enter chemical and foreign material readings collected at each customer’s location.

![Water Analysis Table]

- **Number Of Occupants:** The number of residents in the dwelling or using water from the well or other point source.

- **Regeneration Cycle:** Water treatment equipment such as water softeners need to be regenerated. Enter the number of days or gallons to circulate between cycles.
  - **Gals:** The number of gallons of water circulated through the chemical bed of the water softener between re-generation cycles.
  - **Days:** The number of days that water is circulated through the chemical bed of the water softener between re-generation cycles.

- **Hardness:** A measure of the calcium and magnesium salts in the water. Hardness is often measured in grains per gallon of water.
- **Iron:** Amount of Iron in mg/L.
- **Nitrates:** Amount of Nitrates in parts per million.
- **Manganese:** Amount of Manganese in milligrams/Liter (mg/L.)
- **pH:** pH value of the water. This is a number between 6 and 8.
- **Alkalinity:** Amount of sodium present in mg/L.
- **Tannins:** Amount of Tannins in water. Units of measurement vary.
- **Hyd. Sulfate:** Amount of Hydrogen Sulfate in water.
- **Chloride:** Amount of Chloride in mg/L.
- **TDS:** Amount of Total Dissolved Solids in mg/L.
- **Turbidity:** Measurement of the cloudiness in water.
- **Iron Bacteria:** Amount of Iron Bacteria in water.
- **Other:** This may include: Oxygen, organic carbon, ammonia nitrogen, phosphorus, fluoride, aluminum, barium, cadmium, chromium, lead, zinc, fecal coli-forms, etc.
Site Stats:

*Site Stats* allow you to enter specific data regarding well depths and tank settings on-site.

### Fields:

- **Test Date:** Date the water sample(s) were obtained.
- **Test Location:** Enter a description for the location.
- **Water Source:** This may be a well, spring, stream, impounded water, Artesian well, cistern, etc.
- **Well Depth:** The normal depth to water if a well is the water source.
- **Pressure Tank Settings: In/Out:** This is the pressure in pound per square inch (PSI) in the water supply tank. The pump may start operating at a Cut In pressure around 20 PSI and turn off or Cut Out at about 40 PSI. These settings vary depending on the location of the pressure tank with respect to plumbing fixtures.
- **GPM:** This is normally the pumping rate in gallons per minute at a pressure rating of 40 PSI. This is the flow rate to the pressure tank.
- **EWU:** Estimated water use (or usage). This is gallons or liters per day.

**NOTE:** The above information is collected by the driver or sales representative to analyze a customer’s needs.
**Industry:**

This section contains miscellaneous options and additional fields that can be defined for your own usage.

![Image of Industry Options]

**Fields:**

*Tax Exempt:* Check this box if the customer is exempt from paying sales tax. Additionally, you will be able to enter the customer’s exempt tax code for reference.

*Net Transactions for Refund:* Selecting this option will refund any balance on the customer’s account if the Net Invoices option is selected while processing refund checks within Transactions > Payments > Print Refund Checks.

*Static Delivery:* Used with the RDEX Module (Route Scheduling).

*Use Alternate G/L No.:* Select this option to post all product sales this account to the Alternate G/L account assigned within the Product Charge Codes screen.

**NOTE:** If the option above is selected and a product posted to the account is not assigned an Alternate G/L, the standard G/L account assigned to the product will be used.

*Cylinder Exch (Propane Industry):* Switches the account to handheld cylinder exchanges on the handheld.

*Check 1-4:* These fields can be renamed and used for options of your choice.

*Text 1-4:* These fields can be renamed and used for options of your choice.

*Export Reference:* Not currently in use.

**NOTE:** For further information on renaming fields in RMA, refer to Chapter 1.04 of the Supplemental Guide.
Service Schedule:

The Service Schedule option is currently in development and detailed information will be released in future versions.

Other:

This option is part of a future enhancement in RMA.
Products Tab

The *Products* tab contains the customer’s default products, bottle deposits, and equipment information.

**Default Products:**
The items listed in this section are considered standing orders on the customer’s account. These items will be displayed on the handheld with each delivery. Each product can be set up at the desired price and quantity within this screen.

**Fields:**
- **Code:** The identification code of the product.
- **Description:** The description of the product.
- **Price:** The price assigned to the product (may differ per customer).
- **Qty:** The quantity that will be sold to the customer with each delivery.
- **Qty Disc:** This option enables *Quantity Discount Pricing* on the product. A series of discounts can be established as the customer purchases multiple quantities of the same item.

**NOTE:** For further information on *Quantity Discount Pricing*, refer to Chapter 2.01 of the *Supplemental Guide*. 
**Credit:** This option is used with the *Pre-Pay* feature in RMA; which allows customers to prepay for items, and redeem them using credits accumulated on the account.

**NOTE:** For further information on the *Pre-Pay* feature, refer to *Chapter 2.09* of the *Supplemental Guide*.

**Pricing Type:** Displays *C/P* on products assigned to the *Cost Plus* pricing option.

**Delivery Orders:** Click this button to view any open *Delivery Orders* on the account.

**NOTE:** Refer to *Chapter 3.09* of the *Supplemental Guide* for further information on *Delivery Orders*.

![Add](image)

**Add:** Select this option to add a new *Default Product* to the account.

![Delete](image)

**Delete:** Select an item and choose the delete key to remove an item from the *Default Products* list.

![Modify](image)

**Modify:** Select an item and choose the modify key to update the price or quantity of an item already added to the *Default Products* list.

**Move:** Use the arrows to change the order of the products displayed on the screen. The products will also be listed on the handheld in the same order.

![Recurring Charges](image)

**Recurring Charges:** Select this option to add or view any *Recurring Charges* on the customer’s account — this type of charge is generally used to bill fuel surcharges or processing fees.

**Fields:**

**Charge Code:** The product code used to bill a *Recurring Charge*.

**Product Description:** The product description.

**Amount:** The amount of the recurring fee.

**Bill only on:** Select the desired billing option:

- **Activity:** This option will bill the customer with each delivery on the handheld.
- **No Activity:** This option will bill the customer at the end of each month the customer has not had activity.

**Exclude Suspended Accounts:** This option will exclude the account if it is suspended.
**PAR**

**PAR:** The Par Module is used to maintain an established level of product at all times with each delivery.

<table>
<thead>
<tr>
<th>Product</th>
<th>Description</th>
<th>Par Value</th>
<th>Reported Qty</th>
</tr>
</thead>
<tbody>
<tr>
<td>316</td>
<td>1 Gal Bean</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>316</td>
<td>5 Gallon Spring</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>710</td>
<td>5 Gallon Deposit</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>710</td>
<td>BULLET DEP 3</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Product:** The product code of the par item.

**Par Value:** The quantity to be maintained with each delivery.

**Reported Qty:** The quantity reported by the driver during the customer’s last delivery.

Choose **Add** or **Modify** to input the **Par Value** for each item required. The quantities entered will be displayed on the handheld, and can be updated by the driver with each delivery.

**NOTE:** The **Reported Qty**, entered by the driver, can be programmed to automatically add the required quantity to each handheld invoice by choosing the ‘Automatically Default to Par/Reported’ option within Handheld Class > Sales Rules.

**FREE**

**Free:** This option is used with the Period Discount Pricing option available in RMA. Refer to Chapter 2.15 of the Supplemental Guide for further information.
1.....6 **Delivery Summary:**

Click the *Delivery Summary* button to view products sold to the customer during the last five deliveries.

<table>
<thead>
<tr>
<th>Charge Code</th>
<th>Product Description</th>
<th>Aug 23</th>
<th>Aug 9</th>
<th>Jul 26</th>
<th>Jul 12</th>
<th>Jun 26</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>0010</td>
<td>3 GAL FLTRD</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>0104</td>
<td>3 GAL FRIDGE HEAD</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0202</td>
<td>3 GAL FLT DEP</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Fields:**

**Charge Code:** The product charge code for each product delivered.

**Product Description:** The charge code description for each product delivered.

**Dates:** The delivery date of the last five invoices.

**Average:** The average quantity of products delivered.

**Deposits:**

This section displays and maintains empty container and deposit information for each customer.

**NOTE:** Refer to Chapter 2.04 of the *Supplemental Guide* for further information on establishing deposits and container tracking within RMA.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Price</th>
<th>Qty</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>728</td>
<td>3 Gallon Deposit</td>
<td>5.00</td>
<td>2.00</td>
<td></td>
</tr>
<tr>
<td>735</td>
<td>3 Gallon Deposit</td>
<td>4.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

**Fields:**

**Code:** The product charge code for the container deposit.

**Description:** A description of the container deposit.

**Price:** The price of the container deposit.

**Qty:** The container deposit quantity.

**NOTE:** This number represents the number of containers on hand at this location. Normally, each quantity is updated automatically as your delivery person picks up and delivers product.

**Type:** Displays the container tracking type assigned to the item.

**Deposits Total:** The total amount charged for container deposits on the account.
Other Fields:

**Pre-Pay Products:** This option allows customers to pre-pay for items that will be redeemed during a requested delivery. Refer to Chapter 2.09 of the Supplemental Guide for further information.

**Use Qty Discount:** This option allows the customer to receive discounted rates for purchasing a high volume of items. Refer to Chapter 2.01 of the Supplemental Guide for further information.

**Use Price List:** Check this box to assign a pre-established list of items to the customer’s account. Refer to Chapter 2.01 of the Supplemental Guide for further information.

**Promotional Price List:** Select a Promotional Price List from the dropdown list to assign to the account. Refer to Chapter 2.01 of the Supplemental Guide for further information.

**W. S. Orders:** This option enables the Weekly Standing Orders option in RMA. Refer to Chapter 4.12 of the Supplemental Guide for further information.

**Plan/Qty/Package:** These fields are used with the Package Plan Module. Contact Advantage Route Systems for further information.

### Equipment Tab

The Equipment tab allows you to manage equipment on each customer’s account.

**NOTE:** For further information on equipment setup and usage, refer to Chapter 3.11 of the Supplemental Guide.

### Fields:

**Equip ID:** The serial number of the equipment located at this site.

**Type:** The type of equipment located at this site.

**Style:** The style of equipment located at this site.

**Freq.:** The rent billing frequency code used for the equipment (e.g., ‘M’ for Monthly).

**Code:** The product code assigned to the equipment that will be used when generating rent.
Rent: The rent amount charged for the equipment.

Installed: The date the rented equipment was installed.

Status: Part of a future enhancement.

Exchange: Select a piece of equipment and choose this button to exchange it for a new one — using this option will apply the customer’s current rental settings to the new piece of equipment.

Add: Select this option to add a new piece of equipment on the customer’s account.

Remove: Select a piece of equipment and choose this option to remove the item from the customer’s account.

Modify: Select a piece of equipment and choose this option to modify settings on the item.

Equipment Service: Select this option to view scheduled service days for the selected piece of equipment.

Orders Tab

The Orders tab is part of the Weekly Standing Orders feature in RMA. This option allows you to set up recurring product orders on each customer’s account that repeat regularly.

NOTE: Refer to Chapter 4.12 of the Supplemental Guide for further information.
Customer Setup Codes

In order to set up customers in RMA, a majority of the items listed within this section will need to be established. Each item is defined in the order listed.

<table>
<thead>
<tr>
<th>Customer Status Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Type Codes</td>
</tr>
<tr>
<td>Delivery Order Status Codes</td>
</tr>
<tr>
<td>Credit Class Codes</td>
</tr>
<tr>
<td>Credit Terms</td>
</tr>
<tr>
<td>Statement Codes</td>
</tr>
<tr>
<td>Dunning Messages</td>
</tr>
<tr>
<td>Dunning Letters</td>
</tr>
<tr>
<td>Late Charge Codes</td>
</tr>
<tr>
<td>Administrative Charge Codes</td>
</tr>
<tr>
<td>Start / Stop Groups</td>
</tr>
<tr>
<td>Start / Stop Reasons</td>
</tr>
<tr>
<td>Customer Promotions</td>
</tr>
<tr>
<td>Contact Message Groups</td>
</tr>
<tr>
<td>Contact Message Reasons</td>
</tr>
<tr>
<td>Service Priority Codes</td>
</tr>
<tr>
<td>Suspend Service Codes</td>
</tr>
<tr>
<td>Contact Via Codes</td>
</tr>
<tr>
<td>Contact Frequency Codes</td>
</tr>
<tr>
<td>Major Account Codes</td>
</tr>
<tr>
<td>Contract Type Codes</td>
</tr>
<tr>
<td>Dynamic Header Codes</td>
</tr>
</tbody>
</table>

**NOTE:** For additional assistance with setting up these items, refer to the *Getting Started Guide*. 
Customer Status Codes

*Customer Status Codes* are used to designate the account’s current status and to allow for uniform changes as an account is moved from one status to another.

Common status codes used are *Free Trial*, *Active*, *Waiting for pick up*, and *Terminated*.

![Customer Status](image)

**Fields:**

- **Status Code**: A single character code to identify the account’s status.
- **Description**: The description of the status code.
- **On Status Change, set this Code to**: Select the ‘Change Statement Type to’ or ‘Change Credit Class’ options to indicate which *Statement Type* and *Credit Class* to assign customers to upon status change.
- **New Customer Review**: This option is part of the *Handheld Customer Setup* feature; refer to *Chapter 4.11* of the *Supplemental Guide* for further information.
Customer Type Codes

Customer Type Codes are the primary option to categorize customers into groups, and to assign a series of default customer settings from within the New Customer W/ Order Wizard.

Common Customer Types used are:
- Residential
- Commercial
- COD

You may also establish types for school districts, store chains, etc.

NOTE: Customer Type Codes are used as filters on many reports in RMA. Most of the items discussed within this screen are defined in greater detail later in Chapter 6.

Fields:

**Type ID:** Enter up to two characters to use as a customer type identifier.

**Description:** A description of the customer type.

Customer Defaults:

To speed up data entry, the default settings below will automatically be assigned to accounts within the New Customer W/ Order Wizard upon selection of the Customer Type Code.

**Status Code:** Select the default Customer Status Code that should be used.

**Credit Class:** Select the default Credit Class Code that should be used.

**Late Charge:** Select the default Late Charge that should be used.

**Statement:** Select the default Statement Code that should be used.

**Statement Assessment:** Select the default Statement Assessment Code that should be used.

**Rent Calendar:** Select the default Rent Calendar that should be used.

**Sales Tax:** Select the default Sales Tax Code that should be used.

**Service Priority:** Select the default Service Priority Code that should be used.
**Use Price List:** Check this box to assign a *Price List* to this *Customer Type Code*.

**Price List:** Select the desired *Price List* to assign to this *Customer Type Code*.

**Price Level:** Select the *Price Level* that should be assigned to this *Customer Type Code*. Each *Price Level* relates to the *Pricing* tab within the *Product Charge Code* screen (up to ten levels of pricing can be established).

**Use Branch:** Choose this option to use the *Price Level* established within *Branch Setup*, on the *Customer* tab.

**Promotional Price Group:** This option is part of the *Buy/Gets Module*, contact Advantage Route Systems for further information.

**Credit Limit:** Enter a default *Credit Limit*, if necessary. Leaving the amount at 0.00 is considered unlimited credit.

**Open Invoice:** Check this box to use the *Open Invoice* billing method as the default setting for this *Customer Type*. Using *Open Invoice* allows payments to be applied directly to open items on the account. If this option is not selected, the open items will not be tracked separately.

**Cylinder Exchange:** Switches each assigned account to handheld cylinder exchange option on the handheld — replaces standard container deposit tracking.

**Refund Check Code:** Select the standard refund check code to assign to each account.

**EDI Code:** This option is part of the *EDI Module*; contact Advantage Route Systems for further information.

**Reward Points Multiplier:** This option is part of the *Customer Retention Program* available in RMA, refer to *Chapter 4.04* of the *Supplemental Guide* for further information.

**Delete Reward Points…Days Old:** This option is part of the *Customer Retention Program* available in RMA, refer to *Chapter 4.04* of the *Supplemental Guide* for further information.

**Pre-Call Options:**

**Don't Call:** Select this option to prevent the customer from being called during *Route Pre-Sale* and *RV2000* (optional module) pre-calls.

**Start Time:** This field indicates the default starting time to call this customer.

**End Time:** This field indicates the default ending time to call this customer.

**Language (in development):** Select the default language the *RV2000* program should use when calling this customer.

**Flash Report Options:**

**Type:** Select the type of account to use on the *Flash Report*.

**Payment Options:**

**Preferred Payment:** Select the payment method that will be commonly used for this type of customer.

**Preferred Bank:** Select the default bank account that will be used for this type of customer.
**Default Products Tab**

Establish *Default Products* that will be assigned to each customer’s account automatically.

**Fields:**

- **Default Products:** Add all of the *Default Products* required for this *Customer Type*.
- **Pre-Pay Products:** Choose this option to establish pre-pay products as defaults for this *Customer Type*.

**NOTE:** The *Cost Plus Pricing* option is also available when adding products in this screen; refer to *Chapters 2.01 and 2.09* of the *Supplemental Guide* for further information on these options.

- **Deposit Codes:** Add each container deposit code that will be used with this *Customer Type*. 
**Handheld Tab**

Establish default handheld settings that will be assigned to each customer’s account automatically.

![Customer Type Codes](image)

**Fields:**

*Suppress Balance*: Select this option to suppress the customer’s balance on all handheld transactions.

*Signature Required*: Select this option to require a signature for each handheld delivery.

*Remittance Stub*: Select this option to provide the customer with a payment remittance slip with each handheld invoice.

*Group Area Code*: Select a default Group Area Code for this customer type.

*Invoice Copies*: Establish the number of handheld invoices to print with each delivery.

*Show Points on HH Receipt*: Select this option to print the number of ‘points’ the customer has earned on the handheld invoice.

**NOTE:** This option is part of the Customer Retention Program available in RMA; refer to Chapter 4.04 of the Supplemental Guide for further information.
**HH New Customer Tab**

The *Handheld New Customer* tab is part of the *Enhanced Customer Setup* option available on the handheld.

**NOTE:** Refer to Chapter 4.11 of the *Supplemental Guide* for further information on this option.

**Fields:**

**Enable / Require:** Check the appropriate box to enable or require each item below during customer setup on the handheld.

- Name
- Address
- City
- State
- Zip
- Phone Number

**Start Reason Group:** Enter the default *Start Reason Group* that will be assigned to accounts created on the handheld.

**Start Reason:** Enter the default *Start Reason* that will be assigned to accounts created on the handheld.
**Web New Customer Tab**

The Web New Customer tab is part of the Electronic Commerce 2000 module available from ARS. This useful tool allows your customers to manage their accounts online, place orders, and even sign up for service.

**NOTE:** Contact Advantage Route Systems for further information on this module.

### Fields:

**Show on Web:** Select this option to allow new customers to select this Customer Type when signing up for service online.

**Start Reason Group:** Enter the default Start Reason Group that should be assigned to accounts created on the Web.

**Start Reason:** Enter the default Start Reason that should be assigned to accounts created on the Web.

**Billing Information:**

**Enable / Require:** Check the appropriate box to enable or require each item below during customer setup on the Web.

- **Name**
- **Address**
- **City**
- **State**
- **Zip**
- **Phone Number**
- **Promo Code**
Contact Information:

Enable / Require: Check the appropriate box to enable or require each item below during customer setup on the Web.

- Contact Name
- Phone
- Fax
- Work Phone
- Cell
- Email

Route Information:

Enable / Require: Check the appropriate box to enable or require each item below during customer setup on the Web.

- Name
- Delivery Address
- City
- State
- Zip
- Phone

Delivery Contact Information:

Enable / Require: Check the appropriate box to enable or require each item below during customer setup on the Web.

- Contact
- Phone
- Fax
- Work Phone
- Cell
- Contact Phone

Delivery Order Status Codes

The Delivery Order Status Codes option is used with a ‘Dashboard’ feature that is currently in development.
Credit Class

The Credit Class option is used to assign past due terms, dunning notices, and other balance related rules to each customer.

Information Tab

The Information tab contains the primary setup items required for each Credit Class.

Fields:

Credit Class ID: Enter a single character that will represent the Credit Class.

Description: Enter a description for the Credit Class (e.g., Standard Credit, Excellent Credit, COD).

Extended Description: Enter any additional description, for reference.

Average Days to Pay: The average number of days that an account assigned to this Credit Class takes to make a payment (display only).

Statement Terms (Custom Statement Only): Terms to be printed on the customer’s statement (e.g., Net-15, Net-30).

Inactive: Check this box to flag all customers assigned to the current Credit Class as ‘Inactive’.

Past Due At: Choose the default number of days to notify the user and customer that the account is Past Due.

Hold Service: Choose the default number of days to place an account on ‘Hold Service’ status.

Dunning Msg: Choose the default number of days to begin printing a Dunning Message with all printed invoices and statements.

Ignore if Below: Enter the maximum balance that should be ignored under each respective option (i.e., if 1.00 is entered, all balances at 1.00 or less will be ignored).

Invoice Due (Euro-Finance Only): Insert a value that will be used to calculate the due date on each invoice.

...days from period close (Euro-Finance Only): Insert a value that will be used to calculate the due date on each statement.
**Statement and Handheld Dunning Message Code:** Select the *Dunning Message Code* that should be used for printing past due messages on invoices and statements.

**Other Fields:**

**Collections Class:** Check this option to display a ‘Collections’ flag on each account assigned to this *Credit Class*.

**COD Class:** Check this option display a ‘COD’ flag on each account assigned to this *Credit Class*. This option will also be used to control other activities on the customer’s account (refer to the *Handheld Class* option).

**Prepay Class:** Select this option if the *Credit Class* will be used on *Pre-Pay* accounts. Refer to Chapter 2.09 of the Supplemental Guide for further information.

**Block on Over Limit:** Choose this option to require a *Release Code* on accounts that have exceeded their established *Credit Limit* on the *Credit tab* of *Customer Information*.

**Block on Credit Hold:** Choose this option to require a *Release Code* on accounts that are on ‘Hold Service’ status.

**Allow COD Sale to Past Due Customer:** Select this option to allow a *COD sale* on a *Past Due* account.

**Allow COD sale to Hold Service Customer:** Select this option to allow a *COD sale* on a ‘Hold Service’ account.

**Make Stops Inactive After [ ] Skips (Optional):** Enter the number of consecutive delivery ‘Skips’ that will be accepted prior to inactivating a route stop (will only inactivate the current route stop on a multi-stop account).

**Include Desktop Transactions:** Check this box to include skips entered on desktop transactions.

**Include HH Transactions:** Check this box to include skips entered on handheld transactions.
Dunning Tab

The Dunning tab allows past due letters to be assigned to each Credit Class. To learn more about this feature, refer to Chapter 2.08 of the Supplemental Guide.

Fields:

Dunning Letter Type: Choose a Dunning Letter to assign to each level.
Include Balances: Enter the range of balances to include on each level.
Days: Enter the range of days to include on each level.
Over Credit Limit Notice: Choose a unique Dunning Letter for customers that have exceeded established Credit Limits.
Credit Terms

Credit Terms are used to identify payment terms extended to customers. This option is only used for reference on the desktop (unless SAGE Export is used).

**Fields:**

- **Credit Term ID:** Enter a single character that will represent the Credit Term.
- **Description:** Enter the description of the Credit Term.
Statement Codes

RMA contains multiple statement types that can be configured to suit the needs of each company.

Layout Tab

The Layout tab controls the type of statement that will be used and a majority of the configuration options available.

Fields:

Statement ID: Enter up to two characters that will represent the Statement Code.

Description: Enter the description of the Statement Code.

Statement Label: Enter a title that will appear on the statement (e.g., Statement, Monthly Statement, Account Status).

Due Date… From Close Date: Enter a value that will be used to calculate the due date printed on each statement (i.e., if ‘15’ is entered and the statement is printed on 12/31, the due date used will be 1/15).

Exclude Amounts:

Minimum and Maximum: Enter a range of customer balances for which you would like to exclude statements from printing (i.e., in the example screen above, a statement will not be printed for any customer with a balance less than 1.00).
Statement Types:

No Statement: Select this option for customers that do not require a statement.

Standard Statement: Select this option to use a standard printed 8 ½ x 11 statement format.

Bulk Statements: Select this option to create a bulk file that will be sent to an external statement processing company (e.g., Matrix Imaging).

Handheld Statements: Select this option to use a statement that will be printed from the handheld automatically during the last delivery of the month for each customer.

Fax: Select this option to use process fax statements to your customers (requires additional setup).

E-mail: Select this option to process statements via E-mail using Microsoft Outlook or SMTP service (requires additional setup).

Standard Postcard (Custom Only): Select this option to process statements using postcard paper stock.

Self Mailer (Custom Only): Select this option to process a 3-fold paper statement type.

Custom Statement: Select this option to process a custom statement.

Options:

The items listed below are available based on the Statement Type selected.

Include Payment Voucher: Select this option to include a payment voucher on Standard Statement types.

Include Invoices: Select this option to include separate invoice copies with each statement. Select the invoice type to include from the following radio buttons:

- Standard: Select this option to include all invoice copies for the current period with each statement.
- Rental: Check this box to only print Rental Invoices with each statement.

NOTE: This option only applies to customers with the ‘Rent Invoice’ option selected in Customer Information > Credit > Billing/Statement. Additionally, in order for the invoice to be processed with the statement, the ‘Rent Invoice’ option will need to be selected prior to generating the customer’s rental.

- Open: Select this option to include only open invoice copies with each statement (requires Open Item Statement option).

Pre-Printed Form: Select this option to suppress information on the top left portion of the statement to allow room for pre-printed information.

Open Item Statement: Select this option to replace all of the monthly transactions with only the items that remain open on the account.

Day Aging: Enter a value here that will be used to separate each transaction into one of five aging levels (i.e., if 30 is entered, 5 aging buckets separated by 30 days each will be used).

Suppress Aging: Select this option to suppress all aging details from each statement.

Include Stop Information: Select this option to include detailed stop information on each statement (helpful with multi-stop accounts).
**Include Bottle Count:** Select this option to include a summary of the total number of bottles (containers) exchanged for the current period on the statement. This option also includes an ‘On-Hand’ total per container type.

**Exclude Postal Bar Code:** Select this option to will suppress the USPS bar code from the statement.

**Detail Side First (Custom Only):** Select this option to print detailed line items on Postcard Statements first.

**8 ½ X 11 Invoice Format:** Select this option to convert all invoices to the 8 ½ X 11 invoice format (when selecting Include Invoices).

**Include No Charge Items:** Select this option to include items on the statement that were sold to the customer at 0.00 price.

**Don’t Include Invoice Details:** Select this option to suppress individual invoice details from each statement (will include invoice number and total only).

**Suppress Options During Printing:** Select this option to force the items selected here to be used within the Statements screen (disables on-the-fly changes from being made).

**Separate Statement for each Transaction:** Select this option to generate a separate statement for each transaction on each customer’s account.

**Include Payment Coupon Bar Code:** Select this option to include a barcode on each statement that will be used for scanning payments into RMA (requires additional hardware and configuration).

**Display Bottle Exchange Quantities:** Select this option to include bottle (container) movement per invoice on the statement.

**Show Mini Signatures on Statement:** Select this option to include signatures (when applicable) with each invoice listed on the statement screen.

---

**NOTE:** The option above may not work with certain statement types. Contact ARS for further information.

**Include Invoice Comments on Statement Detail:** Select this option to include any invoice comments on the statement.
Messages Tab

The Messages tab contains company address details and special messages that can relay important information to each customer.

Statement Address:

Name: Enter your company name here.

Address: Enter the street address or P.O. number for your company here.

Email Address: Enter an Email address for your company here.

Web Address: Enter the company’s web address.

Company Registration Number: Enter the company’s registration number.

VAT Registration Number: Enter the company’s VAT registration number.

Phone: Enter the company’s business phone number.

Use Customer’s Home Branch Address: Select this option to use the company’s address information entered under File > Branch Setup.

Fax: Enter the company’s fax number.

Header Logo: Select this option to use a company logo on your statements (dimensions 350w x 145h).

NOTE: Refer to Chapter 2.17 of the Supplemental Guide for additional information on logos.

Accounting Message:

The Accounting Message can be used for relaying account related information to your customers.

Statement Notes:

The Statement Note can be used for promotional messages or general information that you would like relayed to your customers.
Bill Frequency Tab

The Bill Frequency tab contains advanced billing options for generating statements.

**Fields:**

**Period End:** Select this option if this Statement Code will be billed at the end of each accounting period.

**Quarterly:** Select this option if this Statement Code will be billed at the end of each quarter.

**Right After Delivery:** Select this option if this Statement Code will be billed immediately following each delivery. All transactions that have not previously been sent on a statement will be billed when these statements are generated.

**NOTE:** Statement Numbers must be enabled to use this option.

**Use Billing Cycles:** Select this option to print statements based on a defined Billing Cycle.

**Billing Cycle Days (Use Billing Cycles Must Be Selected):** Select this option to establish your Billing Cycles.

**At Time of Delivery:** Select this option to print a statement during delivery (requires custom statement).

**Since Last Statement:** Choose this option to include activity on the account since the last statement was generated for the customer (This statement can only be printed once per period).

**Once per Month:** Check this option to ensure that only one statement is printed per month when using the Since Last Statement option.

**Only After Last Delivery of the Current Period:** Check this option to ensure that statements are only generated after the last scheduled delivery within the current period.
Defining Billing Cycles:
By defining Billing Cycles on the calendar, you will be able to control which days of the month each customer is sent a statement. This is helpful for spreading out statement printing for the month.

1. Click on the day of the month you would like to establish a Billing Cycle.
2. Enter a single character identification code.
3. Repeat the steps above and create multiple Billing Cycles, if desired.

NOTE: Billing Cycles do not repeat automatically, you will need to define each month individually.

Assign a Billing Cycle:
After you have established the Billing Cycle Calendar, you must assign the new cycles to your customers.

1. Browse to a customer’s account and select the Credit tab.
2. Select a Statement Cycle under the Billing/Statement menu.

NOTE: An account assigned to Statement Cycle A will be billed on the 15th of September, according to the calendar established earlier.

At Time of Delivery: Select this option to create a statement at the time of each delivery. Custom programming will be required to implement this feature.
Dunning Messages

*Dunning Messages* are past due messages that can be distributed to your customers on statements and handheld invoices automatically. Each *Dunning Message* is controlled by the customer's assigned *Credit Class*.

**NOTE:** For more detailed information on managing past due accounts, refer to Chapter 2.08 of the Supplemental Guide.

**Statements/Handhelds**

These past due messages can be automatically included on statements and handheld receipts based on each customer’s assigned *Credit Class Code*.

![Dunning Messages Interface](image)

**Fields:**

- **Maximum Characters for Message:** Enter the maximum number of characters your handheld printer will allow.
- **Message ID:** Enter a single character that will be used to represent the *Dunning Message*.
- **Monthly Message:** Enter a message that will print automatically on each desktop and handheld statement.
- **Current-Over 150 days:** Enter all of the past due messages you would like to include on statements and handheld receipts for the customers that qualify.
- **Show Grid:** This places a grid over the message field. It should be used as a character guide.
**Dunning Letters**

*Dunning Letters* are past due messages that can be distributed to your customers through the mail. Each *Dunning Letter* is controlled by the customer’s assigned *Credit Class*. The Statements and Handhelds tab both display the same message format.

**NOTE:** For more detailed information on managing past due accounts, refer to *Chapter 2.08* of the *Supplemental Guide*.

---

**Fields:**

- **Letter ID:** Enter a single character that will represent the *Dunning Letter*.
- **Location of Letter:** Enter, or browse to, the location of the letter.
- **Description:** Enter a description for the letter.
- **Valid Until:** Enter a date that this letter will be valid through (for reference).
- **Comments:** Enter any comments regarding the letter if desired.
Late Charge Codes

*Late Charge Codes* are used to assess late fees on past due accounts. Multiple rates may be used, but only one code may be applied to each customer.

![Late Charge Codes](image)

**Fields:**

- **Late Charge Code:** Enter a single character that will represent the *Late Charge Code*.
- **Description:** The description of the *Late Charge Code*.
- **Annual Rate:** Currently not in use.
- **Period Rate:** The percentage applied as a late fee to each account that is past due.
- **Min. Charge:** The minimum charge that will be added to an account that is past due.
- **Charge Code:** Select the *Product Charge Code* that will be used to apply late fees to each account.
- **Apply to Balance at:** Select the number of days overdue that you would like to qualify for a late fee.
- **Don’t Charge for Collections Accounts:** Select this option to prevent a *Late Charge* from being generated on accounts that are currently assigned to a ‘Collections’ *Credit Class Code*.
- **Move Customer to Credit Class:** Select this option to automatically move the customer to the *Credit Class* of your choice upon generating a *Late Charge* on the account (e.g., Collections Class).
Statement Message: This message will be included on statements generated for customers that received a Late Charge for the month. The following optional fields can be added to the message, as desired:

- **{Days}** – Includes the number of days until payment is due, based on the ‘Due [ ] days from Close Date’ field of the Statements screen.

- **{Date}** – Includes the approximate date that payment is due, based on the ‘Due [ ] days from Close Date’ field of the Statements screen.

- **{Due}** – Includes the total amount due, based on the Total Due field of the customer’s statement.

- **{Late}** – Includes the balance due if the payment is late, based on the amount entered in the Min. Charge field of the Late Charge Codes screen.

<table>
<thead>
<tr>
<th>Statement Message</th>
<th>Please send your payment of (DUE) by (DATE) to avoid a late fee</th>
</tr>
</thead>
<tbody>
<tr>
<td>(DAYS) x Days</td>
<td>(DATE) x Due Date</td>
</tr>
</tbody>
</table>

Sample: Please send your payment of 10.00 by 03/20/2017 to avoid a late fee.
Administrative Charge Codes

Administrative Charge Codes are used to assess ‘handling’ fees on large accounts that demand a high level of resources and time in the office. Multiple rates may be used, but only one code may be applied to each customer.

Fields:

Administrative Charge ID: Enter a single character that will represent the Administrative Charge Code.

Description: The description of the Administrative Charge Code.

Rate: The percentage applied to each account as an administrative fee.

Minimum Charge: The minimum charge that will be applied to each account.

Charge Code: Select the Product Charge Code that will be used to apply administrative fees to each account.

Charge Only on Sales Activity: Select this option to only bill customers if they have purchased items for the month.

Charge Only on No Sales Activity: Select this option to only bill customers if they have not purchased items for the month.
Start/Stop Groups

Start/Stop Groups are used to group together Start/Stop Reasons by type. These items are used to specify why customers start or stop service with your company.

Fields:

**Inactive:** Select this option to prevent the Start/Stop Group from being used within the New Customer W/Order Wizard and Customer Information screens.

**ID:** Enter up to three characters that will represent the Start/Stop Group.

**Label:** Enter the category label of the Start/Stop Group.

**Description:** Enter an extended description of the Start/Stop Group.

**Use as Default on Customer Wizard:** Select this option to use this Start/Stop Group as the default choice within the New Customer W/Order Wizard.

**Reason Type:** Select the type of Start/Stop Group this item represents.

**NOTE:** Select Both if you would like this item to show up as a Start and Stop Group option.
Start/Stop Reasons

Start/Stop Reasons are used to specify why customers start or stop service with your company. Each reason will also be assigned to a Start/Stop Group to categorize them by type.

### Fields:

- **Reason Code**: Enter up to three characters that will represent the Start/Stop Reason.
- **Group Code**: Select the default Start/Stop Group Code that the reason will be assigned to.
- **Reason**: Enter the description for the Start or Stop Reason (e.g., Yellow Pages, Friend, Moving, Competitor).
- **Moved**: Check the box if this reason will be assigned to accounts that have left your service area and terminated service, for reference.
- **Inactive**: Select this option to prevent the Start/Stop Reason from being used within the New Customer W/Order Wizard and Customer Information screens.
- **Start and Stop Figures**: Each box displays the total number of starts and stops for each period listed.

**NOTE**: More detailed information is provided in the Start and Stops report found under Reports > Management Reports.

- **Reason Type**: Select the type of Start/Stop Reason this item represents.
- **NOTE**: Select *Both* if you would like this item to show up as a Start and Stop Reason option.

- **Use as Default on Customer Wizard**: Select this option to use this Start/Stop Reason as the default choice within the New Customer W/Order Wizard.

**NOTE**: If a default Start/Stop Group has been established, the default Start/Stop Reason selected must be assigned to the same group in order for it to be properly defaulted within the New Customer W/Order Wizard.
**Customer Promotions**

The Customer Promotions option allows you to configure marketing programs that can offer your customers additional savings, promotional items, etc. Items can be assigned to each promotion created, and will be added to the customer’s First Order during the New Customer W/Order entry process. The promotion will also be permanently referenced within the customer’s account, on the Credit tab.

![Customer Promotions](Image)

**Fields:**

- **Code:** Enter up to three characters that will represent the Promotion Code.
- **Description:** Enter a description for the Promotion Code.
- **Start Date:** Enter the start date for the current promotion.
- **End Date:** Enter the end date for the current promotion.

**NOTE:** Promotions that have expired will not be displayed within the New Customer W/Order Wizard.

**Available To:** Select which areas of the program will include the promotions option:

- **New Customer Wizard**
- **New Stop Wizard**
- **Delivery Orders**
- **Internet Orders**
- **Handheld**

**Handheld Filter Criteria (requires ‘Handheld’ availability):**

- **First Transaction Only:** Select this option to apply the promotion only to the customer’s first transaction on the handheld.
- **Filter by Customer Type:** Select this option to apply the promotion to specific Customer Types.
- **Customer Start Date Greater Than:** Enter a minimum customer start date that will qualify for the promotion.

**Details:** Enter the specific details of the current promotion.
Products: Add the items to the Promotion Code that you would like to assign to the customer’s First Order during New Customer W/Order entry.

Contact Message Groups

Contact Message Groups are used to group together Contact Reasons by type. These items are used when contacting customers for payment, complaints, follow-up, etc.

Fields:

ID: Enter a single character that will represent the Contact Message Group.

Description: Enter a description for the Contact Message Group.
Contact Message Reasons

Contact Message Reasons are used to identify why a customer was contacted by an employee. Each reason will also be assigned to a Contact Message Group to categorize each by type.

Fields:

ID: Enter a single character that will represent the Contact Message Reason.

Description: Enter a description for the Contact Message Reason.

Contact Message Group: Select the default Contact Message Group that the reason will be assigned to.

Requests Descriptions: Enter up to six second level descriptions that can be selected when a Contact Reason is added within the Customer Information screen.

Delete Old Contact Data: Select one of the filters available that will be used to manage archiving Contact Reasons each month. This process takes place during the Period Close process.

NOTE: Contact Message rules can be found under File > Branch Setup > Logging tab.

Complaint Reason: Select this option on “complaint” type reasons to filter messages within Customer Information and the Contact Message Report.

Delivery Order Reasons (disabled/enabled): Use the arrow keys to filter the available Delivery Order Reasons within the Delivery Order screen after selecting the current Contact Message Reason.
Service Priority Codes

Service Priority Codes are used to calculate promise dates, follow-up dates, and service priority on each of your accounts within the Delivery Order and Customer Information screens.

Fields:

ID: Enter a single character that will represent the Service Priority Code.

Description: Enter a description for the Service Priority Code.

Promise Days (Delivery Orders): Enter the number of days to determine the Promise Date for this level of service.

Follow Up Days (Delivery Orders): Enter the number of days to determine the Follow-Up Date for this level of service.

Code Color: Enter a number next to each description to create a default color for the Service Code displayed within Customer Information (next to the customer’s name).
Suspend Service Codes

*Suspend Service Codes* are used to temporarily remove customers from route for a given period of time.

**Fields:**

*Code:* Enter a single character that will represent the *Suspend Service Code*.

*Reason:* Enter a description for this *Suspend Service Code*.

*Default Days:* Enter the default number of days to suspend service for this code.
Contact Via Codes

Contact Via Codes are used to establish contact methods that should be used per customer during the Route Pre-Sale process.

NOTE: Route Pre-Sale is used to secure orders prior to delivery, and can be found under the Route menu.

Fields:

ID: Enter a single character that will represent the Contact Via Code.

Description: Enter a description for the Contact Via Code.

E-Mail, Fax, Telephone, Other: Select the method of contact that applies to this Contact Via Code.
Contact Frequency Codes

Contact Frequency Codes are used to determine how often a customer should be contacted during the Route Pre-Sale process.

NOTE: Route Pre-Sale is used to secure orders prior to delivery, and can be found under the Route menu.

Fields:

**ID:** Enter a single character that will represent the Contact Frequency Code.

**Description:** Enter a description for the Contact Frequency Code.
Major Account Code

Major Account Codes are used for special and or multi-branch customers that require a high level of management.

Fields:

**ID:** Enter up to six characters that will represent the Major Account Code.

**Description:** Enter the description for this Major Account Code.

**Inside Employee:** Select an employee that will manage this account within the office.

**Outside Employee:** Select an employee that will manage this account externally.

**Other Employee:** Select an employee that that will manage the account for any other reason.

**Local Account Representative:** Enter the primary contact for this account.

**Require a Purchase Order for all Sales:** Select this option if a purchase order is required with each invoice for this account.

**Credit Controller:** Select the employee responsible for managing balance related information on the account.

**Credit Class:** Select the default Credit Class that should be assigned to this account.
Contract Type Codes / Setup Tab

*Contract Type Codes* are used to keep track of the different contracts that may be used by your company.

![Contract Types](image)

### Fields:

**ID:** Enter up to three characters that will represent the *Contract Type Code*.

**Inactive:** Select this option when a contract should be inactivated.

**Short Description:** Enter a short description of the *Contract Type Code*.

**Description:** Enter a detailed description of the *Contract Type Code*.

**Valid Dates:** Enter the dates that this contract will be valid.

**Default Period:** Enter the length of the contract in months or weeks (based on your selection).

**Contract Type:** Select the type of contract, *Live* or *Trial* (for reference).

**Expiration Type:** Enter the type of expiration (e.g., Standard).

**Allow Cooler Add:** Select this option to allow installed equipment to be added to the contract.

**Document File:** Browse for, or enter the location of the original contract on your PC or network (optional).

**Details:** Enter specific details regarding the contract, if desired.
Contract Type Codes / Content Tab

The Content tab includes messages that can be included on printed contract related content.

Message Fields:

**Justify:** Enter an L (left), R (right), or C (centered) that corresponds to how you would like the text to be aligned on the printed receipt.

**Font:** Enter a letter corresponding to the font size you would like to use on the printed receipt.

**Message:** Enter the information that you would like to print on each line.

**Dynamic:** Select this button to view dynamic information that can be inserted into the custom contract message.

**Contract Period in Months:** Use the arrow keys to establish the length of the contract in months.

**Lease Version:** Enter version information that can be included on the contract.

**Preview:** Select this button to preview the contract on the screen.
Contract Type Codes / Reference Tab

The Reference tab allows you to attach a document to the Contract Type Code that can be used for reference in the future.

Fields:

Select Document: Select this button to attach the document to the Contract Type Code.
Dynamic Header Codes

*Dynamic Header Codes* allow you to use alternate company headers on handheld invoices for each customer. This is an alternative to the standard company header found under the *Handheld Class* screen.

**NOTE:** This option can be useful if you are running a company under multiple names.

**Fields:**

- **Header Code:** Enter a single character that will represent the *Dynamic Header Code*.
- **Description:** Enter a description for the *Dynamic Header Code*.
- **Justify:** Enter the letter corresponding to how you would like your message to be displayed on the handheld receipt:
  - L: Left
  - R: Right
  - C: Centered
- **Font:** Enter the letter that corresponds to the font size you would like to use on your printed handheld invoices. Examples for the Advantage BT-4 are listed below.

<table>
<thead>
<tr>
<th>Style Identifier</th>
<th>Max. characters / line</th>
<th>Style Identifier</th>
<th>Max. characters / line</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>69</td>
<td>I</td>
<td>69</td>
</tr>
<tr>
<td>B</td>
<td>69</td>
<td>J</td>
<td>69</td>
</tr>
<tr>
<td>C</td>
<td>69</td>
<td>K</td>
<td>69</td>
</tr>
<tr>
<td>D</td>
<td>69</td>
<td>L</td>
<td>69</td>
</tr>
<tr>
<td>E</td>
<td>34</td>
<td>M</td>
<td>34</td>
</tr>
<tr>
<td>F</td>
<td>34</td>
<td>N</td>
<td>34</td>
</tr>
<tr>
<td>G</td>
<td>34</td>
<td>O</td>
<td>34</td>
</tr>
<tr>
<td>H</td>
<td>34</td>
<td>P</td>
<td>34</td>
</tr>
</tbody>
</table>

**NOTE:** Refer to Appendix B of the *Handheld User Guide* for a complete list of handheld printer fonts and examples.

**Message:** Enter the desired header details on each line needed.
ZIP Codes

The ZIP Codes option contains all of the ZIP codes assigned to your customers. If an account needs to be created with a ZIP code that does not exist in the database, it will need to be added in this screen prior to entering the account in the New Customer W/Order Wizard.

Fields:

ZIP Code: Enter up to eight characters for each ZIP code.

NOTE: To accommodate multiple markets, the ZIP code length can be adjusted under File > Branch Setup > Defaults tab.

City: Enter the name of the city associated with this ZIP code.

State: Enter the abbreviated name of the state associated with this ZIP code.

Last Updated (Display Only): The date this entry was modified.

Note: An optional extended description can be entered here.

Suppress ZIP Code on Delivery Address: Select this option to prevent the ZIP code from showing up under the Delivery Address ZIP field within the New Customer W/Order Wizard and Customer Information.

Add to eStoreFront ZIP Code Search: Select this option to add the current ZIP code to the eStoreFront database.

NOTE: The eStoreFront Module allows customers to review their account and order products directly from your Web site. Contact ARS for further information.
Defaults:

Check one or more of the items listed below to select a default code that will be assigned to each account within the New Customer W/Order Wizard, after the current ZIP Code is selected.

- Branch
- Service Priority Code
- Route
- Tax Code
- Asset Tax Code
- Credit Controller
- Delivery Time
- Day Label
- Group Area Code

Geography Codes

*Geography Codes* are used to associate address fields together for faster input. Contact Advantage Route Systems for further information on this option.
Delivery Order Reasons

Delivery Order Reasons are used within the Delivery Orders screen for customers that require special deliveries. Up to 24 custom reasons can be established.

Fields:

**Reason ID:** Enter up to two characters that will represent the Delivery Order Reason.

**Reason:** Enter a description for the Delivery Order Reason.

**Mini Description:** Enter up to two characters to use as an abbreviation for the reason on certain reports.

**Suppress input on Delivery Order:** Select this option to disable the Delivery Order Reason within the Delivery Order screen.

**Warn for Package Plan Contract Expiration Violation:** Check this box to notify the user that the customer has breached a Package Plan contract.

**Display in Route Input Screen on Handheld:** Select this option to display a ‘Delivery Order’ reference message when accessing the stop on the handheld.

**Prevent Order Modification on Handheld:** Select this option to prevent the driver from modifying Delivery Order product quantities on the handheld.

**NOTE:** This option also disables the payment screen on the handheld.

**Allow Quantity Change on Handheld (Requires Option Above):** Select this option to allow the driver to modify the quantities assigned to the Delivery Order.

**Display in Alert Message on Handheld:** Select this option to display the reason as an Alert Message on the handheld.

**Require Weight Entry in RMLive:** Select this option to require weight entries on the RMLive dispatch screen.

**High Priority Reason Code (Delivery Highlighted on HH):** Select this option to flag all Delivery Orders with this reason selected as a ‘High Priority’ order.
NOTE: This option allows you to color-code ‘High Priority’ stops on the handheld. Refer to page 282 for further information on this option.
Organizing What You Sell

The *Product Codes* menu contains the product related items that need to be established prior to creating transactions in RMA. New screen shot needed to add Deposit Types and remove Daily Temperature Recording and EDI Output Codes.

<table>
<thead>
<tr>
<th>Product Charge Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Class Codes</td>
</tr>
<tr>
<td>Web Class Codes</td>
</tr>
<tr>
<td>Product Group Codes</td>
</tr>
<tr>
<td>Primary Category Codes</td>
</tr>
<tr>
<td>Secondary Category Codes</td>
</tr>
<tr>
<td>Product Unit Codes</td>
</tr>
<tr>
<td>Product Price Lists</td>
</tr>
<tr>
<td>Period Discount Pricing</td>
</tr>
<tr>
<td>Daily Cost Recording</td>
</tr>
<tr>
<td>Daily Temperature Recording</td>
</tr>
<tr>
<td>Gratis Reason Codes</td>
</tr>
<tr>
<td>Warehouse Setup</td>
</tr>
<tr>
<td>Inventory Adjustment Codes</td>
</tr>
<tr>
<td>Quarantine Status Codes</td>
</tr>
<tr>
<td>Shipper List Codes</td>
</tr>
<tr>
<td>Production Batch Codes</td>
</tr>
<tr>
<td>EDI Output Codes</td>
</tr>
<tr>
<td>Order Completion codes</td>
</tr>
<tr>
<td>Order Rejection Codes</td>
</tr>
</tbody>
</table>

Each item is explained in detail below.
**Product Charge Codes**

*Product Charge Codes* represent all of the products that you sell to your customers, with additional items created for other functions in the program.

**Info Tab**

The *Info* tab contains the descriptions and various rules established for each item.

![Product Charge Codes](image)

**Fields:**

*Charge Code:* Enter up to five characters that will represent the *Product Charge Code*.

*HH Description:* Enter a description up to forty characters that will be used on the handheld for the item.

*Statement Description:* Enter an item description that will be displayed on *Statements*.

*Mini-Description:* Enter an abbreviated description up to three characters that will be used on reports that cannot display the complete description of the item.

*Secondary Charge Code:* Enter up to fifteen characters that will represent the *Product Charge Code* on invoices and various input screens.

**NOTE:** The *Secondary Charge Code* option allows you to enter a longer code and description for each item that will be used on the invoice entry screen of the desktop and handheld, if required. To enable this option, browse to *File > Branch Setup > Handheld* tab, and select ‘Show/Use Secondary Charge Code’.

*Secondary Description:* Enter a description up to sixty characters that will represent the *Product Charge Code* on the desktop invoice screen, and will be used for reference on the handheld — tap and hold on the product within the *Misc. Items* screen to view on the handheld.

*Vendor Product Number (Vending Only):* Used on the *Purchase Orders Report* for vendor product identification.
Pre-Pay Product: Check this box to establish this item as a Pre-Pay Product. Refer to Chapter 2.09 of the Supplemental Guide for further information on Pre-Pay Product usage.

Internet Product: Check this box to allow this item to be sold on your EC2000 Module web site. Contact Advantage Route Systems for further information.

Update Account Deposit: Select this option to update the Deposit field within Customer Information > $ (Finance) tab with the total amount billed to the customer using this item.

NOTE: This option is generally used for miscellaneous account deposits, such as equipment. This does not apply to container tracking.

Allow for Gratis: Select this option to allow a Gratis Reason to be entered for the item if necessary (allows price change to 0.00 on the handheld).

Block Gratis on HH (requires option above): Select this option to disable gratis options on the handheld.

Require Production Batch Code: Select this option to require a Manufacturing Control Number when this item is added to a delivery vehicle during the Morning Load process.

Require Serial Number: Select this option to require that a serial number is entered when picking up or selling this item. This can be helpful for items that can be tracked by a serial number (i.e., computers or equipment).

Coupon Redeemable Product: Select this option if the item is used with coupon processing.

Inactive Product: Select this option to inactivate the product and remove it from product entry screens.

Eligible for rent refund: Currently not in use.

Print as ‘Extra Charge’ on Invoice: Select this option to include the item as an ‘Extra Charge’ on the printed invoice.

NOTE: For example, recurring fees and handling charges can be lumped together and printed as one line item on the receipt.

Non Inventory Item: Select this option to ignore inventory tracking for this item (e.g., Skip Reasons, Deposits).

Count as Transaction (Recurring Charges Only): Select this option to define if the item counts as ‘activity’ when using the Bill on Activity or Bill on no Activity options available within the Recurring Charges section of Customer Information.

Inactivity Cancellation: Select this option to use this item to reactivate stops that were previously marked inactive as the result of too many skipped deliveries.

NOTE: To inactivate a route stop after skipping a set number of deliveries, browse to Lists > Customer Setup Codes > Credit Class Codes.

Don’t Include in Last 5 Deliveries: Select this option to suppress the item from being included in the customer’s last five deliveries totals used for reference and calculating load requirements (e.g., Skip Reasons, Refund Checks).
**Require Truck Compartment:** Select this option to force a compartment requirement per vehicle for this item (used in the liquid recycling industry).

**Sub Product:** Select a product that will be added to the invoice each time the current product is sold.

**Override Branch Qty Decimals:** Select this option to override the ‘No. of Decimals for Quantity’ field within *Branch Setup > Handheld* tab for this item.

**Qty Decimals (Requires Option Above):** Enter the number of quantity decimals required for the current item.

**Units:**

**Number of Gallons:** Enter the number of gallons per unit, if applicable.

**Volume/Unit:** Enter the total volume of the unit, if applicable.

**Net Product Weight/Unit:** Enter the total net weight of the unit, if applicable.

**Gross Product Weight/Unit:** Enter the gross or total weight of the unit.

**Shipping Weight/Unit:** Enter the shipping weight of the unit.

**No. of Units:** Enter the number of items within each unit, if applicable

**Product Unit Reference:** Select the *Product Unit Code* that applies to the current item.

**NOTE:** This option is used with Multi-Unit Pricing, refer to Chapter 2.14 of the Supplemental Guide for further information.

**Suppress:**

**Printing on Statements:** Select this option to prevent the item from being displayed on customer statements.

**Printing on Invoices:** Select this option to prevent the item from being displayed on customer invoices.

**View on Account History:** Select this option to prevent the item from being displayed within the History button on the handheld.

**On EDI Output:** This option is used with the *EDI Module*, contact Advantage Route Systems for further information.
Pricing Tab

The Pricing tab determines the prices that will be charged to each customer. There are ten price levels that can be assigned to each product.

Fields:

Price/Cost/Default-Level 9: Enter up to ten levels of prices and costs on each item.

Use Daily Cost: Select this option to use cost entries found within the Daily Cost Recording screen under Lists > Product Codes in RMA. The information will be included on reports that list product cost figures (i.e., Sales Detail Report).

NOTE: It is not required that you assign your customers to the Daily Cost Recording pricing option to use this feature. Refer to Chapter 2.01 of the Supplemental Guide for further information on all of the features available with Daily Cost Recording.

Use Default Cost For All Levels: Select this option to use the cost figure listed in the Default field for all cost levels available on the screen.

Tax Code:

The category labels displayed determine how items are taxed in RMA and are established under File > Branch Setup, on the Taxes tab. Select the appropriate tax category for the item:

NOTE: For a complete tutorial on the sales tax setup process, refer to Chapter 2 of the Getting Started Guide.
**Redemption Value:** In select states, a ‘redemption value’ may be placed on items as they are sold. Choose the redemption code that should be associated with this item.

**NOTE:** Search keywords ‘Redemption Value’ on [www.ARS247.com](http://www.ARS247.com) for further information.

**Reward Points:** Enter the number of ‘points’ that will be awarded to the customer when the item is purchased.

**NOTE:** This option is used with the Customer Retention Program; refer to Chapter 4.04 of the Supplemental Guide for further information.

**Associated Cost Plus Product:** Select a Cost Plus Product from the list.

**NOTE:** Cost Plus Pricing allows you to easily adjust prices for products based on changes to the wholesale price. This option is typically used, but not limited to, the propane industry. Refer to Chapter 2.01 of the Supplemental Guide for further information.

**Base Unit Relations:**

These options are part of the Multi-Unit Pricing feature in RMA. This unique pricing option allows you to set up relationships between various units of sale, such as individual, 6-packs, cases, etc.

**NOTE:** For further information on this feature, refer to Chapter 2.14 of the Supplemental Guide.

**Base Relation:** Select the Base Item to associate with this product.

**Base Quantity:** Enter the number of Base Items that are contained within the current product.

**Product Unit Reference (Display Only):** The Product Unit Code assigned to the item.

**Load Reference Unit:** Select this option to convert quantities and reference this product on all reports and certain areas of the handheld screen — as an alternative to using the Base Unit.
**QTY Pricing Tab**

The *QTY Pricing* tab allows you to establish quantity discount prices per item. Select the ‘Use Qty Pricing’ option within *Customer Information > Products* tab per account to use this feature.

**NOTE:** Refer to Chapter 2.01 of the *Supplemental Guide* for further information on pricing options.

![Product Charge Codes](image)

**Fields:**

*Ignore Quantity Pricing:* Select this option to disable the quantity pricing option for this item.

*From/To:* Enter the range of quantities that should be purchased per level. To establish a cap in the highest level observed, enter ‘9999’ in the *To* field (displayed above).

*Price:* Enter the price that will be used per level.
**Handheld Tab**

The *Handheld* tab defines options used in the handheld RMA program.

![Handheld Tab Diagram]

**Fields:**

**Handheld Product:** Select this option if the item will be used on the handheld.

**NOTE:** This option should be selected for certain non-inventory options as well, such as *Skip Reasons* and *Rental Codes*.

**Include on Exception Report:** Select this option to include all product sales for this item on the afternoon *Exceptions Report*.

**Require COD Payment:** Select this option to require that a payment is made on the handheld for the line total of the item before an invoice can be saved.

**Require Beginning and Ending Readings:** Select this option to enable the ability to enter beginning and ending meter readings within the *Quantity* screen for the item on the handheld. The system will determine the quantity of the item sold to the customer based on the information entered.

**Tank Measurement and Calculations Required:** Check this box if liquids are picked up by the route operator — this option is generally used in the oil recycling industry.

**Count Towards Cage Capacity:** Select this option if this item is stored within a storage cage at the customer’s location (i.e., propane cage).

**NOTE:** Cage capacities are controlled within the *Equipment Master List* found under *Lists > Equipment*.

**Cylinder Equipment Scan:** Select this option if the current product requires the scanning of cylinder equipment.

**Reverse Quantity on Handheld:** Select this option to automatically use a negative quantity when adding this item on the handheld.
**Block Sale on Failed Halogen Test:** Select this option to block the sale of the current item when the halogen test has failed.

**NOTE:** Halogen tests are used in the recycled oil industry to determine contamination levels. This option requires that you select the option ‘Collect Halogen Data’ within Lists > Routes > Handheld Class, on the General tab.

**Show Accumulated Labor on Misc. Items Screen:** Select this option to display the accumulated labor time to service each stop on the handheld — for calculating labor charges.

**NOTE:** Enable the time recording options within the General tab of the Handheld Class screen to use this option successfully.

**Truck Sequence Code (Optional):** Enter up to three digits to use as the item’s Truck Sequence Code.

**NOTE:** If this option is left blank, all products will be sorted by Product Charge Code on the handheld.

**Truck Product Code:** This option allows you to relate multiple codes for the same product together by entering a primary product code here. This is useful if there are several Product Charge Codes created for the same product that only differ in price.

**NOTE:** This option allows you to easily add or remove products from the delivery vehicle using a primary product code.

**Product Group Code:** Select a Product Group Code to assign to the current item. This option allows you to categorize products into groups that are selected on the handheld, allowing the driver to easily enter the desired product on the invoice.

**NOTE:** To manage the Product Groups sent to the handheld per route, navigate to Lists > Routes > Route Master.

**Extra:** Information entered here will be attached to the end of the product code on the handheld. This option is used for reference only and will not be printed on the customer’s receipt.

**Product UPC Code:** Enter up to twelve characters that will be assigned to the product’s UPC code (requires additional hardware).

**On Receipt, Show Product:** This option allows you to change the print order of the product and sales tax on the receipt.

**Long Description:** Enter additional information on each product, if desired. This information can be viewed on the handheld by tapping-and-holding on top of the item within the Misc. Items screen on the handheld.

**Show Long Description in Default Product Listing:** Select this option to display the Long Description within the Default Products section on the handheld.
Skips:

The following options are only displayed on Skip Reasons (Product Class 9 items) added to the Product Charge Codes list:

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag Code</td>
</tr>
<tr>
<td>End of Day Skip Reason</td>
</tr>
<tr>
<td>Allow Entry of Next Delivery Date on Skip</td>
</tr>
<tr>
<td>Close Delivery Order on Skip</td>
</tr>
</tbody>
</table>

**Drag Code:** Select this option if the Skip Reason should ‘Drag’ the customer’s stop to the next delivery day when selected.

**End of Day Skip Reason (only displayed on Skip Reason):** Select this option to display the Skip Reason under the ‘Skip Remaining Stops’ option on the handheld.

**Allow Entry of Next Delivery Date on Skip (only displayed on Skip Reason):** Select this option to allow the driver to reschedule the customer’s next delivery date on the handheld when choosing the current Skip Reason.

**NOTE:** A Delivery Order will be created for the date selected and the customer’s delivery schedule will remain the same after the special delivery. If a new date is not selected, the customer’s next scheduled delivery will remain the same.

**Close Delivery Order on Skip:** Select this option to close the associated order when skipping the stop.
Accounting Tab

The Accounting tab defines the product classification of each item.

Fields:

Product Class: Select a Product Class Code from the drop-down list. The class assigned to each item is used for tracking and reporting purposes.

NOTE: The assigned Product Class Code is fundamental to the operation of RMA and each class is designed to perform a specific function in the program. Refer to Chapter 2 of the Getting Started Guide for further information on this topic.

Equipment Status Code: Select an Equipment Status Code to assign when adding this product to an invoice with related equipment activity.

NOTE: This option is only available after selecting the option ‘Equipment Status Change’ within the Product Class Codes screen for the currently assigned Product Class Code.

Commission Class: Select a Commission Class Code if commissions will be calculated on the item. Refer to Chapter 2.05 of the Supplemental Guide for further information on this topic.

Mapping Product Class (Optional Module): Specify the Mapping Product Class for the item when using the Mobile IQ/Route Engineering interface.

Deposit Type: Select the Deposit Type Code that will be associated with the item.

NOTE: Refer to Chapter 2.04 of the Supplemental Guide for further information on this topic.

Promotional Price Buy Class (Buy/Gets Module): Select the Buy Class that the item will be assigned to.

Promotional Price Get Class (Buy/Gets Module): Select the Get Class that the item will be assigned to.
NOTE: The *Buy/Gets Module* is used to offer free or discounted items to your customers for buying an established quantity of products during a promotion. Contact Advantage Route Systems for further information.
**General Ledger:**

*G/L Acct No:* Select the primary *G/L Number* that you would like to use for general accounting values for the item.

*Gratis G/L No:* Select the *G/L Number* that you would like to use for values accumulated from giving the item to customers at no charge.

*Alternate G/L Number:* Select an alternate *G/L Number* that you would like to use for values accumulated on customer accounts that have the ‘Use Alternate G/L No’ option selected within *Customer Information > Route > Other.*

**NOTE:** Using this option will allow you to accumulate values in the account for selected customers only.

*Cost of Goods G/L Number:* Select the *G/L Number* that you would like to use for the direct costs attributable to the production or purchase of goods sold.

**NOTE:** Refer to Chapter 3.20 of the *Supplemental Guide* for further information on inventory costs.

*Inventory Asset G/L Number:* Select the *G/L Number* that you would like to use for recording the value of items available for purchase.

*Inventory Adjustment G/L Number:* Select the *G/L Number* that you would like to use for any adjustments made to the value of the inventory available for sale (i.e., broken items in the warehouse).

*On use, Email Notification:* Enter an Email address in this field to receive a notification message when the item is posted, for monitoring purposes.

**Internet Options:**

The following options are used by the eStoreFront module, which is an electronic commerce solution that allows your customers to review their account online, order products, make payments, and more. Contact ARS for further information.

- **Internet Product:** Check this box if the item should be available for purchase on the eStoreFront site.
- **Web Class:** Select the *Web Class Category* that applies to this item.
- **Web Display Order:** Enter up to four digits that will control the display order of the item on the eStoreFront site.
**Stock Tab**

This option displays the product’s inventory information. Additionally, this tab is part of a future enhancement in RMA and will be updated periodically.

**Inventory:**

**Branch:** Displays the branch totals per item.

**Quantity On Hand:** The number of units currently on hand for this item.

**Reorder Level:** Enter a reorder level for the item.

**Max. Level:** Enter a maximum product level, if desired.

**NOTE:** The remaining fields on the screen are part of a future enhancement to inventory in RMA.
History Tab

The History tab displays the 24 most recent Accounting Periods of activity for this product.

**NOTE:** Click directly on the dates displayed to toggle between the period close date and period name.

![Image of Product Charge Codes]

**Fields:**

- **Sales:** The sales total for this product during the Accounting Period.
- **Cost:** The total cost for this product during the Accounting Period.
- **Qty:** The quantity sold for this product during the Accounting Period.

**NOTE:** These totals are for reference only. Refer to the Sales Detail Report under Reports > Accounting Reports > Sales for detailed product sold information.
**Hazmat Tab:**

The **Hazmat** tab contains items related to hazardous materials transported on the delivery vehicle.

**NOTE:** The following options are custom to industries that transport hazardous materials. Contact ARS for further information.

**Print NSF Logo:** Check this box to print include a *National Sanitation Foundation* logo on the receipt for the item.

**MSDS Show:** Check this box to include a *Material Safety Data Sheet* printout when this item is sold on the handheld.

**NSF Message:** Enter the appropriate *National Sanitation Foundation* description related to the item.

**HH Message:** Enter any additional *National Sanitation Foundation* description related to the item.

**Manifest Message:** Not currently in use.

**Hazmat Report Product Type:** Contact ARS for further information on report types.
Vendor Tab:

The Vendor tab allows you to assign vendor information for received items in RMA.

**NOTE:** For further information on the Purchase Orders system in RMA, refer to Chapter 4.06 of the Supplemental Guide.

![Product Charge Codes](image)

**Fields:**

*Preferred Vendor:* Select the vendor that supplies the item to your company.

*Vendor Product Number:* Enter the product ID assigned to the item by your vendor.

*Vendor Price:* Enter the price of the item from the vendor.

*Country of Origin:* Enter the country of origin for the item.

*Registration Number:* Enter the registration number of the item.
**Product Class Codes**

*Product Class Codes* are used to separate products for sales and data related purposes. Certain *Product Classes* are used internally by RMA to perform special functions in the program. Options such as, charging rentals, deposits, or skipping a customer’s delivery are all controlled by the assigned *Product Class*.

The following *Product Classes* are used internally by RMA and should be assigned to the appropriate items:

- **4 – Equipment Rental**: Assign this class to all rental codes assigned to equipment.
- **5 – Redemption Value**: Assign this class to all redemption codes being used.
- **7 – Deposit Code**: Assign this class to all container deposit codes.
- **9 – Skip Reasons**: Assign this class to all *Skip Reasons* established in the product list.
- *** – Empty Containers**: Assign this class to all empty containers added to the product list.

**NOTE:** If the *Product Classes* above do not exist in RMA, they will need to be added to the program.

**NOTE:** Refer to *Chapter 2.04 of the Supplemental Guide* for a complete tutorial on setting up container deposits and empty bottle tracking.

In addition to the *Product Classes* used internally by RMA, you can add additional classes within the *Product Class Codes* screen; for example, *Product Class* ‘W’ has been added below for water products that require a deposit.

![Product Class Codes Screen](image)

**Fields:**

- **Class**: Enter up to two characters that will represent the *Product Class Code*.
- **Description**: Enter a description for the *Product Class Code*.
- **Short Description**: Enter a short description that will be used on the *Business Flash Report*. 
**Include on Business Pulse Report:** Select this option to include all products sold under this class on the Business Pulse Report.

**Product Class Used for Equipment Sales:** Select this option if this class will be used for equipment sales codes.

**NOTE:** Refer to Chapter 3.15 of the Supplemental Guide for further information on this topic.

**Coupon Book Sale:** Choose this option to use this Product Class for coupon processing.

**Direct Meter Transfer Code:** Select this option to enable ‘capacity’ entries on the handheld for items assigned to this class — this feature is generally used in the propane industry.

**Show as Qty in RMLive:** Select this option to display quantity details for items assigned to this class within the RMLive Console screen.

**NOTE:** The RMLive Module allows your drivers to receive and transmit data from the field during the route day. Contact Advantage Route Systems for further information.

**Display on Internet (eStoreFront Module):** Check this box if this Product Class should be available on the eStoreFront Web site.

**Equipment Status Change:** Select this option to enable the Equipment Status Code update field within the Accounting tab of the Product Charge Codes screen.

**NOTE:** This option allows you to select an Equipment Status Code within the Product Charge Code screen that can be used for updating status codes on equipment related invoices.

### Deposit Types

The Deposit Types option is used to filter your different container deposit types within RMA. For example, this can be helpful for identification purposes if you would like to track or charge deposits for pallets, water bottles, etc.
Fields:

Deposit Type ID: Enter up to five characters that will represent the Deposit Type.

Description: Enter a description for the Deposit Type.
Web Class Codes

Web Class Codes are used to categorize the items you would like available on your eStoreFront Web site. Contact Advantage Route Systems for further information on the eStoreFront module.

Fields:

Web Class: Enter up to three characters that will represent the Web Class Code.

Description: Enter a description for the Web Class Code.

Display Order: Enter a number that will be used to control the display order of the Web Class Code on the Web site.

Enable on Web: Select this option to enable this Web Class Code on the Web site.
Product Group Codes

*Product Group Codes* allow products to be grouped together for filtering purposes on the handheld. For example, if all coffee products are assigned to the ‘Coffee’ *Product Group*, the driver can easily filter out other products from the list to speed up the entry process. Also, if certain drivers do not deliver coffee products, these items can be removed from their product list completely.

**NOTE:** This option is controlled on two levels: within the *Product Charge Codes* screen under *Lists > Product Codes*, on the *Handheld* tab you can assign each product to the appropriate *Product Group Code*. In addition, within the *Route Master* screen, under *Lists > Routes*, you have the ability to enable or disable each group of products that will be transferred to the handheld.

### Fields:

**Group Code:** Enter up to five characters that will represent the *Product Group Code*.

**Description:** Enter a description for the *Product Group Code*.

**Qty Discount Pricing:** Select this option to enable the *Product Group Discount* feature on items that are assigned to this *Product Group Code*. Enter a discount percentage for each level that will be used. To establish a cap in the highest level observed, enter ‘9999’ in the To field (displayed below).

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>0.000</td>
</tr>
<tr>
<td>11</td>
<td>30</td>
<td>5.000</td>
</tr>
<tr>
<td>51</td>
<td>9999</td>
<td>15.000</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
</tbody>
</table>

**NOTE:** Refer to *Chapter 2.01* of the *Supplemental Guide* for further information on the *Product Group Discount* feature.
Primary Category Codes

Primary Category Codes are part of an enhanced product filtering option that can be used on the handheld.

NOTE: This option works with the Product Group Codes and Secondary Category Codes options. To enable the product category feature on the handheld, select ‘Use Product Categories in Miscellaneous Sales’ within Branch Setup, on the Handheld tab.

Fields:

Group Code: Enter up to five characters that will represent the Primary Category Code.

Description: Enter a description for the Primary Category Code.

Secondary Category Codes: Enable or disable the Secondary Category Codes associated with the Primary Category Code by toggling between ‘Yes’ or ‘No’.

EXAMPLE: If a company sells fresh flowers, the Primary Category Code may represent the cut of the flower (e.g., Long Stem).

An example of how a flower company may use the category feature:

- Primary Category Code: Long Stem
- Secondary Category Code: Roses
- Product Group Code: Red
Secondary Category Codes

Secondary Category Codes are part of an enhanced product filtering option that can be used on the handheld.

**NOTE:** This option works with the Product Group Codes and Primary Category Codes options. To enable the product category feature on the handheld, select ‘Use Product Categories in Miscellaneous Sales’ within Branch Setup, on the Hanhdeld tab.

![Secondary Category Codes](image)

**Fields:**

- **Group Code:** Enter up to five characters that will represent the Secondary Category Code.
- **Description:** Enter a description for the Secondary Category Code.
- **Product Group Codes:** Enable or disable the Product Group Codes associated with the Secondary Category Code by toggling between ‘Yes’ or ‘No’.

**EXAMPLE:** If a company sells fresh flowers, the Secondary Category Code may represent the type of flower (e.g., Roses).

An example of how a flower company may use the category feature:

- **Primary Category Code:** Long Stem
- **Secondary Category Code:** Roses
- **Product Group Code:** Red
Product Unit Codes

Product Unit Codes allow you to add multiple types of units for a single product; for example, a company that sells soft drinks may add Can, 6-Pack, and Case to the program.

NOTE: This option is part of the Multi-Unit Pricing option in RMA, refer to Chapter 2.14 of the Supplemental Guide for further information.

**Fields:**

*Code*: Enter up to five characters that will represent the Product Unit Code.

*Description*: Enter a description for the Product Unit Code.
Product Price Lists

The Product Price Lists option provides a convenient way of assigning a group of products to your customers at the prices and quantities entered within each list.

**Fields:**

- **Price List:** Enter up to four digits that will represent the Product Price List.
- **Description:** Enter a description for the Product Price List.
- **Promotional Price List:** Select this option to establish the current Price List as part of a date-controlled promotion.

**NOTE:** Refer to Chapter 2.01 of the Supplemental Guide for further information on Promotional Price Lists.

- **Start Date (Promotional Price List):** Enter the date for activation of this Promotional Price List.
- **Expire Date (Promotional Price List):** Enter the expiration date for this Promotional Price List.

**NOTE:** The options below are not displayed in modify mode.

- **View by Products:** The default view of the Product Price List screen.
- **View by Customer:** Select this option to view each account assigned to the current Product Price List.
Adding Products:

Choose the Add button to add products to the Price List. Select a product, and enter the desired price and quantity.

Fields:

Product Code: Select the desired Product Charge Code.

Description: The description of the selected Product Charge Code.

Promotional Price List: This pricing method allows you to offer promotional prices to your customers for a specific length of time. This is helpful if the customer will only qualify for a price temporarily.

Start Date (Requires Promotional Price List): Enter the start date for activation of this Promotional Price List.

Expire Date (Requires Promotional Price List): Enter the end date for this Promotional Price List.

NOTE: For further information on Promotional Price Lists, refer to Chapter 2.01 of the Supplemental Guide.

Product Code: Select the product code to be added to the Price List.

Price: The default price of the Product Charge Code. This price can be updated if necessary.

Quantity: The default quantity for the Product Charge Code. The quantity field can be updated if necessary.

Qty Pricing: Select this option to use the Quantity Discount Pricing option for the item.

NOTE: For further information on Quantity Discount Pricing, refer to Chapter 2.01 of the Supplemental Guide.

Retain Level: Select this option to retain each customer’s Price Level assignment for the item.

Cost Plus Set: Select this option to establish Cost Plus Pricing on the item.

Find: Use this option to search for items within the list by code or description.

Do not show Price List in Default Products: Select this option to hide the items assigned to the current Price List, within each assigned account, in the Default Products list of Customer Information.
Period Discount Pricing

The Period Discount Pricing option allows you to offer product discounts to your customers based on an established quantity of items purchased over a period of time (i.e., Monthly, Quarterly, or Yearly).

NOTE: For detailed information on this option, please refer to Chapter 2.15 of the Supplemental Guide.
Promotional Price Codes

This option is part of the Promotional Pricing (or Buy/Gets) Module, which allows you to offer free or reduced priced items to your customers if they purchase a pre-established quantity of qualified products. For example, if a customer purchases 5-bottles of water on a single invoice, perhaps they receive a free “Souvenir Mug” at no charge, or a free bottle of water.

NOTE: For further information on this module, please contact Advantage Route Systems.
Promotional Price Class

This option is part of the *Promotional Pricing (or Buy/Gets) Module*, which allows you to offer free or reduced priced items to your customers if they purchase a pre-established quantity of qualified products. For example, if a customer purchases 5-bottles of water on a single invoice, perhaps they receive a free “Souvenir Mug” at no charge, or a free bottle of water.

**NOTE:** For further information on this module, please contact Advantage Route Systems.

---

Promotional Price Group Codes

This option is part of the *Promotional Pricing (or Buy/Gets) Module*, which allows you to offer free or reduced priced items to your customers if they purchase a pre-established quantity of qualified products. For example, if a customer purchases 5-bottles of water on a single invoice, perhaps they receive a free “Souvenir Mug” at no charge, or a free bottle of water.

**NOTE:** For further information on this module, please contact Advantage Route Systems.
Daily Cost Recording

*Daily Cost Recording* allows you to automatically adjust each customer’s retail price based on the wholesale cost of each product. This feature is typically used if you sell commodities with fixed prices over wholesale.

**NOTE:** Refer to Chapter 2.01 of the Supplemental Guide for further information on *Daily Cost Recording*.

**Fields:**

- **Charge Code:** The *Base Unit* that will be used for cost adjustments.
- **Valid Date:** The date that the updated cost should be used.
- **Cost:** The updated cost of the *Base Unit*.
- **Replacement Cost:** Enter an alternate cost value to use for figuring the price that the customer will receive.

**NOTE:** If *Replacement Cost* is left blank, the *Cost* field will be used for figuring the *Cost Plus* price.

- **Comment:** Enter a miscellaneous note that will be associated with the entry.
- **Branch:** The company branch that the update will apply to.
- **Employee:** The employee that created the adjustment.
Gratis Reason Codes

Gratis Reasons can be logged on invoices for items given to the customer at no charge (e.g., Damaged Product, Promotion). This information is permanently stored per item and can be reviewed within the Gratis Sales by Route Report.

Fields:

ID: Enter a single character that will represent the Gratis Reason.
Description: Enter a description for the Gratis Reason.
Short Description: Enter up to two characters that will represent the Gratis Reason on certain reports that cannot display the complete description.

Package Plans

This option is part of the Package Plan Module, which allows you to offer a flat-rate billing program to your customers. For example, a plan can be created that offers your customers 5 bottles of water and a rental for 35.00 dollars a month. This flat-rate will be billed monthly.

NOTE: For further information on this module, please contact Advantage Route Systems.
Warehouse Setup

Permanent warehouses need to be established for each company branch added to RMA to assist with inventory processing.

NOTE: Refer to Chapter 3.10 of the Supplemental Guide for further information on inventory, as well as the Enhanced Inventory option.

Fields:

Warehouse: Enter up to ten characters that will represent the warehouse.

Pallet Reference Code: Enter a reference code that you would like to include in Pallet Identification Codes generated and printed within the Inventory Adjustments screen.

NOTE: A unique Pallet ID can be generated and printed for each inventory item received in RMA, and can be attached to the pallet that contains the items. The Pallet ID will only be generated on Inventory Adjustment Codes with the option ‘Require Pallet Number’ selected under Lists > Product Codes. An optional Warehouse Prefix (File > Branch Setup > Defaults) can be included in the Pallet ID as well.

Name: Enter the description of the warehouse.

Branch: Select the Branch responsible for the operation of the warehouse.

Warehouse Type: Select the type of warehouse being used. For example, each company branch should be assigned a ‘Permanent’ warehouse.

NOTE: Refer to Chapter 3.10 of the Supplemental Guide for further information on Warehouse Types.

Latitude/Longitude: Enter the lat/long coordinates for the warehouse. This information is used with optional GPS features in RM2000.
**Break down pallets entering this warehouse:** Select this option to automatically breakdown pallet quantities when transferring pallets (Pallet ID) to an alternate warehouse.

**NOTE:** This option works with the Pallet Reference Code option located at the top of the Warehouse Setup screen. Refer to this option for further information.

**Warehouse Quantity (Read Only):** The total quantity of product stored in this location.

**Transit Quantity (Read Only, Enhanced Inventory Required):** The total ‘in transit’ quantity from this location.

**Unposted Quantity (Read Only, Enhanced Inventory Required):** The total quantity of product uploaded and waiting to be posted.

**Damaged Quantity (Read Only, Enhanced Inventory Required):** The amount of damaged inventory stored in this location.

**NOTE:** For further information on damaged and returned product tracking, refer to Chapter 2.13 of the Supplemental Guide.
Inventory Adjustment Codes

Inventory Adjust Codes are required each time an entry is made within the Inventory Adjustments screen found under Transactions > Inventory. The codes created should reflect the needs of the company (i.e., Purchased Product, Received Product, Bad Product, etc).

NOTE: For further information on managing inventory, refer to Chapter 3.10 of the Supplemental Guide.

Fields:

Code: Enter up to two characters that will represent the Inventory Adjustment Code.

Reason: Enter a description for the Inventory Adjustment Code.

Reverse Quantity: Select this option to remove the quantity entered from inventory when using this code (e.g., Loss from Theft).

Require Receiving Warehouse: Select this option to require a receiving warehouse during entry.

Require Transfer via Warehouse: Select this option to require that a ‘transfer’ warehouse be entered when using this adjustment code (e.g., trailer, truck).

Returned Goods (Handheld) / Damaged: This option is part of the damages and returns process in RMA. Refer to Chapter 2.13 of the Supplemental Guide for more information.

Require New Manufacturing Batch No.: Select this option to require that a Production Batch Code be entered each time an entry is made within the Inventory Adjustments screen using this code.

Do Not Require Cost: Select this option if the adjustment code will be used for items that do not require ‘cost’ information.

Refill Container Stock: Select this option to use the adjustment code for empty container refilling purposes.

NOTE: This option can be used to simplify the adjustment process by making a single entry for removing empty containers from stock, and producing full containers. Refer to the Inventory Adjustments screen for further information.
**Handheld Inventory Code:** Select this option to use this inventory adjustment code on the handheld.

**NOTE:** This option is used with the Handheld Inventory Module, which allows you to control RMA inventory on the handheld. Refer to Chapter 3.10 of the Supplemental Guide for further information.

**Require Pallet Number/Print:** A unique Pallet ID can be generated and printed for each inventory item received within the Inventory Adjustments screen, and can be attached to the pallet that contains the items.

**NOTE:** An optional Warehouse Prefix (File > Branch Setup > Defaults) and Pallet Reference Code (Lists > Product Codes > Warehouse Setup) can be included in the Pallet ID if desired.

**Default Quarantine Status:** Select this option to use the adjustment code to hold items in ‘quarantine’ prior to selling them.

**Cost of Goods G/L Number:** This option is part of the damages and returns process in RMA (refer to Chapter 2.13 of the Supplemental Guide for more information).

**Allow Access to Processor Type:** Select this option to allow ‘Processor’ employee types to view and create entries using the current Inventory Adjustment Code.

**NOTE:** Employee Types can be assigned under Lists > Employee Setup > Employees.
Quarantine Status Codes

This option is used for special instructions on inventory items, such as hold times.

NOTE: These codes can be applied to items within Transactions > Inventory > Inventory Adjustments.

Fields:

**Code**: Enter up to two characters that will represent the Quarantine Status Code.

**Description**: Input a description for the Quarantine Status Code.

**Warn on Transaction Entry**: A warning will be displayed if an item is sold that is assigned to this code.

**Warn on Inventory Entry**: A warning will be displayed when this inventory code is used.
Shipper List Codes

Shipper List Codes are used to identify shipping companies within the Supply Chain Orders program in RMA.

NOTE: Supply Chain Orders are used for order “picking” and expiditing within RMA. For further information on this feature, refer to Chapter 4.09 of the Supplemental Guide.

Fields:

ID: Enter up to three characters that will represent the Shipper List Code.

Description: Enter a description for the Shipper List Code.

Do Not Adjust Inventory: Select this option to disable inventory adjustments on entries created using the current Shipper List Code.
Production Batch Codes

*Production Batch Codes* can be assigned to products input through the *Inventory Adjustments* screen in order to track them for recall purposes.

**NOTE:** Refer to Chapter 4.02 of the *Supplemental Guide* for further information on *Production Batch Codes*.

**Fields:**

- **Production Code:** Enter up to ten characters that will represent the *Production Batch Code*.
- **Production Date:** Enter the date the product was produced.
- **Status:** Enter the quarantine status of the product.
- **Product Charge Code:** Enter your company Product Charge code for this product.
- **Quantity Produced:** Enter the quantity produced or in inventory if known.
EDI Output Codes

EDI (Electronic Data Exchange) Output Codes are required by certain companies that need invoices to be processed electronically.

NOTE: For further information on EDI exporting, contact Advantage Route Systems.

Fields:

**Code:** Enter up to six characters that will represent the EDI Output Code.

**Description:** The description of the EDI Output Code.

**Output Folder:** The folder the exported data will be placed in.

**Comm. ID:** The identification code assigned to the company.

**EDI Program:** The program to use when exporting the data.

**Transport:** The type of transfer that will be used.

**E-Mail:** The E-mail address to use when using the ‘E-Mail’ Transport type.

**FTP Parameters:**

**Server IP:** The IP (Internet Protocol) address of the remote server.

**FTP User:** The FTP (File Transfer Protocol) username assigned to your company.

**FTP Password:** The FTP (File Transfer Protocol) password assigned to your company.

**Other:**

**Data Prefix Code:** Used with ‘BAT’ export only.

**Invoice Prefix Code:** Used with ‘BAT’ export only.

**Export After Posting:** Select this option to automatically export data during the Post Transactions process.
Order Completion Codes

Order Completion Codes are used to complete orders within the Supply Chain Orders program in RMA.

NOTE: Supply Chain Orders are used for order “picking” and expiditing within RMA. For further information on this feature, refer to Chapter 4.09 of the Supplemental Guide.

Fields:

ID: Enter up to three digits that will represent the Order Completion Code.

Description: Enter a description for the Order Completion Code.

Allow Zero Quantity: Select this option to complete an order without a quantity entry.
Order Rejection Codes

Order Rejection Codes are selected on the handheld to reject order requests dispatched through the RMLive program.

NOTE: The RMLive program allows Deliver Orders to be dispatched to drivers throughout the delivery day using real-time data transfers. Contact Advantage Route Systems for further information.

Fields:

ID: Enter up to three characters that will represent the Order Rejection Code.

Description: Enter a description for the Order Rejection Code.

Day End Reject Code: Select this option to use this code to reject all remaining orders during the delivery day.
Accounting Setup

The Accounting Setup feature allows you to configure accounting related options in RMA.

- Sales Tax Rates
- Asset Tax Code
- Statement Assessment Code
- General Ledger Setup
- Bank Accounts
- Preferred Payment Methods
- Credit Card Groups Setup
- Departments
- Refund Check Setup
- Daily Cash Recording Setup
- Write-Off Reasons
- Credit Note Reasons

Each option is covered in this section.
Sales Tax Rates

Most states require you to collect sales tax from your customers on certain products. RMA allows you to control which products are to be charged sales tax, and the rates that apply.

Setting up sales tax in RMA involves two steps:

1. Creating component rates as Tax Authorities.
2. Creating Tax Codes by assigning one or more Tax Authorities.

NOTE: For a complete tutorial on setting up Sales Tax Codes in RMA, refer to Chapter 2 of the Getting Started Guide.

Sales Tax Codes

Sales Tax Codes combine individual Tax Authorities to create the total tax rate that will be billed.

![Sales Tax Codes](image)

**Fields:**

- **Tax Code:** Enter an eight-character code that will represent the Sales Tax Code.
- **Authorities:** Select up to four tax authorities that will create the total rate charged for sales tax.
- **Description:** Enter a description for the Sales Tax Code.
- **Handheld Description:** This option is currently in development.
- **QuickBooks Tax Code:** Enter the QuickBooks tax code that is associated with the current code when importing data into QuickBooks.

NOTE: This option is part of the QuickBooks Integration mode available within RMA. Contact ARS for further information.

**Total Tax Rates (Read Only):** Displays the combined rate of the selected authorities by product type.

**G/L No:** Select the general ledger number that the sales tax code should be assigned to (i.e., a liability account, such as Sales Tax Payable).

**Assess Bottle Redemption:** Select this option to enable the ‘Redemption Value’ option (e.g., CRV in California).
NOTE: Redemption Value Codes can be assigned to products under Lists > Product Codes > Product Charge Codes, on the Pricing tab. Additionally, each Redemption Code established will need to be assigned to Product Class ‘5’ to become available.

**Inactive:** Choose this option to disable the Sales Tax Code.

**Do Not Update (MangoGeo option):** Select this option if you are using the optional MangoGeo module to update your Sales Tax Codes and you would not like the current tax code rates to be changed.

### Authorities Tab

Tax Authorities represent the individual entities that create the total tax rate (i.e., State, County, and Local) in your area. The following screen allows each tax authority and rate to be entered individually.

![Authority Tab Screen](image)

**Fields:**

- **Authority ID:** Enter up to eight characters that will represent the Tax Authority.
- **Authority Description:** Enter a description for the Tax Authority.
- **Line Item Designation:** Enter the identification code that you would like to display on invoices and receipts for the Tax Authority.
- **Note (Optional):** This field can be used to store additional information, if needed.

**Tax Rates:**

Enter the tax rate for the individual authority within each tax category displayed.

NOTE: Each category displayed can be modified under File > Branch Setup, on the Taxes tab. Additionally, each category is listed within the Product Charge Codes screen. For further detail on this information, refer to Chapter 2 of the Getting Started Guide.
Asset Tax Codes

The *Asset Tax Code* is used to identify the location of each piece of equipment added to the *Equipment Master List* for tax purposes.

**Fields:**

*ID:* Enter up to two characters that will represent the *Asset Tax Code.*

*Description:* Enter a description for the *Asset Tax Code.*
Statement Assessment

The *Statement Assessment Code* is used to add a charge to each customer’s statement at the end of the month (e.g., for a statement fee, postage).

![Statement Assessment window](image)

**Fields:**

- **Assessment Code:** Enter a single character that will represent the assessment code.
- **Description:** Enter a description for the assessment code.
- **Charge Code:** Select a *Product Charge Code* that will be used for billing the fee on the account.
- **Charge Amount:** Enter the amount that will be billed to the customer.
- **Inactive:** Select this option to deactivate the assessment code.
- **Apply to Balance at:** Select the aging bucket that the assessment fee will apply towards.
- **Calculate with Late Charges:** Select this option to generate the *Statement Assessment Fees* while processing *Late Charges*.
- **Don’t charge for Collections Accounts:** Select this option to prevent a *Statement Assessment* from being generated on accounts that are currently assigned to a ‘Collections’ *Credit Class Code*. 
General Ledger Setup

RMA will be used for customer related Accounts Receivable tracking in your business. Add all of the general ledger accounts that apply.

**NOTE:** The accounts added should fall under one of six general ledger types available: Cash, Asset, Accounts Receivable, Liability, Revenue, and Expense.

### Fields:

**G/L Number:** Enter up to twenty characters that will represent the General Ledger Code.

**G/L Description:** Enter a description for the General Ledger Code.

**G/L Date:** The date the record was last modified, for reference.

**G/L Acct Type:** Select the type of account that applies to the current entry:

- **Cash:** Add at least one account that will be used for payments received in RMA.
- **Asset:** This option is part of a future enhancement in RMA and is not currently being used.
- **Accounts Receivable:** Add one account which will control all sales in RMA.
- **Liability:** Add multiple accounts for any long or short-term liabilities (e.g., Sales Tax Payable, Container Deposits).
- **Revenue:** Add multiple accounts for product sales (e.g., Water Sales, Coffee Sales, Equipment Rent).
- **Expense:** Add multiple accounts for expenses (e.g., Write-Offs, Refunds).

**Current Unposted:** Not in use currently.

**January-December (Read Only):** Displays posted totals per account for each General Ledger Period.

**Used by (Read Only):** Displays the Product Charge Codes assigned to each account.

**Show in G/L Override Dropdown:** Select this option to enable the ability to assign an alternate G/L number to the item when adding to a customer’s account within Customer Information > Default Products.

**NOTE:** This option is primarily used within the propane industry.
Bank Accounts

At least one Bank Account should be added to RMA for receiving payments. Each account added will be available within the payment screen, and can be established as a default within each customer’s account for convenience.

Fields:

Bank ID: Enter up to two characters that will represent the Bank Account.

Bank Account Description: Enter a description for the Bank Account.

Routing Number: Enter the bank’s routing number.

National Banking: This field is used in Russia only, for reference.

Bank ID: Enter the bank’s identification code.

Legal Name: Enter the bank’s legal name.

Address: Enter the bank’s primary address.

Legal Text: Enter a legal disclaimer, if required.

Check Endorsement: Enter the endorsement that should be placed on checks scanned into the system using the Check21 module.

G/L Number: Select the general ledger account that all payments for this Bank Account will post to.

Inactive: Select this option to disable the Bank Account in RMA.
Preferred Payment Methods

Set up a list of payment methods that will be assigned to your customers. This can be helpful to facilitate certain payment options within RMA.

Fields:

*ID*: Enter an ID for the payment method.

*Description*: Enter a description for the payment method.

Credit Card Groups Setup

Credit Card Groups allow you to bill customers in separate batches throughout the month when using the EC2000 Module.

**NOTE:** The EC2000 Module allows you to process credit card transactions within RMA. Please contact Advantage Route Systems for further information.

Fields:

*Group ID*: Enter a single character that will represent the Credit Card Group.

*Description*: Enter a description for the Credit Card Group.
Departments (Vending Only)

This option is part of the Vending feature in RMA. Please contact Advantage Route Systems for further information.

Fields:

ID: Enter a single character that will represent the Department.

Description: Enter a description for the Department.
Refund Check Code

The *Refund Check Code* screen allows you to define a series of options that determine how RMA generates refunds for your customers.

**NOTE:** You can assign each customer to a refund code under *Customer Information > Credit > Billing/Statement* and select the appropriate code within the *Refund Handling Code* field.

---

### Fields:

- **Refund Code:** Enter up to two characters that will represent the refund check code.
- **Refund Description:** Enter a description for the refund check code.
- **Bank Account:** Select the Bank Account that handles the refund checks.
- **Show on HH as Credit Class:** Select this option to replace the Credit Class with the refund check code on the handheld *Quick Entry* screen.
- **Calculate Check Based On Credit Invoice Amount:** Select this option to refund any credit invoices on the customer’s account.
- **Calculate Check on Net Amount of Charges, Less Credits:** Select this option to refund any amount remaining after applying all credits on the customer’s account.
- **Custom Processing:** Not currently in use.
- **Do Not Generate Refund Check:** Select this option to disable the refund check option for customers assigned to this code.
Daily Cash Recording Setup

The *Daily Cash Recording* feature in RMA allows you to manually record cash collected per route after the data has been uploaded to the desktop. This can be used to verify payment amounts collected from drivers in the office, versus the payment amounts entered on the handheld. If the amount entered into the *Daily Cash Recording Entry* program does not match the amount uploaded, an invoice can be created to charge the driver for any discrepancies.

**NOTE:** For further information on this feature, refer to Chapter 3.19 of the *Supplemental Guide*.

### Fields:

**Description:** Enter a description for each monetary unit.

**Multiplier:** Enter the value of each monetary unit.

**Cash Type 1-14:** Enter up to fourteen monetary units.

**Clear/Use US$ Defaults:** Select this option to clear all of the current monetary unit entries.

**NOTE:** ‘Use US$ Defaults’ becomes available if Clear has been selected, this allows you to load a series of default monetary settings used in the United States.

**Show Checks:** Select this option to display all of the checks received on route within the *Daily Cash Recording Entry* screen. Each check will need to be verified during entry.

**Auto Bill Employee for Shortages:** Select this option to automatically bill the driver for any shortages when the *Lock* button is selected during entry.
Write-Off Reasons

Create a series of Write-Off Reasons that can be selected when using the Finance Assistance option on the Module Bar.

![Write-Off Reasons](image)

**Fields:**

**ID:** Enter up to three characters that will represent the Write-Off Reason.

**Description:** Enter a description for the Write-Off Reason.

Credit Note Reasons

Create a series of Credit Note Reasons that can be selected when using the Finance Assistance option on the Module Bar.

![Credit Note Reasons](image)

**Fields:**

**ID:** Enter up to three characters that will represent the Credit Note Reason.

**Description:** Enter a description for the Credit Note Reason.
Organizing and Tracking Equipment

Equipment tracking in RMA allows you to keep track of equipment rented, loaned, and sold to customers. Each piece of equipment will also have a complete history of service performed, previous locations, and other valuable information.

Equipment Master List

The Equipment Master List screen contains multiple tabs to keep track of important equipment information.

NOTE: Equipment cannot be added to RMA using the Equipment Master List, this must be done within the Equipment Setup Wizard found under Lists > Wizards.

NOTE: Refer to Chapter 2 of the Getting Started Guide for further information on managing equipment in RMA. Additionally, multiple chapters have been added to the Supplemental Guide regarding various equipment options.

Information Tab

The Information tab contains basic information about each piece of equipment.

Fields:

Equip. ID (Read Only): Displays the equipment identification code.

Unit Type: Displays the Equipment Type Code selected for this piece of equipment.

Unit Style: Displays the Equipment Style Code selected for this piece of equipment.

NOTE: Equipment Type and Style Codes can be added to RMA under Lists > Equipment.

Last Change: Each time a record is updated, the ‘change’ date is automatically updated.
Branch: Displays the branch this piece of equipment is assigned to.

Location: Displays additional text regarding the specific location of the piece of equipment.

First Installed: Displays the date the equipment was initially installed on any account.

Comment 1 and Comment 2: Displays optional comments that can be added to each piece of equipment for reference.

Status: This option is part of a future enhancement.

Status Date: This option is part of a future enhancement.

**Purchased / Sales Info:**

*Purchased From:* Displays the vendor the equipment was purchased from. The list of vendors can be added to RMA under *Lists > Equipment > Manufacturers List.*

*Date Purchased:* Displays the date the unit was acquired from the vendor.

*Purchase Cost:* Displays the purchase price from the vendor.

*Warranty Exp:* Displays the date the warranty expires with the vendor.

*Financed:* Select this option if the equipment is financed with the vendor.

*Active Lease:* Select this option if there is an active lease with the vendor.

*Manufactured Date:* The year the piece of equipment was built.

*Sold Price:* Displays the purchased price if the unit has been sold to a customer.

*Sold Date:* Displays the date the unit was purchased by a customer.

*Sold As:* Check the appropriate box to indicate whether the unit was new or used at the time of the sale, for tax reference purposes.

*Owned By Customer:* Select this option if the customer owns their own equipment. This option can be used to offer equipment servicing on customer owned equipment.

*Destroyed:* Select this option if the equipment was destroyed and is no longer in service.

*Deposit Amount:* Displays a security deposit paid by the customer, if applicable.

*Equipment ID2:* Enter an alternate serial number for each unit (e.g., a factory serial number).

*Model number:* Displays an equipment model number supplied by the vendor.

*Capacity:* Enter the total number of items the unit can hold (e.g., for Racks, Cages).

*Container Charge Code:* Select the primary product that the unit will hold.

**NOTE:** The *Capacity* and *Container Charge Code* fields are part of the *Cylinder Exchange* option found under *Lists > Routes > Handheld Class,* on the *Sales Rules* tab.
**Tank Type (Oil Recycling Industry):** Select the type of tank that applies to the equipment.

**Minimum Level:** This item is currently in development.

**Maximum Level:** This item is currently in development.

**Equipment Service Calendar:** This button allows equipment service scheduling to be established.

To schedule equipment service, simply click on the appropriate day on the calendar and you will be prompted to enter an *Equipment Service Code*.

---

**NOTE:** *Equipment Service Codes* can be added to RMA under *Lists > Equipment > Equipment Service Codes*. Refer to Chapter 3.14 of the *Supplemental Guide* for further information.

---

On the calendar, regular delivery days for the customer will be displayed in green, while scheduled service days are displayed in red.

**Equipment Document Filing:** This button is part of the EF2000 module which allows you to scan and store legal documents (rental agreements, service agreements, etc.) within the RMA program. Please contact ARS for further information.
**Rents Tab**

The *Rents* tab displays rent related information on each piece of equipment.

**NOTE:** Multiple rent codes can be enabled, if necessary. Select the option ‘Use Multiple Rent Codes’ under *File > Branch Setup*, on the *Equipment* tab.

![Equipment Master List](image)

**Fields:**

**Statement Billed:** Select this option to bill rent for this piece of equipment on the desktop. Alternatively, leave the option unchecked to bill rent on the handheld.

**NOTE:** For more information on generating rent, refer to *Chapter 3.11* of the *Supplemental Guide*.

**Asset Tax:** This field is available for tracking coolers by location based on the assigned *Asset Tax Code* — this is generally used for personal property tax.

**NOTE:** *Asset Tax Codes* can be added to RMA under *Lists > Accounting Setup*.

**Contract Expiration Date:** Enter the expiration date for a current equipment lease, if applicable.

**Contract ID:** Enter an identification code for a current equipment lease, if applicable.
**Period Code:** Displays the default rent billing frequency. There are multiple options available, refer to the chart below:

<table>
<thead>
<tr>
<th>Freq:</th>
<th>Due in:</th>
<th>Code:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annually</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>January</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>February</td>
<td>B</td>
</tr>
<tr>
<td></td>
<td>March</td>
<td>C</td>
</tr>
<tr>
<td></td>
<td>April</td>
<td>D</td>
</tr>
<tr>
<td></td>
<td>May</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td>June</td>
<td>F</td>
</tr>
<tr>
<td></td>
<td>July</td>
<td>G</td>
</tr>
<tr>
<td></td>
<td>August</td>
<td>H</td>
</tr>
<tr>
<td></td>
<td>September</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>October</td>
<td>J</td>
</tr>
<tr>
<td></td>
<td>November</td>
<td>K</td>
</tr>
<tr>
<td></td>
<td>December</td>
<td>L</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly</td>
<td>M</td>
</tr>
<tr>
<td></td>
<td>Odd Months</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Even Months</td>
<td>P</td>
</tr>
<tr>
<td>Quarterly</td>
<td>1st month of Quarter</td>
<td>Q</td>
</tr>
<tr>
<td></td>
<td>2nd month of Quarter</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>3rd month of Quarter</td>
<td>S</td>
</tr>
<tr>
<td>Semi-Annually</td>
<td>Jan. / July</td>
<td>T</td>
</tr>
<tr>
<td></td>
<td>Feb. / August</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td>Mar. / September</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>Apr. / October</td>
<td>W</td>
</tr>
<tr>
<td></td>
<td>May / November</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>June / December</td>
<td>Y</td>
</tr>
<tr>
<td>MISC.</td>
<td>No Rent</td>
<td>Z</td>
</tr>
<tr>
<td></td>
<td>Rent Schedule 1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Rent Schedule 2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Rent Schedule 3</td>
<td>@</td>
</tr>
<tr>
<td></td>
<td>Rent Schedule 4</td>
<td>#</td>
</tr>
<tr>
<td></td>
<td>Sold Cooler</td>
<td>3</td>
</tr>
<tr>
<td>Freq:</td>
<td>Due in:</td>
<td>Code:</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------</td>
<td>-------</td>
</tr>
<tr>
<td></td>
<td>Trial cooler</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Rental Groups</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>Jan. / May / Sept.</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>Feb. / June / Oct.</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>Mar. / July / Nov.</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>April / Aug. / Dec.</td>
<td>9</td>
</tr>
<tr>
<td>Deposit Equipment</td>
<td>N/A</td>
<td>+</td>
</tr>
<tr>
<td>Lease Equipment</td>
<td>N/A</td>
<td>=</td>
</tr>
</tbody>
</table>

**Charge Code:** Displays the rental code assigned to this piece of equipment.

**Period Rate:** Displays the rental rate assigned to this piece of equipment.

**Rental Group (Optional):** Displays the Rental Group Code assigned to the piece of equipment.

**NOTE:** Rental Groups allow you to generate rents in separate batches throughout the month. For further information on this feature, refer to Chapter 3.11 of the Supplemental Guide.

**Rent Day:** This field is not in use currently.

**Start Rent On:** Displays the start rent date for this piece of equipment. This can be helpful for delaying a rental charge for a period of time.

**Stop Rent On (Optional):** Displays the rent termination date. This can be helpful if you have an equipment rent contract with the customer.

**Last Rent Billed:** Displays the last date that rent was billed for this piece of equipment.

**Rent Pending:** This date is used internally by the system to prevent double-billing customer rentals and should not be modified.

**Current Rent From and To:** Displays the date range of the current rental period.

**Year Revenue:** Displays the total amount in rent billed for the year.

**Total Revenue:** Displays the total amount in rent collected for the life of the unit.
Customer History Tab

The Customer History tab contains historical data on previous installation locations.

**NOTE:** Data cannot be changed on this screen. The information is automatically updated when equipment is placed in a new location.

**Fields:**

- **Acct Number:** Displays the account number that the piece of equipment is currently assigned to.
- **Account Name:** Displays the name on the account that the piece of equipment is currently assigned to.
- **Date Installed:** Displays the installation date of the equipment currently assigned to the account.
- **Gross Rents:** Displays the total rental amount billed on the account for the piece of equipment.
- **Date Out:** Displays the date the piece of equipment was removed from the account.
Location Tab

The Location tab displays the current location of the selected piece of equipment.

**NOTE:** Data cannot be changed on this screen. The information is automatically updated when equipment is placed or removed on each account directly, or while using the Equipment Movement option. Refer to Chapter 3.05 of the Supplemental Guide for further information.

### Fields:

Each ‘radio’ button listed represents the current location of the piece of equipment. The options are:

- **Warehouse:** Currently assigned to the warehouse, ready to be installed.
- **On Truck:** Currently out for delivery or left on a delivery vehicle.
- **Installed:** Currently assigned to a customer’s account.
- **Picked Up:** Currently picked up from a customer, and pending location update.
- **Received:** Currently received in a staging area.
- **Service:** Currently out for equipment service.
- **Suspense:** Currently prevented from being assigned to a customer.
- **Write Off:** Currently lost, stolen, or not suitable for a customer.

**Date:** The date the equipment entered the location.

**Time:** The time the equipment entered the location.

**By:** The initials of the employee that transferred the equipment to the indicated location.

**Name:** The name of the employee that transferred the equipment to the indicated location.
Service History Tab

This tab displays the complete service history for this piece of equipment.

NOTE: Data cannot be changed on this screen. The information is automatically updated when an entry is made on the handheld, or from within the Equipment Service option on the desktop. Refer to Chapter 3.14 of the Supplemental Guide for further information.

Fields:

Code: The Equipment Service Code used.
Service Description: The Equipment Service Code description.
Date: The date the equipment service was performed.
Time: The time of day the equipment service was performed.
By: The employee that performed the equipment service.
Hrs: The total number of hours spent servicing the equipment.
Labor Amt: The labor cost associated with the service performed.
Parts Amt: The equipment parts charge associated with the service performed.
Year Repair: Displays the total labor and parts costs for the current year.
Total Repair: Displays the total labor and parts costs for the life of the unit.
Equipment Type

Equipment Type Codes represent the various types of equipment available to your customers.

Fields:

Equipment Type: Enter up to five characters that will represent the Equipment Type Code.

Description: Enter a description for the Equipment Type Code.

Charge Code (Optional): Select a default rent code for this equipment type. This option works within the Equipment and New Customer Wizards.

Use as Cylinder: Select this option of the current Equipment Type will be included in cylinder equipment scans on the handheld.

Flash Report Options:

Equipment Type: Choose the category to use for Equipment Types on the Flash Report.

NOTE: Refer to User Guide B for further information on the Flash Report.

Other:

Capacity: Enter the number of units the container type can hold, if applicable.
Equipment Style

*Equipment Style Codes* represent the various styles of equipment available to your customers.

**Fields:**

- **Equipment Style:** Enter up to three characters that will represent the *Equipment Style Code*.
- **Description:** Enter a description for the *Equipment Style Code*. 
Equipment Type and Style Assignment

This option allows you to associate *Equipment Type* and *Style Codes* with *Equipment Rent Codes*. Using this option will allow you to automatically populate the *Type* and *Style* fields within the equipment ‘Orders’ sections of the *Delivery Order* and *New Customer Wizard* after selecting a rent code.

**Fields:**

*Product Code:* Select the rental code that will be assigned a default type and style.

**Associations:**

*Equipment Sell Charge Code:* Select a default ‘selling’ code to associate with the current type and style (only used in Germany).

*Equipment Type:* Select the default *Equipment Type* for this rental code.

*Equipment Style:* Select the default Equipment Style for this rental code.
Equipment Status Codes

The Equipment Status Codes are used on certain reports within RMA to help you more easily identify the status of each piece of equipment in inventory.

**Fields:**

- **Status ID:** Enter up to four characters that will represent the Equipment Status Code.
- **Description:** Enter a description for the Equipment Status Code.
- **New/In Stock Equipment Status Code:** Select this option if the status code applies to new/in stock pieces of equipment.

**Posting Options:**

Select any of the install/uninstall options that you would like to apply during the Post Transactions process for equipment transfer entries on equipment assigned to the current Equipment Status Code.

- **Install Equipment:** This option is currently in development.
- **Update Period Code:** Select this option to update the assigned Equipment Period Code for install/uninstall entries during the posting process.
- **Update Period Rate:** Select this option to update the assigned Equipment Period Rate for install/uninstall entries during the posting process.
- **Update Product Charge Code:** Select this option to update the assigned rental product code for install/uninstall entries during the posting process.
- **Update Deposit:** This option is currently in development.
- **Update Lease:** This option is currently in development.
Manufacturer List

The Manufacturers List is used as a database for vendors that you purchase equipment from. These codes can be assigned to each piece of equipment.

**Fields:**

*ID*: Enter up to two characters that will represent the Equipment Manufacturer Code.

*Description*: Enter a description for the Equipment Manufacturer Code.
Equipment Service Codes

An Equipment Service Code should be created for each reason that equipment service will be scheduled and performed.

NOTE: For further information on equipment service, refer to Chapter 3.14 of the Supplemental Guide.

**Fields:**

*Service Code:* Enter up to three characters that will represent the Equipment Service Code.

*Description:* Enter a description for the Equipment Service Code.

*Service Hours:* Enter the number of hours required to perform the indicated service.

*Service Parts $:* Enter the cost of all parts necessary to perform the service.

*Equipment Pickup Code:* Select this option to designate this service code as a ‘pickup code’, which will be required each time a piece of equipment is removed from an account.

*Handheld Service Code:* Select this option to display this service code on the handheld.

*Sent for External Repair:* Select this option if the service code will be used on equipment sent out for external repair.

*Warranty Repair:* Select this option if the service code will be used on equipment repaired under warranty.

*Labor Amount (W/ Warranty Repair):* Enter the labor amount billed under a warranty repair.

*Parts Amount (W/ Warranty Repair):* Enter the cost of parts billed under warranty repair.

*Direct Customer Billing Code:* If you would like to bill the customer directly for parts or labor associated with the service code, add a Product Charge Code here that will automatically be billed to the customer when an Equipment Service Day is scheduled through the Delivery Order screen.
Generate Service Schedule [ ] Days From Handheld Service: To support recurring equipment cleaning or sanitation, enter the number of days that RMA should automatically schedule a service day again for the same code.

- On exact date
- First day of month
- Last day of month

Equipment Faults

Equipment Faults allow you to create a series of codes that indicate what the initial problem reported on a piece of equipment was. This option will be in addition to the Equipment Service Code.

**Fields:**

**ID:** Enter up to two characters that will represent the Equipment Fault Code.

**Description:** Enter a description for the Equipment Fault Code.
Equipment Label Generator

The *Equipment Label Generator* allows you to generate new equipment serial numbers in RMA, and print pre-formatted labels that can be placed on each unit added to inventory.

![Generate Equipment Master Items](image)

**Fields:**

- **Starting Equipment Number:** Enter the starting serial number value that you would like to use.
- **Number of Equipment to Generate:** Enter the number of new serial numbers to generate.
- **Default Type:** Select the default *Equipment Type Code*.
- **Default Style:** Select the default *Equipment Style Code*.
- **Purchased From:** Select the default *Manufacturer Code*.
- **Purchased Date:** Enter a default *Purchased Date*.
- **Purchased Price:** Enter a default *Purchased Price*.
- **Location:** Select a default *Location*.
- **Period Code:** Select a default rental *Period Code*.
- **Charge Code:** Select a default rental *Product Charge Code*.
- **Branch:** Select a default *Branch*.
- **Equipment Status:** Select a default *Equipment Status Code*.
Equipment Label Setup

The Equipment Label Setup feature allows you to format labels that can be printed and placed on new pieces of equipment added to inventory.

**NOTE:** This feature will allow you to globally add equipment to RMA, as well as generate labels for identification purposes. Equipment labels can be generated and printed under Lists > Equipment > Equipment Label Generator.

---

**Include:**

For the following options, select the fields that you would like to include on each label, and the order to use:

- **Equipment Bar Code:** Displays the barcode of the unit.
- **Serial Number:** Displays the serial number assigned to the unit.
- **Type:** Displays the Equipment Type Code assigned to the unit.
- **Style:** Displays the Equipment Style Code assigned to the unit.
- **Manufacturer:** Displays the Manufacturers Code (vendor) assigned to the unit.
- **Purchase Date:** Displays the purchase date of the unit.

**Paper:**

Select one of the following options:

- **Ticker Tape:** Used for ticket tape label devices (e.g., Brother ProXL).
- **HP Label:** Used for 70x36 24 Sheet HP label device.

**Preview:**

Displays a preview of how the printed label will appear.
**Font:**

*Test Lines 1-4:* Contains the font settings that will be used on the label.

*Barcode:* Contains the barcode font that will be used on the label.

**NOTE:** Select the browser button next to each line to change the assigned font.

**Barcode Top:** Enter a numeric value in this field to offset the barcode from printing towards the top of the label.

**Barcode left:** Enter a numeric value in this field to offset the barcode from printing towards the left side of the label.

**Tank Types**

The Tank Types option allows companies that pick up used oil from various service shops to adequately account for the amount of oil picked up so that customers can be properly charged for the service provided.

**NOTE:** Oil is normally stored in tanks that may or may not be equipped with gauges or sight glasses for determining the amount of liquid in the container before and after emptying the tank. The driver will measure or provide a best estimate of the before and after amounts, and the calculations provided will be based on the information entered in the screen below.

**Fields:**

*Code:* Enter up to five characters that will represent the Tank Type.

*Description:* Enter a description for the Tank Type.

*Comment:* Add optional comments that may include the steps to follow when performing a measurement, or any details pertinent to the Tank Type.

*Type:* Select the type of tank being used. Labels are provided in the graphic on the screen to assist the driver in making proper entries for height, width, and length.

*Orientation:* Select the appropriate orientation of the Tank Type.

*Unit of Measurement:* Select the appropriate unit of measurement.
**Height:** Enter the measured height of the tank.

**Width:** Enter the measured width of the tank.

**Length:** Enter the measured length of the tank.

**Cubic Inches:** The total Cubic Inches/Meters will be calculated for you based on the entries made above.

**Gallons:** The total number of Gallons will be calculated for you based on the entries made above (i.e., 231 cubic inches = 1 gallon. 1,000 liters = 1 cubic meter).

**Test Calculations:**

Test Calculations are for the amount of liquid removed at the time of pickup. They are made on the basis of the two input fields below.

**Top Inches/Top Meters:** This is the measured distance from the bottom of the tank to the top of the liquid **Before** pumping.

**Bottom Inches/Bottom Meters:** This is the measured distance from the bottom of the tank to the top of the liquid **After** pumping.

**Measured Cubic Inches/Cubic Meters:** The amount of liquid removed.

**Measured Gallons/Liters:** The amount of liquid removed.

**Remote Tank Setup**

The Remote Tank Setup option is part of the Remote System Monitor Module that uses data recorded by a third party your company works with to capture remote data from your equipment in the field. Contact ARS for further information on this option.
Setting Up Your Routes

Each customer receiving a regular delivery will need to be assigned to a route in RMA. A driver will be assigned to each route, and the options available on the handheld will be defined under each Handheld Class in use. This section defines each item.

NOTE: Ensure you have added all of your route drivers to the program under Lists > Employees > Employee Setup prior to creating routes.

Route Master

The Route Master option allows you to create route ID’s, assign drivers, and much more.

**Information Tab:**

The Information tab includes information related to the route and driver.

**Fields:**

- **Route:** Enter up to five characters that will represent the route.
- **Inactive:** Select this option to disable the route in the program.
- **Description:** Enter a description for the route.
- **Home Branch:** Select the branch that this route is assigned to.
**Route Type:** Select the route type that applies to this route (e.g., Delivery, Service).

**NOTE:** Route Types can be established under Lists > Routes in RMA. A color code can be created per route type, which is especially helpful when using the Route Dispatch Manager under the Route menu.

**Driver:** Select the driver that will run the route.

**Global Route for Delivery Orders:** Select this option if you would like the current route to be accessible by any user scheduling Delivery Orders, regardless of Branch.

**Manifest Type:** Select a Driver Manifest Code to assign to the current route.

**NOTE:** Driver Manifest Codes are located under the Tools menu. Contact ARS for further information on this topic.

**Drag Stop/Delivery Orders:**

**Schedule on Holidays:** Select this option to allow ‘Drag’ stops to be scheduled on holidays established within the Holiday Calendar.

**Schedule on Saturdays:** Select this option to allow ‘Drag’ stops to be scheduled on Saturdays.

**Schedule on Sundays:** Select this option to allow ‘Drag’ stops to be scheduled on Sundays.

**Other:**

**Operator:** Select the employee in charge of ‘pre-calling’ each customer assigned to this route.

**Major Account:** Select a Major Account Code to assign to the current route entry.

**NOTE:** This option will automatically assign the Major Account Code to all customers assigned to the current route when changes are made within Customer Information or when using the Global Changes screen to assign customers to the current route.
**Handheld Tab:**

The *Handheld* tab contains information related to filtering data on the handheld, and more.

![Handheld Tab Image]

**Geographic Area:**

Select each *Group Area Code* that this route services.

**NOTE:** *Group Area Codes* are used as customer filters on each route based on the option selected under *Lists > Routes > Handheld Class*, on the *Off Route* tab. Additionally, *Group Area Codes* can be added under to RMA under *Lists > Routes*.

**Handheld Product Group:**

Select each *Handheld Product Group* that this route services.

**NOTE:** *Product Group Codes* are used as product filters on the handheld and can be added to RMA under *Lists > Product Codes > Product Group Codes*. In order to successfully use this option, every product will need to be assigned to a group. Additionally, you can use the group codes to easily filter products directly within the *Misc. Items* screen of the handheld program by selecting the option ‘Use Product Categories in Miscellaneous Sales’ under *File > Branch Setup*, on the *Handheld* tab.

**Forward Sales:**

**Default Route:** Enter a default route for any *Forward Sales* created on the handheld.

**Lead Days:** The default number of days in advance a *Forward Sale* will be scheduled from the handheld.

**Network Transfer Parameters:**

**Transfer Time (Advanced Communications Module Only):** Enter the time (in military format) that wireless data transfers should take place.

**Other:**

**Include in “All Routes” for Morning Card Process:** Select this option to include this route in the ‘All Routes’ process during a *Morning Card* transfer.
NOTE: The ‘All Routes’ feature allows you to prepare each route for the drivers to download at a later time.

Use Quick Sale Option: Select this option to use a modified version of the Quick Entry screen on the handheld that has been formatted for rapid entry.

NOTE: This will also disable certain features available on the standard Quick Entry screen and may not be suitable for all users.

Invoices Tab:
The Invoices tab contains information related to the invoice numbers used on route.

Fields:
Use Invoice Pool: Check this box to use the invoice pool established under File > Branch Setup, on the Setup tab.

Use Sequenced Invoice Numbers (Used in Argentina): Select this option to only allow sequenced invoice numbers. This will modify certain features on the handheld.

Starting Invoice: Enter up to fourteen digits as the starting invoice number to use on this route.

NOTE: The invoice number length accepted is controlled under File > Branch Setup, on the Desktop tab. Enter a number up to ‘14’ within the Invoice No. Mask field. Each route should contain a unique invoice ‘pool’ to prevent duplicate numbers. Alternatively, you may opt to select the ‘Use Invoice Pool’ option to automatically retrieve available invoice numbers from a company wide invoice pool available under File > Branch Setup, on the Setup tab.

Current Invoice: Enter up to fourteen digits as the current invoice number being used on this route. After this option is initially established, it will be automatically updated each day.

Off-Route Invoice Quantity: Enter the number of invoices that should be added to the route in addition to the number allocated to scheduled stops (i.e., ‘20’ additional invoices for call-ins not scheduled).
**Invoice Rollover:** Enter up to fourteen digits as the ending invoice number to use on this route. After this number has been reached, the system will revert back to the *Starting Invoice* number established.

**NOTE:** Selecting ‘Use Invoice Pool’ will ignore the invoice pool established within the *Route Master* screen.

**Validity Check:**

Enter criteria in the following fields to enable low/high sales, cash, and tax alert figures on the *Transaction Detail* report during the upload process.  

- *Sales*  
- *Cash*  
- *Tax*

**NOTE:** This option can be helpful for quickly identifying sales related issues on route.

**RDM / Mapping Tab:**

The *RDM / Mapping* tab contains information related to mapping modules and route management utilities available in RMA. Refer to the RDM manual or contact ARS for further information on these items.
**Handheld Class**

The *Handheld Class* feature allows you to define all of the handheld options available to your drivers on route. Each class will control the type of handheld, the features available to the driver, and messages that will print on each customer’s receipt.

**NOTE:** A separate *Handheld Class* should be created for each handheld type used at your company.

---

**General Tab**

The *General* tab contains common options used on the handheld.

**Fields:**

*Class ID:* Enter up to two characters that will represent the *Handheld Class*.

*Class Description:* Enter a description for the *Handheld Class*.

*Department (Vending Only):*  
Specify the department that invoices generated from this *Handheld Class* should be logged under. The *Departments* option allows you to group transactions and isolate sales for specific areas of business.

*Handheld Language:*  
Choose the language file that should be used within the handheld program.
Require Password on Exit (Optional):

Enter a four digit alphanumeric code that will be required upon exiting the handheld program.

Route Input Display:

Delivery Order Reason ID’s: Choose this option to display Delivery Order Reason ID’s on the route list of the handheld (under the customer’s address).

Delivery Order Products: Choose this option to display Delivery Order Products on the route list of the handheld (under the customer’s address).

Quick Sale Menu:

Change Menu Icon: Select this option to enable a new menu option on the Quick Entry screen.

Show Skip Reasons (Requires Change Menu Icon): Select this option to enable Skip Reasons on the Quick Sale Menu.

Show Camera (Requires Change Menu Icon): Select this option to enable the Camera function on the Quick Sale Menu.

NOTE: The Quick Sale option uses a modified version of the Quick Entry screen on the handheld that has been formatted for rapid entry, and can be enabled under the Route Master screen for each route. Additionally, this feature will disable certain features available on the standard Quick Entry screen and may not be suitable for all users.

Start/Stop Time:

Record Start Time for Each Sale: This option will record the duration of time it takes to complete each invoice.

Prompt for Start Time: Select this option to prompt the driver to begin recording.

Door Scan for Start Time: Select this option to scan a barcode at each location for the start time.

Opening Stop for Start Time: Not currently in use.

NOTE: Start/Stop Time information can be retrieved on the Route Times report, found under Reports > Route Reports > Management, on the desktop.

Inventory Module:

Enable Inventory Module (Requires Handheld Inventory Module): Select this option to allow users to manage RMA inventory on the handheld.

NOTE: Enabling this option will allow you to use all of the desktop inventory adjustment options on the handheld. For further information on this feature, refer to Chapter 3.10 of the Supplemental Guide.

Collect Halogen Data: Select this option to collect halogen data on the handheld (used in Oil Recycling industry).

Miscellaneous Items:

Enable Notes Function on Handheld: Select this option to allow route drivers to enter notes from within the handheld program. Each note will be logged and uploaded to the desktop.
**Reverse Names on Handheld:** Select this option to reverse the order of each customer name on the handheld — this option will only work if semicolons (;) separate each name.

**Force Service on Equipment Pickup:** Choose this option to force the driver to enter an *Equipment Service Code* when picking up equipment on the handheld.

**Force Fault Reason on Equipment Pickup:** Select this option to require that an ‘Equipment Fault’ code be selected on equipment pick up.

**Hide Shopping Cart:** Select this option to hide the shopping cart displayed on the ‘Confirm Sale’ screen.

**Exclude Suspended Accounts on Pre-Route Report:** Select this option to exclude all suspended customers from the *Pre-Route Report*.

**Exclude Suspended Accounts on Handheld:** Select this option to exclude all suspended accounts from the handheld.

**Days of History on Handheld:** Enter the number of history days you would like the drivers to view on the handheld.

**Include This Month Last Year:** Select this option to include the same month of the previous year within the history screen of the handheld (recommended for seasonal accounts).

**Include Last 5 Deliveries Totals with History:** Choose this option to display products and average purchases from the customer’s last five deliveries within the *History* screen of the handheld.

**Don’t Use Color on Customer Totals:** Choose this option to disable the color display on the handheld screen for balance totals.

**Set Handheld Date to Route Date:** Select this option to force the ‘route date’ on the handheld, rather than the current date.

**Display Long Descriptions in Default Product List:** Select this option if you are using the ‘Long Description’ within your *Product Charge Codes* and would like them to be displayed on the *Default Product* line of the handheld.

**Prompt for Units on Case Prices (Multi-Unit Pricing):** Select this option to prompt the driver for a unit type when choosing a multi-unit product on the handheld.

---

**NOTE:** Multi Unit Pricing allows you to set up relationships between various units of sale, such as a logical hierarchy similar to the following: Can, 6-Pack, Case, and Pallet. For further information on this feature, refer to Chapter 2.14 of the Supplemental Guide.

---

**GPS – Use MangoPilot for Navigation:** Select this option to use the MangoPilot GPS program with your handheld.

---

**NOTE:** The MangoPilot program allows you to use an externally mounted GPS device that communicates with your existing handheld to guide you to each location. Contact Advantage Route Systems or visit www.MangoPilot.com for further information.

---

**GPS – Automatically Pop-up Directions for Each Stop:** Select this option to automatically access your integrated GPS program when selecting each stop on the handheld screen.

**GPS Navigation Software:** Select the navigation program you are using from the drop-down menu.

**Returned Goods:**
**Allow Entry of Return Quantities:** Select this option to enable the ‘Returns’ option on the handheld (displayed within the Quantity field).

**Default to Entry of Returns (Allow Entry of Return Quantities must be selected):** Select this option to automatically display the ‘Returns’ screen when clicking on the Quantity field.

---

**NOTE:** For further information on product returns and damages tracking, refer to Chapter 2.13 of the Supplemental Guide.

---

**Popup Quantity Entry on Change Default Product:** Select this option to allow drivers to update standing order quantities added to the Default Product list on the handheld.

**Sequencing:**

**Reorder Stops On Upload:** Select this option to automatically assign new sequence numbers to your accounts during the Afternoon Card process (i.e., sequences 0001, 0002, and 0003 are renumbered 0010, 0020, and 0030).

**Ignore Driver Resequencing On Handheld Upload:** Choose this option if re-sequencing customers should only be handled on the desktop.

**Use Follow-me tracking for Resequencing:** This option re-sequences customers based on the order that your route driver delivered during the route day — this will not include any off-route deliveries.

**Use Classic Resequencing Method:** Choose this option to use a cut-and-paste method of re-sequencing stops on the handheld.

**Hardware Tab**

The Hardware tab contains information related to the type of handheld, and transfer methods being used.

![Handheld Class](image)

**Fields:**

**EHT-30/EHT-40:** Select the appropriate model if you are using the older Epson style handelds.
**CE Device:** Select this option if you are using a *Windows Mobile* device, and choose your handheld type from the drop-down menu — the list is always expanding and may differ in your version:

![Handheld List](image)

**NOTE:** If your handheld type is not listed, contact Advantage Route Systems so that we may assist you in choosing a compatible option.

**Communications Options:**

**Cable:** Select this option to use a serial cable for communications between the handheld and the desktop.

**Modem:** Select this option if the handheld connects to the desktop via dial-up modem.

**Network:** Select this option if the handheld communicates with the desktop through a network connection.

**Card:** Select this option if a card reader is being used for transferring data between the handheld and the desktop.

**Lan/WiFi/Bluetooth (Requires Network option above):** Select the connection method being used to connect to the network.

**NOTE:** The **Modem** and **Network** options require the *Advanced Communications Module*. Please contact Advantage Route Systems or your reseller for further information.

**Handheld Printer Type:**

Select the type of printer being used with your *Windows Mobile* device:

![Printer List](image)

**NOTE:** Select *Auto-Detect* if your printer is not listed. If the printer does not work, contact Advantage Route Systems.
**GFX Line Spacing (Bluetooth Dongle Required):** This option only applies to dot matrix style printers and is typically not used.

**Printer Connection Type:**
Select the connection method your printer uses to communicate with the handheld:
- Serial
- IR (Infrared)
- Bluetooth

**Printer timeout (Value * 2 in ms):** Enter the number of milliseconds the printer and handheld should wait before canceling a print job.

**Data Transfer:**
- **Compress data for transfer:** Choose this option to compress data prior to transfer (ideal for slow transfer speeds).
- **Compress update for transfer:** Choose this option to compress the update prior to transfer (ideal for slow transfer speeds).
- **Days to process in Adv. Comm during Morning Card:** Select the number of delivery days that will be transferred to the handheld wirelessly during the **Morning Card** process.

**NOTE:** This option is only available when using the Advanced Communications Module and is enabled by selecting the option ‘Select Process Date for Transfer’ within File > Branch Setup, on the **Defaults** tab. Contact ARS for further information.

**Use RMLive (Optional Module):** Select this option to use RMLive with this Handheld Class.

**NOTE:** The RMLive Module allows your drivers to receive and transfer data while making deliveries in the field. Contact Advantage Route System for further information.

**Force WiFi for Transfer (RMLive Module Only):** Select this option to use a WiFi transfer method instead of GPRS during the **Morning** and **Afternoon Card** process.

**Don’t use WiFi Power Saver:** Select this option to prevent RMA from disabling WiFi on the handheld when NOT transferring data.

**Use WM DLL for WiFi Transfer:** This option serves as an alternate method for enabling/disabling WiFi connectivity on the handheld. Use this option if you are experiencing trouble with connectivity when using wireless data transfer options.

**Other:**
- **Use Camera:** Select this option to allow pictures to be taken with a camera equipped handheld while on route — this can be helpful for verifying damaged equipment or products, and will be logged within each customer’s account on the desktop.
- **Photo Resolution:** Choose the desired picture resolution:
  - Low (250KB)
  - Medium (350KB)
  - High (High 550KB)

**NOTE:** The higher the resolution, the better the quality and size of the picture — adjustments may need to be made if higher resolutions are causing slow data transfer speeds.
Transfer Photos via RMLive (Optional Module): Select this option to receive photos from the handheld during RMLive transfers.

NOTE: Additional setup steps are required to use the photo feature. First, select the ‘Allow Camera to be Used’ option within Branch Setup, on the Handheld tab. Second, establish a directory on your computer to save the photos in, and select it under File > Local Settings, on the Directories tab.

Modem Transfer Options:

Each item below requires a dial-up modem and the Advanced Communications Module.

Baud Rate: Select the baud rate of your dial-up modem.

Dial Back Number: Enter the primary phone number that should be used when attempting a dial-up modem transfer.

NOTE: The remote phone line must be dedicated and cannot be shared with a fax machine or any auto-answer device.

Alternate Number (1-3): You may enter up to three alternate phone numbers to dial for data transfers. Each number can be selected on the handheld individually.

Misc. Options:

Block Keys: Select this option to disable the physical keypad on certain handheld devices.

Use Docking Cradle (For EHT30 Only): Choose this option if you are using a docking cradle with your handheld.

Use EM2000: Not currently in use.

Disable eject notification: Choose this option to disable the ‘OK’ message after creating a Morning Card.

Network Retries (Advanced Communication Module Only): The number of retry times the system will initiate when using the Network transfer method.

GPS Logging:

GPS Logging is used to write detailed GPS coordinates to the driver’s route card throughout the day for tracking stop times, locations, duration, and more.

NOTE: These options are part of the Route Track 2000 Module. Please contact Advantage Route Systems for further information.

Bluetooth GPS: Select this option if you are using an external Bluetooth GPS device.

Log GPS Info on Handheld: Select this option to log the GPS information internally on the handheld.

GPS Baud Rate: Select the baud rate used by the GPS device.

GPS Com Port: Select the COM port used by the GPS device.

GPS Logging Interval: Enter the number of seconds to capture and log GPS coordinates each time.
Load/Unload Tab

The Load/Unload tab contains information related to handheld verification procedures.

Fields:

Load Verification Required: Select this option if each driver will need to verify product loads placed on the trucks prior to delivery.

The following options are only available when Load Verification Required has been selected:

- Morning Load Verification Not Required: Select this option to disable the Morning Load verification option.
- Reload Verification not Required: Select this option to disable the Reload verification option.
- Afternoon Load Verification not Required: Select this option to disable the Afternoon Load verification option.

Allow Variance of Verified Qts by: Enter a percentage that you will allow as a margin of acceptable difference between the Driver and Checker load.

NOTE: This option requires that the Load Verification Required option is enabled above. Additionally, the Checker quantity is always used when observing the quantity difference. For example, if a margin of 10% is allowed and the Driver enters 100, while the Checker enters 95, the Checker quantity is used and recorded.

Don’t Require Checker to Verify Equipment: Select this option to disable the ‘Checker’ verification procedure when loading equipment on the handheld.

Lock Morning Load After Verify: Choose this option to disable the ability to edit the Morning Load screen after it has been verified.

Serial Verification Required: This option is currently in development.

Swap Order of Signatures on Load Verification: Select this option to allow the Checker to sign prior to the Driver during load/unload verifications on the handheld.
**Truck Options:**

*Show Large Bay at Rear of Truck:* Select this option to enable a loading bay at the rear of your truck on the Bay screen within the handheld program — this is only used when there is an odd number of bays on the truck.

*Default Number of Bays to:* Enter the number of bays on your route trucks. If you have both eight-bay and ten-bay trucks, then set the value to the largest number of bays in your fleet.

*Enter Load Using Product List:* During the check-out process, each driver can enter products by choosing them from a list, or by entering the Product Code ID manually. Selecting this option defaults to the ‘list mode’ entry; however, drivers will still have the ability to toggle between each mode on the handheld at any time.

*Require Equipment ID’s Exist in Master List:* Select this option to force RMA to verify that the equipment ID being entered exists in the Equipment Master List when using keypad entry mode — this will prevent the drivers from keying in invalid pieces of equipment.

*Leave Clean Equipment on Truck:* Select this option to leave undelivered equipment within the truck’s inventory from day-to-day.

*Right Side Driver:* Select this option if the driver operates the vehicle from the right-hand side, and the bay listing should be switched.

*Force Vehicle Inspection during Morning:* Select this option to force each driver to complete a Vehicle Inspection Checklist on the handheld during the Morning Load process.

*Force Vehicle Inspection during Afternoon:* Select this option to force each driver to complete a Vehicle Inspection Checklist on the handheld during the Afternoon Unload process.

*Use Surveys:* Select this option to use the Surveys feature found under the Tools menu within RMA.

**NOTE:** This feature allows your drivers to conduct dynamic surveys during delivery.

*Leave Products in Truck Order During Load Entry:* Choose this option to leave the products in the order they are listed by default (instead of the order they have been loaded).

*Require Serial Number During Load Entry (Requires Scanner):* Select this option to require that a serial number is scanned for items added to a delivery vehicle that require it.

*Require Serial Number During Unload Entry (Requires Scanner):* Select this option to require that a serial number is scanned for items unloaded from a delivery vehicle that require it.

**NOTE:** Select the ‘Require Serial Number’ option within Product Charge Codes > Info to enable this feature.
**Missed Stop Action:**

If any stops on the handheld are not serviced, you can select from the following actions to take:

- **Nothing:** No action will be taken on the missed stop and a report will be generated showing which stops were not serviced.
- **Drag:** Missed stops will be rescheduled for the next available delivery day. A report will be generated showing which stops were rescheduled.
- **Force Service:** The driver will not be able to print the *Driver Closeout Reports* from the handheld until all stops have been serviced.

**NOTE:** On *Force Service*, the driver may select the ‘Skip Remaining Stops’ option from within the *Afternoon* screen on the handheld.

**Other Options:**

- **Overload Warning:** Select this option to warn drivers when too much product is being added to the truck.

**NOTE:** The maximum load per truck can be specified within the *Bottle Capacity* field under *Lists > Truck Information > Trucks*.

- **Under Load Warning:** Select this option to warn drivers when product quantities do not meet the promised quantity on scheduled *Delivery Orders*.

- **Block Truck Status:** Select this option to disable the *Truck Status* screen on the handheld.

- **Allow Entry of Broken Bottles on Unload:** Select this option to allow broken container quantities to be entered during the *Afternoon Unload* process on the handheld.

- **Force Beginning Mileage Entry:** Select this option to force the driver to enter beginning mileage for the delivery vehicle on the handheld.

- **Require First Stop Mileage Entry:** Select this option to force the driver to enter mileage on the handheld at the first stop of the delivery vehicle.

- **Force End Mileage Entry:** Select one of the options below to manage mileage entry options after the driver has completed the *Morning Load* process:
  - **None:** Select this option if you will not require the driver to enter any mileage information after the *Morning Load* process has been completed.
  - **After Each Stop:** Select this option to force the driver to enter mileage totals prior to printing each invoice on the handheld and before completing the *Afternoon Unload* process.
  - **Before Each Stop:** Select this option to force the driver to enter mileage totals prior to accessing the invoice screen on the current stop.
  - **End of Day:** Select this option to force the driver to enter mileage totals prior to completing the *Afternoon Unload* process.

- **Allow Manual Entry on Change Equipment Screen:** This option allows the driver to add equipment to accounts by manually creating serial numbers on the fly.

- **Use Perpetual Inventory:** Choose this option to enable the *Perpetual Inventory* module.
**NOTE:** The *Perpetual Inventory* feature allows you to carry product inventory totals on your truck from one day to the next — this is especially helpful for companies running coffee service or snack routes. Refer to *Chapter 3.17* of the *Supplemental Guide* for further information.

**Skip Remaining Stops on Network Transfer:** Choose this option to automatically ‘skip’ all stops during the upload process that were not serviced on route for the day.

**Populate Checker Qtys When Receiving Load Orders:** Select this option to automatically populate the *Checker Load* option in the handheld with Load order quantities (when applicable).

**NOTE:** This option makes it easier for a load to be verified without the *Checker* actually having to verify each quantity on the *Load Order*.

**Upload Skip Reason (Requires Skip Remaining Stops on Network Transfer):** Select the global *Skip Reason* to use when skipping stops automatically during a network transfer.

**Move All Drag Stops to Route (Requires ‘Drag’ Option):** Select an alternate route to place all dragged stops on — by default, dragged stops are placed on their original route.

### Production Batch Options:

*Production Batch Codes* are identification codes that can be assigned to products in RMA to identify and track a batch of products for quality control and recall purposes.

**NOTE:** Refer to *Chapter 4.02* of the *Supplemental Guide* for further information on these items.

**Record Batch Numbers at Truck Level-Not on Invoice:** Select this option to disable *Production Batch Code* entry or selection within the *Invoices and Adjustments* screen and the handheld invoice entry screen -- this forces you to enter and select batch codes from within the *Morning Load* screen.

**Production Batch Verification Required:** Select this option to require that both the *Driver* and *Checker* verify the batch numbers entered on the handheld during the *Morning Load* process.

**Block Driver Morning Batch Entry:** Select this option to only require the *Checker* to enter batch numbers on the handheld during the *Morning Load* process.

**Block Batch Entry During Sale:** Select this option to disable the batch number selection screen that appears when an item assigned to a production batch code is sold on an invoice.

**Allow Multiple Batch Numbers per Line Item:** Select this option to allow more than one *Production Batch Code* to be selected per line item during a transaction.

**Production Batch Mask:** Enter the format that should be followed when entering production batch codes on the handheld (hover the mouse cursor over the mask field to view formatting options).
### Sales Rules Tab

The **Sales Rules** tab contains information related to payment and sales information on the handheld.

**Confirm Sale:**

- **Require Signature on All Deliveries:** Select this option to require a signature on each invoice created on the handheld.
- **Require Minimum Pixel Amount on Signature:** Choose this option to require a minimum number of pixels when capturing a signature.
- **Show GPS location button:** Select this option to enable the ‘Capture GEO-Coding’ button on the **Confirm Sale** screen of the handheld. This allows you to capture the customer’s Latitude/Longitude Coordinates for mapping purposes (requires an active GPS connection).

**NOTE:** This information will be uploaded and stored on the customer’s **Route** tab within **Customer Information**.

- **Allow for mileage entry on each stop:** Select this option to require each driver to input a current mileage entry per stop.
- **Force Signature if Customer Signature Required:** Select this option to force a signature if the ‘Signature Required’ option is selected within the customer’s account.
- **Show First Three Products in Signature Screen:** Select this option to display the first three products sold to the customer on the signature screen, for reference.
- **Use Alternate Signature Graphic:** Select this option to use the “Signatory” style graphic on the signature capture screen.
- **Require Driver’s Signature for all Deliveries:** Select this option to require that the route driver enter a signature on the invoice screen to complete the sale.
- **Require Customer’s Name:** Select this option to require that the driver enter the customer’s name prior to saving the invoice.
- **Direct Meter Transfer Type:** Generally only used in the propane industry, select one of the ticket types for entering ‘Capacity’ readings on the **Confirm Sale** screen.
Confirm Handheld Date Change on Save: Select this option to prompt the driver to select the correct handheld/invoice date on the handheld should there be a date discrepancy when selecting the save key on the Confirm Sale screen.

Payments:

Default Payment Type to ROA: Select this option to establish the ROA (Received on Account) payment type as the default choice within the payment screen on the handheld.

NOTE: The driver can easily toggle between ROA and COD (Cash on Delivery) on the handheld regardless of selection here.

Force Payments to Own Invoice: Select this option to require that all payments are entered on invoices that do not include any product sales.

NOTE: On an account purchasing product and making a payment, two invoices will need to be created. One will include the products being sold, while the other will only include the payment and a Skip Reason (required to save the invoice).

Allow Refunds on Payment Screen: Select this option to allow your drivers to enter negative amounts from within the payment screen.

Disable Change Button: Select this option to disable the Payment Change button within the payment screen.

Future Orders:

Default: Standard invoice mode, most commonly used.

Future Only Orders: Select this option to use the ‘Pre-Sale’ mode option on the handheld, which allows salesmen to create orders on each account.

Choose Future or Sales: Select this option to allow the handheld program to toggle between the Default and Future modes on the handheld.

Other:

Payment Skip Reason: Select a Skip Reason that will be assigned to all ‘payment only’ invoices on the handheld.

Use Previous Ending Reading as Beginning Meter Reading: Select this option to populate the customer’s beginning meter reading with their most recent ending meter reading on the handheld (used in the propane industry).

Sales Options:

Disable equipment movement on handheld: Select this option to disable the equipment movement options on the handheld invoice screen.

Disable barcode scanner in customer [delivery screen]: Choose this option to disable the barcode scanning option within the invoice screen on the handheld.

Allow Price Overrides: Select this option to allow price changes on the handheld.

Allow Rent Charges to be Removed: Select this option to allow the driver to remove any rent charges that may appear on the handheld.

Don’t Show Bottles on Hand: Choose this option to remove the Bottles on Hand (containers) display from the invoice screen.
**Force Input of Bottles Returned:** Select this option to force the driver to input a ‘returned’ quantity on each invoice.

**NOTE:** The driver will be forced to select the *Returns* “spinner” or input screen before saving the invoice.

**Force input of gratis for zero dollar [sale]:** Choose this option to force a *Gratish Reason* to be selected when selling an item at zero price.

**Remove Rents on Skipped Stop:** Choose this option to automatically remove any rent charges when ‘skipping’ a stop from the invoice screen.

**Require Reason for Returned Goods:** Select this option to require that a reason be given when a negative price or quantity on a product is entered on the handheld.

**NOTE:** Refer to Chapter 2.13 of the Supplemental Guide for further information on managing returned products.

**Automatically Default to Par/Reported (Par Module):** Select this option to automatically add the quantity needed to the invoice after entering the *Reported* amount on the handheld.

**NOTE:** The *Par Module* allows your drivers to maintain a pre-established quantity of items at a customer’s location at all times. Contact Advantage Route Systems for further information.

**Use Original Par Value to Compute Difference:** Select this option to use a modified version of the par screen that allows the driver to view the customer’s previous standing par value along with the current one.

**NOTE:** This is helpful for drivers that need to make adjustments to standing par values frequently based on the customer’s needs.

**Automatically Go to Next Stop in Route Sequence:** Choose this option to auto-load the next stop in sequence after completing the previous sale.

**Allow Product Group Discounts:** Select this option if you are using *Product Groups* and would like to use the percentage discounting option.

**NOTE:** *Product Group Discounts* allow you to automatically discount the price for products purchased by your customers. This option differs from the standard quantity discount since the discounts are based on combined products purchased from a group, not per product. Refer to Chapter 2.01 of the Supplemental Guide for further information.

**Allow Duplicate Default Products:** Select this option to allow duplicate products assigned to the *Default Products* section of the handheld.

**Display Promos as Alert Messages (Buy/Gets Module Required):** Select this option to display available promotions as an *Alert Message* on the handheld.

**NOTE:** The *Buy/Gets Module* allows you to offer your customers free or reduced priced items if they purchase a pre-established quantity of qualified products within the RMA program. Contact Advantage Route Systems for further information.

**Don’t Show Default Products on Delivery Orders:** Select this option to suppress the customer’s default items on an invoice that applies to a *Delivery Order.*
Skip Confirm Order Screen: Select this option to disable the Confirm Order screen after choosing Save on the handheld invoice screen.

Hide Alert Popup Screen: Select this option to prevent Alert Messages from being displayed automatically when an account is selected on the handheld — the messages can only be accessed using the ‘I’ button on the Quick Entry screen.

ZIP Code Length on Select Stop Screen: Enter the ZIP code length that should be displayed on the handheld (0-9).

Out of Stock Options: Select the desired option to use when a product is sold to a customer that is not available on the truck: Nothing, Give a Warning, or Prohibit Sales.

Show Available Truck Qtys on Misc Items and Forward Sales Screens: Select this option to include Truck Status quantities within the Misc. Items and Forward Sales screens (tap the product to view the totals).

Show Available Warehouse Qtys on Misc Items and Forward Sales Screens: Select this option to include Warehouse quantities per product within the Misc. Items and Forward Sales screens (tap the product to view the totals).

Show Description before Code On Misc Items List: Select this option to display the Product Description in front of the Product Code within the Misc. Items screen.

Allow Manual Entry of Coupons: This option is used with Coupon Tracking in RMA, contact ARS for further information.

Sales Rules 2 Tab

The Sales Rules 2 tab contains additional information related to payment and sales information on the handheld.

Sales Options:

Show Avg. of Last 5 Deliveries in Default Product List: Select this option to include an average number of units sold next to each product within the Default Products list on the handheld.

Misc Items Fast Find: Select an available option to enable/disable the keypad search option that can be used within the Misc. Items screen on the handheld (helpful if you have a large inventory of items); you can elect to search by Charge Code or Description.
Labels Tab

The Labels (1&2) tab contains default descriptions and products that will be displayed on the Quick Entry screen of the handheld.

Labels (Page 1):

Sales Tax Label (Sales Tax is used if blank): Enter the sales tax description used in your company (e.g., VAT, PST, or GST).

Tax Categories: This description is used on the handheld when entering a new customer. This label is displayed above the tax rates.

History Page: Historical data can be accessed and printed from the handheld on each account, enter a description for this option (e.g., Customer History, Statement of Account).

Product on Hand: Enter a description for products or containers on hand (e.g., Bottles on Hand, Crates, or Pallets).

Redemption Label: Enter a standard label that will relate to the redemption value of a container (i.e., in California it is C.R.V.).

Account # Label (Account # is used if blank): Enter a standard account number label.

Standard Invoice Label (Invoice # is used if blank): Enter a standard invoice label.

Credit Invoice Label (Euro Finance Only): Enter an invoice label that will be used on credit invoices.

Gratis Label (Gratis is used if blank): Enter a label that will be displayed next to ‘Gratis’ items on the invoice.

Delivery Address (no label if empty): Enter a label for an alternate Delivery Address on the invoice.

Bill to Label: Enter a label for an alternate Bill to address on the invoice.

NOTE: Select the ‘Print Billing and Delivery Addresses on Receipt’ option on the Handheld Class > Receipt tab to include the billing address on the printed invoice.

PO Number Label (PO Number is used if blank): Enter a standard label for a Purchase Order Number on the invoice.

Invoice Total Label (Invoice Total is used if blank): Enter a standard label for the sales total on the invoice.
Statement Label: Enter the label that will print on all handheld statements.

Labels (Page 2):

Deposit Label: Enter the label that will print next to all deposit related criteria on the receipt.

Extra Label: Enter a standard label to use for the Extra field under the Account Number on the invoice.

NOTE: The Extra field is used for alternate account numbers or any other reference information, and can be found on the Info tab of Customer Information.

Signee Label: Enter a standard label to display on the ‘Signee’ box displayed within the Capture Signature screen of the handheld.

NOTE: This option must be enabled before a signee name can be entered. Select the ‘Require Customer’s Name’ option under Handheld Class > Sales Rules tab.

Original Par: Enter the label that will print next to original par level values listed at the beginning of the transaction.

New Par: Enter the label that will print next to new par level values listed at the completion of the transaction.

Alternate Labels:

Default to Alt Invoice Label: Select this option to always use the ‘Alt. Invoice Label’ when printing handheld invoices.

Alt. Invoice Label: Enter an alternate invoice label that will print on handheld invoices for accounts with the option ‘Use Alternate Invoice Label’ selected within Customer Information, on the Route tab.

Alt. Credit Invoice Label (Euro Finance Only): Enter an alternate credit invoice label that will print on your handheld invoices on accounts with the option ‘Use Alternate Invoice Label’ selected within Customer Information, on the Route tab.

Quick Sale Screen Labels:

Quantity (QTY will be used if blank): Enter a default label for product quantities on the handheld.
Price (PRICE will be used if blank): Enter a default label for product prices on the handheld.

Amount (AMOUNT will be used if blank): Enter a default label for balances on the handheld.

NOTE: The Quick Sale option uses a modified version of the Quick Entry screen on the handheld that has been formatted for rapid entry, and can be enabled under the Route Master screen for each route. Additionally, this feature will disable certain features available on the standard Quick Entry screen and may not be suitable for all users.

Standard Charge Codes:

Default Product: Enter a Product Charge Code that will be assigned to all accounts on the handheld. This should be a product that most customers purchase.

NOTE: If this field is empty, the system will use the first valid (non Skip Reason) product in the Product Charge Code file.
**Off Route Tab**

The *Off-Route* tab contains information related to customers serviced off-route.

![Handheld Class](image)

**Information for Off-Route Customers:**

Select each item that you would like to include with your accounts serviced ‘Off-Route’ on the handheld:

- Alert Messages
- Statement Messages
- Invoice Messages
- Default Products
- Driver/Site Instructions
- PO Numbers
- Invoice History

**Off-Route Filter:**

*Filter Type:* Choose one of the following *Off-Route Filter Types* to apply on the handheld:

- Include all customers on the off-route list.
- Include only customers on route being processed.
- Include only today’s customers in the off-route list.
- Include all authorized branches in off-route list.
- Include all route areas (from authorized branches) in off-route list.
- Only include route areas (within home branch) in off-route list.
**Service History:** Select one of the following available filters to include equipment service history on the handheld:

- **None:** Select this option to disable service history on the handheld.
- **On Route Only:** Select this option to include service history for equipment assigned to customers scheduled on route.
- **Both On and Off Route:** Select this option to include service history for equipment assigned to both on route and off route customers.

**Other:**

*Show Stop Number for Off-Route Listing:* Select this option to display stop numbers when searching for customers using the Off-Route option (used with multi-stop accounts).

*Allow Enhanced Customer Setup:* Select this option to use the enhanced new customer setup utility on the handheld.

**NOTE:** By establishing default settings on the desktop, the driver will be able to capture more information about the customer than the standard New Customer option available on the handheld. The data received will be uploaded to the desktop, and the customer’s account will be created automatically. For further information on this option, refer to Chapter 4.11 of the Supplemental Guide.

**Special Accounts:**

*New Customer:* Select an account number that will be used to temporarily store new customer data captured on the handheld.

*Cash Sale:* Select an account number that will be used for cash sales on the handheld (i.e., used for walk-ups or off-the-truck sales).
**Finance Tab**

The *Finance* tab contains information related to payment collections on the handheld.

![Finance Tab Image]

**Fields:**

*Require Past Due Authorization:* Select this option to require a *Past Due Authorization Code* if a driver attempts to service an account that is past due.

*Require Authorization for COD Customers:* Select this option to require a *COD Authorization Code* if a driver attempts to service an account that is assigned to a *COD Credit Class*.

*Popup Payment for COD Customers:* Select this option to pop-up the payment screen when choosing the *Save* button on the handheld invoice.

*Force Invoice Amount as Payment Amount (Requires Option Above):* Select this option to automatically populate the payment field with the total amount due when the payment screen is displayed.

*Require Suspended Authorization:* Select this option will require the driver to call and get an authorization code to service the suspended customer.

*Require Hold Service Authorization:* Checking this box will require the driver to get an authorization code to complete a sale without taking a payment on an account that is considered to be on Hold Service status.

*Require Authorization for Over Credit Limit Customers:* Select this option to require an authorization code if a driver attempts to service an account that has exceeded an established *Credit Limit*.

**NOTE:** Daily authorization codes can be printed and distributed on each route using *Reports > Route Reports > Daily > Authorization Codes*. Additionally, individual authorization codes can be retrieved per customer under *Lists > Customer Information*, and select the *Release Codes* button on the *Credit* tab — this method can be used if you would prefer the driver to call the office for the authorization code.

*Default Bank Account:* Select the bank account to use for payments collected from drivers assigned to this *Handheld Class*.

*Send Open Invoice Detail to Handheld:* Select this option to display the customer’s open invoice information within the *Invoices* tab of the
Extended Customer Info (tap on Current, Past Due, etc.) option on the handheld.

Allow ROA Application of Open Items in Payments (Requires Open Invoice Detail option above): Select this option to allow the driver to select the Open Invoices to apply a payment towards when receiving an ROA payment on the handheld.

**Handheld Payment Types:**

Select the types of payments that are accepted on the handheld:

- **Cash**
- **Check**
- **Credit Card**

**Process Credit Cards on Handheld:** Select this option to automatically process credit card transactions form the handheld.

*NOTE:* This option requires an active wireless connection and the Electronic Funds Module. Contact ARS for further information and configuration steps.

- **Coupon**
- **Money Order**
- **Debit Card**
- **Barter**
- **Direct Deposit**

**Other:**

**Disable Gratis Button:** Select this option to disable the Gratis button on the handheld.

**Block Negative Quantities:** Select this option to disable the ability for the driver to enter a negative quantity for items on the handheld.

**Limit Returns to On-hand Quantity:** Select this option to restrict the driver from entering more container returns than what is currently on hand on the customer’s account.
Messages Tab

The Messages tab contains header and footer information that will print on each customer’s receipt.

**NOTE:** For further information on setting up and formatting your receipt, refer to the Handheld User Guide.

**Tabs:**

**Header Tab:** The text in this field prints before the main body of the receipt.

**Number of Lines to Skip for Header:** Enter the number of lines to skip between the header and the body of the invoice.

**Footer Tab:** The text in this field prints after the main body of the receipt.

**Prepay Msg (Requires Pre-Pay Option):** The text in this field prints after the main body of the receipt for prepay customers.

**Prepay Warning (Requires Pre-Pay Option):** The text in this field prints after the main body of the receipt to alert the customer that their pre-pay balance is low.

**NOTE:** For further information on setting up the Pre-Pay option, refer to Chapter 2.09 of the Supplemental Guide.

**Remit to:** The text in this field will appear on the payment remittance stub.

**Post Receipt (Paper Shredding Only):** The text in this field will print on a Certificate Of Destruction for the customer.

- **Include Post Receipt Document:** Select this option to include the Post Receipt, configured above, with each customer’s invoice.

- **Require a signature with Document:** Select this option to require that a signature be captured with each Post Receipt.

**Lease Receipt:** This option allows you to format an equipment lease agreement that can be printed from the handheld.
**Contract Period in Months:** Use the arrow keys to establish the length of the contract in months.

**Lease Version:** Enter version information that can be included on the contract.

**Preview:** Select this button to preview the contract on the screen.

**NOTE:** Refer to Chapter 4.10 of the Supplemental Guide for further information on lease agreements.

**Fields:**

**Justify:** Enter an L (left), R (right), or C (centered) that corresponds to how you would like the text to be aligned on the printed receipt.

**Font:** Enter a letter corresponding to the font size you would like to use on the printed receipt.

**NOTE:** Refer to Appendix B of the Handheld User Guide for examples.

**Message:** Enter the information that you would like to print on each line.
**Receipt Tab**

The Receipt tab contains formatting options for the printed receipt.

**Fields:**

**Enhanced Invoice Body:** Select this option to use bold text on the invoice total and account balance on the printed receipt.

**Print Last Payment on Invoice:** Check this box if you would like the last payment date and amount to print on the receipt.

**Print Bottles on Hand on Invoice:** Select this option to include the containers on hand total on the customer’s printed receipt.

**NOTE:** This information is stored within the Deposits section of the customer’s account, on the Products tab.

**Print Bar Code on Payment Slip:** Check this box to print ‘Code 39’ bar codes on your Remittance Slips.

**NOTE:** This option should only be used if you are using a handheld scanner for payments on the desktop. Contact Advantage Route Systems for further information.

**Block Next Delivery Date On Invoice:** Select this option to suppress the customer’s next delivery date from printing on the invoice.

**Use SERVICE DATE instead of DELIVERY DATE:** Select this option to replace the ‘Delivery Date’ label printed on the handheld receipt with ‘Service Date’.

**Always Print Deposit Exchange:** Select this option to include the current delivery’s container exchange on the printed receipt.

**Include Remittance Stub:** Select this option to include a payment remittance stub with each printed invoice.

**Don’t Pause Between Invoice and Remittance Stub:** Check this box to print both the invoice and remittance stub without pausing between the two.

**Paper Saver Receipt:** Select this option to print a condensed receipt for the customer (disables bold text and minimizes text spacing).
 Suppress Invoice Details on Statement: Choose this option to suppress invoice details when printing a Handheld Statement.

 Print Quantity for Non-Delivery Reasons: Check this box to print Skip Reason descriptions and quantity detail on the handheld invoice.

 Use Invoice Headers by Customer Type: Select this option to enable alternate company headers to print on each customer’s handheld receipt based on their assigned ‘Dynamic Header Code’ available under Lists > Customer Information > Route > Handheld Options.

 NOTE: Each Dynamic Header Code can be created under Lists > Customer Setup Codes within RMA.

 Use Driver Initial: Choose this option to print the driver’s initials on the handheld receipt instead of their full name.

 Print Sales Tax Rate: Choose this option to print the tax percentage rate on the receipt.

 Print only the PO#: Select this option to suppress the ‘PO Number’ description from printing above the P.O. on the handheld invoice.

 Don’t Ask to Reprint Invoice at End of Sale: Choose this option to suppress the reprint request after the initial invoice is printed.

 Print Par Value on Receipt: Choose this option to print PAR values on receipts when using the Par Module.

 Only Show Secondary Currency for Invoice Total: Choose this option if you are using the ‘secondary currency’ option and would prefer to use this form of currency on your invoice total.

 Sales Tax Incl. – Show Prices including Sales Tax: Choose this option to include sales tax totals in the price of each product (instead of printing the total tax separately).

 Suppress Prices on Invoice: Select this option to suppress product prices on the printed invoice.

 Suppress Sales Tax on Invoice: Check this box to suppress the sales tax label and any tax totals from printing on the handheld receipt.

 Suppress Totals on Invoice: Select this option to suppress invoice totals on the printed invoice.

 Suppress Balance on Invoice: Select this option to suppress account balances on the printed invoice.

 Don’t Print Equipment Transfers: Select this option to suppress equipment transfer information on the printed invoice.

 Print Address: Choose the desired customer address to include on the printed invoice.

 Other Fields:

 Prepay Credit Minimum: Input the minimum amount that a customer must give the driver to prepay for items on their account (when using the Prepay option within RMA).

 Extra Charge Label: Enter a label to use for products labeled as an extra charge on invoices (select ‘Print as Extra Charge on Invoice’ on the Setup tab of the Product Charge Code screen).

 Driver Label: A label that can print next to the driver’s name or initials (i.e., Route Salesman instead of Driver).

 Receipt Type: This option should always be set to Standard unless it is being used in Pakistan.
**PDF Reprint Width:** Select the .PDF width that corresponds to the printer type that you are using.

**NOTE:** This option applies to reprinted invoices that may not have been assigned the correct printer settings originally.

**Other:**

**Allow Use Alternate Heading:** Select this option to allow the driver to print an alternate heading on the receipt by selecting the ‘Use Alternate Heading’ option on the Confirm Sale screen of the handheld.

**NOTE:** The Alternate Heading can be entered in the ‘Alt. Invoice Label’ field under the Handheld Class screen, on the Labels tab.

**Allow Printing of Invoice for Receipt Customers:** Select this option to allow the driver to temporarily override any suppressed options on the handheld receipt (i.e., blocked balances, suppressed prices) and print a complete invoice for the customer.

**None:** Select this option to prevent the driver from using either of the previous two options on the handheld.

**Print 8 inch invoice:** Select this option if you are using an IRDA truck mounted Dot Matrix printer, and you would like to print full-size invoices.

**Suppress Printing Signature:** Select this option to suppress the customer’s signature on the printed invoice.

**Print Driver First Name Only:** Select this option to only print the driver’s first name on the handheld invoice.

**Print Charge Codes:** Select this option to print the Product Charge Code ID’s next to the descriptions on the handheld invoice.

**Summarize Quantities by Product Class:** Select this option to include a Product Class sales summary on the handheld invoice.

**Print UPC Product Code:** Select this option to print the UPC code on the handheld invoice (entered on the Product Charge Code screen).

**Show Vendor Price:** Select this option to include the vendor price (Purchase Order Module) on the handheld invoice.

**Print Delivery Order Reasons:** Choose this option to print the Delivery Order Reason selected on a Delivery Order invoice receipt.

**Print Serial Number:** Select this option to print the equipment serial number on rental transactions.

**Print Secondary Description:** Select this option to print the Secondary Description entered for the item on the handheld receipt.

**NOTE:** The Secondary Description can be entered for each item under Lists > Product Codes > Product Charge Codes, on the Info tab.

**Print Beginning and Ending Meter Readings:** Select this option to include meter reading information on the printed invoice (used in the propane industry).

**Print Delivery Order No:** Select this option to include the Delivery Order number on the printed invoice (if applicable).

**Print Legal Name in Place of Delivery Name:** Select this option to print the customer’s Legal Name in place of the Delivery Name on the printed invoice.
NOTE: The customer’s Legal Name can be entered on the Info tab of Customer Information.

*Print Delivery Phone Number on Invoice:* Select this option to include the delivery phone number on the printed receipt.

*Print Arrival/Departure Time on Invoice:* Select this option to include the recorded arrival/departure time of the driver on the printed receipt.

**Upload Reports Tab**

The Upload Reports tab contains a list of all of the report options available when uploaded route data during the Afternoon Card process.

NOTE: Specify the number of copies of each report desired. If ‘0’ is entered, the report will not print.

---

**Handheld Class**

*Desktop Reports:*

**Transaction Detail:** This report includes a detailed list of all transactions that occurred while out on route.

NOTE: Entering a quantity of ‘9’ will print a Transaction Detail Report Summary, suppressing all of the detailed information.

**Blank Lines on Transaction Detail:** This option represents the number of blank lines to include between transactions, giving you additional space to write in notes or changes.

**Exceptions:** This report includes price changes, skipped stops, sales to past due accounts, and much more.

NOTE: Select the box to the right of this report to choose the detailed options you would like to include daily.

**Re-sequence:** This report includes stops that were re-sequenced by the driver.

**Driver Commissions:** This report includes commission totals accumulated for the current route day.
**Payment Summary:** This report includes a summary of all payments collected on route.

**Inventory Sold:** This report includes inventory totals for the route day.

**Driver Notes:** This report includes all notes entered on the current route by the driver.

**Equipment Movement:** This report includes all equipment movement for the route day (i.e., picked up, dropped off, and equipment left on the truck).

**Perpetual Inventory:** This report includes perpetual inventory totals for the route day.

**NOTE:** The *Perpetual Inventory* option enables the ability to carry product inventory totals on a delivery vehicle from one day to the next. Refer to Chapter 3.17 of the *Supplemental Guide* for further information.

**Credit Card (EC2000 Module Only):** This report includes collected credit card data for the route day.

**Create PDF Archive of Upload Reports:** Select this option to create a PDF copy of each set of reports that print during the *Afternoon Card* process.

**NOTE:** Each PDF file will be stored within the RMA directory under \\PDF\Handheld\Afternoon.

**Display Full CC Number on Report:** Choose this option to print the unmasked credit card number on the payment summary report.

**Report Sort Order:** Select a sorting option to use on the *Transaction Detail Report*.

**Show Deposit Detail on Transaction Detail Report:** Check this box to display all customer bottle exchanges on the *Transaction Detail report*.

**Use Par over Product Sold report (Par Module Only):** Not currently in use.

**Show Authority Level Summary on Transaction Detail Report:** Select this option to show *Sales Tax Authority* details on the *Transaction Detail Report*.

**Level 1-4 (Requires option above):** Enter the description that you would like to display for each authority on the report.

**Secondary Printer:** Enter a secondary printer to redirect a second set of *Afternoon Reports* to another printer on the network.
**Upload Reports 2 Tab**

The *Upload Reports 2* tab is a continuation of the previous tab.

![Handheld Class](image)

**Desktop:**

**Missed Stops:** This report includes any stops that were not serviced on route.

**Pre-Route Total Net/Serviced Customers:** This report will track the number of customer’s that have been ‘serviced’ based on the items added to the *Products Indicating Serviced* field (displayed on the same tab).

**Par Levels (Par Module Only):** This report includes Par Level related information for the current route.

**Asset Scans (Shredding Industry):** This report includes scanned equipment information.

**Forward Sales:** This report includes all *Forward Sales* invoices created on the current route.

**Special Product Orders:** This report includes special product requests from the customers (including items that you may not carry currently).

**Daily Coupon Upload:** This report includes all coupon activity on the current route.

**NOTE:** Contact ARS for further information on using coupons within RMA.

**Customer Promotions:** This report includes all product activity related to customer promotions.

**Secondary Printer:** Enter a secondary printer to redirect a second set of *Afternoon Reports* to another printer on the network.

**Pre-Route Total Net/Serviced Customers Report Options:**

This option allows you to create a report that indicates the number of ‘serviced’ customers based on items added to the *Products Indicating Serviced* field.

**NOTE:** This report can also be reprinted on the desktop under *Reports > Route Reports > Management > Pre-Route Total Net/Serviced Customers Report*. 

---

280 • Chapter 6 -- List Information  
Route Manager Advanced User Guide - Part A
**Available products:** A list of all of the products available within the program.

**Products Indicating Serviced:** A list of all items that qualify as ‘service’ items.

### GPRS Tab

The GPRS tab contains wireless transfer settings used with the Advanced Communications and RMLive Modules.

**NOTE:** For further information on these items, please contact Advantage Route Systems.

![Handheld Class](image)

**Fields:**

**Modem/Cable Transfer Code:** Enter a number from 1 to 9999 that will be used to initiate each data transfer, for security purposes.

**FTP Server IP/Name:** The IP or host name of the FTP server.

**PASV Mode:** Select this option if your FTP server and firewall are set up to allow for PASV mode transfers.

**FTP Server Login:** The login name used to login to the remote server.

**FTP Server Password:** The password used to login to the remote server.

**FTP Port Number (Port 21 used if blank):** The port number used by the remote server.

**Prompt to Send Transaction Data (RMLive Module):** Choose this option to prompt drivers to transfer data via RMLive after each transaction on the handheld.

**NOTE:** For further information on Network, WiFi, and RMLive transfer settings, please contact Advantage Route Systems.
**Driver ETA (RMLive Module Only):**

*None:* Select this option to disable *Order Acceptance* prompts on the handheld.

*Prompt Driver for ETA on Order Acceptance:* Select this option to prompt the driver for a time estimate when accepting a new order on the handheld.

*Driver ETA Required on Order Acceptance:* Select this option to require a time estimate on the handheld when a driver accepts a new order.

**NOTE:** The *RMLive Module* allows your drivers to receive and transmit data from the field during the route day. Contact Advantage Route Systems for further information.

---

**Real Time Tracking:**

*Enable Real Time Tracking:* Select this option to enable the *Real Time Tracking* feature of the *RDM Module*.

*RTT Server IP:* Enter the IP used for *Real Time Tracking* (RTT) service.

*RTT Server Port:* Enter the port number used to transmit real time tracking data from RTT to the RDM *Truck Tracking* screen.

*Tracking Interval (seconds):* Enter the number of seconds between data capture.

**NOTE:** *Real Time Tracking* is part of the *Route Dispatch Manager* in RMA that allows you to make route changes and transmit updated information to your drivers in real-time; contact ARS for further information on this feature.
**Screen Tab**

The *Screen* tab contains options that allow you to color-code the stop selection screen on the handheld. Select the **Browse** button next to each option to assign a custom color.

---

**Serviced Stops:**

*Serviced:* Select the color that you would like to display for all serviced stops on the handheld.

*Skips:* Select the color that you would like to display for all ‘skipped’ stops on the handheld.

---

**Unserviced Stops:**

*Unserviced:* Select the color that you would like to display for all unserviced stops on the handheld.

*Specials:* Select the color that you would like to display for all unserviced special deliveries on the handheld.

*Drags:* Select the color that you would like to display for all unserviced ‘drag’ stops on the handheld.

*High Priority:* Select the color that you would like to display for all unserviced ‘High Priority’ stops on the handheld.

**NOTE:** In order for items to be flagged as ‘High Priority,’ the stop must be assigned a *Telephone Reason* with the option ‘High Priority Reason Code’ selected under *Lists > Delivery Order Reasons*.

---

**Allow Route List Filtering by Delivery Time:** Select this option to allow the driver to sort the stop selection screen based on the preferred *Deliv. Time* (AM or PM) established under each account.

**NOTE:** This option can be found within *Lists > Customer Information > Route > Handheld Options.*
Upload Tab

The Upload tab contains items related to uploading daily transactions from the handheld.

### Upload Options:

**Allow Load Request Scheduling:** Select this option to allow drivers to schedule Load Requests on the handheld.

**Retrieve GPS Log (Requires RT2000 Module):** Select this option to retrieve GPS information during the Afternoon Card process.

**NOTE:** The Route Track 2000 Module is used to log detailed GPS coordinates on the driver’s route card throughout the day for tracking stop times, locations, duration, and more. Contact Advantage Route Systems for further information.

**Print Deposit Slip After Day End Cash Report:** Select this option to print the Deposit Slip Report after the Day End Cash Report automatically on the handheld.

With this option enabled, you can configure header information for a bank deposit slip (to be printed and attached to payments collected on route) by selecting the icon.

**Show Equipment Rental on Day End:** Select this option to include the total rental amount billed to customers on the Day End Cash Report.

**Place Payments on Posting Hold:** Select this option to enable the ‘Posting Hold’ flag on each payment when the route is uploaded to the desktop.

**NOTE:** Selecting this option will prevent payments from being posted on the desktop until the flag is removed.
Reverse Quantity on Upload: This option is currently in development and should not be used.

Copies of Day End Cash Reports: Enter the default number of Day End Cash Report copies to print from the handheld each day.

Copies of Load Verification Reports: Enter the default number of Load Verification Reports to print from the handheld each day.

Time Card Segment:
Track Driver’s Time on Handheld:
Prompt for Start Time:
Force Lunch Break:
Force Lunch After (Hours):
Minimum Lunch Length:
Allow Lunch Delay:
Lunch Delay Length:

Route Types
The Route Types option is used within the Route Dispatch Manager, found under the Route menu in RMA. This option allows you to color-code each route type (e.g., Delivery, Service) to assist you with managing your routes within the dispatch screen.

NOTE: The Route Dispatch Manager is a unique routing tool that simplifies your daily route management routines. Contact ARS for further information.

Fields:
Code: Enter up to two characters that will represent the Route Type.
Description: Enter a description for the Route Type.
Color 1, 2, 3: Use the spinners for Red, Blue, and Green to obtain the desired route identification color and shading.
Clear: Select Clear to reset each box.
Stop Overhead Processing Time: Enter the number of minutes that it typically requires to complete a delivery on-site.
Group Area Codes

Group Area Codes allow you to separate customers by geographic region for Off-Route customer filtering purposes on the handheld.

NOTE: The Off-Route filtering options available on the handheld can be found under Lists > Routes > Handheld Class, on the Off-Route tab. If your company database contains less than 5000 customers, it is not necessary to use this feature.

Fields:

Area Code: Enter a single character that will represent the Group Area Code.

Description: Enter a description for the Group Area Code.

Stop Type Codes

Stop Type Codes can be used as an additional identifier on certain reports within RMA, and can be assigned to each account under Lists > Customer Information, on the Route tab.

Fields:

ID: Enter up to two characters that will represent the Stop Type Code.

Description: Enter a description for the Stop Type Code.
Site Inspection Reasons

The Site Inspection Reasons are used on the handheld to verify the condition of equipment on-site.

Fields:

**Code:** Enter up to two characters that will represent the Site Inspection Reason.

**Description:** Enter a description for the Site Inspection Reason.

**Contact Reason:** Assign a Contact Reason to the current code to log the information on each customer’s Contacts tab.
Handheld Dunning Messages

Messages entered under *Handheld Dunning Messages* can be manually printed by your drivers from the *Extended Info* screen on the handheld. The messages have been formatted for customers that are 60, 90, and 120 days past due.

**NOTE:** *Dunning Messages* that print automatically on invoices are controlled within the *Credit Class* screen, found under *Lists > Customer Setup Codes*.

**Fields:**

*Justify:* Enter a *L* (left), *R* (right), or *C* (centered) that corresponds to how you would like the text to be aligned on the printed receipt.

*Font:* Enter a letter corresponding to the font size you would like to use on the printed receipt.

**NOTE:** Refer to *Appendix B* of the *Handheld User Guide* for examples.

*Message:* Enter the information that you would like to print on each line.
**Container Contents**

The *Container Contents* option is used in the *Paper Shredding* industry to identify the contents of the containers being picked up, emptied, or destroyed.

**Fields:**

*Code*: Enter up to two characters that will represent the *Container Content Code*.

*Description*: Enter a description for the *Container Content Code*. 
Employee Setup

The Employee Setup menu contains all information relating to employees, security, and commissions. Because much of this information is considered confidential, only supervisors should be allowed to access, view, and change this information.

<table>
<thead>
<tr>
<th>Employees</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Level Codes</td>
</tr>
<tr>
<td>Login Policies</td>
</tr>
<tr>
<td>Employee Groups</td>
</tr>
<tr>
<td>Commission Class Codes</td>
</tr>
<tr>
<td>Field Service Qualifications</td>
</tr>
</tbody>
</table>

Employees

The Employees screen contains three tabs for employee, commission, and driver information. Each employee that will use the RMA desktop and handheld program should be entered into the program here.

Information Tab

The Information tab contains common employee information and security settings.

Fields:

Employee ID: Enter up to sixteen characters that will represent the employee.

Initials: Enter the employee’s initials.

Inactive: Select this option to inactivate the employee and remove him/her from the login screens.

Name: Enter the employee’s name.

NOTE: For larger companies, it may be helpful to add employees last name first, to assist with logging in and employee based report sorting.

SSN (Optional): Enter the employee’s social security number.

Home Phone: Enter the employee’s home phone number.
Phone: Enter an alternate phone number for the employee.

Password: Enter a desktop password for the employee.

Require change on next login: Select this option to require a new password the next time the employee logs into the program.

Re-Enter Password: Re-enter the desktop password to confirm that it has been entered correctly.

Reset: Select this option to clear the current password.

Hire Date: Enter the date the employee was hired.

Release Date: Enter a date in this field if the employee is no longer with the company.

NOTE: Employees with a termination date will not be able to log into the system or have access to a handheld.

Home Branch: Select the employee’s home branch.

Employee Groups (Optional): Select an Employee Group Code to assign this employee to.

NOTE: Refer to Employee Groups found later in this chapter for further information on this option.

Financial Limit: Not currently in use.

Default Warehouse: Select the default warehouse where this employee generally receives inventory.

NOTE: This option is only used with the Handheld Inventory Module. For further information on this feature, refer to Chapter 3.10 of the Supplemental Guide.

Hourly Rate: Enter the hourly pay rate for this employee.

Overtime @ Hrs: Enter the number of hours worked prior to calculating overtime.

HH Password: Enter a numeric password for employees that will be using the handheld program.

Master User: Select this option for employees that will be allowed to make changes to Security Level Codes within RMA — typically, only one or two users should have this option enabled.

Security Level: Select the desired Security Level Code for this employee.

Employee Type: Select the desired employee type for this employee from the following options:

- Clerical: Employee will only use the desktop program.
- Driver: Employee will use the handheld program and be assigned to a route.
- Checker: Employee will use the handheld program and verify product loads on delivery vehicles.
- Credit Controller: Employee will contact past due customers.
- Salesperson: Employee will use the desktop and handheld program.
- Route Caller: Employee will only use the Route Pre-Sale screen.
**E-mail Address:** Enter the employee’s e-mail address.

**Business Phone:** Enter the employee’s business phone number.

**Extension:** Enter the employee’s business phone number extension.

**Business Fax:** Enter the employee’s business fax number.

**Note entry required on customer screen:** Select this option to require a note entry each time the employee makes a change within the Customer Information screen.

**NOTE:** The note entered will be logged within the Note field found on the Info tab of Customer Information.

**Available Branches:** Contains the list of all available branches added to RMA.

**Branches:** Contains the list of all branches this employee will have access to within RMA.

**NOTE:** All branches moved to the Branches list will be available to the employee. Double-click on each branch, or use the arrows to add/remove them.

**AF 2000:**

These options are used with the Advanced Faxing module. Contact ARS for further information.

**Commissions Tab**

The Commissions tab contains commission settings for each employee.

**NOTE:** For further information on setting up commissions, refer to Chapter 2.05 of the Supplemental Guide.

**Fields:**

**Class:** The Commission Class Code assigned.

**Rate:** The commission rate being used.
**Percentage/Units:** The type of commission rate being used, valid options are:

- **P (Percentage):** the Rate entered is treated as a percentage (i.e., 5.000 is 5%).
- **U (Unit):** The Rate entered is treated as a flat rate per unit (i.e., 5.000 is 5 dollars).

**Balance (Optional):** Allows you to enter a running balance that will be included on the Route Commission Report.

**Quantity:** Allows you to enter a running quantity that will be included on the Route Commission Report.

**Cash Percentage (Optional):** Allows you to pay drivers commissions based on payments collected in full. Enter the percentage that the driver will collect for the paid items.

**Driver/Checker Tab**

The Driver/Checker tab contains handheld settings for the employee.

**NOTE:** The tab displayed depends on the Employee Type selected on the Information tab.

**Fields:**

- **License ID:** Select the License ID that this employee is qualified for.
- **Truck ID:** Select the Truck ID that the employee regularly uses on route.
- **Handheld Class:** Select the Handheld Class that this employee will use.

**Account/Charge Code to bill if short on Daily Cash Recording:**

- **Account Number:** Select the account number that will be billed for any daily cash shortages.
**Charge Code:** Select the *Product Charge Code* that will be used for billing daily cash shortages.

**NOTE:** The *Daily Cash Recording* option allows you to verify daily cash collected per route after the data has been uploaded to the desktop. If the amount entered does not match what was uploaded on route, an invoice will be created to charge the driver for any shortages. Refer to Chapter 3.19 of the *Supplemental Guide* for further information.

**Field Service Qualifications Screen:**

**NOTE:** The *Field Service Qualifications* options are used to control the types of products that your route drivers are qualified to handle on route. This option is currently in development and is part of the *Route Dispatch Manager*. Contact ARS for further information.

**Field Cert. Code 1-3:** Select up to three certification levels that apply to the current employee.

**Last Cert:** Enter the date the certification was received.

**Exp. Date:** Enter the date this certification will expire.

**Note:** Enter any notes pertinent to the qualifications of this employee for this certification — this may be comments on limitation or reservation for the employee.
Security Level Codes

The Security Level Codes screen allows you to establish specific user rights within RMA.

**Security Level Codes**

**Fields:**

- **Level Code:** Enter a single character that will represent the Security Level Code.
- **Description:** Enter a description for the Security Level Code.
- **Login Policy:** Select a Login Policy that will control password expirations, minimum lengths, and more.

**NOTE:** Login Policies are optional and can be created under Lists > Employee Setup.

- **Branch:** Select a branch from the dropdown menu.

The following fields are read-only, and are controlled by the Login Policy selected:

- **Expires in (days):** Displays the number of days before the login password will expire.
- **Min Password Length:** Displays the minimum number of characters that the password must be.
- **Change on first login:** Forces a password change on the first login.
- **Allow old password:** Allows previous passwords to be used.

**Find:** To search for a field name in the Selection column, enter the data and click ‘GO’.

**Selection:** This field displays the menu items in RMA.

**Level:** This field displays the access level given to a particular option.

**NOTE:** Double-click on each field name to modify security level access. Each option available is defined on the next page: All, Write, Read, and None.
Mark all as: To globally change all of the items to the same security level, click on one of the following buttons:

- **All:** Allows users to access, modify, and delete data in all areas of the program.
- **Write:** Allows users to access and modify data, but they cannot delete it.
- **Read:** Allows users to view information, but they cannot modify it.
- **None:** Disables access to all options. Users will not be able to view or modify any data.

**NOTE:** Some items cannot use all four security options.

Login Policies

The *Login Policy* option will allow you to establish password security rules in RMA.

**Fields:**

*User Login Policy:* Enter up to two characters that will represent the *Login Policy*.

**Policies**

*Maximum Password Age:* Enter the maximum number of days each users password will be valid before requesting a new one.

*Min Password Length:* Enter the minimum number of characters the password must contain.

*Change on first login:* Select this option to force a password change the first time the user logs in to RMA.

*Allow old password:* Select this option to allow old passwords to be used.
Employee Groups

The Employee Groups option allows you to create a series of codes that can be assigned to employees for filtering purposes within the Contacts tab of Customer Information.

**Fields:**

**Employee Group:** Enter up to five characters that will represent the Employee Group Code.

**Description:** Enter a description for the Employee Group Code.

**Default Contact Message Filter:**

Select the Contact Message Groups that employees assigned to this group will view by default within the Contacts tab of Customer Information.

**NOTE:** Contact Message Groups can be found under Lists > Customer Setup Codes.

**No Reason:** Select this option to include messages that are not assigned a Contact Message.

**Ungrouped Reasons:** Select this option to include messages that are not assigned to a Contact Message Group.
Commission Class Codes

The *Commission Class Codes* option is used to pay your drivers a point-of-sale commission rate.

**NOTE:** For further information on setting up commissions, refer to Chapter 2.05 of the Supplemental Guide.

**Fields:**

*Class:* Enter a single digit character that will represent the *Commission Class Code.*

*Description:* Enter a description for the *Commission Class Code.*

Field Service Qualifications

The *Field Service Qualifications* option is used to control the types of products that your route drivers are qualified to handle on route. This option is currently in development and is part of the Route Dispatch Manager, contact ARS for further information.

**Fields:**

*Code:* Enter up to two characters that will represent the *Field Service Qualification* code.

*Description:* Enter a description for the *Field Service Qualification* code.

*Months Valid:* Enter the number of months the qualification code will be valid.

*Note:* Enter any notes pertinent to the qualification code.
Truck Information

The Truck Information section contains settings related to your delivery vehicles.

Trucks

The Trucks option allows you to create an entry for each delivery vehicle in your fleet. This information will be used on each route and handheld.

General Tab

The General tab contains all of the standard options that apply to each delivery vehicle.

Fields:

Truck ID: Enter up to ten characters that will represent each Truck.

Truck Class ID: Select the appropriate class for this truck type.

NOTE: Refer to the Truck Class option on the next page for further information.

Bays (Read-Only, default from Truck Class): The number of bays assigned to this truck.

Bottle Capacity (Default from Truck Class): The maximum number of products this truck can carry.

Required License (Read-Only, default from Truck Class): The required drivers license for this truck.

Mileage: Displays the truck’s current mileage. Mileage is automatically updated from the handheld when entries are made.

Vehicle Description: Enter a description for the truck.

License Plate (Optional): Enter the truck’s license plate information.

VIN (Optional): Enter the truck’s vendor identification number.
**Next Service Date (Optional):** Enter the truck’s next service date.

**Warehouse (Enhanced Inventory Only):** Select the receiving warehouse for this truck.

**Mobile Warehouse (Enhanced Inventory Only):** Select the Mobile Warehouse ID for this truck.

**Registration Expiration:** Enter the date the registration for this vehicle expires.

**State Registered:** Enter the name of the state where this vehicle is registered.

**Location:** Enter the location where this vehicle is normally parked during non-delivery times.

**Assigned Driver:** Enter the name of the driver normally assigned to this vehicle.

**IFTA:** Check this box for IFTA compliance.

---

**NOTE:** The International Fuel Tax Agreement (IFTA) is an agreement between all 48 contiguous states, and 10 Canadian provinces. It enables participating jurisdictions to cooperate in the collection and administration of motor fuel taxes. An IFTA account is set up with the base state, which authorizes travel in all IFTA jurisdictions. You need an IFTA license if you travel in two or more member jurisdictions, and if your vehicle either weighs more than 26,000 pounds, OR has three or more axles, regardless of weight.

**Comments:** Enter any comments pertinent to the use or operation of this vehicle.

---

**Direct Route Tab**

The Direct Route tab is used in the propane industry to interface with the Direct Route program and is part of a custom enhancement. Contact ARS for further information.
Truck Class

The Truck Class option allows you to input settings that apply to each truck in your fleet. Within each Truck Class, you can enter the number of bays, weight, capacity, etc.

NOTE: After you have created each Truck Class, they can be assigned within the Trucks option covered on the previous page.

Information Tab

Class ID: Enter up to four characters that will represent the Truck Class.

Description: Enter a description for the Truck Class.

Bays: Enter the number of bays to use for trucks assigned to this class.

Bottle Capacity: Enter the maximum number of products to allow for trucks assigned to this class.

Side Load: Check this box if the bays on trucks assigned to this class will be side loaded.

Rear Load: Check this box if the bays on trucks assigned to this class are rear loaded.

Tail Lift: Check this box if the trucks assigned to this class will contain a tail lift.

Useful Load: Enter the maximum weight of product trucks assigned to this class can carry.

Empty Weight: Enter the weight of empty trucks assigned to this class.

Gross Weight: Enter the maximum weight of trucks assigned to this class filled to capacity.

Truck Volume: Enter the total volume of items added to trucks in this class.

Truck Gallons: Enter the total gallons of liquid added to trucks in this class.

Cost Per Mile: Enter the cost per mile to operate the trucks assigned to this class.

Required License: Enter the licenses required to drive a truck in this class.

User Def.1 & 2: This can be used for any numeric information of your choice.
**Compartments Tab**

The *Compartments* tab is part of a custom enhancement. Contact ARS for further information.

![Compartments Tab Image]

**License**

The *License* options ensures that each route driver is properly licensed to operate an assigned truck.

**NOTE:** The license requirement can be assigned within the *Truck Class* option covered on the previous page. Additionally, to ensure the driver is qualified to operate the vehicle, assign the license each driver possesses within *Lists > Employee Setup > Employees*, on the *Driver* tab.

![License Image]

**Fields:**

*ID:* Enter a single character that will represent the *License.*

*Description:* Enter a description for the *License.*
Vehicle Condition Inspection

The Vehicle Condition Inspection option allows you to create a list of safety items that will need to be verified on the handheld each day prior to delivering to customers. Additionally, the checklist can be printed from the handheld after the inspection.

**NOTE:** To require that a Vehicle Inspection is completed daily, select the ‘Force Vehicle Inspection’ option found under Lists > Routes > Handheld Class, on the Load/Unload tab.

### Fields:

**ID:** Enter up to three digits that will represent a Category ID.

**NOTE:** To group items of the same type together, use the same Category ID (i.e., all items related to the engine may be assigned ‘01’).

**Item:** Enter up to three digits to designate the inspection item number.

**Description:** Enter a description for the item.

**Type:** Select the item type from the following list:

- **Yes / No:** Select this type if the item requires a ‘Yes’ or ‘No’ answer (i.e., “Does the engine run?”).
- **Numeric Value:** Select this type if the item requires a numeric value within a preset range. You can enter the lowest and highest value accepted (e.g., Tire Pressure).
- **Text:** Select this type if the item requires a text response. You can enter the maximum length accepted (e.g., Need Wiper Fluid).
- **List:** Select this type if the item will accept one of multiple options on a list (e.g., Excellent, Average).
- **Category Heading:** Select this option to designate the item as a category heading (e.g., Engine).

**Mandatory:** Select this option if the item will be required prior to completing the inspection.
**Non-Drive Warning:** Select this option to display a warning message if the response on the item is outside of an acceptable range.

**NOTE:** This option only applies to the ‘Yes/No’ and ‘Numeric Value’ item types.

**Print:** Select one of the following print options:

- **Always:** Select this option to always include this item on the *Vehicle Inspection Report* printed from the handheld.
- **Non-Drive Only (Requires Non-Drive Warning Option):** Select this option to include this item on the *Vehicle Inspection Report* only if it fails inspection.

### Route and Truck Management

The *Route and Truck Management* option allows you to easily update driver truck assignments by using a click-and-drag method on the screen. Simply click-and-drag a *Truck ID* within the right window pane over to the driver that it will be assigned to within the left window pane, and release.

**NOTE:** To remove a *Truck ID* from a driver, simply click-and-drag any white area within the *Truck* pane over the driver’s name, and release.

---

**Fields:**

- **Route:** The route assigned to the current driver.
- **Driver Name:** The name of the driver.
- **Truck ID:** The current truck assigned to the driver.
- **Truck ID:** The truck identification code.
- **Truck Description:** The description of the truck.
Custom Report Groups

The Custom Report Groups option allows you to link your own reports to the RMA menu for convenience to your desktop users. This can be helpful if your employees are calling up external spreadsheets or documents frequently.

**NOTE:** Refer to Chapter 4.05 of the Supplemental Guide for further information on this topic.

![Custom Report Groups](image)

**Fields:**

- **Menu Title for Report Group:** Enter the name of the external report.
- **Shortcut Character:** Select the shortcut letter that will be used within the RMA reports menu.
- **Report folder location:** Enter the directory that contains the shortcut file to the external report.

**NOTE:** The Report Folder Location must contain a shortcut file to the report with an `.lnk` extension.

- **Inactive Reports Folder:** Choose this option to inactivate the Custom Report Group.

**Security Level Access:**

- **Available:** This field contains all of the Security Level Codes in RMA.
- **Selected:** This field displays all of the Security Level Codes that will view the Custom Report Group.

**NOTE:** Double-click on an individual Security Level Code, or use the arrows, to enable the Custom Report Group for your employees that qualify.
Setup Wizards

Setup wizards allow you to input information quickly and accurately into RMA.

<table>
<thead>
<tr>
<th>New Customer w/Order Wizard</th>
<th>New Stop Wizard</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Equipment Setup</td>
</tr>
</tbody>
</table>

New Customer with Order Wizard

The New Customer With Order Wizard allows you to enter all of the information required to create a new customer in RMA.

NOTE: Before a new customer can be created, basic Lists menu items must be learned and created. Refer to each item discussed earlier in this manual and the Getting Started Guide for further information.

Step 1 of 4 – Customer Address Info

This tab contains all of the customer’s billing and delivery contact information.

**Fields:**

**Home Branch:** Select the Branch that the customer will be assigned to.

**Customer Type:** Select the Customer Type Code that should be applied to this account.

**Start Date:** Enter the date that the customer signed up for service.

**Start Reason Group:** Select the Start Reason Group that should be applied to this account.

**Start Reason:** Choose a Start Reason for this account.
**Promotion Code:** This option is used for promotions that can be offered to customers for signing up for service with your company.

**NOTE:** Optionally, any products included in a promotion can be added to each Promotion Code under Lists > Customer Setup Codes. As the Promotion Code is selected within the New Customer W/ Order Wizard, any products associated with the promotion will automatically be added to the customer’s First Order.

**Major Account Code:** Select a Major Account Code for this account.

**Contract Exp. Date:** Enter an expiration date for customers that are under contract.

**Delivery Information:**

**Delivery Account Name and Address:** Enter the customer’s delivery name and address information.

**Delivery ZIP Code:** Select the customer’s ZIP Code from the drop-down list.

**NOTE:** All ZIP Codes that will be assigned to customers must be added to RMA under Lists > Zip Codes.

**MangoGeo:** Select this option to use the MangoGeo program for address verification and correction services.

**NOTE:** Try the Mango Geo program at no charge for fifteen addresses before being prompted to sign up for service. Additionally, you will automatically receive fifty additional usages by simply provided us with your contact information if you’re interested in the program.

**Detail Button:** Select this option to select enter advanced address information associated with Lists > Geography Codes.

**Check Address:** Select this option to verify address information using the Advanced Mapping Module.

**NOTE:** The Advanced Mapping Module integrates with Microsoft Mappoint to provide address correction and route optimization options. Contact Advantage Route Systems for further information.

**Phone:** Enter the new customer’s phone number and extension (if any).

**Work Phone:** Enter the customer’s work phone number and extension (if any).

**Fax:** Enter the new customer’s fax number.

**Cell:** Enter the new customer’s cell phone number.

**Contact:** Enter the primary contact person to contact regarding deliveries on the account.

**Phone:** Enter the phone number of the delivery contact person.

**E-mail:** Enter the customer’s e-mail address.
**Billing Information:**

**Billing Account Name and Address:** Enter the customer’s billing name and address information.

- **Duplicate Check:** Select this option to check if the customer has been added to RMA already.

**Billing ZIP Code:** Select the customer’s ZIP Code from the drop-down list.

- **MangoGeo:** Select this option to use the MangoGeo program for address verification and correction services.

**NOTE:** Try the MangoGeo program at no charge for fifteen addresses before being prompted to sign up for service. Additionally, you will automatically receive fifty additional usages by simply provided us with your contact information if you’re interested in the program.

**Detail Button:** Select this option to select enter advanced address information associated with Lists > Geography Codes.

- **Check Address:** Select this option to verify address information using the Advanced Mapping Module.

**Extra:** Enter reference information of your choice (e.g., previous account number).

**Legal Name:** Enter the account’s legal name.

**Master Billing Account Number:** Enter an account number to which all transactions for this customer will be posted and billed. For standard accounts, leave this option blank.

**Phone:** Enter the new customer’s phone number and extension (if any).

**Work Phone:** Enter the customer’s work phone number and extension (if any).

**Fax:** Enter the new customer’s fax number.

**Cell:** Enter the new customer’s cell phone number.

**Contact:** Enter the person to contact regarding billing information on the account.

**Phone:** Enter the phone number of the billing contact.

**E-mail:** Enter the customer’s e-mail address.

**NOTE:** Multiple e-mail addresses can be entered if desired, in the following format: email1@domain.com;email2@domain.com (there should not be any spaces after each semi-colon). Up to 50 characters can be used for all addresses in this field.

**Sales Rep1, 2, & 3:** Enter up to three separate sales representatives on the account.

**Show Hints:** Select this option to view ‘Hints’ in the top-right corner of the screen while using the wizard.
Step 2 of 4 – Customer Order Info

This tab contains the customer’s product and equipment information.

Equipment (Order or Setup):

Order: Select this option to setup an order for equipment on the account (generally, a Delivery Order will be scheduled).

Setup: Choose this option to manually install a piece of equipment on the account (generally used if equipment has already been installed).

First Order (Products):

First Order: Select this option to enter products that will be delivered on the customer’s first order (generally, a Delivery Order will be scheduled).

Default Products: Choose this option to establish a standing product order on the account permanently.

Sales Tax: Select the customer’s Sales Tax Code.

Price Level: Select the product price level to apply to the account.

Use Price List: Select this option to assign the customer to a Product Price List.

Price List: Select the Product Price List to apply to the account (after choosing the ‘Use Price List’ option).

Quantity Discount Pricing: Select this option to use Quantity Discount Pricing on the account.

Pre-Pay Products: Select this option to use the Pre-Pay feature on the account.

NOTE: For further information on the pricing options above, refer to Chapter 2.01 and Chapter 2.09 of the Supplemental Guide.

Bottle Deposits:

Add all of the container deposits that apply to the account.

NOTE: Refer to Chapter 2.04 of the Supplemental Guide for further information on container deposits.
**First Order (Delivery Order Scheduling):**

**Due On & Route:** If an initial Delivery Order is being scheduled, enter the date and route desired.

**Messages:**

Select from the following message types to enter messages on the account:

- **Order:** This message will apply to the current Delivery Order and be displayed on the handheld (if scheduled).
- **Invoice:** This permanent message will be printed on the customer’s handheld invoice.
- **Order Reasons (Only displayed if Order is selected):** Select this option to choose a Delivery Order Reason — if a Delivery Order is being scheduled.

**Other:**

- **Package Plan (Package Plan Module Only):** Choose the Package Plan Code to apply to the account.
- **Order Copies:** Select the printed Delivery Order format to use — when scheduling a Delivery Order.

**Step 3 of 4 – Customer Credit Info**

This tab contains the customer’s credit information.

**Fields:**

- **SS Number:** Enter the customer’s social security number.
- **Bus. License:** Enter the business license for this customer.
- **Status:** Select the customer’s Account Status Code.
- **Service Priority:** Select the customer’s Service Priority Code.
- **Credit Class:** Select the customer’s Credit Class Code.
- **Late Charge:** Select the customer’s Late Fee Code.
- **Statement Assessment:** Select the customer’s Statement Assessment Code.
- **Statement:** Select the customer’s Statement Code.
- **Second Statement:** Select a secondary Statement Code for the customer.
Admin. Chrg Code: Select the customer’s Administrative Charge Code.

Refund Chk Code: Select the customer’s Refund Check Code.

Preferred Payment: Select the customer’s preferred payment method.

Open Invoice: Select this option to use the ‘Open Invoice’ option for payments received on the account.

NOTE: Open Invoice allows you to apply payments directly to open invoices on the customer’s account. Alternatively, with this option unchecked, the account will be considered Balance Forward, and payments will only be able to be applied to the balance on the account.

Preferred Bank: Select the preferred bank account for this customer.

Rent Calendar: Select the appropriate rent calendar for this customer.

Rent Invoice (Requires a Statement with Invoices): Select this option if the customer should only receive a Rental Invoice copy with their statement.

Opening Balance: Enter an opening balance on the account.

EDI Code (Optional Module): Select the customer’s EDI Code.

Asset Tax: Select the customer’s equipment Asset Tax Code.

Promotional Price Group (Buy/Gets Module Only): Choose the promotion to apply to the account.

NOTE: The Buy/Gets Module is used to offer free or discounted items to your customers for buying an established quantity of products during a promotion. Contact Advantage Route Systems for further information.

Period Discount Pricing: This unique pricing option allows you to set up discounts or free items for customers that purchase an established quantity of items over a period of time.

NOTE: For further information on Period Discount Pricing, refer to Chapter 2.15 of the Supplemental Guide.

Credit Information:

Contact: Enter the credit contact for this account.

Phone: Enter the credit contacts phone number.

Alternate Phone: Enter an alternate phone number for the account.

Ext.: Enter the extension to dial.

Fax: Enter the customer’s credit fax number.

E-mail: Enter the customer’s credit e-mail address.

Credit Controller: Assign an employee to the account that will manage credit or past due inquiries.

Credit Terms: Choose the terms that you would like to assign to this account.

Credit Rating: Enter the customer’s credit rating.

Credit Limit: Specify the credit limit on the account.

NOTE: Leave the number at ‘0.00’ to establish unlimited credit on the account.
**Payment Note:** A note entered here will be displayed when a new payment is added for this customer.

**Messages:**

**Notes:** This permanent message will be logged on the *Info* tab of the customer’s account.

**NOTE:** You may elect to popup this message each time the customer’s account is accessed by selecting the ‘Popup Customer Note’ option found under *File > Branch Setup*, on the *Desktop* tab.

**Statement Msg:** This permanent message will be displayed on the customer’s desktop statement each month.

**Other:**

**Credit Card (EC2000 Module Only):** Select this option to enter credit card details on the account.

**Bank Info (EC2000 Module Only):** Select this option to enter bank details on the account.

**Recurring Billing:** Select this option to establish *Recurring Billing Charges* on the account.

**Show Additional Flags:** Select this button to access optional fields for storing additional data of your choice on the account.

**Step 4 of 4 – Customer Route Info**

This tab contains the customer’s route information.

**Default Route Info:**

**Route:** Select the route the customer is to be assigned to.

**Sequence:** Enter the sequence number of the stop on route.

**Stop Type:** A *Stop Type* can be assigned to each account and used as an identifier on certain reports within RMA.

**Delivery Calendar:** Select this option to setup the customer’s permanent delivery schedule.

**NOTE:** Refer to Chapter 4 of the *Getting Started Guide* for further information on scheduling customers for delivery.
**Will Call:** Check this box to prevent the current stop from showing up on route, even if a delivery schedule has been established. The stop will only show up on route when either a *Delivery Order* or *Route Pre-Sale* has been created.

**Exact:** Select this option to only allow the current stop to be scheduled on the “exact” *Day Label* assigned within the deliver calendar when managing routes within the RDM screen.

**NOTE:** If the stop is assigned to Day Label ‘W01’ within the delivery calendar, then the stop can only be assigned to available ‘W01’ labels within the RDM screen when the *Exact* option is selected.

### Handheld Options:

**Signature Required:** Select this option to require the customer’s signature with each delivery.

**Remittance Stub:** Select this option to print a payment remittance stub with the customer’s handheld receipt.

**Suppress Prices on Invoice:** Select this option to suppress all product prices on the printed handheld receipt.

**Suppress Totals on Invoice:** Select this option to suppress all product price totals on the printed handheld receipt.

**Suppress Balance:** Select this option to suppress the customer’s balance from printing on the handheld receipt.

**Use Alternate Invoice Label:** Select this option to replace the standard *Invoice Label* with the *Alternate Invoice Label* found under *Lists > Routes > Handheld Class*, on the *Labels* tab.

**Display Unit Reference on Invoice:** Select this option to use the unit *Product Reference Label* — under *Product Charge Codes*, on the *Info* tab — and the *Base Qty. (Pricing)* tab as the product reference on each invoice.

**Group Area Code:** This option allows you to separate customers by groups within the *Off-Route List* of the handheld. The codes can be set up under *Lists > Routes > Group Area Codes*.

**Dynamic Header Code:** Select the *Dynamic Header Code* to use on the account.

**NOTE:** *Dynamic Header Codes* allow you to use alternate company headers on handheld invoices for each customer, and can be found under *Lists > Customer Setup Codes*. This is an alternative to the standard company header found under the *Handheld Class* screen.
**Invoice Copies:** Enter the number of handheld invoice copies to print with each delivery.

**Deliv. Time:** Select the customer’s preferred delivery time, AM or PM.

**NOTE:** Customers can be sorted by delivery time on the handheld by selecting the ‘Allow Route List Filtering by Delivery Time’ option under Lists > Customer Information > Routes > Handheld Class, on the Screen tab.

---

**Precalling:**

![Precalling Form](image)

**Don’t Call (RV2000):** Select this option if the customer should not receive a call prior to delivery.

**Don’t Call (Presale):** Select this option to exclude the customer from being called when using the Route Pre-Sale option.

**Start / End Time:** Select the time range that the customer would like to receive a call when using RV2000 or Route Pre-Sale.

**Language:** Select the language required when contacting this customer.

**Phone No. to Call:** Enter the phone number to use when pre-calling this customer.

**Route Caller:** Select an employee in charge of pre-calling the customer (employee must be type: Route Caller).

**Call Freq:** Select the Pre-Call Calendar code to assign to the customer.

**Next Call:** Displays the next pre-call scheduled on the account.

---

**Purchase Order:**

![Purchase Order Form](image)

**Purchase Order (up to 3):** Enter a purchase order up to 30 characters on the account.
**P.O. Exp. Date:** If you would like this P.O. to expire, enter an expiration date.

**NOTE:** A report can be run periodically that will list all of the expired, or about to expire, P.O. numbers. This report can be generated under *Reports > Management Reports > Expired Purchase Orders.*
**Product Class (Multiple P.O. Only):** This option allows you to choose a specific Product Class that this P.O. will apply to. Products from other classes will not be assigned this P.O.

**NOTE:** If the Product Class field is empty, all products will apply to the P.O. as normal.

**Available:** This field is automatically adjusted as sales are made if an amount has been entered within the P.O. Limit field below.

**P.O. Limit:** Enter the maximum amount that should be billed under the current P.O.

**Note:** Available for additional text.

### Water Analysis:

![Water Analysis Table]

**Number Of Occupants:** The number of residents in the dwelling or using water from the well or other point source.

**Regeneration Cycle:** Water treatment equipment such as water softeners need to be regenerated. Enter the number of days or gallons to circulate between cycles.

- **Gals:** The number of gallons of water circulated through the chemical bed of the water softener between re-generation cycles.

- **Days:** The number of days that water is circulated through the chemical bed of the water softener between re-generation cycles.

**Hardness:** A measure of the calcium and magnesium salts in the water. Hardness is often measured in grains per gallon of water.

**Turbidity:** Measurement of the cloudiness in water.

**Hyd. Sulfate:** Amount of Hydrogen Sulfate in water.

**Iron:** Amount of Iron in mg/L.

**Manganese:** Amount of Manganese in milligrams/Liter (mg/L.)

**Iron Bacteria:** Amount of Iron Bacteria in water.

**Alkalinity:** Amount of sodium present in mg/L.

**Tannins:** Amount of Tannins in water. Units of measurement vary.

**Nitrates:** Amount of Nitrates in parts per million.

**Chloride:** Amount of Chloride in mg/L.

**TDS:** Amount of Total Dissolved Solids in mg/L.

**Iron:** Amount of Iron in mg/L.

**PH:** pH value of the water. This is a number between 6 and 8.

**Other:** This may include oxygen, organic carbon, ammonia nitrogen, phosphorus, fluoride, aluminum, barium, cadmium, chromium, lead, zinc, fecal coli-forms, etc.
Site Stats:

Test Date: Date the water sample(s) were obtained.
Test Location: Enter a description for the location.
Water Source: This may be a well, spring, stream, impounded water, Artesian well, cistern, etc.
Well Depth: The normal depth to water if a well is the water source.
GPM: Gallons per minute.
EWU: Expeditionary Water Unit
Pressure Tank Settings: In/Out: This is the pressure in pound per square inch (PSI) in the water supply tank. The pump may start operating at a Cut In pressure around 20 PSI and turn off or Cut Out at about 40 PSI. These settings vary depending on the location of the pressure tank with respect to plumbing fixtures.

NOTE: The above information is collected by the driver or sales representative to analyze a customer’s needs.

Industry:

Tax Exempt
Net Transactions for Refund
Static Delivery
Use Alternate G/L No.
Cylinder Exch.
Check 1
Check 2
Check 3
Check 4

Fields:

Tax Exempt: Check this box if the customer is exempt from paying sales tax. Additionally, you will be able to enter the customer’s exempt tax code for reference.
Net Transactions for Refund: Selecting this option will refund any balance on the customer's account if the Net Invoices option is selected while processing refund checks within Transactions > Payments > Print Refund Checks.

Static Delivery: Used with the RDEX Module (Route Scheduling).

Use Alternate G/L No.: Select this option to post all product sales this account to the Alternate G/L account assigned within the Product Charge Codes screen.

NOTE: If the option above is selected and a product posted to the account is not assigned an Alternate G/L, the standard G/L account assigned to the product will be used.

Cylinder Exch (Propane Industry): Switches the account to handheld cylinder exchanges on the handheld.

Check1-Check4: These fields can be renamed and used for options of your choice.

Text 1-4: These fields can be renamed and used for options of your choice.

Export Reference: Not currently in use.

NOTE: For further information on renaming fields in RMA, refer to Chapter 1.04 of the Supplemental Guide.

Service Schedule:
The Service Schedule option is part of Degree Day Forecasting. For further information on this topic, refer to Chapter 3.22 within the Supplemental Guide.
Other:
The *Other* option is used for misc. enhancements to RMA.

Fields:

*On-Site Time:* Enter the number of minutes needed for a typical delivery stop at this location (used with the *RDM Module*).

Messages:

*Alert:* This permanent message will automatically popup on the handheld when the driver selects the customer’s stop.

*Driver:* This permanent message is used for driving instructions on the handheld.

*Hours:* This permanent message allows you to enter the hours of operation at a customer’s location.

**NOTE:** This option requires at least one *Time Band*, found under *File > Branch Setup*, on the *Handheld* tab.

*One Time:* This message will allow you to select a range of dates to display a temporary message on the handheld.

*Site:* This permanent message is used for special instructions for the driver at the customer’s location.

*Hours:* This permanent message allows you to enter the hours of operation at a customer’s location.

**NOTE:** This option requires at least one *Time Band*, found under *File > Branch Setup*, on the *Handheld* tab.

*Invoice:* This permanent message will be printed on the customer’s handheld invoice.

Other:

*Latitude:* Enter the latitude coordinate of the stop.

*Longitude:* Enter the longitude coordinate of the stop.

*Map Page:* Enter the map page this stop can be found on within a *Thomas Guide* or similar.

*Key No.:* This field can be used to store a key code, and is displayed within the *Driver Instructions* field on the handheld.

*Contact Via (Route Pre-Sale):* The method of contact that should be used for this customer.

*Frequency (Route Pre-Sale):* The frequency that the customer should be contacted.
New Stop Wizard

The New Stop Wizard allows you to add an additional stop on an existing customer’s account.

Step 1 of 2 – Customer Delivery Info

This tab contains all of the new stop’s billing and delivery contact information.

Account Information:

Acct #: Enter the existing customer’s account number for which you are adding a stop (if applicable).

Delivery Information:

Delivery Account Name and Address: Enter the customer’s delivery name and address information.

Delivery ZIP Code: Select the customer’s ZIP Code from the drop-down list.

Detail Button: Select this option to select enter advanced address information associated with Lists > Geography Codes.

Check Address: Select this option to verify address information using the Advanced Mapping Module.

NOTE: The Advanced Mapping Module integrates with Microsoft Mappoint to provide address correction and route optimization options. Contact Advantage Route Systems for further information.

Phone: Enter the new customer’s phone number and extension (if any).

Work Phone: Enter the customer’s work phone number and extension (if any).

Fax: Enter the new customer’s fax number.

Cell: Enter the new customer’s cell phone number.

Contact: Enter the primary contact person to contact regarding deliveries on the account.

Phone: Enter the phone number of the delivery contact person.

E-mail: Enter the customer’s e-mail address.
**PO Number:** Enter a standing purchase order number on the account.

**PO Exp. Date:** Enter a purchase order expiration date.

**PO Limit:** Enter a purchase order limit.

**Available:** Enter an available purchase order amount.

**Messages:**
Select from the following message types to enter messages on the account:

- **Order:** This message will apply to the current Delivery Order and be displayed on the handheld (if scheduled).
- **1 Time:** This message will allow you to select a range of dates to display a temporary message on the handheld.
- **Site:** This permanent message is used for special instructions for the driver at the customer’s location.
- **Invoice:** This permanent message will be printed on the customer’s handheld invoice.
- **Alert:** This permanent message will automatically popup on the handheld when the driver selects the customer’s stop.
- **Driver:** This permanent message is used for driving instructions on the handheld.
- **Hours:** This permanent message allows you to enter the hours of operation at a customer’s location.

**NOTE:** This option requires at least one Time Band, found under File > Branch Setup, on the Handheld tab.

**Order Reasons (Only displayed if Order is selected):** Select this option to choose a Delivery Order Reason — if a Delivery Order is being scheduled.

**Notes:** This permanent message will be logged on the Info tab of the customer’s account.

**NOTE:** You may elect to popup this message each time the customer’s account is accessed by selecting the ‘Popup Customer Note’ option found under File > Branch Setup, on the Desktop tab.

**Statement Msg:** This permanent message will be displayed on the customer’s desktop statement each month.

**Handheld Options:**

- **Remittance Stub:** Select this option to print a payment remittance stub with the customer’s handheld receipt.
- **Suppress Balance:** Select this option to suppress the customer’s balance from printing on the handheld receipt.
- **Signature Required:** Select this option to require the customer’s signature with each delivery.
- **Invoice Copies:** Enter the number of handheld invoice copies to print with each delivery.
**Dynamic Header Code:** Select the *Dynamic Header Code* to use on the account.

**NOTE:** *Dynamic Header Codes* allow you to use alternate company headers on handheld invoices for each customer, and can be found under *Lists > Customer Setup Codes*. This is an alternative to the standard company header found under the *Handheld Class* screen.

**Pre Call Options:**

*Don’t Call:* Select this option if the customer should not receive a call prior to delivery.

*Start Time:* Select the earliest time to call the customer.

*End Time:* Select the latest time to call the customer.

*Language:* Select the language that should be spoken to the customer.

*Phone No. to Call:* Enter the phone number to use when pre-calling the customer.

*Route:* Select the route the customer is to be assigned to.

*Stop Type:* A *Stop Type* can be assigned to each account and used as an identifier on certain reports in RMA.

*Will Call:* Check this box to prevent the current stop from showing up on route, even if a delivery schedule has been established. The stop will only show up on route when either a *Delivery Order* or *Route Pre-Sale* has been created.

*Sequence:* Enter the sequence number of the stop on route.

*Latitude:* Enter the latitude coordinate of the stop.

*Longitude:* Enter the longitude coordinate of the stop.

*Map Page:* Enter the map page this stop can be found on within a *Thomas Guide* or similar.

*Group Area Code:* Select the customer’s *Group Area Code*.

*Delivery Calendar:* Select this option to setup the customer’s permanent delivery schedule.

**NOTE:** Refer to Chapter 4 of the *Getting Started Guide* for further information on scheduling customers for delivery.

*Recurring Billing:* Select this option to establish *Recurring Billing Charges* on the account.

*Show Hints:* Select this option to view ‘Hints’ in the top-right corner of the screen while using the wizard.
Step 2 of 2 – Customer Order Info

This tab contains the customer’s product and equipment information.

![Image of Customer Order Info Tab]

**Equipment (Order or Setup):**

- **Order**: Select this option to setup an order for equipment on the account (generally, a Delivery Order will be scheduled).
- **Setup**: Choose this option to manually install a piece of equipment on the account (generally used if equipment has already been installed).

**First Order (Products):**

- **First Order**: Select this option to enter products that will be delivered on the customer’s first order (generally, a Delivery Order will be scheduled).
- **Default Products**: Choose this option to establish a standing product order on the account permanently.

**Bottle Deposits:**

Add all of the container deposits that apply to the account.

**NOTE:** Refer to Chapter 2.04 of the Supplemental Guide for further information on container deposits.

**First Order (Delivery Order Scheduling):**

- **Due On & Route**: If an initial Delivery Order is being scheduled, enter the date and route desired.
- **Order Copies**: Select the printed Delivery Order format to use — when scheduling a Delivery Order.

**Other:**

- **Promotion Code**: This option is used for promotions that can be offered to customers for signing up for service with your company.

**NOTE:** Optionally, any products included in a promotion can be added to each Promotion Code under Lists > Customer Setup Codes. As the Promotion Code is selected within the New Stop Wizard, any products associated with the promotion will automatically be added to the customer’s First Order.
Sales Tax: Select the customer’s Sales Tax Code.

Asset Tax: Select the customer’s equipment Asset Tax Code.

Exempt: Check this box if the customer is exempt from paying sales tax. Additionally, you will be able to enter the customer’s exempt tax code for reference.

Use Price List: Select this option to assign the customer to a Product Price List.

Quantity Discount Pricing: Select this option to use Quantity Discount Pricing on the account.

Price List: Select the Product Price List to apply to the account (after choosing the ‘Use Price List’ option).

Pre-Pay Products: Select this option to use the Pre-Pay feature on the account.

NOTE: For further information on the pricing options above, refer to Chapter 2.01 and Chapter 2.09 of the Supplemental Guide.

Package Plan (Package Plan Module Only): Choose the Package Plan Code to apply to the account.
Equipment Setup Wizard

The Equipment Setup Wizard allows you to add all of your equipment to RMA.

NOTE: Refer to the Equipment Import document available on www.ARS247.com for information on importing all of your equipment globally.

Step 1 of 4

This step allows you to enter equipment identification information.

Fields:

**Equipment ID**: Enter up to sixteen characters that will represent the piece of equipment.

**Unit Type**: Select the Equipment Type Code that applies to this piece of equipment.

**Unit Style**: Select the Equipment Style Code that applies to this piece of equipment.

**Vending Machine**: Not currently in use.

**Branch**: Select the branch this piece of equipment is assigned to.

**Equipment ID2**: Enter an alternate identification code for this piece of equipment, if desired.

**Model Number**: Enter the model number for this piece of equipment.

**Capacity**: Enter the total number of items the unit can hold (e.g., for Racks, Cages).

**Container Content Charge Code**: Select the primary product that the unit will hold.

NOTE: The Capacity and Charge Code fields are part of the Cylinder Exchange option found under Lists > Routes > Handheld Class, on the Sales Rules tab.
**Tank Type (Oil Recycling Industry):** Select the type of tank that applies to the equipment.

**Minimum Level:** Enter the minimum number of containers that should be maintained.

**Maximum Level:** Enter the maximum number of containers.

**Manufactured Date:** Enter the product manufacturing date.

---

**Step 2 of 4**

This step contains purchasing information for each piece of equipment.

![Equipment Tracking Interface](image)

**Fields:**

**Equipment Status:** Select the default *Equipment Status Code*.

**Purchased From:** Select the *Manufacturers Code* for the vendor that you purchased the equipment from.

**Date Purchased:** Enter the date you acquired the unit.

**Purchase Cost:** Enter the purchase amount for the unit.

**Warranty Exp:** Enter the warranty expiration date.

**Financed:** Check this box if the equipment was financed when purchased.

**Owned By Customer:** Select this option if the customer owns the piece of equipment.

---

**NOTE:** Adding customer owned equipment to RMA will allow you to offer equipment servicing to the customer.

**Sold Price:** If the customer purchased the unit from your company, enter the sold price.

**Sold Date:** Enter the sold date.

**Sold As:** Select whether the unit was sold as ‘New’ or ‘Used’.
**Step 3 of 4**

This step contains optional comment fields that can be used for storing miscellaneous information on each unit.

**Fields:**

*Comments 1 & 2:* Enter any miscellaneous comments about this piece of equipment.
Step 4 of 4

This step contains location and billing information for each piece of equipment.

Fields:

Location: Choose one of the following options:
- Warehouse: Currently assigned to the warehouse, ready to be installed.
- On Truck: Currently out for delivery or left on a delivery vehicle.
- Installed: Currently assigned to a customer’s account.
- Picked Up: Currently picked up from a customer, and pending location update.
- Received: Currently received in a staging area.
- Service: Currently out for equipment service.
- Suspense: Currently prevented from being assigned to a customer.

NOTE: If the unit will not be installed, simply choose the ‘Warehouse’ option under Location to add it to inventory.

Account Number: Enter the account number that the unit will be/is assigned to.

Installed: Enter the date the equipment will be/was installed.

Location: Indicate where the cooler can be found at the customer’s location.

Service Schedule: Select this button to setup an Equipment Service Calendar for this unit.

Name (Installed Only): Displays the name on the customer’s account.

Address (Installed Only): Displays the address on the customer’s account.

Stop Number (Installed Only): Displays the stop number on the customer’s account.
**Billing Information:**

*Period Code:* Select the *Rental Frequency Code* that will be used on this unit.

*Charge Code:* Select the *Rental Code* that will be used on this unit.

*Period Rate:* Enter the rental rate that will be used on this unit.

*Rental Group:* Select the *Rental Group Code* that will be used on this unit (if applicable).

*Start Rent On:* Enter the starting rental date for this unit.

*Statement Billed:* Select this option to bill all rentals for this unit on the desktop. Alternatively, if this option is not selected, equipment rentals will be billed on the handheld.

---

**NOTE:** For further information on rental setup and billing, refer to *Chapter 3.11* of the *Supplemental Guide.*
Chapter 7 – Daily Processing and Transactions

Overview

The Transaction pad gives you access to a variety of functions relating to daily processing. These functions include creating invoices, receiving payments, altering invoice data, posting transactions, calculating charges, equipment transactions, inventory, and purchase orders.

<table>
<thead>
<tr>
<th>Invoices and Adjustments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route Settlement Entry</td>
</tr>
<tr>
<td>Supply Chain Orders</td>
</tr>
<tr>
<td>Enhanced Customer Review</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Payments</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Transaction Reports</td>
</tr>
<tr>
<td>Pre Post Transactions</td>
</tr>
<tr>
<td>Post Transactions</td>
</tr>
<tr>
<td>General Ledger Postings</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Generate Rent Charges</td>
</tr>
<tr>
<td>Package Plan</td>
</tr>
<tr>
<td>Calculate Late Charges</td>
</tr>
<tr>
<td>Calculate Administrative Charges</td>
</tr>
<tr>
<td>Generate Recurring Billing Charges</td>
</tr>
<tr>
<td>Generate Discounts and Free Goods</td>
</tr>
<tr>
<td>Generate/Review Standing Order TeleSales</td>
</tr>
<tr>
<td>Close Period</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Credit Check</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Print Refund Checks</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Equipment Processing</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Inventory</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Purchase Orders</td>
</tr>
</tbody>
</table>
Entering and Modifying Invoice Data

The *Invoices and Adjustments* screen is used for daily transactions. Most of your invoice data input will be done via the handheld computer. However, additional items may need to be entered on the desktop (i.e., sales in the office, handwritten tags, adjustments).

### Fields:

**Account Number:** Enter the customer's account number.

**Invoice Number:** Enter the desired invoice number, or press the *Tab* or *Enter* key to automatically generate an invoice number for this customer.

**Name:** This field displays the customer's name.

**Address:** This field displays the customer's address.

**City:** This field displays the customer's city.

**Tax Code:** This field contains the customer’s *Sales Tax Code*.

**Major Account:** This field contains the customer’s *Major Account Code*.

**Date:** This field displays the date the invoice was created.

**Start Time:** This field displays the time the invoice was created.

**Time:** This field displays the time the invoice was saved.

**Route:** Displays the *Route ID* assigned to the stop.

**Seq. No:** Displays the *Sequence Number* assigned to the stop.

**Truck:** Displays the *Truck* used on route.

**Employee ID:** Displays the employee initials that created the transaction.

**Employee Name:** Displays the employee name that created the transaction.

**Dept ID & Desc (Vendor Option Only):** Displays the *Department ID* and description used for vending.
**P.O.** Displays the customer’s purchase order number.

**Ticket Number** Displays the Delivery Order ticket number (if applicable).

**Load Order** Displays the Load Order number (if applicable).

**This Invoice:**

**Previous Balance** Displays the customer’s previous balance.

**Sub Total** Displays the sub-total for all items added to the invoice.

**Tax** Displays the total tax amount on the invoice.

**Pre-Pay Credit (only displayed on Pre-Pay account)** Displays the total pre-pay credit dollar value on the account.

**Total** Displays the total invoice amount, including the sub-total and tax.

**Payments** Select this button to enter a payment on the invoice.

**Total Due** Displays the total due amount minus any payments entered on the invoice.

**New Balance** Displays the current account balance.

**Detail Lines:**

**Charge Code** Displays the Product Charge Code added to the invoice.

**Description** Displays the description of the Product Charge Code.

**Qty** Displays the quantity being sold.

**Price** Displays the unit price.

**Total** Displays the product total per line item.

**Tax** Displays the product tax total per line item.

**Serial / Batch Code** Depending on the type of item added, this field may display equipment serial numbers and Production Batch Codes (if applicable).

**Gratis Reason** If a product is being provided free of charge, a Gratis Reason may be displayed per line item.

**Available invoice options:**

- **Add** Choose this option to add products to an invoice.

- **Delete** Choose this option to delete items from the invoice.

- **Modify** Choose this option to modify an item on invoice.

- **Quick Return Entry** Choose this option to use a quick method for entering returns and deposits on an invoice.

**NOTE:** This option can be enabled under File > Branch Setup, on the Desktop tab.

- **Equipment Service** Choose this option to service equipment installed on the customer’s account directly through the invoice screen.

**NOTE:** This option can be enabled under File > Branch Setup, on the Desktop tab.

- **Update Equipment** Choose this option to add, remove, or swap equipment on the customer’s account from the invoice screen.
Promotional Offers (Buy/Gets Module Only): Select this button to view any promotions the customer may qualify for with their purchase.

Coupon Entry (Requires Additional Setup): Select this option to enter a coupon on the invoice.

NOTE: Contact Advantage Route Systems for additional information on using coupons in RMA.

HD Scan: Use this option to scan hard drives into the system for destruction.

NOTE: Refer to Chapter 4.19 of the Supplemental Guide for further information on this topic.

Scan Items: Use this option to scan items using a handheld scanner or similar hardware.

NOTE: Refer to Chapter 4.18 of the Supplemental Guide for further information on this topic.
Route Settlement Entry

The *Route Settlement Entry* screen allows you to enter route data from manual tickets used by your drivers.

![Route Settlement Entry Screen](image)

**Fields:**

- **Employee:** Select the employee that will be assigned to each transaction.
- **Route:** Select the route the transactions were created for.
- **Truck:** Select the truck that was used on route.
- **Date:** Enter the date of the invoices.

Select a button from the choices below:

- **Invoices:** Use this option for entering all invoices on route.
- **Credit/Debit (Euro Finance Only):** Use this option to create account debits and credits.
- **Delivery Tickets:** Use this option if you are using previously generated route tickets.
- **Load Sheet:** Use this option to enter inventory totals for the day.
- **Skips:** Use this option to enter skipped deliveries for the day.
- **Missing Tickets:** Use this option to view previously generated delivery route tickets that have not been input for the day.
- **Payments:** Use this option to enter payments collected for the day.
- **Cash Recording:** Select this option to use the *Daily Cash Recording* feature.
- **Autogenerate Transactions:** The *Autogenerate Transactions* feature allows you to automatically create invoices from tickets that have already been printed for the day.
- **Exit:** Select this option to exit the screen.


**Invoices**

The Invoices screen is used to input invoice transactions that have been created on route.

**Fields:**

- **Account Number:** Enter the customer’s account number.
- **Invoice Number:** Enter the desired invoice number, or press the *Tab* or *Enter* key to automatically generate an invoice number for this customer.
- **Name:** This field displays the customer’s name.
- **Address:** This field displays the customer’s address.
- **City:** This field displays the customer’s city.
- **Tax Code:** This field contains the customer’s *Sales Tax Code*.
- **Major Account:** This field contains the customer’s *Major Account Code*.
- **Date:** This field displays the date the invoice was created.
- **Start Time:** This field displays the time the invoice was created.
- **Time:** This field displays the time the invoice was saved.
- **Route:** Displays the *Route ID* assigned to the stop.
- **Seq. No:** Displays the *Sequence Number* assigned to the stop.
- **Truck:** Displays the *Truck* used on route.
- **Employee ID:** Displays the employee initials that created the transaction.
- **Employee Name:** Displays the employee name that created the transaction.
- **P.O.:** Displays the customer’s purchase order number.
- **Ticket Number:** Displays the *Delivery Order* ticket number (if applicable).
- **Load Order:** Displays the *Load Order* number (if applicable).
**This Invoice:**

*Previous Balance:* Displays the customer’s previous balance.

*Sub Total:* Displays the sub-total for all items added to the invoice.

*Tax:* Displays the total tax amount on the invoice.

*Pre-Pay Credit (only displayed on Pre-Pay account):* Displays the total pre-pay credit dollar value on the account.

*Total:* Displays the total invoice amount, including the sub-total and tax.

*Payments:* Select this button to enter a payment on the invoice.

*Total Due:* Displays the total due amount minus any payments entered on the invoice.

*New Balance:* Displays the current account balance.

**Detail Lines:**

*Charge Code:* Displays the Product Charge Code added to the invoice.

*Description:* Displays the description of the Product Charge Code.

*Qty:* Displays the quantity being sold.

*Price:* Displays the unit price.

*Total:* Displays the product total per line item.

*Tax:* Displays the product tax total per line item.

*Serial / Batch Code:* Depending on the type of item added, this field may display equipment serial numbers and Production Batch Codes (if applicable).

*Gratis Reason:* If a product is being provided free of charge, a Gratis Reason may be displayed per line item.

**Available invoice options:**

- **Add:** Choose this option to add products to an invoice.

- **Delete:** Choose this option to delete items from the invoice.

- **Modify:** Choose this option to modify an item on invoice.

- **Quick Return Entry:** Choose this option to use a quick method for entering returns and deposits on an invoice.

**NOTE:** This option can be enabled under *File > Branch Setup*, on the *Desktop* tab.

- Equipment Service: Choose this option to service equipment installed on the customer’s account directly through the invoice screen.

**NOTE:** This option can be enabled under *File > Branch Setup*, on the *Desktop* tab.

- **Update Equipment:** Choose this option to add, remove, or swap equipment on the customer’s account from the invoice screen.

- **Promotional Offers (Buy/Gets Module Only):** Select this button to view any promotions the customer may qualify for with their purchase.
**Coupon Entry (Requires Additional Setup):** Select this option to enter a coupon on the invoice.

**NOTE:** Contact Advantage Route Systems for additional information on using coupons in RMA.

**HD Scan:** Use this option to scan hard drives into the system for destruction.

**NOTE:** Refer to Chapter 4.19 of the Supplemental Guide for further information on this topic.

**Scan Items:** Use this option to scan items using a handheld scanner or similar hardware.

**NOTE:** Refer to Chapter 4.18 of the Supplemental Guide for further information on this topic.

**Credit/Debit**

The Credit/Debit screen allows you to enter adjustments that will be uniquely identified on the customer’s statement.

![Credit/Debit Screen](image)

**Fields:**

**Account Number:** Enter the customer’s account number.

**NOTE:** Choose the Fast Find binoculars to search for the customer by name.

**Invoice Number:** Enter the desired invoice number, or press the Tab or Enter key to automatically generate an invoice number for this customer.

**Name:** This field displays the customer’s name.

**Address:** This field displays the customer’s address.

**City:** This field displays the customer’s city.

**Tax Code:** This field contains the customer’s Sales Tax Code.
**Major Account:** This field contains the customer’s Major Account Code.

**Date:** This field displays the date the invoice was created.

**Start Time:** This field displays the time the invoice was created.

**Time:** This field displays the time the invoice was saved.

**Route:** Displays the Route ID assigned to the stop.

**Seq. No.:** Displays the Sequence Number assigned to the stop.

**Truck:** Displays the Truck used on route.

**Employee ID:** Displays the employee initials that created the transaction.

**Employee Name:** Displays the employee name that created the transaction.

**P.O.:** Displays the customer’s purchase order number.

**Ticket Number:** Displays the Delivery Order ticket number (if applicable).

**Load Order:** Displays the Load Order number (if applicable).

**This Invoice:**

**Previous Balance:** Displays the customer’s previous balance.

**Sub Total:** Displays the sub-total for all items added to the invoice.

**Tax:** Displays the total tax amount on the invoice.

**Total:** Displays the total invoice amount, including the sub-total and tax.

**Total Due:** Displays the total due amount minus any payments entered on the invoice.

**New Balance:** Displays the current account balance.

**Detail Lines:**

**Charge Code:** Displays the Product Charge Code added to the invoice.

**Description:** Displays the description of the Product Charge Code.

**Qty:** Displays the quantity being sold.

**Price:** Displays the unit price.

**Total:** Displays the product total per line item.

**Tax:** Displays the product tax total per line item.

**Serial / Batch Code:** Depending on the type of item added, this field may display equipment serial numbers and Production Batch Codes (if applicable).

**Gratis Reason:** If a product is being provided free of charge, a Gratis Reason may be displayed per line item.

**Available invoice options:**

- **Add**: Choose this option to add products to an invoice.
- **Delete**: Choose this option to delete items from the invoice.
- **Modify**: Choose this option to modify an item on invoice.
- **Quick Return Entry**: Choose this option to use a quick method for entering returns and deposits on an invoice.

**NOTE:** This option can be enabled under File > Branch Setup, on the Desktop tab.
Equipment Service: Choose this option to service equipment installed on the customer’s account directly through the invoice screen.

NOTE: This option can be enabled under File > Branch Setup, on the Desktop tab.

Update Equipment: Choose this option to add, remove, or swap equipment on the customer’s account from the invoice screen.

Promotional Offers (Buy/Gets Module Only): Select this button to view any promotions the customer may qualify for with their purchase.

Coupon Entry (Requires Additional Setup): Select this option to enter a coupon on the invoice.

NOTE: Contact Advantage Route Systems for additional information on using coupons in RMA.

HD Scan: Use this option to scan hard drives into the system for destruction.

NOTE: Refer to Chapter 4.19 of the Supplemental Guide for further information on this topic.

Scan Items: Use this option to scan items using a handheld scanner or similar hardware.

NOTE: Refer to Chapter 4.18 of the Supplemental Guide for further information on this topic.

Delivery Tickets

This screen is used for inputting invoices without payments.
Fields:

Invoice Number: Enter the desired invoice number, or press the Tab or Enter key to automatically generate an invoice number for this customer.

Account Number: Enter the customer’s account number.

NOTE: Choose the Fast Find binoculars to search for the customer by name.

Name: This field displays the customer’s name.
Address: This field displays the customer’s address.
City: This field displays the customer’s city.
Tax Code: This field contains the customer’s Sales Tax Code.
Major Account: This field contains the customer’s Major Account Code.
Date: This field displays the date the invoice was created.
Start Time: This field displays the time the invoice was created.
Time: This field displays the time the invoice was saved.
Route: Displays the Route ID assigned to the stop.
Seq. No: Displays the Sequence Number assigned to the stop.
Truck: Displays the Truck used on route.
Employee ID: Displays the employee initials that created the transaction.
Employee Name: Displays the employee name that created the transaction.
P.O.: Displays the customer’s purchase order number.
Ticket Number: Displays the Delivery Order ticket number (if applicable).
Load Order: Displays the Load Order number (if applicable).

This Invoice:

Previous Balance: Displays the customer’s previous balance.
Sub Total: Displays the sub-total for all items added to the invoice.
Tax: Displays the total tax amount on the invoice.
Pre-Pay Credit (only displayed on Pre-Pay account): Displays the total pre-pay credit dollar value on the account.
Total: Displays the total invoice amount, including the sub-total and tax.
Payments: Select this button to enter a payment on the invoice.
Total Due: Displays the total due amount minus any payments entered on the invoice.
New Balance: Displays the current account balance.

Detail Lines:

Charge Code: Displays the Product Charge Code added to the invoice.
Description: Displays the description of the Product Charge Code.
Qty: Displays the quantity being sold.
Price: Displays the unit price.
Total: Displays the product total per line item.
Tax: Displays the product tax total per line item.
Serial / Batch Code: Depending on the type of item added, this field may display equipment serial numbers and Production Batch Codes (if applicable).

Gratis Reason: If a product is being provided free of charge, a Gratis Reason may be displayed per line item.

Available invoice options:

Add: Choose this option to add products to an invoice.
Delete: Choose this option to delete items from the invoice.
Modify: Choose this option to modify an item on invoice.
Quick Return Entry: Choose this option to use a quick method for entering returns and deposits on an invoice.

NOTE: This option can be enabled under File > Branch Setup, on the Desktop tab.

Equipment Service: Choose this option to service equipment installed on the customer’s account directly through the invoice screen.

NOTE: This option can be enabled under File > Branch Setup, on the Desktop tab.

Update Equipment: Choose this option to add, remove, or swap equipment on the customer’s account from the invoice screen.

Promotional Offers (Buy/Gets Module Only): Select this button to view any promotions the customer may qualify for with their purchase.

Coupon Entry (Requires Additional Setup): Select this option to enter a coupon on the invoice.

NOTE: Contact Advantage Route Systems for additional information on using coupons in RMA.

HD Scan: Use this option to scan hard drives into the system for destruction.

NOTE: Refer to Chapter 4.19 of the Supplemental Guide for further information on this topic.

Scan Items: Use this option to scan items using a handheld scanner or similar hardware.

NOTE: Refer to Chapter 4.18 of the Supplemental Guide for further information on this topic.
Load Sheet

The Load Sheet option is used to add or edit truck inventory totals for each delivery day.

Fields:

Route: Displays the route being edited.

date: Displays the route date being edited.

driver Name: Displays the driver assigned to the route.

Employee: Displays the employee editing the Load Sheet.

Truck Number: Select the truck used on route.

Control No: The manufacturing control number used on the truck.

Starting Mileage: The starting mileage recorded on the truck.

Ending Mileage: The ending mileage recorded on the truck.

Start Time: The start time recorded for the delivery day.

End Time: The end time recorded for the delivery day.

Checker: Select the Checker assigned to the truck.

Check-out Time: The time that the load verification sheet was printed in the morning.

Check-in Time: The time that the load verification sheet was printed in the afternoon.

Detail Lines:

Charge Code: The Product Charge Code loaded on the truck.

Description: The description of the Product Charge Code.

Quantity Out1: The quantity that was loaded on the truck.

Quantity In1: The quantity that was brought back to the warehouse.

Quantity Out2: The quantity that was loaded on the truck.

Quantity In2: The quantity that was brought back to the warehouse.

Returns: The quantity that was returned by the customer.

Damaged: The quantity that was reported as damaged and returned by the customer.

Difference: A result of subtracting Quantity In and Damaged from Quantity Out.
**Sold:** The quantity that was sold on route — the displayed quantity is based on pending transactions.

**Other:**

- **Load Order:** Select this option to edit an existing Load Order that was sent to the handheld.

**NOTE:** Load Orders are used with the Enhanced Inventory Module and can be created under the Route menu in RMA. Refer to Chapter 3.10 of the Supplemental Guide for further information.

**Skips**

The Skip option is used to record stops that were skipped on route for the day.

**Invoice #:** Enter the invoice number assigned to the customer.

**Acct Number:** Enter or browse for the customer’s account number.

**Skip Reason:** Select the Skip Reason assigned to the customer.

**Last Entered:** Displays the last account number accessed.

**Missing Tickets**

The Missing Tickets option allows you to view a report of all of the route tickets that were printed but not entered on the desktop.

**NOTE:** In order for the Missing Tickets option to work properly, tickets will need to be printed prior to delivery under Route > Print Route Tickets.

<table>
<thead>
<tr>
<th>Route Date</th>
<th>Route</th>
<th>Acct #</th>
<th>Ticket #</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/12/2004</td>
<td>A</td>
<td>019500</td>
<td>000000003 3014</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>005419</td>
<td>000000003 3015</td>
</tr>
</tbody>
</table>

![Missing Tickets](image)
Payments

The Payments option allows you to enter payments collected on route for the day.

Fields:

**Acct Number:** Enter or browse for the customer’s account number.

**Amount Paid:** Enter the amount paid.

**Payment Date:** Enter the date the payment was made.

**Check Date:** Enter the check date (if applicable).

**Route:** Select the route assigned to the customer.

**Account Balance:** Displays the total amount due on the account.

**Unapplied Amount:** Displays the total unapplied amount for the current payment.

**Pal All/Oldest:** Select this option to automatically apply the payment to the oldest open items on the account.

**Bank Account:** Select the bank account to be used with this payment.

**Document ID:** Enter a receipt or reference number of an invoice, if desired.

**Batch Number:** Enter a batch number that can be assigned to groups of payment entered.

**Employee:** Select the employee that created the payment.

**Name:** Displays the customer’s name.

**NOTE:** Right-click on the Name field to view a mini-screen that displays the customer’s aged balance.

**Address:** Displays the customer’s address information.
**Payment Type:** Select the payment type from the following options:

- Cash
- Check
- Credit Card
- Coupon
- Money Order
- Debit Card
- Bank Transfer
- Barter
- Direct Deposit

**Check/Coupon Number:** Enter a check number or reference number on the payment (if applicable).

**Posting Hold:** Select this option to prevent the payment from being posted on the customer’s account, if desired.

**NOTE:** This item will need to be cleared in order to post the payment later.

**Discount Amount:** Enter a discount or ‘write-off’ amount that will be added to the payment.

**Note:** Enter any desired miscellaneous note in this field.

**Open Item Fields:**

If Open Invoice is selected within the customer’s account (on the Credit tab), the following fields will be displayed on the screen.

**NOTE:** Selecting the Open Invoice option will allow payments to be applied directly to unpaid open items.

<table>
<thead>
<tr>
<th>Acct No.</th>
<th>Invoice No.</th>
<th>Date</th>
<th>Inv Amt</th>
<th>Pending</th>
<th>Open Amt</th>
</tr>
</thead>
<tbody>
<tr>
<td>100001</td>
<td>100100</td>
<td>05/11/2003</td>
<td>66.60</td>
<td>0.00</td>
<td>66.60</td>
</tr>
<tr>
<td>100002</td>
<td>100101</td>
<td>06/01/2004</td>
<td>75.75</td>
<td>0.00</td>
<td>75.75</td>
</tr>
<tr>
<td>100003</td>
<td>100102</td>
<td>06/02/2004</td>
<td>65.00</td>
<td>0.00</td>
<td>65.00</td>
</tr>
<tr>
<td>100004</td>
<td>100103</td>
<td>06/03/2004</td>
<td>75.00</td>
<td>0.00</td>
<td>75.00</td>
</tr>
<tr>
<td>100005</td>
<td>100104</td>
<td>06/04/2004</td>
<td>10.00</td>
<td>0.00</td>
<td>10.00</td>
</tr>
</tbody>
</table>

**Acct Number:** Displays the customer’s account number.

**Invoice (or Statement) Number:** Displays the invoice (or statement) number assigned to the item.

**Date:** The date of the invoice.

**Inv. Amt:** The original invoice amount.

**Pending:** The payments applied to this invoice that have not been posted on the account.

**Open Amt:** The amount of the invoice that is not paid.

**Print Item:** Select an invoice on the screen and choose this option to print a copy of the item.

**Search:** Select this option to search for an invoice within the displayed items on the screen.
**Lookup Invoices:** Select this option to search for an invoice on all customer accounts.

**Show Check (Check 21 Module Only):** Choose this option to view an associated scanned check with the payment.

**Cash Recording**

The **Cash Recording** option allows you to manually record cash collected per route after the data has been entered or uploaded on the desktop. If the payment amount entered does not match the amount collected, an invoice can be created to charge the driver for any discrepancies.

**NOTE:** Refer to Chapter 3.19 of the Supplemental Guide for further information on setting up and using the **Daily Cash Recording** feature.

### Fields:

**Description:** The description of the monetary unit.

**Quantity:** The quantity of each monetary unit entered.

**Cash Entered:** Displays the total amount of all currency entered.

**Cash From Route:** Displays the total amount uploaded from the current route.

**Cash Difference:** Displays the difference between **Cash Entered** and **Cash From Route**. This represents the amount that will be billed to the driver.

**Check Number:** Displays the check number assigned to the payment.

**Amount:** Displays the amount of the check.

**NOTE:** Double-click on each check/amount to verify that it has been collected.

**Checks Entered:** Displays the total amount of all checks verified on route.

**Checks From Route:** Displays the total amount of checks uploaded on the current route.
**Checks Difference:** Displays the difference between *Checks Entered* and *Checks From Route*. This represents the amount that will be billed to the driver.

**Modify:** Select this button to enter totals on the current route.

**Save:** Select this button to save all changes made on the current route.

**Cancel:** Select this button to cancel all changes made on the current route.

**Exit:** Select this button to exit the screen.

**Print:** Select this option to preview and print totals entered on the current route.

**Lock:** Select this option to lock the current route from further entry and create an invoice if there are any *Cash/Check Differences*.

### Autogenerate Transactions

The *Autogenerate Transactions* feature allows you to automatically create invoices from tickets that have already been printed for the day.

**NOTE:** This option is helpful for companies that mostly deliver the same products to their customers each day. For the occasional adjustment to an order, the generated invoice can be modified prior to posting.

<table>
<thead>
<tr>
<th>Delivery Note Number</th>
<th>Acct. No.</th>
<th>Acct. Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>10012</td>
<td>001100</td>
<td>9th Street Deli</td>
</tr>
<tr>
<td>100211</td>
<td>001120</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100210</td>
<td>001110</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100209</td>
<td>001110</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100200</td>
<td>001110</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100199</td>
<td>001110</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100219</td>
<td>001110</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100201</td>
<td>001110</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100202</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100203</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100204</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100205</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100206</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100207</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100208</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
<tr>
<td>100209</td>
<td>001150</td>
<td>Subway Deli</td>
</tr>
</tbody>
</table>

**Fields:**

**Delivery Note Number:** Displays the invoice number previously generated.

**Acct. No.:** Displays the account number.

**Acct. Name:** Displays the account name.

**Select All:** Choose this option to generate invoices for all orders on the screen.

**De-select All:** Choose this option to de-select all of the orders on the screen.

**Generate:** After you have made your invoice selections, choose this option to generate the transactions.

**Exit:** Select this option to exit the screen.
Supply Chain Orders

The Supply Chain Orders option allows you to create product orders on the desktop that will be processed or “picked” from the warehouse, verified, and shipped to the customer.

NOTE: For a complete tutorial on the Supply Chain Orders process, refer to Chapter 4.09 of the Supplemental Guide.

Supply Chain Order Entry

Use the Order Entry screen to create an order for the customer.

NOTE: Products can be entered under different dates on the same order, allowing products to be processed on separate days.

Fields:

Account Number: Enter or browse for the customer’s account number.

NOTE: Choose the Fast Find binoculars to search for the customer by name.

Order Number: The Order Number field will be populated once Save has been selected.

Name: Displays the customer’s name.

Address: Displays the customer’s address.

City: Displays the city assigned to the customer.

Tax Code: This field contains the customer’s Sales Tax Code.

Major Account: This field contains the Major Account Code assigned to the customer.

Date: This field contains the date of the order.
**Seq. No:** This field contains the customer’s assigned sequence number.

**Time:** This field contains the time the order was created.

**Order Notes:** Enter a miscellaneous note on the order, if desired.

**Employee ID:** Select the employee that should be assigned to the transaction.

**Employee Name:** Displays the selected employee’s name.

**P.O.:** Enter the customer’s Purchase Order number, if applicable.

**Ticket Number:** Enter the Delivery Order number, if applicable.

**Shipper Information:** Enter the shipping information for the order:

![Shipper Information](image)

- **Shipper:** Select the company that will be used to ship the order.

  **NOTE:** This information can be added to RMA under Lists > Product Codes > Shipper List Codes.

- **Truck License Number:** Enter the vehicle’s license plate number.

- **Seal Number:** Enter the vehicle’s seal number.

- **Container Number:** Enter the container number the items are being shipped in.

- **Ship Date:** Enter the shipping date.

- **Route:** Select the route that the order will be processed for.

- **Load Order:** Enter the load order number.

- **Truck:** Enter the delivery vehicle being used.

- **Origin Warehouse (Enhanced Inventory):** The location the product will be processed from.

- **Destination Warehouse (Enhanced Inventory):** The receiving Mobile or Permanent Warehouse the product will be transferred to.

**This Invoice:**

**Previous Balance:** Displays the customer’s previous balance.

**Sub Total:** Displays the sub-total for all items added to the invoice.

**Tax:** Displays the total tax amount on the invoice.

**Total:** Displays the total invoice amount, including the sub-total and tax.

**Payments:** Select this button to enter a payment on the invoice.

**Total Due:** Displays the total due amount minus any payments entered on the invoice.

**New Balance:** Displays the current account balance.
**Detail Lines:**

- **Charge Code:** Displays the Product Charge Code added to the invoice.
- **Description:** Displays the description of the Product Charge Code.
- **Qty:** Displays the quantity being sold.
- **Price:** Displays the unit price.
- **Total:** Displays the product total per line item.
- **Tax:** Displays the product tax total per line item.
- **Date:** The date the product should be processed to the customer (multiple dates are allowed).
- **Batch Code:** Not currently in use.
- **Print Packing List:** Select this option to automatically print a Packing List (or pick list) on Save.
- **Print Bill of Lading:** Select this option to automatically print the Bill of Lading on Save. Generally, a Bill of Lading is attached to the shipped order for the customer (may require custom programming from ARS).

**Packing Slips**

Packing Slips can be printed and used to expedite Supply Chain Orders for shipment.

![Packing Slips](image)

**Fields:**

- **Account Number:** Enter the range of account numbers to include.
- **Order Number:** Enter the order number range to include.
- **Dates:** Enter the range of dates to include.
- **Custom Bill of Lading:** Choose a custom Bill of Lading from the drop-down list (requires custom programming).
Confirm Supply Chain Order

The Confirm Supply Order option is used to complete processed Supply Chain Orders.

**Fields:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Number</td>
<td>Enter or browse for the customer’s account number.</td>
</tr>
<tr>
<td>Order Number</td>
<td>The Order Number field will be populated once Save has been selected.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the customer’s name.</td>
</tr>
<tr>
<td>Address</td>
<td>Displays the customer’s address.</td>
</tr>
<tr>
<td>City</td>
<td>Displays the city assigned to the customer.</td>
</tr>
<tr>
<td>Tax Code</td>
<td>This field contains the customer’s Sales Tax Code.</td>
</tr>
<tr>
<td>Major Account</td>
<td>This field contains the Major Account Code assigned to the customer.</td>
</tr>
<tr>
<td>Date</td>
<td>This field contains the date of the order.</td>
</tr>
<tr>
<td>Time</td>
<td>This field contains the time the order was created.</td>
</tr>
<tr>
<td>Order Notes</td>
<td>Enter a miscellaneous note on the order, if desired.</td>
</tr>
<tr>
<td>Employee ID</td>
<td>Select the employee that should be assigned to the transaction.</td>
</tr>
<tr>
<td>Employee Name</td>
<td>Displays the selected employee’s name.</td>
</tr>
<tr>
<td>Route</td>
<td>Select the route assigned to the order.</td>
</tr>
<tr>
<td>Terms</td>
<td>Enter any credit terms of the order, for reference.</td>
</tr>
<tr>
<td>Truck (Enhanced Inventory Only)</td>
<td>Enter the truck number assigned to the order.</td>
</tr>
<tr>
<td>Warehouse (Enhanced Inventory Only)</td>
<td>The warehouse the order is being processed from.</td>
</tr>
</tbody>
</table>
**Shipper Information:** Enter the shipping information for the order:

![Shipper Information Window]

- **Shipper:** Select the company that will be used to ship the order.
- **Truck License Number:** Enter the vehicle’s license plate number.
- **Seal Number:** Enter the vehicle’s seal number.
- **Container Number:** Enter the container number the items were shipped in.
- **Ship Date:** Enter the shipping date.
- **Completed:** Select this option to complete the order.
- **P.O.:** Enter the customer’s *Purchase Order* number, if applicable.
- **Ticket Number:** Enter the *Delivery Order* number, if applicable.

**This Invoice:**

- **Previous Balance:** Displays the customer’s previous balance.
- **Sub Total:** Displays the sub-total for all items added to the invoice.
- **Tax:** Displays the total tax amount on the invoice.
- **Total:** Displays the total invoice amount, including the sub-total and tax.
- **Payments:** Select this button to enter a payment on the invoice.
- **Total Due:** Displays the total due amount minus any payments entered on the invoice.
- **New Balance:** Displays the current account balance.

**Detail Lines:**

- **Charge Code:** Displays the *Product Charge Code* added to the invoice.
- **Description:** Displays the description of the *Product Charge Code*.
- **Qty Ordered:** The number of units requested.
- **Qty Shipped:** The number of units shipped.
- **Price:** Displays the unit price.
- **Total:** Displays the product total per line item.
- **Date:** The date the product should be processed to the customer (multiple dates are allowed).

---

*NOTE:* This information can be added to RMA under *Lists > Product Codes > Shipper List Codes.*
**Confirmation Code:** Enter the *Completion Code* for the product ordered.

**NOTE:** *Order Completion Codes* can be added to RMA under *Lists > Product Codes*.

### Open Supply Chain Orders

The *Open Orders* report will allow you to view all of the *Supply Chain Orders* entered into RMA.

![Open Supply Orders](image)

**Fields:**

- **Sort Option:** Select the desired sort option, from the list of 4, to use on the report.

- **Account Number:** Enter the range of customer’s account numbers to include on the report.

- **Dates:** Enter the range of dates to include on the report.

- **Open:** Select this radio button to only view open *Supply Chain Orders*.

- **Confirmed:** Select this radio button to only view completed *Supply Chain Orders*.

- **Both:** Select this radio button to view both open and completed *Supply Chain Orders*.
Print Bill of Lading

The Bill of Lading option is used to print order information that can be attached to orders before they are shipped.

NOTE: This option may require custom programming from ARS.

Fields:

Account Number: Enter the range of account numbers to include.
Order Number: Enter the range of order numbers to include.
Dates: Enter the range of dates to include.

Enhanced Customer Review

The Enhanced Customer Review feature allows your drivers to create new customer accounts while making deliveries on the handheld. By establishing default settings on the desktop, you will now be able to capture important customer data on the handheld, and create each account automatically during the Afternoon Card process.

NOTE: Refer to Chapter 4.11 of the Supplemental Guide for further information on this feature. Additionally, this option is used with the eStoreFront Module, allowing new customers to sign up for service on your Web site; contact ARS for further information.
Payments

The Payments feature allows you to record payments collected, apply credits, and much more.

<table>
<thead>
<tr>
<th>Local Payments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Credit Cards</td>
</tr>
<tr>
<td>EFT</td>
</tr>
<tr>
<td>Process EDI Transactions</td>
</tr>
<tr>
<td>Lock Box</td>
</tr>
<tr>
<td>Returned Check Processing</td>
</tr>
<tr>
<td>Disputed Invoices</td>
</tr>
<tr>
<td>Payment Lookup</td>
</tr>
<tr>
<td>Apply Payments and Credits</td>
</tr>
<tr>
<td>Check 21</td>
</tr>
</tbody>
</table>

Each item is explained within this section.
Local Payments

The Local Payments feature allows you to input payments that are mailed into the office.

Fields:

**Acct Number:** Enter or browse for the customer’s account number.

**NOTE:** Choose the Fast Find binoculars to search for the customer by name.

**Amount Paid:** Enter the amount paid.

**Payment Date:** Enter the date the payment was made.

**Check Date:** Enter the check date (if applicable).

**Route:** Select the route assigned to the customer.

**Account Balance:** Displays the total amount due on the account.

**Unapplied Amount:** Displays the total unapplied amount for the current payment.

**Pal All/Oldest:** Select this option to automatically apply the payment to the oldest open items on the account.

**Bank Account:** Select the bank account to be used with this payment.

**Document ID:** Enter a receipt or reference number of an invoice, if desired.

Mail Payments

The Mail Payments option is used to enter standard payments received in the office.

Fields:

- **Acct Number:** Enter or browse for the customer’s account number.
- **NOTE:** Choose the Fast Find binoculars to search for the customer by name.
- **Amount Paid:** Enter the amount paid.
- **Payment Date:** Enter the date the payment was made.
- **Check Date:** Enter the check date (if applicable).
- **Route:** Select the route assigned to the customer.
- **Account Balance:** Displays the total amount due on the account.
- **Unapplied Amount:** Displays the total unapplied amount for the current payment.
- **Pal All/Oldest:** Select this option to automatically apply the payment to the oldest open items on the account.
- **Bank Account:** Select the bank account to be used with this payment.
- **Document ID:** Enter a receipt or reference number of an invoice, if desired.
**Batch Number:** Enter a batch number that can be assigned to groups of payment entered.

**Employee:** Select the employee that created the payment.

**Name:** Displays the customer’s name.

---

**NOTE:** Right-click on the *Name* field to view a mini-screen that displays the customer’s aged balance.

---

**Address:** Displays the customer’s address information.

**Payment Type:** Select the payment type from the following options:

- Cash
- Check
- Credit Card
- Coupon
- Money Order
- Debit Card
- Bank Transfer
- Barter
- Direct Deposit

**Check/Coupon Number:** Enter a check number or reference number on the payment (if applicable).

**Posting Hold:** Select this option to prevent the payment from being posted on the customer’s account, if desired.

---

**NOTE:** This item will need to be cleared in order to post the payment later.

---

**Discount Amount:** Enter a discount or ‘write-off’ amount that will be added to the payment.

**Note:** Enter any desired miscellaneous note in this field.

**Customer Type (Display Only):** This field displays the *Customer Type* assigned to the account.

---

**Open Item Fields:**

If *Open Invoice* is selected within the customer’s account (on the Credit tab), the following fields will be displayed on the screen.

---

**NOTE:** Selecting the *Open Invoice* option will allow payments to be applied directly to unpaid open items.

---

**Acct Number:** Displays the customer’s account number.

**Invoice (or Statement) Number:** Displays the invoice (or statement) number assigned to the item.

**Date:** The date of the invoice.
**Inv. Amt:** The original invoice amount.

**Pending:** The payments applied to this invoice that have not been posted on the account.

**Open Amt:** The amount of the invoice that is not paid.

[Print Item] Select an invoice on the screen and choose this option to print a copy of the item.

[Search] Select this option to search for an invoice within the displayed items on the screen.

[Lookup Invoices] Select this option to search for an invoice on all customer accounts.

**Show Check (Check 21 Module Only):** Choose this option to view an associated scanned check with the payment.

## Enter Statement Payments (Optional)

In countries where ‘Statement Invoices’ are mailed to customers each month, the Enter Statement Payments option is used for entering payments on these items.

**NOTE:** This option is only available if you have selected the ‘Use Statement Numbers’ option within File > Branch Setup, on the Statement tab.

### Fields:

**Acct Number:** Enter or browse for the customer’s account number.

**NOTE:** Choose the Fast Find binoculars to search for the customer by name.

**Amount Paid:** Enter the amount paid.

**Payment Date:** Enter the date the payment was made.

**Check Date:** Enter the check date (if applicable).

**Route:** Select the route assigned to the customer.

**Account Balance:** Displays the total amount due on the account.
**Unapplied Amount:** Displays the total unapplied amount for the current payment.

**Pay All/Oldest:** Select this option to automatically apply the payment to the oldest open items on the account.

**Bank Account:** Select the bank account to be used with this payment.

**Document ID:** Enter a receipt or reference number of an invoice, if desired.

**Batch Number:** Enter a batch number that can be assigned to groups of payment entered.

**Employee:** Select the employee that created the payment.

**Name:** Displays the customer’s name.

---

**NOTE:** Right-click on the *Name* field to view a mini-screen that displays the customer’s aged balance.

---

**Address:** Displays the customer’s address information.

**Payment Type:** Select the payment type from the following options:

- Cash
- Check
- Credit Card
- Coupon
- Money Order
- Debit Card
- Bank Transfer
- Barter
- Direct Deposit

**Check/Coupon Number:** Enter a check number or reference number on the payment (if applicable).

**Posting Hold:** Select this option to prevent the payment from being posted on the customer’s account, if desired.

---

**NOTE:** This item will need to be cleared in order to post the payment later.

---

**Discount Amount:** Enter a discount or ‘write-off’ amount that will be added to the payment.

**Note:** Enter any desired miscellaneous note in this field.
Open Item Fields:

If Open Invoice is selected within the customer’s account (on the Credit tab), the following fields will be displayed on the screen.

NOTE: Selecting the Open Invoice option will allow payments to be applied directly to unpaid open items.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acct Number</td>
<td>Displays the customer’s account number.</td>
</tr>
<tr>
<td>Statement Number</td>
<td>Displays the statement number assigned to the item.</td>
</tr>
<tr>
<td>Date</td>
<td>The date of the invoice.</td>
</tr>
<tr>
<td>Inv. Amt</td>
<td>The original invoice amount.</td>
</tr>
<tr>
<td>Pending</td>
<td>The payments applied to this invoice that have not been posted on the account.</td>
</tr>
<tr>
<td>Open Amt</td>
<td>The amount of the invoice that is not paid.</td>
</tr>
</tbody>
</table>

Print Item: Select an invoice on the screen and choose this option to print a copy of the item.

Lookup Invoices: Select this option to search for an invoice on all customer accounts.

Show Check (Check 21 Module Only): Choose this option to view any associated scanned check with the payment.
Payment by Type (Invoice & Statement)

The Payment by Type option is used for rapid payment entry. This option also includes automatic batch numbers, and balance sheets to ensure accuracy.

NOTE: The Payment by Type (Statement) option is only available if you have selected ‘Use Statement Numbers’ within File > Branch Setup, on the Statement tab.

Fields:

Payment Date: Enter the date that will be used on all payments entered in the current batch.

Employee: Select the employee that will be assigned to all payment entered in the current batch.

Payment Type: Select the payment type that will be used on all payments entered in the current batch.

Bank Account: Select the bank account that will be assigned to all payments entered in the current batch.

Use Customers Bank: Select this option to automatically use the default bank assigned per customer.

Automated Payment: Select this option to use a handheld barcode scanner to enter payments (requires additional setup).

Check 21 Payments: Select this option to use a desktop check scanner (Requires the Check 21 Module).

Autosum Discounts: Select this option to include a sum total of discounts entered within the payment screen.

Get Batch: Select this option to edit an existing payment batch.
The *Payments by Type* screen has been designed for quick entry. The differences between *Mail Payments* and *Payments by Type* are noted below:

### Fields:

- **Done**: Choose this option when payment entry is complete.
- **Clear**: Choose this option to clear the current payment being entered.

### Payment by Type Check-Out:

After entering your batch of payments, choose the *Done* button.

In order to complete the *Payment by Type* entry, the following balance sheet dialog box is included to double-check the payment totals entered. Enter the total amount of payments entered in this batch within the *Total Amount* field and click ‘OK’.
If the amount entered matches the payment amounts entered, the system will prompt you to lock the batch.

Alternatively, if the amounts do not match, the system will not allow you to continue.

**Additional Options:**

- **Delete:** Highlight a payment and choose this option to delete it from the batch.
- **Edit:** Highlight a payment and choose this option to delete it from the batch.
- **Add:** Select this option to add a new payment to the batch.
- **Include Detail (applies to Print option below):** Select this option to include Open Invoice details on the report.
- **Print:** Select this option to view or print the Payment by Type Check Out Report.
Payments by Major Account

The *Payments by Major Account* option allows you to apply a check payment to multiple accounts based on their assigned ‘Major Account Code.’

**Fields:**

- **Major Account Code:** Enter the *Major Account Code* in this field to view all of the associated accounts.
- **Amount Paid:** Enter the amount paid.
- **Payment Date:** Enter the date the payment was made.
- **Check Date:** Enter the check date.
- **Route:** Select the route assigned to the customer.
- **Unapplied Amount:** Displays the total unapplied amount for the current payment.

**NOTE:** You will be required to enter an account number to apply any remaining unapplied amount to when the payment is saved (if applicable).

- **Pay All/Oldest:** Select this option to apply the payment to the oldest open items.
- **Bank Account:** Select the bank account to be used for this payment.
- **Document ID:** Enter a receipt or reference number of an invoice, if desired.
- **Batch Number:** Enter a batch number that can be assigned to groups of payments entered.
- **Employee:** Select the employee that created the payment.
- **Account Description:** Displays the *Major Account Code* description.
- **Payment Type:** Select the type of payment used.
- **Check Number:** Enter the check number used.
- **Posting Hold:** Select this option to prevent the payment from being posted.

**NOTE:** This item will need to be cleared in order to post the payment later.
Discount Amount: Enter a discount or ‘write-off’ amount that will be added to the payment.

Note: Enter any desired miscellaneous note in this field.

Open Item Fields:
If Open Invoice is selected within the customer’s account (on the Credit tab), the following fields will be displayed on the screen.

NOTE: Selecting the Open Invoice option will allow payments to be applied directly to unpaid open items.

<table>
<thead>
<tr>
<th>Acct No.</th>
<th>Invoice No.</th>
<th>Date</th>
<th>Inv Amt</th>
<th>Pending</th>
<th>Open Amt</th>
</tr>
</thead>
<tbody>
<tr>
<td>000100</td>
<td>00145</td>
<td>04/13/2010</td>
<td>1.00</td>
<td>0.00</td>
<td>1.00</td>
</tr>
<tr>
<td>001000</td>
<td>00144</td>
<td>05/10/2010</td>
<td>2.30</td>
<td>0.00</td>
<td>2.30</td>
</tr>
<tr>
<td>002000</td>
<td>00145</td>
<td>06/01/2010</td>
<td>4.50</td>
<td>0.00</td>
<td>4.50</td>
</tr>
<tr>
<td>003000</td>
<td>00146</td>
<td>06/02/2010</td>
<td>10.00</td>
<td>0.00</td>
<td>10.00</td>
</tr>
<tr>
<td>004000</td>
<td>00144</td>
<td>06/10/2010</td>
<td>12.00</td>
<td>0.00</td>
<td>12.00</td>
</tr>
<tr>
<td>005000</td>
<td>00150</td>
<td>06/17/2010</td>
<td>5.00</td>
<td>0.00</td>
<td>5.00</td>
</tr>
<tr>
<td>000100</td>
<td>00169</td>
<td>06/24/2010</td>
<td>35.94</td>
<td>0.00</td>
<td>35.94</td>
</tr>
</tbody>
</table>

Acct Number: Displays the customer’s account number.

Invoice (or Statement) Number: Displays the invoice (or statement) number assigned to the item.

Date: The date of the invoice.

Inv. Amt: The original invoice amount.

Pending: The payments applied to this invoice that have not been posted on the account.

Open Amt: The amount of the invoice that is not paid.

Print Item: Select an invoice on the screen and choose this option to print a copy of the item.

Delete Payments by Batch
The Delete Payment by Batch option allows you to globally delete payments by Batch ID.
Credit Cards (Electronic Funds Module)

The *Electronic Funds Module* allows you to process credit cards directly with your bank or credit card processing software. Please contact Advantage Route systems for further information.

EFT (Electronic Funds Module)

The Electronic Funds Module allows you to process checking account information directly with your bank. Please contact Advantage Route systems for further information.

Process EDI Transactions (Optional Module)

EDI *(Electronic Data Interchange)* is used for electronically exchanging documents between businesses. Please contact Advantage Route Systems for further information.
Lock Box Import

The Lock Box option is used to globally import payment transactions entered on an external spreadsheet.

Fields:

**Import Type:** Select the import format to use.

**Batch No:** Enter a batch number to be assigned to the payments imported

**Account Number:** The account number to receive the payment posting.

**Amount Paid:** The total amount of the payment.

**Payment Type:** Select the type of payment the customer used from the drop-down list. Your options are:

- Cash
- Check
- Credit Card
- Coupon
- Money Order
- Debit Card
- Bank Transfer
- Barter

**Multiple Items:** Check this box if more than one item is being imported.

**Default Bank:** Choose the default bank account to use on import.

**Employee:** The employee code of the person entering this transaction. You can type it in or select it from the drop-down list.

**Date:** The date for the payment being acquired. It does not have to be today’s date.

**Check Number:** If your customer paid by check, enter the check number used for this payment.

**Auto Apply to Invoices:** Choose this option to auto-apply the imported payments to the customer’s oldest invoices.

**File Name:** Enter the name of the file or choose a file from the browse window.
Spreadsheet Example:

When importing payment data, you have the option of either importing a single payment that will be applied to multiple invoices, or you can import multiple payments that will be applied manually.

Single Payment Option:

To import a single payment using the Excel option, the data must be formatted as shown below:

![Spreadsheet Example](image)

**Fields:**

*Date:* The date of the posted invoice.

*Invoice #:* The invoice number assigned to the item.

*Account #:* The customer’s account number.

*Amount:* The total due amount of the invoice.
Multiple Payments Option:

To import multiple payments using the Excel option, the data must be formatted as shown below:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account #</th>
<th>Check #</th>
<th>Amount</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/02/2000</td>
<td>60112</td>
<td>5110</td>
<td>100.00</td>
<td>Bill Hefley</td>
</tr>
<tr>
<td>01/02/2000</td>
<td>60112</td>
<td>5110</td>
<td>100.00</td>
<td>Rob Snyder</td>
</tr>
<tr>
<td>03/10/2000</td>
<td>049512</td>
<td>0345</td>
<td>65.74</td>
<td>Shirley Smiths</td>
</tr>
<tr>
<td>04/08/2000</td>
<td>049511</td>
<td>0345</td>
<td>58.45</td>
<td>Anthony Jones</td>
</tr>
<tr>
<td>06/08/2000</td>
<td>999857</td>
<td>0345</td>
<td>10.58</td>
<td>Roger Culp</td>
</tr>
<tr>
<td>06/10/2000</td>
<td>999852</td>
<td>0345</td>
<td>105.07</td>
<td>Larry Thomas</td>
</tr>
</tbody>
</table>

Fields:

- **Date:** The date of the payment.
- **Account #:** The customer’s account number.
- **Check #:** The check number assigned to the payment (if applicable).
- **Amount:** The payment total.
- **Name:** The customer’s name.

Procedure to Import Data:

When you are importing a file using the Excel import option, it must be saved as type: ‘Microsoft Excel 5.0/95’ from within the ‘Save As’ screen in Microsoft Excel®. After the file format has been updated, use the browse option to select the directory where the file is stored on your PC, and click ‘OK’. Once the information has been imported, you will receive a report listing all of the transactions processed.
Returned Check Processing

The Returned Check Processing option allows you to enter, track, and bill your customers for insufficient funds.

Fields:

Acct Number: The customer’s account number.

Invoice Number: Displays the invoice number that was generated to add the insufficient funds back to the customer’s account.

NOTE: The invoice is generated after the Post option has been selected on the bottom-right portion of the screen.

Check Number: The check number that was returned.

Check Amount: The amount of the returned check.

Check Date: The date on the returned check.

Entry Date: The date the returned check entry was made in RMA.

Paid Date: The date the customer paid your company for the insufficient funds.

NOTE: Once the ‘Paid Date’ is entered and the record is saved, select the Post button to clear the Returned Check flag from the customer’s account.

Contact Reasons: Select a Contact Message Reason to associate with the returned check. This is used for reference on the Contacts tab of the customer’s account.

NOTE: The Contact Reason above can be established as a default selection by going to File > Branch Setup > Banking tab.

Employee: The employee that created the returned check entry.

Note 1-4: Use the notes fields to input any information desired, for reference.

Paid Note: Enter a miscellaneous paid note for reference.
**Product Charge Codes:**

*Returned Check Balance:* Enter a *Product Charge Code* that will be assigned to the invoice created for the amount of the returned check payment.

*Returned Check Fee:* Enter a *Product Charge Code* that will be assigned to the returned check invoice to bill the customer a penalty fee.

**NOTE:** The *Product Charge Codes* above can be established as default selections by going to *File > Branch Setup > Banking* tab.

*Returned Check Fee Amt:* Enter the penalty fee that the customer will pay for the returned check.

**NOTE:** If this option is left at 0.00, the default price assigned to the *Returned Check Fee Product Code* will be used.

**Post:** This button is selected after a new returned check entry is saved. RMA will create an invoice that includes the *Returned Check Balance* and *Returned Check Fee* options listed above. Additionally, the customer’s account will be flagged with ‘Returned Check’ throughout the program, and a new message will be added to their *Contacts* tab.

**NOTE:** The returned check invoice created will need to be posted on the customer’s account using the standard *Post Transactions* process.

**Additional Steps:**

When the ‘Save’ option is selected, the system will ask you to *Purge (Delete)* any entries marked as paid. Select ‘Yes’ to permanently remove previous returned check entries that have been resolved.

![Returned Checks](image)

**Clearing a Returned Check:**

Once the customer resolves the returned check issue, simply return to the *Returned Check Processing* screen and modify the existing entry.

1. Enter a date into the *Paid Date* field.
2. Enter any desired notes in the *Paid Note* field.
3. Choose *Save*.
4. Select the *Post* button.

After the *Post* button has been selected, the ‘Returned Check’ flag will be removed from the customer’s account.
Disputed Invoices

The *Disputed Invoices* option allows you to dispute and resolve invoice problems with customers.

**NOTE:** Alternatively, simply right-click on an invoice listed within the *Open Invoices* section of a customer’s account to *Dispute* or *Resolve* items.

![Disputed Invoices](image)

**Fields:**

- **Acct No.:** Displays the customer’s account number.
- **Acct Name:** Displays the customer’s account name.
- **Acct Balance:** Displays the customer’s account balance.
- **Date:** Displays the invoice date.
- **Invoice #:** Displays the invoice number.
- **Amt:** Displays the original invoice amount.
- **Open:** Displays the remaining open amount due on the invoice.
- **Disputed:** Displays the disputed date of the invoice.
- **Resolved:** Displays the resolved date of the invoice.

**Disputing an Item:**

1. Browse for the customer and choose the *Modify* button.
2. Double-click on the invoice to dispute.
3. The *Disputed* field will be populated with the current date, click *Save* to continue.

**Resolving an Item:**

1. Browse for the customer and choose the *Modify* button.
2. Double-click on a disputed invoice.
3. The *Resolved* field will be populated with the current date, click *Save* to continue.

**Additional Options:**

Select the *Print* button on the screen to access the *Disputed Invoices Report*. This report can also be found under *Reports > Accounting Reports > Sales.*
### Payment Lookup

This function allows you to search for payments, either by check number or payment amount. Press ESC during the lookup process to abort the lookup and display the results found to that point.

![Payment Lookup](image)

#### Fields:

- **From**: Enter a starting check number to include in the range (if applicable).
- **To**: Ending an ending check number to include in the search (if applicable).
- **Check Date**: Enter the check date to include in the search (if applicable).
- **Payment Amount**: Enter the payment amount to search for.
- **Include Previous**: Enter the number of previous months to include in the search.
- **Batch No**: Enter a batch number to include in the search (if applicable).
- **Document ID**: Enter a document identification code to include in the search (if applicable).
- **Receipt Notes**: Enter a payment note to include in the search (if applicable).
- **Account Number**: Enter the account number to include in the search (if applicable).

#### Detail Line:

- **Document ID**: Displays matching Document ID’s.
- **Check No.**: Displays matching check numbers.
- **Date**: Displays matching payment dates.
- **Amount**: Displays matching payment amounts.
- **Account Number**: Displays matching account numbers.
- **Batch Number**: Displays matching Batch Numbers.
- **Customer Name**: Displays matching customer names.
- **Receipt Note**: Displays matching payment notes.
Apply Payments and Credits

The Apply Payments and Credits screen is used to apply payments and credits to invoices that have not been previously applied.

Fields:

- **Acct. No.:** Enter the customer’s account number.
- **Payment Date:** Enter the date of the entry.
- **Account Balance:** Displays the customer’s current account balance.
- **Unapplied Amount (Displayed when Applying):** Displays the remaining amount that can be applied to open items.
- **Pay All/Oldest:** Choose this option to apply the credit to the oldest open items listed.
- **Name:** Displays the customer’s name.
- **Address:** Displays the customer’s address.

Detail Lines:

- **Acct Number:** Displays the customer’s account number.
- **Invoice Number:** Displays the customer’s invoice number.
- **Date:** Displays the date of the invoice.
- **Inv. Amt:** Displays the original invoice amount.
- **Pending:** Displays any payment amounts that are applied to the item but not posted on the account.
- **Open Amt:** The amount of the invoice that is not paid.

- **Print Item:** Select an invoice on the screen and choose this option to print a copy of the item.
- **Search:** Select this option to search for an invoice within the displayed items on the screen.
- **Lookup Invoices:** Select this option to search for an invoice on all customer accounts.
- **Show Check (Check 21 Module Only):** Choose this option to view an associated scanned check with an unapplied payment.

Check 21

This option is available with the optional Check 21 Module. Please contact Advantage Route Systems for further information.
Transaction Reports

The following Transaction Reports are available to help you with your daily accounting:

![Transaction Reports]

These reports are described in detail within the section below.

**Transaction Detail**

The Transaction Detail Report provides you with detailed invoice and payment information entered into RMA.

NOTE: This report can be configured to automatically print during the Afternoon Card process under Lists > Routes > Handheld Class, on the Upload Reports tab.

![Transaction Details Report]

**Fields:**

**Sort Option 1 and Sort Option 2:** Select from the following sort options:

- Invoice Number
- Account Number
- Customer
- Time
- Stop

**Route:** Select the route you would like to view.

**All Routes:** Select this option to include all route transactions for the date specified on the report.

**Invoice Date:** Enter the date range to include in the report.

**All Dates:** Select this option to include all transactions dated within the current period.

**Blank Lines:** Enter the number of blank lines you want between each record on the report (for writing notes).
**Only Handheld Transactions:** Select this option to only include handheld transactions on the report.

**List Only for Selected Employee:** Select this option to view transactions entered by a specific employee (choose an employee from the list upon selection).

**All Unposted Transactions:** Select this option to include all un-posted transactions on the report.

**Posted Transactions:** Select this option to include posted transactions on the report.

**Include All Payments:** Select this option to include all payments entered per employee on the Transaction Detail Summary Report (regardless of the route assigned to the payment).

**Suppress COD Customers without Payment:** Select this option to suppress the additional report that will print for all COD customers that did not include a payment with their invoice.

**Exclude Skip Reasons:** Select this option to exclude skipped stops on the report.

**Include Inventory Sold Summary:** Select this option to include an inventory sold summary for the route entered.

**Summary Only:** Select this option to suppress transaction details on the report.

**Include G/L Summary:** Select this option to include a General Ledger Posting Summary Report with your report.

**Add Previous and Current balance:** Select this option to include the beginning and ending balance per customer on the report.

**Show Product Deposit Exchange:** Select this option to include container exchanges per customer on the report.

**Show Delivery Address:** Select this option to include each customer’s delivery address on the report.

**Show Authority Level Summary on Transaction Detail Report:** Select this option to include sales tax authority level detail on the report.
Cash Journal Report

The Cash Journal Report provides you with detailed payment information entered into RMA.

Fields:

Sort Option1: Select from the following sort options:

- Record Order
- Batch Number
- Major Acct Code
- Customer Type
- Sales Rep

Account Number: Enter the range of account numbers to include in the report.

Payment Date: Enter the range of payment dates to include in the report.

Customer Type: Select the Customer Type Codes to include in the report.

Sales Rep: Select the sales representatives to include in the report.

Major Acct: Select the Major Account Codes to include in the report.

Search Posted Payments from CURRENT Period: Select this option to run the report for posted payments within the current period.

NOTE: The report will only include un-posted payments when this option is unchecked.

List Only for Selected Employee: Select this option to view payments entered by a specific employee (choose an employee from the list upon selection).

Include Cash Detail: Select this option to include customer account detail on cash payments.

Include Summary by Employee: Select this option to include an additional report that will summarize payment totals entered per employee.

Show Customer Names: Select this option to include customer names in the report.
List Only for Batch Number: Select this option to view the report based on the entered Payment Batch Number (enter a batch number in the box upon selection).

Only Include Payments From Drivers: Select this option to only include payments collected from drivers in the report.

Only Hold Service Accounts: Select this option to only include payments collected on ‘Hold Service’ accounts in the report.

Include Batch# / Date / Employee: Select this option to include the Batch #, Date, and Employee fields on each payment in the report.

Include Batch Summary: Select this option to include an additional report that will summarize batch number totals.

Payment Type: Select one or more payment type to include in the report.

Daily Sales by Employee Report

The Daily Sales by Employee Report is useful for evaluating the daily effectiveness of each employee within RMA.

Fields:

Sort Option 1 and Sort Option 2: Select from the following sort options:

- By Employee ID
- By Invoice Number

Date: Enter the date that you would like to include in the report.

Available Employees: Lists the employees that can be added to the report.

Selected Employees: Lists the employees that will be included in the report.

NOTE: Double-click on each name, or use the arrows, to add or remove each employee on the report.

Include Invoice Details: Select this option to include detailed invoice data on the report.

Posted Transactions: Select this option to include posted transactions on the report.
Pre Post Transactions

The Pre-Post Transactions option is used when multiple branches have been added to RMA. An employee at each branch location will ‘pre-post’ daily transactions to verify they are ready to be posted.

Fields:

Invoice Transactions: Select this option to pre-post invoice transactions.

Group product by class: Select this option to group items by Product Class on the Pre-Posting Summary Report.

Payment Transactions: Select this option to pre-post payment transactions.

Equipment Movement: Select this option to pre-post equipment changes.

Print Equipment Transfer Report: Select this option to print a report that will include all pre-posted equipment changes.

Post by Route: Select this option to pre-post transactions by route selections.

Payment Batch: Select an individual payment batch to pre-post, if desired.
**Pre-Posting Transactions:**

1. Make your selections on the *Pre-Post Transactions* screen and click ‘OK’.

2. On the *Select Date(s)* screen, select the desired date to pre-post and click ‘OK’.

**NOTE:** To pre-post multiple dates, hold down the CTRL key on your keyboard and click each date desired.

3. The *Summary of Transactions* screen will be displayed for review. Click ‘OK’ to pre-post the transactions.

The transactions will be pre-posted and a *Pre-Posting Summary Report* will be generated automatically.
Post Transactions

The Post Transactions option is used to permanently add transactions to each customer’s account. In addition, the posting process will update product sales information, equipment, and much more.

**Fields:**

*Invoice Transactions:* Select this option to post invoice transactions.

*Group product by class:* Select this option to group items by Product Class on the Posting Summary Report.

*Payment Transactions:* Select this option to post payment transactions.

*Equipment Movement:* Select this option to post equipment changes.

*Print Equipment Transfer Report:* Select this option to print a report that will include all posted equipment changes.

*Post by Route:* Select this option to post transactions by route selections.

*Payment Batch:* Select an individual payment batch to post, if desired.
**Posting Transactions:**

1. Make your selections on the *Post Transactions* screen and click ‘OK’.

2. On the *Select Date(s)* screen, select the desired date to post and click ‘OK’.

   **NOTE:** To post multiple dates, hold down the CTRL key on your keyboard and click each date desired.

3. The *Summary of Transactions* screen will be displayed for review. Click ‘OK’ to post the transactions.

   The transactions will be posted and a *Posting Summary Report* will be generated automatically.
General Ledger Postings

This option creates a *G/L Posting Report* from your accounts receivable transactions.

Select a month/year combination and click ‘OK’.

Select the output option desired to generate the report.
Generate Rent Charges

The Generate Rent Charges option is used to create equipment rental transactions.

NOTE: This option is generally used during the Month End process. Refer to Chapters 3.11 and 3.12 of the Supplemental Guide for further information.

**Fields:**

**Enter Month to Bill (Read-Only):** Displays the equipment rent codes that will be billed.

**Billing Type:**

**Statement Billed:** Select this option to generate rentals for customers that are billed on the desktop.

**Rents Not Billed:** Select this option to generate rentals for customers that are billed on the desktop, and any handheld billed customer’s that have not been charged for their rental.

**Rent Schedule:**

**Regular:** Select this option to generate rentals using the standard rent billing cycle.

**Schedule 1:** Select this option to generate rent according to your custom rent schedule (if applicable).

**Schedule 2:** Select this option to generate rent according to your custom rent schedule (if applicable).
**Schedule 3:** Select this option to generate rent according to your custom rent schedule (if applicable).

**Schedule 4:** Select this option to generate rent according to your custom rent schedule (if applicable).

**Rental Group:** Select this option to choose a *Rental Group* to bill.

**NOTE:** For further information on rent billing methods in RMA, refer to *Chapter 3.11* of the *Supplemental Guide*.

---

**Reports:**

Select the desired report(s) to print when generating rentals:

- **Billing Summary Report:** This report includes a summary of the total amount billed per rental code.
- **Rent Billing Detail Report:** This report includes detailed customer information per rental.
- **Rental Income Report:** This report includes deferred rent billing details.

**NOTE:** Refer to *Chapter 3.11* of the *Supplemental Guide* for further information on *Deferred Rent Billing*.

---

**Other:**

- **Customer Type:** Select the range of *Customer Type Codes* to include when generating rentals.

- **Equipment Type:** Select the range of *Equipment Type Codes* to include when generating rentals.

- **Employee:** Select the employee that will be assigned to all 'Statement Billed’ rental invoices.

**NOTE:** The route driver assigned to a handheld billed customer will be assigned to any rent invoices generated on the desktop.

- **Use This Employee For All Rents:** Select this option to use the selected employee on all rental invoices generated (route drivers will not be used).

- **Delete Pending Rents:** Click this button to delete any pending rents that have already been generated.
Package Plan

The Package Plan feature is an optional module, please contact Advantage Route Systems for further information.

Calculate Late Charges

The Calculate Late Charges option allows you to generate late charges on past due accounts.

![Late Charge Calculation](image)

**Fields:**

*Customer Range:* Enter the range of account numbers to include when generating late fees.

*Late Charge Code:* Select the range of Late Charge Codes to include when generating late fees.

*Minimum Account Balance:* Enter the minimum balance a customer must have to qualify for a late fee (any balance under this amount will not be charged).

*Transaction Date:* Enter the date that you would like to apply to the generated transactions.

*Aging Override:* Use this option to manually override the ‘aging’ settings assigned to the Late Charge Codes selected. The late fees will be based on the number of days entered here.

*Use Customer’s Route for Transactions:* Select this option to assign the customer’s route to the invoices (instead of the employee generating the transactions).

*Delete Unposted Late Charges:* Click this button to delete any pending late charges that have already been generated.
Calculate Administrative Charges

The Calculate Administrative Charges option is used to assess ‘handling’ fees on large accounts that demand a high level of resources and time in the office.

Fields:

Account Number: Enter the range of account numbers to include when generating administrative charges.

Administrative Charge Code: Select the range of Administrative Charge Codes to include when generating administrative charges.

Minimum Balance: Enter the minimum balance a customer must have to qualify for an administrative fee (any balance under this amount will not be charged).

Show Detail on Administrative Charges: Select this option to include detailed account information on the Administrative Charges Report.

Delete Unposted Administrative Charges: Click this button to delete any pending administrative charges that have already been generated.
Generate Recurring Billing

The Generate Recurring Billing option allows you to bill your customers for recurring fees such as fuel, invoicing, etc.

**Fields:**

- **Account Number:** Enter the range of account numbers to include when generating recurring charges.
- **Customer Type:** Select the range of Customer Type Codes to include when generating Recurring Billing Charges.
- **Charge Code:** Select the range of Product Charge Codes to include when generating Recurring Billing Charges.
- **Minimum Balance:** Enter the minimum balance a customer must have to qualify for a recurring charge (any balance under this amount will not be charged).
- **Show Detail on Recurring Billing Report:** Select this option to include detailed account information on the Recurring Billing Report.
- **Delete Unposted Recurring Charges:** Click this button to delete any pending recurring charges that have already been generated.
Generate Discounts and Free Goods

The Generate Discounts and Free Goods feature allows you to set up discounts or free items for customers that purchase an established quantity of items over a period of time.

**NOTE:** Refer to Chapter 2.15 of the Supplemental Guide for further information on this feature.

Generate / Review Standing Orders

Telesales

The Generate / Review Standing Orders Telesales option allows you to set up recurring product orders on each customer’s account that will repeat from week to week.

**NOTE:** Refer to Chapter 4.12 of the Supplemental Guide for further information on this feature.

Close Period

The Close Period function is used to reset totals, archive customer data, and other important information at the end of each accounting period.

**NOTE:** You MUST close the period at the end of each month. Refer to Chapter 3.12 of the Supplemental Guide for a complete tutorial on the Month End process.
Refund Checks

RMA includes an advanced refund check processing system that incorporates enhanced features for various route delivery industries.

Print Refund Checks

The Print Refund Checks option allows you to refund your customers that have a credit balance.

NOTE: There are four available check printing options under Branch Setup, on the Accounting tab. If the available check formats do not fit your needs, the Print Refund option still makes it convenient for creating refunds within the system, and the checks can be written by hand. Refer to Chapter 3.08 of the Supplemental Guide for further information on Printing Refund Checks within RMA.

Fields:

Primary and Secondary Sort: Select from the following sort options:

- Account Name
- Account Number
- Date
- Refund Amount

Terminated Accounts: Select this option to include terminated accounts with negative balances in the criteria.

Active Accounts: Select this option to include active accounts with negative balances in the criteria.
**Terminated Date/Invoice Date:** Enter the range of termination dates (the customer’s End Date) or invoice dates to include when generating refunds.

**NOTE:** If the customer is not terminated, check the ‘Include Active Accounts’ option.

**Account Number:** Enter the range of account numbers to include when generating refunds.

**Refund Amount:** Enter the range of customer balances to include when generating refunds (enter positive amounts).

**Refund Code (Displayed on ‘Active Accounts’ only):** Select the Product Charge Code to use for refunds.

**Accept Criteria:** Select this option to search for customers that qualify for a refund based on the criteria entered.

**NOTE:** You can single click on each account to include or exclude from generating and printing a refund.

**Preview:** Select this option to preview a report prior to generating the refunds.

**Generate Refunds:** Select this option to generate and print the refunds.

**De-select All:** Select this option to de-select all of the displayed accounts.

**Choose Printer:** Select this option to select an alternate printer for processing the refund checks.

**Exit:** Select this option to exit the screen.

**Default Refund Check Format:** This standard refund check format is automatically selected.

**Custom Format:** Select this option to choose a custom refund check format (requires custom programming).

**Starting Check Number:** Enter the starting check number that should be used.
Print Check Register

The *Print Check Register Report* includes a summary of all refund transactions generated and posted for an entered date range.

**Fields:**

**Account Number:** Enter the account number range to include in the report.

**Check Date:** Enter the range of refund check dates to include in the report.

**Check No:** Enter the range of refund check numbers to include in the report.

**Refund Check Codes:** Enter the range of *Refund Check Codes* to include in the report.
Refund Detail Report

The Refund Detail Report provides you with detailed invoice and itemized information important for recurring refund users in industries such as oil, recycled paper, and others.

Fields:

Account Number: Enter the account number range to include in the report.

Invoice Date: Enter the posted refund check invoice date range to include in the report.

Check No: Enter the range of refund check numbers to include in the report.

Refund Check Code: Enter the range of Refund Check Codes to include in the report.

Check Date: Enter the range of refund check dates to include in the report.

Select one of the following options to determine the information included in the report:

- Checks not Printed: Select this option to only include refund checks that have not been printed in the report.
- Checks Printed: Select this option to only include refund checks that have been printed in the report.
- Both: Select this option to include both of the options above in the report.

Start each Customer on a New Page: Select this option to reserve a full page for each customer when printing a detailed report.
Equipment Processing

The Equipment Processing options allow you to manage equipment movement and servicing.

![Equipment Processing Options](image)

Equipment Transfer

The Equipment Transfer option is used to manage equipment movement entered on the handheld. New records are created as each route is uploaded, and the transfers are completed by selecting the Equipment Movement option within the Post Transactions screen.

**NOTE:** Each entry can be modified or deleted prior to posting, if desired.

![Equipment Transfer Screen](image)

**Fields:**

- **Account Number:** Displays the account number associated with the entry.
- **Serial Number:** Displays the equipment serial number associated with the entry.
- **Name:** Displays the customer’s name.
- **Transaction Date:** Displays the date of the entry.
- **Action:** Displays the ‘action’ taken for the entry, the choices are:
  - Picked Up (P)
  - Dropped Off (D)
  - On Truck (T)
  - Added to Truck (A)
  - Removed from Truck (R)
  - Exchanged (E)
  - Serviced (S)
- **Statement Bill:** This option corresponds to the Statement Billed setting on each unit.
Charge Code: Displays the rental code assigned to the unit.

Period Code: Displays the period code assigned to the unit.

Period Rate: Displays the rental rate assigned to the unit.

Rental Group 1-3: Displays any Rental Groups assigned to the unit (if applicable).

Start Rent: Displays the start rent date assigned to the unit.

**Equipment Movement**

The Equipment Movement option allows you to manually move equipment on the desktop.

**NOTE:** For further information on moving equipment in RMA, refer to Chapter 3.05 of the Supplemental Guide.

**Fields:**

*Equipment ID:* Select an equipment ID from the list.

*Date:* Displays the date of the entry.

*Time:* Displays the time of the entry.

*By:* Displays the employee that created the entry.

**Move To:**

Select the location that the unit will be moved to, the choices are:

- Warehouse
- On Truck
- Picked Up
- Received
- Service
- Suspense

**NOTE:** Once you have entered all of the information, the unit will be moved automatically when the Save or More button is selected.
Equipment Service

The *Equipment Service* option allows you to enter and track the service performed on each piece of equipment.

**NOTE:** For further information on equipment service options in RMA, refer to *Chapter 3.14* of the *Supplemental Guide*.

![Equipment Service Screen](image)

**Fields:**

*Equipment ID:* Select the equipment ID to service from the list.

**Adding a Service Code:**

To add a service code to the equipment ID selected, choose the *Add* key and the following screen will appear:

![Service Code Screen](image)

**Fields:**

*Service Code:* Select the *Equipment Service Code* desired from the list.

*Description:* Displays the description corresponding to the service code.

*Date:* Enter the date the service was performed on this unit (double-click to choose on calendar).

*Time:* Enter the time the service was performed.

*By:* Select the employee that performed the service.

*Hours:* Enter the number of hours spent performing the service.

*Part Cost:* Enter the cost of parts used for the service.
**Reported Fault:** Select the reported fault.

**Actual Fault:** Select the actual fault determined by the service technician.

**Equipment Service Call**

The *Equipment Service Call* option allows you to create service tickets that can be printed and distributed to your service technicians.

**NOTE:** For further information on equipment service options in RMA, refer to *Chapter 3.14* of the *Supplemental Guide*.

---

**Fields:**

**Account Number:** Enter or browse for the customer’s account number.

**Equipment ID:** Select the unit that will be serviced.

**Date:** Displays the date the entry was created.

**Call Type:** Select the Equipment Service Reason that applies to the request.

**Time:** Displays the time the entry was created.

**Message:** Enter any notes desired for the service technician.

**Service History:** Displays any previous equipment services performed on the unit.

**Employee ID:** Displays the employee that created the entry.

**Follow Up Info:**

**Maintenance Personnel:** Select the service technician that will perform the service on the unit.

**Follow Up Date:** Enter the date to schedule the service.

**Follow Up Time:** Enter the time to perform the service.

**Completed:** This option is updated automatically when the service call is completed on the *Follow-Up* tab.

**Other:**

**Under Warranty:** Displays the warranty status of the unit.
**Service Follow-Up Tab:**

The *Service Follow Up* tab is used to enter all of the information associated with completing the service call.

![Service Calls](image)

**Fields:**

**Maintenance Personnel:** Select the service technician that completed the service.

**Start and Finish Information:**

**Date:** Enter the start/finish date of the service call.

**Time:** Enter the start/finish time of the service call.

**Other:**

**Mechanical Problems:** Select the *Equipment Service Codes* related to the service performed.

**Cost:**

**Hours:** Enter the number of hours it took to complete the service.

**Amount/ Hour:** Enter the rate per hour to perform the service.

**Total Cost:** Displays the total labor cost associated with the service performed.

**Comments:** Enter any comment desired regarding the service.

**Service Call Complete:** Select this option to indicate that the service call is completed.

**Equipment Master Tab:**

The *Equipment Master* tab allows you to quickly access the *Equipment Master* screen of the unit being serviced.
Inventory

The *Inventory* options address inventory entry and tracking.

### Inventory Adjustments

This feature allows you to enter inventory as it is created or received from your supplier.

![Inventory Adjustments](image)

**Fields:**

- **Reason Code:** Select the *Inventory Adjustment Code* corresponding to the entry.
- **Charge Code:** Select the *Product Charge Code* being updated.
- **Entry Date:** Enter the date the product is being updated.
- **Quantity:** Enter the number of units being updated.
- **Cost:** Enter the cost of the unit.
- **Empty Code (only displayed on Refill Container Stock):** Select the empty container code associated with the item selected in the *Chrg. Code* field.
- **Product Batch Code:** Enter a production batch code if desired (generally supplied by the product manufacturer).
- **Pallet ID:** A unique *Pallet ID* can be generated and printed for each inventory item received in RMA, and can be attached to the pallet that contains the items (requires additional setup).

**NOTE:** The *Pallet ID* will only be generated on *Inventory Adjustment Codes* with the option ‘Require Pallet Number’ selected under *Lists > Product Codes*. An optional *Warehouse Prefix* (*File > Branch Setup > Defaults*) and *Pallet Reference Code* (*Lists > Product Codes > Warehouse Setup*) can be included in the *Pallet ID* if desired.
**Employee:** Displays the employee creating the entry.

**Update Perpetual Inventory Levels (Perpetual Inventory/Mobile Warehouse only):** Choose this option to manually adjust the stock level of the selected Mobile Warehouse for the item entered.

**Comments:** Enter any comments about the inventory being received, if desired (e.g., P.O. number, waybill number).

---

**NOTE:** The following options are activated or inactivated based on the type of Inventory Adjustment Code selected.

---

**Branch (Transfer From):** Select the branch that the items will be transferred from.

**Warehouse:** Select the warehouse that the items will be transferred from.

**Branch (Transfer To):** Select the branch that will receive the items.

**Receiving Warehouse:** Select the warehouse that will receive the items.

**Expected Date:** Select the date the items should be received.

**Branch (Transfer Via):** Select the branch that the items will be temporarily transferred to prior to the receiving branch.

**Transfer Warehouse:** Select the branch that the items will be temporarily transferred to prior to the receiving warehouse (e.g., Mobile Warehouse).

---

**NOTE:** When using the Transfer Via options, after the initial entry has been posted, use the Transit button available on this screen to complete the transfer to the receiving warehouse.

---

**Truck Bay (Mobile Warehouse only):** Enter the bay that on the delivery vehicle that the items will be stored in for transfer.

---

**Other:**

**Post**

**Post:** After an entry is made and saved, select the Post button to update the inventory.

**Transit**

**Transit:** Select this option to view all ‘Transfer Via’ orders that are being transferred in RMA.

---

**NOTE:** When the items have been successfully transferred to the receiving warehouse, select an entry and click the ‘OK’ button to complete the process.
**Refill**

Select this option to simplify the adjustment process when making multiple adjustments using refillable containers.

The following screen will be displayed:

![Inventory Adjustments Screen](image)

**Fields:**

- **Reason Code:** Select a ‘Refill Container Stock’ adjustment code that applies to the current entry (e.g., Container Refill).

  **NOTE:** You must select ‘Refill Container Stock’ within the Inventory Adjustment Codes screen.

- **Charge Code (1-6):** Select up to six products that are associated with refillable containers (e.g., 5 Gallon Water).

- **Quantity:** Enter the quantity being filled and added to inventory.

- **Empty Code:** Select up to six empty container codes that are being refilled (e.g., 5 Gallon Bottles).

- **Comments:** Enter a miscellaneous note, if desired.

- **Branch:** Select the branch that the inventory adjustment will apply to.

- **Warehouse:** Select the invoice where the inventory will be stored.

- **Entry Date:** Enter the date of the entry.

- **Employee:** Select the employee creating the adjustment.
Inventory Physical Count

This feature allows you to manually enter physical inventory counts that will override the existing quantity-on-hand total listed for each product in RMA.

Fields:

**Counted By:** Select the employee that counted the inventory.

**Count Date:** Enter the date the inventory was counted.

**Warehouse:** Select the warehouse the inventory was counted in.

**Detail Lines:**

**Product:** Displays the Product Charge Code ID.

**Description:** Displays the Product Charge Code description.

**Qty on Hand:** Displays the current quantity-on-hand total listed for the product.

**Difference:** Displays the difference in quantities between the Quantity on Hand and Qty Counted totals.

**Qty Counted:** Enter the total quantity counted for the item.

**Filter:**

**All:** Select this option to display all of the items in the list.

**Counted:** Select this option to display only the items that have been updated currently.

**Not Counted:** Select this option to only display items that have not been counted.

**Difference:** Select this option to only display items with a quantity listed in the Difference column.

**Inactive:** Select this option to include ‘Inactive’ items in the list.

**NOTE:** This option can be found within the Product Charge Codes screen, refer to Chapter 6 for further information.
Non Inventory: Select this option to include ‘Non-Inventory’ items in the list.

**NOTE:** This option can be found within the Product Charge Codes screen, refer to Chapter 6 for further information.

Quick Entry: Select this option to manually enter the product ID and quantity totals (instead of using the list).

**NOTE:** Click ‘Enter’ on your keyboard after each entry using this option.

Print: Select this option to preview or print the current Inventory Physical Count Report.

Save: Select this option to save the inventory adjustments and print the Inventory Physical Count Report.

Exit: Select this option to exit the screen.

**Inventory Valuation Adjustments**

RMA includes an extensive inventory valuation system that allows you to instantly view your inventory values based on established cost information input into the system. Depending on the option you choose, RMA will provide this information on a Fixed Cost, FIFO (First-in, First-out) or LIFO (Last-in, First-out) method of calculation.

**NOTE:** Refer to Chapter 3.20 of the Supplemental Guide for further information on this feature.

**Purchase Orders**

The Purchase Orders option allows you to enter and track purchase orders used by your company for purchased products.

**NOTE:** For further information on the Purchase Order feature, refer to Chapter 4.06 of the Supplemental Guide.

End of Section A of the Route Manager Series 6 User Manual.
Index

A
Accounting
  Information 25
Accounts Receivable 1, 25
Adding New Records 15
Address Adjustment 44
Aging Override 389
  Alignment 16
  Altering Invoice Data 334
Annual Rate 151, 153
Apply Payments and Credits 377
Assembling Materials 7
Asset Tax 31, 111, 169, 217, 229, 312, 326

B
Backup Drive 70
Balances 90
Bank Account Billing Info 105
Bank Transfer
  Processing Directory 70
Baud Rate 69
Bays 300, 302
Bill of Lading 353, 357
Billing
  Account Name 308, 309, 322
  Frequency Code 128
Bookkeeping Programs 26
Bottle Deposits 127
Branch
  Name 22
  Setup 22
Browse 15
Business License 103
Button Descriptions 15

C
Calculate Late Charges 389
Calendar
  Equipment Service 228
  Holiday 55
Cancel 16
Card Reader 68
Cash Journal Report 380
CD ROM 9
Charge Codes 25, 127, 231, 331
Check 21 364, 377
Check Type 27
Clerical Employees 292
Close Period 392
Close Preview 17
Collections
  Class 140
Comments 329
Commission
  Class 182, 293
  Class Codes 293
  Rates 293
Company
  Information 2
  Company Offset 44
Component Rates 215
Contact
  Information 89, 107
  Notes 40
  Contact Frequency Codes 162
  Contact Message Reasons 158
  Contact Via Codes 161
  Contract Expiration Date 97, 229
Contract ID 229
Credit
  Status 96
  Credit Card 104
    Processing 369
    Processing Directory 70
  Credit Classes 138, 139
    ID 139
  Credit Note Reasons 225
  Credit Statement Numbers 44
  Credit Term
    ID 142
  Credit Terms 142
Currency Rounding 26
Currently Unposted Transactions 219
Custom Report Groups 306
Customer
  Contact Information 88
  Type Codes and Descriptions 132
Customer Information
  Contact History 107
  History 95, 232
Daily Cash Recording 224, 294, 295, 349
Daily Cost Recording 202
Daily Processing and Transactions 2, 333
Daily Sales by Employee Report 381
Day Label Calendar 56, 57
Day-to-day Operations 5
Default
  Accounts 25
  Information 21
  Number of Bays 259
Default Products 124
Delete
  Records 16
Unposted Finance Charges 389, 390, 391
Delete Payments by Batch 368
Delivery
  Summary 127
  Delivery Order
    Reasons 170
  Delivery Tickets 342
  Departments 36, 222
  Deposit Code 189
  Disputed Invoices 375
  Docking Cradle 257
  Document Storage 45
Driver
  Directions 113
Dunning
  Messages 149, 150
  Dunning Letter Type 141

E
EDI Transactions 369
E-mail 22, 89, 110
  Statement 144
Employee 291
  Clerical 292
  Hire Date 292
  ID 291
  Information 291
  Type 292
Equipment
  History 40
  ID 128
  Locations 51, 233
  Marking 8
    Movement 398
    Repair Rate 51
    Service 399
    Service Calendar 228
    Service Calls 400
    Setup 327
    Style 236
    Type 235
  Equipment Processing 397
Equipment Transfer 50, 397
  Every … Lines 67
  Exception Reports 179
  Exit 16
  Exiting the Program 86
  Export 80
  Export E-Mail Addresses 82
  Export Report To Excel 16

F
Fax Report 16
Federal Tax ID 31
Field Data Collection 1
Field Service Qualifications 299
Finance Charge(s) 95
  Codes 151
  Deleting Unposted 389, 390, 391
  ID 151, 153
  Financed Equipment 227, 328
  Find Button 15
  First Page 17
  Follow-up Date and Times 400

G
General Ledger 184
  Account Type 219
  Number 215
  Postings 386
  Setup 219
  Generate / Review Standing Orders TeleSales 392
  Generate Discounts and Free Goods 392
  Generate Recurring Billing 391
  Generate Rent Charges 387
  Generate Standing Order Telesales 41
Geographic Area 248
Getting Started 13
Group Area Codes 117, 287, 314

H
Handheld
  Computer 8
  Computer 7
  Notes 40
  Options 2, 135
  Technology 1
Handheld Product 179
  Hard Disk Space 3
  Hardware 8
    Minimum Requirements 3
    Minimum Requirements 3
  Help 2

I
Import
  Files 77
Inputting Customer Data 88
Install
  Equipment 129
  RMAdvanced 9
Internet Connection 3
Inventory 25, 36, 174, 206, 208, 260, 279, 379, 402
  MTD and YTD 185
Sold Summary 379
Inventory Adjustment Codes 206
Inventory Physical Count 405
Invoice
  Copies 118
  Drilldown 32
  Rollover 23, 250
  Starting Numbers 23
  Transactions 382, 384
  Invoices 338

L
Languages 118, 315
Last Page 17
Latitude 24, 111, 320, 324
License Number of Route Trucks 300
License Setup 303
Load Data Set 76
Load Order 335, 338, 341, 343, 352
Load Sheet 345
Loading, Desktop Software 12
Local Payments 359
Local Settings 66
Locating Customers 15
Lock Box 370
Logout 86
Longitude 24, 111, 320, 324

M
Mailing Permit 44
Main Menu Screen 14
Maintaining Data Files 83
Maintenance Personnel 401
Management Guide 2, 3
Manager’s Role 4
MangoGeo 24, 88, 109, 111, 308, 309
MangoPilot 253
Manual Handheld 1
Map page 111
Master Bill Account Number 99, 309
Master Equipment List 226
Master User 20, 292
Mechanical Problems 401
Memory Cards 8
Messages 113
Alert 113
Handheld 40
ID 149, 150
Monthly Statement 147, 148, 149
One Time 113
Statement 99
Mileage on Route Trucks 300
Missing Tickets 346
Modifying Records 15
Module Bar 36
More 15
Multi User Environment 12

N
National Sales Codes 163, 165
Navigational Tools 15
New Customer Setup 307, 322
New Handheld Customer Review 357
Next Invoice Number 23
Next Page 17
Notes 89

O
Obtaining Priority Service 5
Open Hours 48, 113
Open Invoice 98, 133
Optimizations 63
Ordering Supplies 4
Overdue Balances 90

P
Pack (Data Files) 84
Package Plan 67, 128, 389
Package Plans 203
Packing Slips 353
Paper Custom Printed 8
Ordering 8
Passwords 12, 292
Payment Entering 359
Methods 348, 360, 362
Summary 279
Transactions 382, 384
Type 381
Voucher 144
Payment by Major Account 367
Payment Lookup 376
Payments 358
PC Card Marking 8
Pending Transactions 38
Pentium 200 Microprocessor 3
Period Code 230, 331
Period Discount Pricing 199
Period Rate 151, 231, 331
Periodic Maintenance 5
Phone Message Copies 66
Postal Codes 168
Postal Indicia 44
Posting Transactions 378
Pre Post Transactions 382
PreCall Options 133
Preparing Equipment 8
Pre-Route Total Net/Serviced Customers 280
Pre-Route Total Net/Serviced Customers Report Options 280
Presale Message Copies 66
Previous Page 17
Price Levels 98, 133
Price Overrides 263
Pricing Products 176
Print 16
Printer Afternoon Report 71
Fax 71
Impact 71
Label 71
Laser 7, 71
Requirements 8
Setup 16, 86
Printing 86
Refund Checks 393, 395
Product Charge Code 26, 173
Product Class 182
Product Class Code 189
Product Group Code 180
Product Group Codes 193
Product Group Discount 193
Product Information 124
Product on Hand 266
Product Price Lists 197
Product Unit Codes 196
Production Batch Code 174
Profit 94
Promotional Price Codes 200
Prorate Rent 49
Purchase and Sales Information 227
Purchase Order Number 119, 315
Purchase Orders 32, 173, 406

Q
Quick Entry Screen 267

R
RAM 3
Rebuilding Data Files 83
Receipt Fonts 165, 274, 289
Registration Screen 12
Remittance Stub 117
Rent Billing Cycle 58
Rented Equipment 129
Rents - Prorate 49
Reordering Products Level 185
Reports 2
Previewing 16
Restoring Data Files 85
Returned Checks 95
RMADVANCED Software 7
RMLive 42, 68, 170, 190, 213, 256, 257, 281, 282
Rounding 26
Route
Calendar Options 114
Code 114
Driver 292
Schedule 56, 57
Route and Truck Management 305
Route Caller 292
Route Payments 347
RV2000 Options 118, 133

S
SAGE Export 81
Sales Tax 111
Authorities 216
Codes 215
Rates 215
Saving Data 16
Security 20
Level 292
Level Codes 296
Sequence Number 334, 338, 341, 343
Serial Number of Equipment 335, 339, 341, 344, 353, 356
Service
Agreements 5
Codes 240, 399
Equipment 5
Follow Up 401
History of Equipment 234
Support 2
Service Agreement Configuration 18
Service Priority Codes 159
Setting Up
List Information 2, 87
Route Data 5
System 2, 4, 7
Setup Wizards 307
Signature Required 117
Site Instructions 113
Skips 346
Social Security Number 103, 291
Sold Price and Date of Unit 227, 328
Spare Units 5
Start and Stop Reasons 154, 155
Starting the Program 12
State Tax ID 31
Statement
Codes 143
Creating a File 16
Custom 144
Descriptions 173
E-mail 144
ID 143
Self Mailer 144
Standard Postcard 144
Types 144
Statement Assessment 101, 218, 311
Statement Information 43
Statement Numbers 44
Statement Payment Entering 361
Stuck Users 20
Stylus 9
Supplemental 1
Supply Chain Orders 351
Support 2
Suppress Balance 117
Suspend Service Codes 160

T
Tax
Authorities 215
Label 31
Tax breakdown 38
Thermal Receipt Paper 7
Tools 2
Touch Safe 9
Tracking Funds 358
Tracking Equipment 226
Training
   Personnel 4
   Support 2
Transaction
   Detail 378
   Invoice 382, 384
   Payment 382, 384
   Posting 378
   Reports 378
Transferring Data 5
Truck
   Class ID 300
   Class Information 302
   ID 300, 302
   Information 300, 304
   Sequence Code 180
Truck Load Verification 258

U
Undelete 16
Unit Style 327
Unit Type 327
Unposted Transactions 379
USB Ports 8
Use Doc Storage 45
User ID 12
Using Your Desktop Software
   2, 13

W
Warehouse Equipment 48
Warranty
   Expiration Dates 227, 328
   Status 400
Web New Customer Tab 137
Will Call 111
Windows NT 7
Write-Off Reasons 225

Z
ZIP Codes 88, 168
Zoom 17